
Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Diese Hilfe beschreibt die Konfiguration und Bedienung der ILME-FR7 / ILME-FR7K Interchangeable Lens Digital Camera.

Schlagen Sie bei Bedarf in diesem Handbuch und der Bedienungsanleitung der entsprechenden Geräte nach.

Empfohlene Themen der Hilfe

Mit Beginn der Nutzung dieses Produkts erklären Sie sich mit den Bedingungen der Softwarelizenzvereinbarung einverstanden.

Überblick

Von einem Webbrowser aus auf die Web-App zugreifen

Indem Sie das Gerät mit einem Tablet oder Computer verbinden, können Sie es über einen Webbrowser konfigurieren und
bedienen.

Ersteinrichtung des Geräts

Initialisieren Sie die Einstellungen des Geräts wie Angaben zum Administrator, Anzeigesprache sowie Datums- und
Zeiteinstellungen von der Web-App aus.

Geräteeinstellungen zurücksetzen

Sie können alle Netzwerk- und Geräteeinstellungen auf die werkseitigen Standardwerte zurücksetzen.

Anschlussblock

In diesem Thema werden die Lage und Funktion von Elementen am Anschlussblock des Geräts beschrieben.

Verbinden einer Fernbedienung RM-IP500

Sie können eine Fernbedienung RM-IP500 mit dem Gerät verbinden.

Technische Daten

Detaillierte technische Daten des Geräts.

Fehlerbehebung

Hierunter werden Symptome, Ursachen und Lösungen von Problemen beschrieben, die beim Gebrauch des Geräts auftreten
können.

Verbinden des Geräts per Kabel mit einem Netzwerkgerät

Sie können das Gerät mit einem Netzwerk verbinden, das keinen DHCP-Server besitzt (Modus mit fester IP-Adresse). Siehe „Mit
einem Netzwerk ohne DHCP-Server verbinden“.
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Vorbereitung

Typische Anwendungen

Beispiel für eine Systemkonfiguration

Steuern eines einzelnen Geräts mithilfe der mitgelieferten Infrarot-Fernbedienung

Steuern eines einzelnen Geräts mithilfe eines Tablets oder Computers

Steuern eines einzelnen Geräts mithilfe einer externen Fernbedienung

Steuern mehrerer Geräte mithilfe einer externen Fernbedienung

Lage und Funktion der Teile

Vorderansicht

Rückansicht

Anschlussblock

Seitenansicht

Draufsicht

Unteransicht

Objektivabstützung

Lage und Funktion der Elemente auf der Infrarot-Fernbedienung (mitgeliefert)

Bildschirm der Web-App

Übersicht über den Bildschirm der Web-App

Struktur des gemeinsamen Bereichs der Bildschirme

Struktur des Live-Betriebsbildschirms

Struktur des Einstellungsbildschirms PTZ AFR

Struktur des Wiedergabe-Betriebsbildschirms

Struktur des Einstellungsbildschirms

Kameramenü

Anzeige des Kamerabildschirms

Montieren des Geräts

Aufrechte Montage an einer festen Stelle

Aufrechte Montage an einer hoch gelegenen, festen Stelle

Montage an einer Decke

Anbringen/Abnehmen eines Objektivs

Vorsichtsmaßnahmen beim Anbringen/Abnehmen eines Objektivs
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Aufnehmen

Prüfen der Objektivschalter

Vorsichtsmaßnahmen bei Verwendung eines Zoomobjektivs

Anbringen eines Objektivs

Abnehmen eines Objektivs

Anschließen der Kabel

Verbinden des Geräts per Kabel mit einem Netzwerkgerät

Anschließen einer Stromversorgung

Verwendung von Wechselstrom

Verwenden der Stromversorgung über PoE++

Zurücksetzen der Schwenk-/Neigefunktionen

Konfiguration vor der Aufzeichnung

Initialisieren des Geräts mithilfe der Web-App

Von einem Webbrowser aus auf die Web-App zugreifen

Ersteinrichtung des Geräts

Geräteeinstellungen zurücksetzen

Konfigurieren der Grundfunktionen

Vorbereiten von Speicherkarten

Unterstützte Speicherkarten

Einsetzen von Speicherkarten

Auswerfen von Speicherkarten

Formatieren (Initialisieren) von Speicherkarten

Überprüfen der verbleibenden Aufzeichnungszeit

Wiederherstellen von Speicherkarten

Grundfunktionen

Starten/Stoppen der Aufzeichnung

Wechseln zwischen Speicherkarten

Prüfen des Tons

Festlegen von Zeitdaten

Prüfen der Aufnahme (Rec Review)

Anpassen des Bildausschnitts

Bildschirm zum Anpassen des Bildausschnitts
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Anpassen der Aufnahmerichtung

Anpassen der Aufnahmerichtung mithilfe der Web-App

Einstellen der Schwenk-/Neigegeschwindigkeit

Einstellen der Schwenk-/Neigebeschleunigung

Anpassen der Aufnahmerichtung mithilfe der mitgelieferten Infrarot-Fernbedienung

Einstellen des Zooms

Einstellen des Zoomtyps

Zoom mithilfe der Web-App einstellen

Einstellen der Zoomgeschwindigkeit

Einstellen des Zooms mithilfe der mitgelieferten Infrarot-Fernbedienung

Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition der Kamera (Voreinstellungsposition)

Kalibrieren eines Objektivs mit E-Bajonett

Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition und Fokuseinstellung mithilfe der Web-App

Umbenennen von Voreinstellungspositionen mithilfe der Web-App

Ersetzen einer gespeicherten Voreinstellungsposition durch eine neue mithilfe der Web-App

Löschen einer gespeicherten Voreinstellungsposition mithilfe der Web-App

Synchronisieren von Schwenk-/Neigevorgang und Zoom-/Fokusvorgang beim Aufrufen einer Voreinstellungsposition

Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition

Ändern der Übergangsdauer (Schwenken-Neigen/Zoom) beim Aufrufen einer Voreinstellungsposition

Speichern/Wiederherstellen von Schwenk-/Neige- und Zoomposition mithilfe der mitgelieferten Infrarot-Fernbedienung

Aufnahme/Wiedergabe von Bildausschnittvorgängen der Kamera (PTZ-Verfolgung)

Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der Web-App

Wiedergeben von Bildausschnittvorgängen der Kamera mithilfe der Web-App

Löschen von mit der Kamera aufgezeichneten Bildausschnittvorgängen mithilfe der Web-App

Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung

Wiedergeben von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung

Automatische Bildausschnitt-Steuerung der Kamera (PTZ-Bildausschnitt-Steuerung)

Informationen zur PTZ-Bildausschnitt-Steuerung

Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)

Motive an bestimmter Position auswählen und automatisch verfolgen (automatischer Verfolgungsstart)

Kompositionsvoreinstellung einer PTZ-Bildausschnitt-Steuerung aufrufen

Kompositionsvoreinstellung einer PTZ-Bildausschnitt-Steuerung umbenennen
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Ändern einer Kompositionsvoreinstellung der PTZ-Bildausschnitt-Steuerung auf eine neue Voreinstellung

Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen

Einstellen des Fokus

Bildschirm für die Anpassung des Fokus

Manuelle Einstellung des Fokus (Manual Focus)

Manuell mithilfe der Web-App einstellen

Fokus manuell mithilfe der mitgelieferten Infrarot-Fernbedienung einstellen

Fokus durch Angabe einer Fokusposition anpassen (Spot Focus)

Autofokus vorübergehend verwenden (Push Auto Focus (AF))

Verwendung des einmaligen Autofokus (Push Auto Focus (AF-S))

Automatische Einstellung des Fokus (Auto Focus)

Automatisch mithilfe der Web-App einstellen

Fokus automatisch mithilfe der mitgelieferten Infrarot-Fernbedienung einstellen

Einstellen des Bereichs und der Position für den Autofokus (Fokusbereich)

Schnelles Wechseln des Fokusbereichs (Fokuseinstellung)

Fokusbereichsrahmen mittels Touch-Bedienung bewegen (Fokus-Berührbereich)

Anpassen des Autofokusbetriebs (AF-Übergangsgeschwindigkeit, AF-Motivwechselempfindlichkeit)

Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App

Manuelle Fokussierung während Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung

Vorübergehende Verwendung des manuellen Fokus während Autofokus (Push Manual Focus)

Verfolgung mittels Gesichts- und Augenerkennung (Face/Eye Detection AF)

Ein bestimmtes Motiv verfolgen (Echtzeitverfolgungs-AF)

Anpassen der Helligkeit

Bildschirm für die Anpassung der Helligkeit

Einstellen der Basisempfindlichkeit

Einstellen des Zielpegels für die automatische Helligkeitseinstellung

Anpassen der Blende

Automatisches Anpassen der Blende

Manuelles Anpassen der Blende

Anpassen der Verstärkung

Automatische Verstärkungsanpassung

Manuelle Verstärkungsanpassung
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Nützliche Funktionen

Anpassen der Verschlusszeit

Automatische Anpassung der Verschlusszeit

Manuelle Anpassung der Verschlusszeit

Anpassen des Lichtpegels (ND-Filter)

Informationen zum ND-Filter

Einstellung im Voreinstellungsmodus

Automatische Einstellung im variablen Modus

Manuelle Einstellung im variablen Modus

Anpassung für natürliche Farben (Weißabgleich)

Bildschirm für die Anpassung des Weißabgleichs

Automatischer Weißabgleich

Manueller Weißabgleich

Ausführen des automatischen Weißabgleichs

Konfigurieren der aufzunehmenden Audiosignale

Bildschirm zur Audiokonfiguration

Wählen des Audioeingangsgeräts

Automatische Einstellung des Audioaufzeichnungspegels

Manuelle Einstellung des Audioaufzeichnungspegels

Verwenden des Direktmenüs

Belegbare Tasten

Zeitlupe & Zeitraffer

Intermittierende Videoaufzeichnung (Interval Rec)

Aufzeichnen gepufferter Bilder (Picture Cache Rec)

Gleichzeitige Aufnahme auf Speicherkarten A und B (2-slot Simul Rec)

Videosignalmonitor

Clipkennzeichnungen

Kompensation des Fokuspumpens

Proxy-Aufzeichnung

Überblick zur Proxy-Aufzeichnung

Aufnehmen eines Proxy

Aufnehmen mit dem gewünschten Look
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Netzwerkfunktionen

Überblick zum Look

Auswählen eines Looks

Importieren eines gewünschten grundlegenden Looks

Anpassen des Looks

Speichern eines Looks

Löschen eines grundlegenden Looks

Aufnehmen mit Look-Anpassung in der Postproduktion

Aufnehmen mit Look-Anpassung in der Postproduktion

LUT auf HDMI-Ausgabe und Streaming anwenden

Ändern einer LUT

Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten Bild

RAW-Aufnahme

Aufnehmen von RAW-Video

RAW-Video im Zeitlupen- und Zeitraffermodus aufzeichnen

Anpassen des Bokeh (Bokeh-Steuerungsfunktion)

Ein/Ausschalten der Bokeh-Steuerungsfunktion

Anpassen des Bokeh-Grads

Speichern und Laden von Konfigurationsdaten

Überblick zum Speichern und Laden von Konfigurationsdaten

Speichern einer ALL-Datei

Laden einer ALL-Datei

Übertragen von Dateien

Informationen zur Dateiübertragung

Registrieren eines Ziels für die Dateiübertragung

Auswählen und Hochladen einer Datei

Hochladen eines Proxy-Clips auf einer Speicherkarte über die Miniaturbildanzeige

Hochladen eines Originalclips auf einer Speicherkarte über die Miniaturbildanzeige

Prüfen des Dateiübertragungsstatus

Hochladen mithilfe einer sicheren FTP-Übertragung

Konfigurieren des Streaming
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Miniaturbildanzeige

Kameramenü und detaillierte Einstellungen

Informationen zum Streaming

Einstellen des Streaming-Formats

Festlegen des Videocodec für das Streaming

Festlegen des Audiocodec für das Streaming

Starten/Stoppen des Streaming

Miniaturbildanzeige

Wiedergeben von Clips und andere Clip-Vorgänge

Abspielen der aufgezeichneten Clips

Vorgänge mit aufgezeichneten Clips

Konfiguration des Kameramenüs

Bedienen des Kameramenüs

Bedienen des Kameramenüs

Eingeben einer Zeichenfolge

User-Menü

User

Edit User-Menü

Edit User

Shooting-Menü

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

8



Noise Suppression

Flicker Reduce

SteadyShot

Project-Menü

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look-Menü

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt-Menü

P/T Acceleration

TC/Media-Menü

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media
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Format Media

Media Life

Monitoring-Menü

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio-Menü

Audio Input

Audio Output

Thumbnail-Menü

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical-Menü

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network-Menü

Wired LAN

File Transfer

Maintenance-Menü
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Webmenü und detaillierte Einstellungen

Language

Clock Set

Hours Meter

Einstellungen und Standardwerte des Shooting-Menüs

Einstellungen und Standardwerte für ISO/Gain

Einstellungen und Standardwerte für AGC Limit

Für jeden Aufnahmemodus gespeicherte Bildqualitätseinstellungen

Konfiguration des Webmenüs

Funktionen des Webmenüs

Shooting-Menü

Focus

Project-Menü

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look-Menü

Base Look

Pan-Tilt-Menü

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring-Menü

Output Format

Output Display
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Audio-Menü

Audio Input

Audio Output

Technical-Menü

Tracking Data Output

Tracking Data

Tally

IR Remote

RCP/MSU

Lens Controller

Network-Menü

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 bis 3

SSL

SSH

Referer Check

Brute Force Attack Protection

Stream-Menü

Stream

Video Stream

Audio Stream

Maintenance-Menü

Language

Accessibility

Clock Set

Reset

Information

System Log
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Anschließen externer Geräte

Anhang

HTTP Access Log

Service

Software

Anschließen externer Monitore und Aufnahmegeräte

Anschließen einer RCP/MSU (Option)

Verbinden mit RCP/MSU/CNA-2

1:1-Verbindung zwischen Gerät und RCP

Verwenden des Geräts in einer Umgebung mit mehreren Kameras mit MSU/CNA-2/Software zur Kamerafernsteuerung

Liste unterstützter Funktionen

Betrieb mit einer Fernbedienung RM-IP500 (Option)

Betrieb mit einer Fernbedienung RM-IP500 (Option)

Verbinden einer Fernbedienung RM-IP500

Verwenden des „Camera Remote SDK“

Informationen zum Camera Remote SDK

Synchronisierung mit einem externen Gerät

Informationen zur Synchronisierung mit einem externen Gerät

Synchronisieren der Phase des Videosignals (Genlock)

Anwenden des Zeitcodes auf andere Geräte

Anschließen eines externen Mikrofons oder Audiogeräts

Verwalten und Bearbeiten von Clips auf einem Computer

Ausgeben eines faseroptischen Signals

Zuführen eines Tally-Signals

Ausgabe von Verfolgungsdaten

Anschließen eines Objektivcontrollers

Zoom mithilfe eines Objektivcontrollers einstellen

Vorsichtsmaßnahmen bei Betrieb

Ausgabeformate und Beschränkungen

Fehlerbehebung

Betriebsmeldungen

Liste der Menüelemente
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5-041-957-64(1) Copyright 2022 Sony Corporation

In Voreinstellungspositionen gespeicherte Elemente

Blockschaltbilder

Aktualisieren der Software eines Objektivs mit E-Bajonett

Abdeckung der Objektivfreigabetaste anbringen

Lizenzen

Technische Daten

Marken

14



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Beispiel für eine Systemkonfiguration

Dieses Gerät kann mit Peripheriegeräten zu verschiedenen Systemkonfigurationen kombiniert werden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Objektive mit E-Bajonett1.

Adapter für Objektive mit A-Bajonett LA-EA3/LA-EA42.

Infrarot-Fernbedienung (mitgeliefert)3.

CFexpress Type A-Speicherkarten / SDXC-Speicherkarten4.

Lesegerät für CFexpress Type A-Karten / Lesegerät für SD-Karten5.

Mikrofone ECM-680S, ECM-678*, ECM-674*6.
XLR-Adapterkabel EC-0.5X3F5M 3-polig → 5-polig erforderlich.*

Netzteil (mitgeliefert)7.

Videomonitor8.

Fernbedienung RM-IP5009.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Steuern eines einzelnen Geräts mithilfe der mitgelieferten Infrarot-Fernbedienung

Sie können ein einzelnes Gerät mithilfe der mitgelieferten Infrarot-Fernbedienung fernbedienen.

 Videosignal
 Signalweg

5-041-957-64(1) Copyright 2022 Sony Corporation

Infrarot-Fernbedienung (mitgeliefert)1.

Videomonitor2.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Steuern eines einzelnen Geräts mithilfe eines Tablets oder Computers

Sie können ein Tablet oder einen Computer mit dem Gerät verbinden und dann das Gerät mithilfe eines Webbrowsers steuern.

 Videosignal
 Fernsteuersignal

  Signalweg

5-041-957-64(1) Copyright 2022 Sony Corporation

Videomonitor1.

Tablet2.

Computer3.

Zugangspunkt4.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Steuern eines einzelnen Geräts mithilfe einer externen Fernbedienung

Sie können das Gerät mithilfe einer Fernbedienung fernbedienen.

 Videosignal
 Fernsteuersignal

  Signalweg

5-041-957-64(1) Copyright 2022 Sony Corporation

Videomonitor1.

Fernbedienung RM-IP5002.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Steuern mehrerer Geräte mithilfe einer externen Fernbedienung

Sie können bis zu 100 Geräte mithilfe einer einzelnen Fernbedienung fernbedienen.

 Videosignal
 Fernsteuersignal
 Tally-/Kontaktsignal

  Signalweg

5-041-957-64(1) Copyright 2022 Sony Corporation

Videomonitor1.

Videoumschalter2.

Ethernet-Hub3.

Fernbedienung RM-IP5004.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vorderansicht

In diesem Thema werden die Lage und Funktion von Elementen an der Vorderseite des Geräts beschrieben.

Tipp

Diese Beschreibung bezieht sich auf die Abbildung des Geräts ohne angebrachtes Objektiv.

Kamerakopf

Hinweis
Setzen Sie den Kamerakopf keinen starken Stößen aus.

1.

Aufnahme-/Tally-Anzeige
Wenn die Anzeige als Aufnahmeanzeige konfiguriert ist, leuchtet sie bei Aufnahme auf eine Speicherkarte rot auf. Die Anzeige
blinkt, wenn der verbleibende Speicherplatz auf dem Aufnahmemedium gering ist oder wenn ein Fehler auftritt.

Einzelheiten siehe „Betriebsmeldungen“.

Wenn die Anzeige als Tally-Anzeige konfiguriert ist, leuchtet sie je nach externem Tally-Signal rot oder grün auf.

Einzelheiten siehe „Zuführen eines Tally-Signals“.

2.

20



Verwandtes Thema

Wenn [Technical] > [Tally] > [Tally Control] im Webmenü auf [PTZ AFR] gesetzt ist, wird der Betriebsstatus der Bildausschnitt-
Steuerung angezeigt.

Einzelheiten siehe „Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen“.
Bildsensor

Hinweis
Nicht direkt mit den Händen berühren.

3.

Objektivfreigabetaste
Drücken Sie die Taste, um das Objektiv abzunehmen.

Einzelheiten siehe „Abnehmen eines Objektivs“.

4.

Objektivsignalkontakte

Hinweis
Nicht direkt mit den Händen berühren.

5.

Anzeige POWER6.

Anzeige NETWORK
Der Zustand des Geräts wird durch die Kombination von Farbe und Art (leuchtend, blinkend, erloschen) der Anzeigen POWER und
NETWORK signalisiert.

7.

Anzeige
POWER

Anzeige
NETWORK Status des Geräts

Leuchtet
grün*1

Leuchtet grün Eingeschaltet (mit Netzwerk verbunden)

Erloschen Eingeschaltet (nicht mit Netzwerk verbunden)

Blinkt grün Erloschen Einschaltvorgang läuft

Leuchtet
orange

Erloschen Bereitschaftszustand

Blinkt gelb Erloschen Softwareaktualisierung läuft

Blinkt
langsam
orange*2

Blinkt
langsam
grün*2

Das Gerät kann nicht normal betrieben werden. Einzelheiten siehe Systemprotokoll. Falls das
Problem auch nach Wechsel des Geräts in den Bereitschaftsmodus oder Ausschalten und
erneutem Einschalten weiterhin besteht, wenden Sie sich an Ihre Sony-Kundendienstvertretung.

Blinkt
schnell
orange*3

Blinkt schnell
grün*3

Am Gerät ist eine Fehlfunktion aufgetreten. Wenden Sie sich an Ihre Sony-
Kundendienstvertretung.

Blinkt grün, sobald ein Befehl von der mitgelieferten Infrarot-Fernbedienung empfangen wurde.*1

Langsam blinkend: ein Mal pro Sekunde*2

Schnell blinkend: vier Mal pro Sekunde*3

Sensor für Infrarot-Fernbedienung
Empfängt das Steuersignal von der mitgelieferten Infrarot-Fernbedienung.

8.

Lufteinlass

Hinweis
Blockieren Sie den Luftstrom nicht. Andernfalls kann es zu einer Fehlfunktion kommen.

9.
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Betriebsmeldungen

Zuführen eines Tally-Signals
Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen

Abnehmen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rückansicht

In diesem Thema werden die Lage und Funktion von Elementen an der Rückseite des Geräts beschrieben.

Verwandtes Thema
Seitenansicht

5-041-957-64(1) Copyright 2022 Sony Corporation

Arretierhebel des Kamerakopfs
Arretiert die Bewegung vorwärts/rückwärts des Kamerakopfs.

Hinweis

Stets in Arretierposition stellen, wenn das Objektiv nicht gewechselt wird.

Zum Transport des Geräts stets das Objektiv entfernen und in Arretierposition stellen.

Schalten Sie die Stromversorgung des Geräts aus und arretieren Sie mithilfe des Arretierhebels für Schwenken/Neigen den Kamerakopf
horizontal, bevor Sie den Arretierhebel betätigen, um Verletzungen durch eingeklemmte Finger zu vermeiden. Einzelheiten zum Arretierhebel
für Schwenken/Neigen siehe „Arretierhebel für Schwenken/Neigen“ unter „Seitenansicht“.

1.

Gleitschiene2.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Anschlussblock

In diesem Thema werden die Lage und Funktion von Elementen am Anschlussblock des Geräts beschrieben.

Anschluss  (Erdung)
Verbinden Sie diesen Anschluss mit der Erdung in Form eines Erdungskontakts einer Steckdose oder einer Erdungsschiene.

1.

DC IN-Anschluss (Standard-Gleichspannungsbuchse)
Verbinden Sie diesen Anschluss mit einem Netzteil.

Hinweis

Verwenden Sie ausschließlich das mitgelieferte Netzteil. Die Verwendung eines anderen Netzteils kann zu Bränden oder Fehlfunktionen
führen.

2.

 LAN-Anschluss (Netzwerk; RJ-45)
Schließen Sie hier ein Netzwerkkabel (Kategorie 5e oder höher) zur Netzwerkkommunikation und zur PoE++*-Stromversorgung
an.

Anzeigestatus der Speed LED
Zeigt die Geschwindigkeit der Netzwerkverbindung an.

3.

PoE++: Power over Ethernet Plus Plus. Gemäß IEEE802.3bt (Type 4 Class 8). Einzelheiten zum Herstellen der Verbindung finden Sie in der
Bedienungsanleitung zum Stromversorgungsgerät.

*

Anzeige  Verbindungsgeschwindigkeit

Erloschen
10-Mbit/s-Verbindung

100-Mbit/s-Verbindung

Leuchtet orange 1000-Mbit/s-Verbindung
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Anzeigestatus der Link/ACT LED
Zeigt den Status der Netzwerkverbindung an.

Hinweis

Schließen Sie dieses Produkt beim Verbinden mit dem Internet über ein System an, das eine Schutzfunktion bietet, wie etwa ein Router oder
eine Firewall. Andernfalls können Sicherheitsprobleme auftreten.

Anzeige  Verbindungsstatus

 Erloschen Keine Verbindung

Blinkt grün Verbindung hergestellt, Daten aktiv

Leuchtet grün Aktive Verbindung

Anschluss TC IN
An diesem Anschluss führen Sie ein externes Referenz-Zeitcodesignal zu.

Einzelheiten siehe „Anwenden des Zeitcodes auf andere Geräte“.

4.

Anschluss HDMI
Gibt das Video vom Gerät als HDMI-Signal aus.

Einzelheiten siehe „Anschluss HDMI OUT (Typ A)“ unter „Anschließen externer Monitore und Aufnahmegeräte“.

5.

Montageschraube der Halteplatte für HDMI-Kabel
Um zu verhindern, dass das HDMI-Kabel entfernt wird, bringen Sie die mitgelieferte Halteplatte für das HDMI-Kabel mithilfe der
mitgelieferten Montageschraube (M2.6×6) an und sichern das HDMI-Kabel mit einem handelsüblichen Kabelbinder oder -band.

Einzelheiten zum Anbringen der Halteplatte für das HDMI-Kabel siehe „Anschließen der Kabel“.

6.

OPTION-Anschluss
An diesem Anschluss führen Sie ein Tally-Signal eines externen Geräts zu oder schließen einen Objektivcontroller an.

Einzelheiten siehe „Zuführen eines Tally-Signals“ und „Anschließen eines Objektivcontrollers“.

7.

Kabelklemme
Dient zum Sichern des Netzteilkabels.

8.

RESET-Schalter
Mindestens 5 Sekunden lang mithilfe einer Bleistiftspitze oder ähnlichem Gegenstand gedrückt halten, um die Einstellungen des
Geräts auf Standardwerte zurückzusetzen.
Sie können mithilfe des SETUP-Schalters 1 auswählen, ob nur die Netzwerkverbindungseinstellungen oder alle Einstellungen
zurückgesetzt werden sollen.

9.

OPTICAL-Ausgangsanschluss
Gibt ein in das optische Format konvertierte SDI-Signal aus, falls ein SFP+-Modul (Option) angeschlossen ist.

Einzelheiten siehe „Ausgeben eines faseroptischen Signals“.

10.

SETUP-Schalter

Zum Konfigurieren der folgenden Einstellungen.
Schalter 1: Legt fest, welche Einstellungen beim Drücken des RESET-Schalters zurückgesetzt werden sollen.

11.
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Schalter 2: Legt fest, ob die Stromversorgung mit +48 V (Phantomspeisung) ein-/ausgeschaltet wird, wenn ein Audioeingabegerät
angeschlossen wird. Die Einstellung wird unmittelbar übernommen.
Diese Funktion wird aktiviert, wenn [Audio] > [Audio Input] > [AUDIO IN Select] im Kameramenü auf [MIC] gesetzt wird.

Hinweis
Wenn Sie Schalter 2 in Stellung ON bringen und ein Mikrofon anschließen, das nicht mit einer +48-V-Quelle kompatibel ist, kann es zu
Schäden am angeschlossenen Gerät kommen. Überprüfen Sie die Einstellung, bevor Sie das Gerät anschließen.

Schalter 3: Aktiviert/deaktiviert die VISCA over IP-Kommunikation. Die Einstellungen werden übernommen, sobald die Kamera
eingeschaltet wird.
In Stellung ON bringen, um das Gerät bei Verbindung mit einer Fernbedienung (RM-IP500) zu verwenden.

Hinweis

Falls das Administrator-Passwort nicht konfiguriert wurde, ist die VISCA over IP-Kommunikation unabhängig von der Schalterstellung
deaktiviert. Einzelheiten zum Konfigurieren des Administrator-Passworts siehe „Ersteinrichtung des Geräts“.

Schalter 4: Legt die IP-Adresse auf einen bestimmten Wert fest.

Tipp
Schalter 4 legt bei der Softwareversion 3.0 und höher die IP-Adresse fest.

Bei Verwendung einer Softwareversion vor Version 3.0 wird hiermit die Infrarot-Fernbedienung festgelegt. Einzelheiten siehe [Technical] > [IR
Remote] > [Pan-Tilt Speed] im Webmenü.
OFF: Schwenk-/Neigebetrieb mit normaler Geschwindigkeit.
ON: Schwenk-/Neigebetrieb mit hoher Geschwindigkeit.

Einstellung Beschreibung

OFF
(Standard)

Nur die Netzwerkverbindungseinstellungen werden zurückgesetzt. Die Netzwerkeinstellungen,
Sicherheitseinstellungen und Benutzerinformationen (Benutzername und Passwort) des Geräts werden
zurückgesetzt.

ON Alle Einstellungen werden auf Standardwerte zurückgesetzt.

Einstellung Beschreibung

OFF
(Standard)

Keine Stromversorgung mit +48 V (Phantomspeisung) bereitstellen. Konfigurieren Sie diese Einstellung, wenn
Sie ein externes Audiogerät (wie einen Mischer), ein dynamisches Mikrofon oder ein Mikrofon mit integrierter
Batterie verwenden.

ON
Stromversorgung mit +48 V (Phantomspeisung) für ein mit dem AUDIO IN-Anschluss (CH-1 oder CH-2)
verbundenes, mit Phantomspeisung kompatibles Mikrofon bereitstellen.

Einstellung Beschreibung

OFF (Standard) Keine Reaktion auf VISCA over IP-Befehle.

ON VISCA over IP-Befehle werden angenommen.

Einstellung Beschreibung

OFF (Standard) Der Benutzer legt die IP-Adresse fest.

ON

Legt die IP-Adresse des Geräts beim Start auf 192.168.0.100 fest (Modus mit fester IP-Adresse).

Hinweis

Wenn die IP-Adresse nach dem Start im Webmenü geändert wird, stellen Sie diesen Schalter auf OFF.

SDI OUT-Anschluss12.
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Verwandtes Thema
Anwenden des Zeitcodes auf andere Geräte
Anschließen externer Monitore und Aufnahmegeräte

Anschließen der Kabel

Zuführen eines Tally-Signals
Anschließen eines Objektivcontrollers

Ausgeben eines faseroptischen Signals

Ersteinrichtung des Geräts
Synchronisieren der Phase des Videosignals (Genlock)

IR Remote

Anschließen eines externen Mikrofons oder Audiogeräts

5-041-957-64(1) Copyright 2022 Sony Corporation

Gibt das Video vom Gerät als 12G/6G/3G/HD-SDI-Signal aus.
Das Gerät kann auch für RAW-Signalausgabe konfiguriert werden.

Einzelheiten siehe „Anschluss SDI OUT (BNC-Ausführung)“ unter „Anschließen externer Monitore und Aufnahmegeräte“.
 Sensor für Infrarot-Fernbedienung (Rückseite)

Infrarot-Sensor für die mitgelieferte Infrarot-Fernbedienung.
13.

Lüfter/Luftauslass
Zur Abgabe von Wärme aus dem Gerät.

Hinweis

Verdecken Sie den Luftauslass nicht. Andernfalls kann es zu einer Fehlfunktion kommen.

Beachten Sie, dass sich die Umgebung des Luftauslasses erwärmen kann.

14.

GENLOCK-Anschluss
Zum Zuführen eines externen Synchronisationssignals.

Einzelheiten siehe „Synchronisieren der Phase des Videosignals (Genlock)“.

15.

AUDIO IN-Anschluss (XLR-Anschluss, 5-polig)
Zum Zuführen des Signals eines externen Mikrofons oder Audiogeräts.
Der Anschluss fungiert als AUDIO IN CH-1- oder AUDIO IN CH-2-Anschluss.

Einzelheiten siehe „Anschließen eines externen Mikrofons oder Audiogeräts“.

16.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Seitenansicht

In diesem Thema werden die Lage und Funktion von Elementen an der Seite des Geräts beschrieben.

Tipp

Diese Beschreibung bezieht sich auf die Abbildung des Geräts ohne angebrachtes Objektiv.

Arretierhebel für Schwenken/Neigen
Arretiert den Schwenk-/Neigemechanismus des Geräts. Zur Verwendung in den folgenden Fällen.

Bei Transport und Verpackung des Geräts.
Beim Anbringen oder Entfernen eines Objektivs. Einzelheiten siehe „Anbringen eines Objektivs“ oder „Abnehmen eines
Objektivs“.
Bei Verwendung eines Objektivs, das keinen Schwenk-/Neigebetrieb unterstützt (wie die Sony-Objektive
SEL100400GM/SEL200600G/SEL400F28GM/SEL600F40GM).
Zum Transport des Geräts stets das Objektiv entfernen und in Arretierposition stellen.

Tipp
Die Schwenk-/Neigebewegung kann auf die folgenden Winkel festgelegt werden.

1.
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Verwandtes Thema
Anbringen eines Objektivs

Abnehmen eines Objektivs
Einsetzen von Speicherkarten

Von einem Webbrowser aus auf die Web-App zugreifen

5-041-957-64(1) Copyright 2022 Sony Corporation

Gleitschiene2.

Schraubenlöcher für externe Geräte (4 Positionen)
Für M3-Schrauben von bis zu 6 mm Länge.

Hinweis
Verwenden Sie keine Schrauben, die länger als 6 mm sind. Andernfalls kann es zu einer Fehlfunktion kommen.

3.

Zugriffsanzeige A4.

Zugriffsanzeige B
Die Anzeige leuchtet oder blinkt, wenn das Aufnahmemedium eingesetzt wird.

Einzelheiten siehe „Einsetzen von Speicherkarten“.

5.

Einschub für CFexpress Type A/SD-Karte (A)6.

Einschub für CFexpress Type A/SD-Karte (B)
Zum Einsetzen von Aufnahmemedien.

Einzelheiten siehe „Einsetzen von Speicherkarten“.

7.

QR-Code für Netzwerkverbindung
Zur Verwendung beim Konfigurieren von anfänglichen Einstellungen.

Einzelheiten siehe „Von einem Webbrowser aus auf die Web-App zugreifen“.

8.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Draufsicht

In diesem Thema werden die Lage und Funktion von Elementen an der Oberseite des Geräts beschrieben.

Tipp

Diese Beschreibung bezieht sich auf die Abbildung des Geräts ohne angebrachtes Objektiv.

5-041-957-64(1) Copyright 2022 Sony Corporation

Schraubenlöcher für externe Geräte (2 Positionen)
Kompatibel mit 1/4-20 UNC-Schrauben für ein Stativ.
Maximale Länge von 6 mm.

1.

ɸ (Sensorlagemarkierung)
Die Sensorlagemarkierung befindet sich auf derselben Ebene wie der Bildsensor.
Verwenden Sie diese Sensorlagemarkierung als Referenzpunkt, um die Entfernung zwischen dem Gerät und dem Motiv genau zu
messen.

2.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Unteransicht

In diesem Thema werden die Lage und Funktion von Elementen an der Unterseite des Geräts beschrieben.

Tipp

Diese Beschreibung bezieht sich auf die Abbildung des Geräts ohne angebrachtes Objektiv.

Verwandtes Thema
Aufrechte Montage an einer hoch gelegenen, festen Stelle

Schraubenlöcher für Montage der Deckenhalterung (6 Positionen, 5,5 mm effektive Gewindetiefe)
Wenn Sie das Gerät an einer Decke oder an einem Regal in der Höhe montieren, bringen Sie die Gehäusehalterung (Option)
unten am Gerät in diesen Schraubenlöchern mithilfe der sechs Montageschrauben für die Gehäusehalterung an.

Einzelheiten zur Montage siehe „Aufrechte Montage an einer hoch gelegenen, festen Stelle“ und „Montage an einer Decke“.

1.

Stativmontageschrauben (2 Positionen)
Werden zur Montage des Geräts auf einem Kamerastativ verwendet (Option, 1/4-20 UNC-Schrauben von bis zu 5,5 mm Länge).

Hinweis

Verwenden Sie keine Schrauben, die länger als 5,5 mm sind. Andernfalls kann es zu einer Fehlfunktion kommen.

2.
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Montage an einer Decke
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektivabstützung

In diesem Thema werden die Lage und Funktion von Elementen der Objektivabstützung des Geräts beschrieben.

Tipp

Diese Beschreibung bezieht sich auf die Abbildung des Geräts ohne angebrachtes Objektiv.

Objektivstützstange (2)
Dienen zur Abstützung des Objektivs.
Können auch zur Montage von allgemeinem Zubehör für Stangen mit Ø15 verwendet werden.

1.

Objektivstützeinheit
Die Objektivabstützung kann je nach Objektiv vorwärts oder rückwärts geschoben und dann gesichert werden.

2.

Montageschraube für Objektivstützgestell
Zum Anbringen am Objektivstützgestell. Sie können die Schraube aufwärts/abwärts justieren, um die Höhe des
Objektivstützgestells anzupassen.

3.
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Klemmhebel der Objektivstützstange (2 Positionen)
Sichert die Position der Objektivstützeinheit in Vorwärts-/Rückwärtsrichtung.

4.

Klemmhebel an Montageschraube für Objektivstützgestell
Sichert die vertikale Position der Montageschraube am Objektivstützgestell.

Tipp

Falls sich ein Klemmhebel schwer drehen lässt, geben Sie ihn frei und drehen Sie ihn in einen Winkel, in dem er sich leichter verwenden
lässt. Befindet er sich in der gewünschten Position, schließen Sie den Hebel.

A: Klemmhebel an Montageschraube für Objektivstützgestell
B: Klemmhebel der Objektivstützstange

Hinweis
Damit die Objektivabstützung nicht mit dem Schwenk-/Neigebetrieb kollidiert, bewegen Sie die Objektivstützeinheit aufwärts gegen den
Kamerakopf, wenn Sie diese nicht verwenden. Bewegen Sie außerdem die Montageschraube des Objektivstützgestells in die höchste
Position (dem Objektiv am nächsten).

5.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lage und Funktion der Elemente auf der Infrarot-Fernbedienung (mitgeliefert)

In diesem Thema werden die Lage und Funktion von Elementen auf der Infrarot-Fernbedienung (mitgeliefert) beschrieben.

Taste REC● (Aufnahme START/STOP)
Zum Starten oder Stoppen der Aufnahme drücken.

1.

Taste MENU
Zum Ein-/Ausblenden des Kameramenüs drücken.

2.

GUI-Steuertasten
Zum Durchführen von Vorgängen im Kameramenü, in Meldungsdialogen mit Taste und bei anderen Bildschirmanzeigefunktionen
drücken.

3.

Taste CANC./BACK
Zum Verwerfen einer Einstellung oder zur Rückkehr zum vorhergehenden Bildschirm des Kameramenüs des Geräts drücken.

4.

Tasten zur Schwenk-/Neigesteuerung
Pfeiltasten zum Steuern der Schwenk-/Neigebewegung der Kamera drücken. Taste HOME drücken, damit die Kamera in die
Ausrichtung zur Vorderseite zurückkehrt.

5.

Steuertasten für Voreinstellungspositionen
Halten Sie die Taste PRESET gedrückt und drücken Sie eine der Tasten 1 bis 3, um Kamerarichtung, Zoom und
Fokuseinstellstatus unter der entsprechenden Zifferntaste zu speichern.

6.
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Batterie der Infrarot-Fernbedienung

Die Infrarot-Fernbedienung benötigt zwei AA-Batterien (LR6).
Setzen Sie die Batterien wie in der nachfolgenden Abbildung gezeigt in die Infrarot-Fernbedienung ein.

Um den gespeicherten Zustand aufzurufen, drücken Sie eine Zifferntaste mit gespeicherten Einstellungen.
Fokussteuertasten
Zum Einstellen der Fokussierung.
Um den Fokus automatisch einzustellen, drücken Sie die Taste AF.
Um den Fokus manuell einzustellen, drücken Sie die Taste MF und dann entweder die Taste F (Fern) zum Fokussieren auf ferne
Objekte oder N (Nah) zum Fokussieren auf nahe Objekte.

7.

Belegbare Tasten 1 bis 3
Dienen zum Ausführen von ihnen mithilfe des Kameramenüs zugewiesenen Funktionen.
Wenn Sie einer belegbaren Taste die Funktion [Direct Menu] zuweisen, können Sie mithilfe der GUI-Steuertasten die Belichtung,
den Weißabgleich und andere Einstellungen anpassen.

Einzelheiten zum Belegen der Tasten mithilfe des Kameramenüs siehe „Belegbare Tasten“.

Einzelheiten zum Direktmenü siehe „Verwenden des Direktmenüs“.

8.

Taste  (Power)
Zum Einschalten des Geräts oder zum Wechsel der Stromversorgung in den Bereitschaftsmodus drücken.

9.

Taste THUMBNAIL
Zeigt die Miniaturbildanzeige mit auf der Speicherkarte des Geräts aufgezeichneten Clips an.

Einzelheiten zur Miniaturbildanzeige siehe „Miniaturbildanzeige“.

Mithilfe der GUI-Steuertasten können Sie auf der Miniaturbildanzeige Clips auswählen und die Wiedergabe steuern.

Einzelheiten zum Auswählen von Clips und zum Steuern der Wiedergabe siehe „Abspielen der aufgezeichneten Clips“ und
„Vorgänge mit aufgezeichneten Clips“.

10.

Taste SLOT SEL (Auswahl des Speicherkarteneinschubs A/B)
Wenn zwei Speicherkarten eingesetzt sind, drücken Sie die Taste, um zwischen den Speicherkarten für die Aufnahme zu
wechseln.
Drücken Sie in der Miniaturbildanzeige diese Taste, um zwischen den zu betrachtenden Speicherkarten zu wechseln.

11.

Taste P/T RESET (Schwenken/Neigung zurücksetzen)
Setzt die Schwenk-/Neigefunktionen zurück. Drücken Sie die Taste, wenn die Anzeigen POWER und NETWORK gleichzeitig
blinken oder wenn im Steuerbereich der Web-App zum Bildausschnitt [Execute Pan-Tilt Reset] angezeigt wird.

12.

Zoomsteuertasten
Um hereinzuzoomen, drücken Sie die Taste T (Tele).
Um herauszuzoomen, drücken Sie die Taste W (Weitwinkel).

13.
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Hinweis

Verwenden Sie keine anderen als Mangan- oder Alkalibatterien, da andernfalls die Gefahr besteht, dass die Batterien auslaufen.

Entsorgen Sie verbrauchte Batterien gemäß den Gesetzen und Vorschriften des Landes oder der Region.

Verwandtes Thema
Belegbare Tasten
Verwenden des Direktmenüs

Miniaturbildanzeige

Abspielen der aufgezeichneten Clips
Vorgänge mit aufgezeichneten Clips

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Übersicht über den Bildschirm der Web-App

Indem Sie eine Verbindung zu einem Tablet oder Computer herstellen, können Sie über einen Webbrowser das Gerät
schwenken/neigen, zoomen, aufnehmen, aufgezeichnetes Video wiedergeben sowie das Gerät konfigurieren (nachfolgend wird diese
Funktionalität als „Web-App“ bezeichnet).

Einzelheiten zum Starten der Web-App siehe „Von einem Webbrowser aus auf die Web-App zugreifen“.

Hinweis
Die Web-App unterstützt die Audioausgabe der Kamera nicht.

Wenn die Web-App startet, wird der folgende Live-Betriebsbildschirm wird angezeigt.

Live-Betriebsbildschirm

Einzelheiten zum Live-Betriebsbildschirm siehe „Struktur des Live-Betriebsbildschirms“.
Tasten und Symbole, die den Live- und Wiedergabe-Betriebsbildschirmen gemein sind, werden oben auf dem Bildschirm
angezeigt.

Einzelheiten zum gemeinsamen Bereich der Bildschirme siehe „Struktur des gemeinsamen Bereichs der Bildschirme“.
Sie können zwischen Bildschirmen wechseln, indem Sie auf die Wechselregisterkarten im gemeinsamen Bereich drücken.

Einstellungsbildschirm PTZ AFR
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Dieser Bildschirm wird dazu verwendet, die Anfangseinstellungen der PTZ-Bildausschnitt-Steuerung zu konfigurieren und zu ändern.

Zur Konfiguration siehe „Struktur des Einstellungsbildschirms PTZ AFR“ und „Konfigurieren der Anfangseinstellungen für PTZ-
Bildausschnitt-Steuerung“.

Wiedergabe-Betriebsbildschirm

Drücken Sie auf die Registerkarte [Playback], um den Wiedergabe-Betriebsbildschirm anzuzeigen.

Einzelheiten zum Wiedergabe-Betriebsbildschirm siehe „Struktur des Wiedergabe-Betriebsbildschirms“.
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Einstellungsbildschirm

Drücken Sie auf die Registerkarte [Settings], um den Einstellungsbildschirm anzuzeigen (nachfolgend als Webmenü bezeichnet).

Hinweis

Im Webmenü werden Einstellungen erst dann übernommen, wenn Sie auf die Taste [OK] drücken. Wenn Sie Einstellungen auf einer Seite
ändern, die über eine Taste [OK] verfügt, achten Sie darauf, auf die Taste [OK] zu drücken.

Einzelheiten zum Einstellungsbildschirm siehe „Struktur des Einstellungsbildschirms“.
In dieser Hilfe wird der Einstellungsbildschirm der Web-App als Webmenü bezeichnet.

Verwandtes Thema
Von einem Webbrowser aus auf die Web-App zugreifen

Struktur des Live-Betriebsbildschirms
Struktur des gemeinsamen Bereichs der Bildschirme

Struktur des Einstellungsbildschirms PTZ AFR

Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

Struktur des Wiedergabe-Betriebsbildschirms
Struktur des Einstellungsbildschirms

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur des gemeinsamen Bereichs der Bildschirme

In diesem Thema wird die Struktur des gemeinsamen Bereichs der Bildschirme beschrieben.

Kameraname
Zeigt den Namen der Kamera an.
Sie können den Namen mithilfe von [Network] > [Camera Name] im Webmenü ändern.
Die Hintergrundfarbe ändert sich abhängig vom externen Tally-Signal.

1.

Netzschalter
Wenn das Gerät eingeschaltet wird, wird ein Haken im Punkt [Power ON] im Schaltermenü angezeigt.
Sie können den Netzschalter drücken und im Schaltermenü [Power Standby] auswählen, um die Stromversorgung des Geräts in
den Bereitschaftszustand zu versetzen.
Im Bereitschaftsmodus wird der folgende Bildschirm angezeigt.

Um das Gerät wieder einzuschalten, drücken Sie den Netzschalter und wählen im Schaltermenü [Power ON].

2.

Umschalt-Registerkarten des Betriebsbildschirms
Drücken Sie auf eine Registerkarte, um den entsprechenden Betriebsbildschirm anzuzeigen.
Registerkarte [Live]: Live-Betriebsbildschirm anzeigen.
Registerkarte [PTZ AFR Settings]: Einstellungsbildschirm der PTZ-Bildausschnitt-Steuerung anzeigen.
Registerkarte [Playback]: Wiedergabe-Betriebsbildschirm anzeigen.
Registerkarte [Settings]: Einstellungsbildschirm anzeigen (Webmenü).

3.

PoE++-Anzeige, Warnung vor anormaler Temperatur
Bei Verbindung mit einer PoE++-Quelle wird „PoE++“ angezeigt. Falls eine anormale Temperatur auftritt, wird das Zeichen 
(Temperaturwarnung) angezeigt.

4.

Benachrichtigungssymbol
Wenn eine Meldung eintrifft, ändert sich das Benachrichtigungssymbol wie unten abgebildet.

 (Benachrichtigungen aktiv)
Gehen Sie wie nach der im Kamerabildbereich angezeigten Meldung erforderlich vor.

Hinweis

5.
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Meldungen werden nicht angezeigt, wenn [Monitoring] > [Output Display] > [HDMI/Stream] im Webmenü auf [Off] gesetzt ist. Setzen Sie die
Einstellung auf [On], um den Inhalt von Meldungen prüfen zu können.

Taste  (Kamerastatus)
Drücken Sie auf diese Taste, um Informationen zum aufgezeichneten Kamerabild/Ausgabebildsignal, zum Objektiv und zum Status
des Objektivcontrollers (Option) auf einem separaten Bildschirm anzuzeigen.

Wenn eine auf den Objektivcontroller (Option) bezogene Meldung erscheint, wechselt die Anzeige wie unten abgebildet.

6.

Sperrschalter für Bildschirmbedienung
 (Bedienung freigeben): Schieben Sie den Schalter nach links, um die Bedienung des Live- und Wiedergabe-

Betriebsbildschirms freizugeben.
 (Bedienung sperren): Schieben Sie den Schalter nach rechts, um die Bedienung des Live- und Wiedergabe-

Betriebsbildschirms zu sperren und versehentliche Fehlbedienung zu verhindern.

7.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur des Live-Betriebsbildschirms

In diesem Thema wird die Struktur des Live-Betriebsbildschirms beschrieben.
Wenn PTZ-Bildausschnitt-Steuerung deaktiviert ist

Wenn PTZ-Bildausschnitt-Steuerung aktiviert ist
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Steuerbereich für Voreinstellungspositionen
Zeigt die registrierte Position einer Voreinstellung mithilfe eines Miniaturbilds an. Tippen Sie doppelt auf das Miniaturbild, um zur
Position zurückzukehren, die in der Voreinstellung gespeichert ist.

Einzelheiten zu Voreinstellungspositionen siehe „Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition und
Fokuseinstellung mithilfe der Web-App“.
Einzelheiten zu PTZ-Verfolgung siehe „Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der Web-App“.

1.

Kamerabildbereich
Zeigt das aktuelle Kamerabild und den Status des Geräts an.
Hier wird das gleiche Bild wie am HDMI-Ausgang anliegend angezeigt.
Die folgenden Status werden oberhalb des Bilds angezeigt. Außerdem wird um das Bild je nach dem empfangenen externen Tally-
Signal ein roter oder grüner Rahmen angezeigt.

2.
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Taste [Display]
Drücken Sie diese Taste, um Kamerainformationen im Bild anzuzeigen.
Drücken Sie sie erneut, um die Kamerainformationen auszublenden.

Zusätzlich zu Markierungen werden je nach Status Anzeigen und Meldungen in Bezug auf Autofokus eingeblendet. Diese können
nicht durch Drücken der Taste [Display] ausgeblendet werden.

Einzelheiten zu den angezeigten Kamerainformationen siehe „Anzeige des Kamerabildschirms“.

Taste zum Stoppen des Echtzeitverfolgungs-AF
Drücken Sie diese Taste, um die Verfolgung eines Motivs zu stoppen.

Einzelheiten siehe „Ein bestimmtes Motiv verfolgen (Echtzeitverfolgungs-AF)“.

Nr. Anzeige Beschreibung

2-
1

Fokusmodusanzeige Siehe „Fokusmodusanzeige“ unter „Anzeige des Kamerabildschirms“.

2-
2

Anzeige für Aufnahmemodus, Einschub A/B
und Aufnahmeintervall für Interval Rec

Siehe „Anzeige für Aufnahmemodus, Einschub A/B und Aufnahmeintervall
für Interval Rec“ unter „Anzeige des Kamerabildschirms“.

2-
3

Anzeige des Streaming-Status
Wird während des Streaming angezeigt (nur wenn [Stream Setting] auf
[RTMP] oder [SRT-Caller] gesetzt ist).

2-
4

Statusanzeige des RAW-Ausgabesignals
Zeigt den Ausgabestatus des RAW-Signals an. Einzelheiten zu RAW
siehe „Aufnehmen von RAW-Video“.

2-
5

Anzeige der verbleibenden Medienkapazität
Siehe „Anzeige der verbleibenden Medienkapazität“ unter „Anzeige des
Kamerabildschirms“.

2-
6

Anzeige der Zoomposition

Siehe „Anzeige der Zoomposition“ unter „Anzeige des
Kamerabildschirms“.
Wenn ein Objektivcontroller (Option) angeschlossen ist, wird  angezeigt.
Falls am Objektivcontroller (Option) ein Fehler auftritt, wird 
angezeigt.

2-
7

Anzeige des Status der PTZ-Verfolgung
Anzeige des Status der PTZ-Bildausschnitt-
Steuerung

Wird angezeigt, wenn PTZ-Verfolgung oder PTZ-Bildausschnitt-Steuerung
aktiviert ist.

2-
8

Anzeige des AE-Modus/AE-Pegels
Siehe „Anzeige des AE-Modus/AE-Pegels“ unter „Anzeige des
Kamerabildschirms“.

Aufnahmetaste START/STOP
Drücken Sie diese Taste, um mit der Aufzeichnung zu beginnen. Während der Aufzeichnung leuchtet die Aufnahmetaste
START/STOP rot.
Drücken Sie die Taste während der Aufzeichnung, um sie zu stoppen.
Sie können den Schalter Hold in die Position Hold bringen, um Fehlbedienung der Aufnahmetaste START/STOP zu verhindern.

3.

PTZ AFR-Steuerbereich
Die PTZ-Bildausschnitt-Steuerung wird aktiviert, wenn der Schalter PTZ AFR eingeschaltet wird. Tippen Sie im Kamerabildbereich
auf eine zu verfolgende Person.
Sie können die Kamera außerdem zuvor auf dem Bildschirm zur Einrichtung von PTZ AFR so einstellen, dass eine Person, die in
einer bestimmten Person erscheint, automatisch verfolgt wird. Einzelheiten siehe „Konfigurieren der Anfangseinstellungen für PTZ-
Bildausschnitt-Steuerung“.

4.

45



Während der Verfolgung leuchtet der Bereich um die Taste [Pause] blau auf.
Ein blinkendes blaues Licht signalisiert, dass ein Benutzereingriff erforderlich ist. Prüfen Sie die im Kamerasteuerbereich
angezeigte Meldung und greifen Sie wie erforderlich ein.
Steuerbereich für Kompositionsvoreinstellungen
Zeigt die registrierten Kompositionsvoreinstellungen der Bildausschnitte als Miniaturbilder an. Tippen Sie doppelt auf das
Miniaturbild, um zum Rahmen zurückzukehren, die in der Voreinstellung gespeichert ist.
Wird angezeigt, wenn PTZ-Bildausschnitt-Steuerung aktiviert ist.

5.

Bereich für grundlegende Kamerakonfiguration
Zeigt Einstellungen für zur Aufnahme erforderliche Grundfunktionen auf Tasten an. Drücken Sie eine Taste, um den
entsprechenden Einrichtungsbildschirm für die jeweilige Funktion im Bereich für die Anpassung der Grundfunktionen unten (5)
anzuzeigen.

6-1 [FPS]
6-2 [ISO/Gain / Exposure Index]
6-3 [Shutter]
6-4 [Iris]
6-5 [ND Filter]
6-6 [Scene File / Base Look/LUT]
6-7 [White Balance]

Einzelheiten siehe Beschreibung der jeweiligen Funktion.

6.

Funktion Referenz

FPS „Zeitlupe & Zeitraffer“

ISO/Gain
„Einstellen der Basisempfindlichkeit“, „Automatische Verstärkungsanpassung“ und „Manuelle
Verstärkungsanpassung“ unter „Anpassen der Verstärkung“

Exposure
Index

„Einstellen der Basisempfindlichkeit“ und „Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten
Bild“

Shutter
„Automatische Anpassung der Verschlusszeit“ und „Manuelle Anpassung der Verschlusszeit“ unter „Anpassen
der Verschlusszeit“

Iris „Automatisches Anpassen der Blende“ und „Manuelles Anpassen der Blende“ unter „Anpassen der Blende“

ND Filter „Informationen zum ND-Filter“ unter „Anpassen des Lichtpegels (ND-Filter)“

Scene File „Überblick zum Look“ und andere Themen unter „Aufnehmen mit dem gewünschten Look“

Base
Look/LUT

„Aufnehmen mit Look-Anpassung in der Postproduktion“

White
Balance

„Bildschirm für die Anpassung des Weißabgleichs“

Bereich für die belegbaren Tasten/Anpassung der Grundfunktionen der Kamera
Zeigt belegbare Tasten bei Normalbetrieb an. Drücken Sie die Tasten im Bereich für grundlegende Kamerakonfiguration
(Element 6), um die entsprechenden Einrichtungselemente anzuzeigen. Drücken Sie auf das [X] oder erneut auf die Taste
„Kameraeinrichtungsbereich“, um zur Anzeige der belegbaren Tasten zu wechseln.

7.

46



Einzelheiten zu belegbaren Tasten siehe „Belegbare Tasten“.
Einzelheiten zum Bereich für die Anpassung der Grundfunktionen der Kamera siehe Beschreibung der jeweiligen Funktion.

Steuerbereich für den Bildausschnitt / GUI-Steuerbereich / Bereich zur Anpassung der AFR-Komposition
Sie können zwischen dem Steuerbereich für den Bildausschnitt und dem GUI-Steuerbereich mithilfe der Registerkarten oben
wechseln.
Sie können die Taste  (Schließen) oben rechts auf dem Bildschirm drücken, um den Steuerbereich auszublenden und vor
unbeabsichtigter Bedienung zu schützen. Falls der Steuerbereich nicht angezeigt wird, drücken Sie die Taste  (Öffnen), um ihn
einzublenden.
Verwenden Sie den Steuerbereich für den Bildausschnitt zum Anpassen des Bildausschnitts. Drücken Sie auf die Registerkarte

 (Schwenken/Neigen/Zoomen), um den Steuerbereich für den Bildausschnitt anzuzeigen.

Einzelheiten zur Bedienung siehe „Anpassen des Bildausschnitts“.

Tipp
Der Joystick-Bereich des Steuerbereichs für den Bildausschnitt wird wie unten abgebildet angezeigt, wenn der Schwenk-/Neigebetrieb
deaktiviert wurde, wenn eine Initialisierung des Schwenkens/Neigens erforderlich ist oder wenn ein Fehler am Objektivcontroller auftritt.

Wenn Schwenk-/Neigebetrieb mithilfe des Arretierhebels für Schwenken/Neigen deaktiviert ist

Wenn Schwenk-/Neigebetrieb nicht initialisiert wurde

Wenn Schwenk-/Neigebetrieb zurückgesetzt werden muss

8.
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Wenn im Objektivcontroller ein Fehler aufgetreten ist

Wenn Schwenk-/Neigebetrieb deaktiviert ist

Wenn der Schwenk-/Neigebetrieb nicht initialisiert wurde oder zurückgesetzt werden muss, können Sie schnell auf die Taste 
(Schwenken/Neigen zurücksetzen) im Kamerasteuerbereich zugreifen, indem Sie auf die unter dem Joystick angezeigte Meldung drücken.

Verwenden Sie den GUI-Steuerbereich, um das Kameramenü, die Clip-Wiedergabe und andere Funktionen zu bedienen. Drücken
Sie auf die Registerkarte  (Kamera-GUI), um den GUI-Steuerbereich anzuzeigen.

Einzelheiten zur Bedienung siehe „Bedienen des Kameramenüs“ und „Abspielen der aufgezeichneten Clips“.

Verwenden Sie den Bereich zur Anpassung der AFR-Komposition, um die Komposition für PTZ-Bildausschnitt-Steuerung
anzupassen. Drücken Sie auf die Registerkarte  (Anpassung der AFR-Komposition), um den Bereich zur Anpassung der AFR-
Komposition anzuzeigen.
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Tipp

Der Bereich zur Anpassung der Komposition des Bereichs zur Anpassung der AFR-Komposition wird wie unten abgebildet angezeigt, wenn
der Schwenk-/Neigebetrieb deaktiviert wurde, wenn eine Initialisierung des Schwenkens/Neigens erforderlich ist oder wenn ein Fehler am
Objektivcontroller auftritt.

Wenn Schwenk-/Neigebetrieb mithilfe des Arretierhebels für Schwenken/Neigen deaktiviert ist

Wenn Schwenk-/Neigebetrieb initialisiert werden muss

Wenn im Objektivcontroller ein Fehler aufgetreten ist

Bedienung siehe „Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)“.
Kamerasteuerbereich
Dient zum Konfigurieren der zum Betrieb der Kamera erforderlichen Funktionen.
Sie können mithilfe der Registerkarten oben zwischen den anzuzeigenden Bildschirmen wechseln.
Sie können die Taste  (Schließen) oben rechts auf dem Bildschirm drücken, um den Steuerbereich auszublenden und vor
unbeabsichtigter Bedienung zu schützen. Falls der Steuerbereich nicht angezeigt wird, drücken Sie die Taste  (Öffnen), um ihn

9.
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einzublenden.

Einzelheiten siehe Beschreibung der jeweiligen Funktion.

Registerkarte  (Main)
Zeigt die Einrichtungselemente für häufig verwendete Funktionen an.
Die oberen und unteren Schiebereglerfunktionen können durch Drücken auf die Taste [▼] und Auswahl aus der angezeigten Liste
geändert werden. Die folgenden Funktion können ausgewählt werden.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Registerkarte  (Focus)
Zeigt die fokusbezogenen Einrichtungselemente an.

Registerkarte  (Audio)

Zeigt die audiobezogenen Einrichtungselemente an.

Wird je nach den Menüeinstellungen angezeigt.*
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Registerkarte  (Stream)
Zeigt die auf das Streaming bezogenen Einrichtungselemente an.
Die angezeigten Elemente variieren je nach Einstellung des Streaming-Formats.
Bei Einstellung auf [RTMP] oder [SRT-Caller] kann das Streaming auf diesem Bildschirm gestartet/gestoppt werden.

Einzelheiten siehe „Informationen zum Streaming“ und andere Themen unter „Konfigurieren des Streaming“.
Falls ein Verbindungsfehler auftritt, werden Fehlerinformationen angezeigt. Einzelheiten zu Fehlerinformationen siehe
„Betriebsmeldungen“.

Registerkarte  (Others)
Zeigt die auf andere Funktionen bezogenen Einrichtungselemente an.

Durch Drücken der Taste [Full Screen Display] wird im Webbrowser eine neue Registerkarte geöffnet und das Bild des
Kamerabildbereichs auf dem gesamten Bildschirm angezeigt.
Es wird nur das Bild angezeigt; Touch-AF und andere Funktionen sind nicht verfügbar.

Hinweis
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Verwandtes Thema
Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition und Fokuseinstellung mithilfe der Web-App

Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der Web-App

Informationen zur PTZ-Bildausschnitt-Steuerung
Anzeige des Kamerabildschirms

Aufnehmen von RAW-Video

Ein bestimmtes Motiv verfolgen (Echtzeitverfolgungs-AF)
Zeitlupe & Zeitraffer

Einstellen der Basisempfindlichkeit

Automatische Verstärkungsanpassung
Manuelle Verstärkungsanpassung

Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten Bild

Automatische Anpassung der Verschlusszeit
Manuelle Anpassung der Verschlusszeit

Automatisches Anpassen der Blende

Manuelles Anpassen der Blende
Informationen zum ND-Filter

Überblick zum Look

Aufnehmen mit Look-Anpassung in der Postproduktion
Bildschirm für die Anpassung des Weißabgleichs

Belegbare Tasten

Abspielen der aufgezeichneten Clips
Bedienen des Kameramenüs

Informationen zum Streaming

Betriebsmeldungen

5-041-957-64(1) Copyright 2022 Sony Corporation

Der Live-Betriebsbildschirm auf der ursprünglichen Registerkarte funktioniert weiterhin. Wenn keine Bedienung erforderlich ist, wird
empfohlen, dass Sie die Registerkarte schließen, damit die Anzahl der gleichzeitigen Verbindungen reduziert wird.

Drücken Sie die Taste  (Objektivcontroller initialisieren), um den Objektivcontroller (Option von Fremdhersteller) zu
initialisieren. Diese Taste ist nur aktiviert, wenn [Technical] > [Lens Controller] > [Zoom] > [Setting] im Kameramenü auf [On]
gesetzt ist.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur des Einstellungsbildschirms PTZ AFR

In diesem Thema wird die Struktur des Einstellungsbildschirms der PTZ-Bildausschnitt-Steuerung beschrieben.

Registerkarten für Einstellungselemente
Zeigt die Einrichtungselemente an.

1.

Einstellungsbildschirm
Zeigt den Einstellungsbildschirm und eine Hilfe zur Konfiguration an.

2.

Taste [Next]
Der nächste Einrichtungsbildschirm wird angezeigt.

Tipp

Wenn Änderungen an den Einstellungen übernommen werden, wird die Taste [OK] angezeigt.

Beim Initialisieren von Einstellungen wird [Start] angezeigt.

Beim Initialisieren von Einstellungen können nur die Registerkarten für Einstellungselemente [Initial Setup] und [Others] ausgewählt werden.
Nachdem die Anfangseinstellungen abgeschlossen wurden, können sie individuell eingestellt werden.

Einzelheiten siehe „Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung“.

3.
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Verwandtes Thema
Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur des Wiedergabe-Betriebsbildschirms

In diesem Thema wird die Struktur des Wiedergabe-Betriebsbildschirms beschrieben.

Kamerabildbereich
Zeigt das Wiedergabebild und darauf bezogene Informationen an. Wenn die Wiedergabe gestoppt wird, erscheint der Bildschirm
mit dem Kamerabild.

1.
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1-1 Datum und Uhrzeit der Aufnahme
1-2 Wiedergabestatus
1-3 Wiedergabeformat (Bildgröße)
1-4 Wiedergabeformat (Codec)
1-5 Clipnamen-Anzeige
1-6 Clip-Nummer/Gesamtzahl der Clips
1-7 Anzeige LUT-Name
1-8 Streaming-Status
1-9 Wiedergabeformat (Bildrate und Abtastmethode)
1-10 Anzeige Aufnahme-Look

Wiedergabesteuerbereich

Zeigt die Tasten zur Wiedergabesteuerung an.

Taste [Display]
Zum Wechseln zwischen den Bildschirmanzeigen auf dem Bild drücken.
Taste [Thumbnail]
Zeigt die auf der Speicherkarte aufgezeichneten Clips als Miniaturbilder im Kamerabildbereich an.

Durch Drücken der Taste [Thumbnail] während der Anzeige der Miniaturbilder wird die Miniaturbildanzeige geschlossen und das
Kamerabild wieder angezeigt.

Einzelheiten zur Miniaturbildanzeige siehe „Miniaturbildanzeige“.

Taste [Slot Select]
Wechselt zwischen den Wiedergabemedien.

2.

Taste Funktion

Taste  (Wiedergabe/Pause) Gibt einen Clip wieder. Pausiert den Clip während der Wiedergabe.

Taste  (schneller Vorlauf), Taste
 (schneller Rücklauf)

Gibt einen Clip mit hoher Geschwindigkeit wieder. Wenn diese Taste gedrückt wird,
ändert sich die Wiedergabegeschwindigkeit in drei Stufen.

Taste  (Nächster), Taste 
(Vorhergehender)

Springt zum Beginn des Clips oder zum vorhergehenden/nächsten Clip.

Taste  (Stopp) Stoppt die Wiedergabe.

Belegbare Tasten
Hier werden die belegbaren Tasten angezeigt, denen Gerätefunktionen zugewiesen sind.

3.
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Verwandtes Thema
Miniaturbildanzeige
Belegbare Tasten

Abspielen der aufgezeichneten Clips

5-041-957-64(1) Copyright 2022 Sony Corporation

Einzelheiten zu belegbaren Tasten siehe „Belegbare Tasten“.
GUI-Steuerbereich
Verwenden Sie den GUI-Steuerbereich, um das Kameramenü, die Clip-Wiedergabe und andere Funktionen zu bedienen.

Einzelheiten zur Bedienung siehe „Bedienen des Kameramenüs“ und „Abspielen der aufgezeichneten Clips“.

4.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur des Einstellungsbildschirms

Konfigurieren Sie mithilfe des Webmenüs über den Einstellungsbildschirm die verschiedenen Einrichtungselemente des Geräts,
darunter Ersteinstellungen, Netzwerkeinstellungen, Aufnahme-/Wiedergabeeinstellungen.

Hinweis

Im Webmenü werden Einstellungen im Allgemeinen erst dann übernommen, wenn Sie auf die Taste [OK] drücken. Wenn Sie Einstellungen auf
einer Seite ändern, die über eine Taste [OK] verfügt, achten Sie darauf, auf die Taste [OK] zu drücken.

Einzelheiten zum Einstellungsbildschirm siehe „Webmenü und detaillierte Einstellungen“.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameramenü

Drücken Sie die Taste [Menu] im GUI-Steuerbereich des Live- oder Wiedergabe-Betriebsbildschirms, um im Kamerabildbereich das
Kameramenü aufzurufen.

Mithilfe des Kameramenüs können Sie die für die Aufnahme und Wiedergabe erforderlichen Einstellungen konfigurieren.
Drücken Sie während der Anzeige des Kameramenüs die Taste [Menu], um das Kameramenü auszublenden.
Das Kameramenü wird mithilfe des GUI-Steuerbereichs bedient.

Einzelheiten zum Kameramenü siehe „Kameramenü und detaillierte Einstellungen“.

Hinweis
Wenn [Monitoring] > [Output Display] > [HDMI/Stream] im Webmenü auf Off gesetzt wird (deaktiviert Einblendung von Informationen auf der
Bildschirmanzeige), dann wird das Kameramenü nicht mehr im Kamerabildbereich angezeigt. Beachten Sie jedoch, dass die Menüfunktionen im
GUI-Steuerbereich weiterhin aktiviert sind. Um unbeabsichtigte Bedienung zu vermeiden, achten Sie darauf, keine Menübedienungen über den
GUI-Steuerbereich durchzuführen, solange [HDMI/Stream] auf Off gesetzt ist.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Anzeige des Kamerabildschirms

Sie können den Status und Einstellungen des Geräts auf dem Ausgabebild der Kamera einblenden. Mithilfe von [Monitoring] > [Output
Display] im Webmenü können Sie die Ausgänge festlegen, für die die Bildschirmanzeige aktiviert ist.
Die Informationen können über die Taste [Display] ein- bzw. ausgeblendet werden. Falls sie ausgeblendet sind, werden Sie während
der Bedienung des Direktmenüs eingeblendet.
Sie können mithilfe von [Monitoring] > [Display On/Off] im Kameramenü einzelne Elemente ein- bzw. ausblenden.

Bildschirminformationen während der Aufnahme

Hochladeanzeige/Anzeige verbleibender Dateien

Einzelheiten zum Übertragen von Dateien siehe „Informationen zur Dateiübertragung“ und andere Themen unter „Übertragen
von Dateien“.

1.

Fokusbereichsanzeige
Zeigt den Fokusbereich für Autofokus an.

Einzelheiten zum Autofokus siehe „Automatisch mithilfe der Web-App einstellen“ und andere Themen unter „Automatische
Einstellung des Fokus (Auto Focus)“.

2.

Anzeige für Aufnahmemodus, Einschub A/B und Aufnahmeintervall für Interval Rec

Einzelheiten zur Intervallaufzeichnung siehe „Intermittierende Videoaufzeichnung (Interval Rec)“.

3.

Anzeige Bedeutung

●Rec Aufzeichnung

Stby Aufnahmebereitschaft

Schärfentiefenanzeige4.

Anzeige des Abtastmodus des Bildsensors
Wenn die Größe des Bildkreises des Objektivs nicht mit der Einstellung des Abtastmodus des Bildsensors zur effektiven Bildgröße
übereinstimmt, wird die Markierung  (keine Übereinstimmung) angezeigt.
Wenn der Bildsensor-Abtastmodus auf FF eingestellt ist, wird in Modi mit engerem Bildwinkel ein „C“-Symbol angezeigt (für
„cropped“ = beschnitten).
Beschneidung tritt in den folgenden Modi auf.

5.
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Wenn das Aufzeichnungsformat 3840×2160 ist und die S&Q Motion-Bildrate 100 fps oder 120 fps beträgt
Wenn [Codec] auf „RAW“ oder „RAW & XAVC-I“ eingestellt ist und das RAW-Ausgabeformat 3840×2160 ist
Einzelheiten zum Bildsensor-Abtastmodus siehe „Einstellen des Bildsensor-Abtastmodus“ unter „Konfigurieren der
Grundfunktionen“.

Statusanzeige des RAW-Ausgabesignals
Zeigt den Ausgabestatus des RAW-Signals an.

Einzelheiten zu RAW siehe „Aufnehmen von RAW-Video“.

6.

Anzeige der Bildfrequenz für Aufzeichnung mit Zeitlupe/Zeitraffer

Einzelheiten zu Zeitlupe/Zeitraffer siehe „Zeitlupe & Zeitraffer“.

7.

Fokuspositionsanzeige

Zeigt die Fokusposition an.

8.

Fokusmodusanzeige

Gesichts-/Augenerkennungs-AF

Einzelheiten zum Gesichts-/Augenerkennungs-AF siehe „Verfolgung mittels Gesichts- und Augenerkennung (Face/Eye
Detection AF)“.

9.

Anzeige Bedeutung

Focus Hold Modus Focus Hold

MF MF-Modus

AF AF-Modus

 (Echtzeitverfolgungs-AF-Modus) Echtzeitverfolgungs-AF-Modus

Anzeige Bedeutung

 (Gesichts-/Augenerkennungs-AF) Zeigt an, dass Gesichts-/Augenerkennungs-AF aktiviert ist

 (nur Gesichts-/Augenerkennungs-AF) Zeigt an, dass ausschließlich Gesichts-/Augenerkennungs-AF aktiviert ist

 (Symbol „PTZ AFR AF“) Zeigt an, dass PTZ-Bildausschnitt-Steuerung aktiviert ist

 (gespeichertes Verfolgungsgesicht) Zeigt an, dass ein Verfolgungsgesicht gespeichert wurde

 (AF pausiert) Zeigt an, dass AF pausiert wurde*

Wird angezeigt, wenn kein Verfolgungsgesicht gespeichert und kein Gesicht erkannt wurde oder wenn ein Verfolgungsgesicht gespeichert ist, aber das
Zielgesicht der Verfolgung nicht erkannt wurde.

*

Anzeige der Zoomposition
Zeigt die Zoomposition als Brennweite an (bei Verwendung eines Objektivs, das die Anzeige der Zoomposition unterstützt).
Sie können mithilfe der Einstellung [Technical] > [Lens] > [Zoom Position Display] im Kameramenü hierfür auch eine Balken- oder
Zoompositionsanzeige auswählen.
Wenn „Clear Image Zoom“ aktiviert wird, werden dem Display die folgenden Optionen hinzugefügt.

Einzelheiten zum Zoom siehe „Einstellen des Zoomtyps“ und andere Themen unter „Einstellen des Zooms“.

10.

Anzeige Bedeutung

 („Clear Image Zoom“ aktiviert) „Clear Image Zoom“ aktiviert

Vergrößerungswert Bei Verwendung von „Clear Image Zoom“
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Anzeige für den Bildstabilisierungsmodus11.

Rec Control-Statusanzeige für SDI-Ausgang/HDMI-Ausgang
Zeigt den Ausgabestatus des REC-Steuersignals an.

Einzelheiten siehe „Anschließen externer Monitore und Aufnahmegeräte“.

12.

Fokusanzeige

Einzelheiten siehe „Verwendung des einmaligen Autofokus (Push Auto Focus (AF-S))“ unter „Einstellen des Fokus“.

13.

Anzeige der verbleibenden Medienkapazität
Wenn die Speicherkarte schreibgeschützt ist, wird das Symbol  (geschützt) angezeigt.

14.

Anzeige des Weißabgleich-Modus15.

Anzeige Bedeutung

 (ATW) Automatikmodus

 (ATW Hold) Automatikmodus angehalten

W:P Voreinstellungsmodus

W:A Memory A-Modus

Zeitcode-Synchronisierung mit externer Quelle/Zeitdatenanzeige
Die Anzeige „EXT-LK“ erscheint, wenn die Aufnahme mit dem Zeitcode auf einem externen Gerät synchronisiert wird.

Einzelheiten zum Zeitcode siehe „Festlegen von Zeitdaten“.

16.

ND-Filteranzeige

Einzelheiten zu ND-Filtern siehe „Anpassen des Lichtpegels (ND-Filter)“.
Einzelheiten zur Bokeh-Steuerung siehe „Anpassen des Bokeh (Bokeh-Steuerungsfunktion)“.

17.

Anzeige Bedeutung

 (A) Automatikmodus

 (B) Bokeh-Steuerungsmodus

Szenendateianzeige

Einzelheiten zu Szenendateien siehe „Überblick zum Look“ und andere Themen unter „Aufnehmen mit dem gewünschten
Look“.

18.

Anzeige der Blende
Zeigt die Blendenposition an (F-Zahl) (wenn ein Objektiv verwendet wird, das die Anzeige der Blendeneinstellung unterstützt).

Einzelheiten zur Blende siehe „Automatisches Anpassen der Blende“ und „Manuelles Anpassen der Blende“.

19.

Warnanzeige zum Videopegel20.

Anzeige des Verstärkungswerts
Zeigt im Modus Cine EI/Cine EI Quick den EI-Wert an.

21.

Anzeige Bedeutung

 (A) Automatikmodus

L Voreinstellungsmodus L
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Einzelheiten zur Verstärkung siehe „Automatische Verstärkungsanpassung“ und „Manuelle Verstärkungsanpassung“.
Einzelheiten zum Modus Cine EI/Cine EI Quick siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der
Grundfunktionen“.

Anzeige Bedeutung

 (Modus zur vorübergehenden Anpassung) Modus zur vorübergehenden Anpassung

 (B) Bokeh-Steuerungsmodus

Clipnamen-Anzeige
Zeigt den Namen des aktuell aufgezeichnet werdenden oder als Nächstes aufzuzeichnenden Clips an.
Bei Blinken besteht eine Abweichung zwischen dem letzten Clip auf dem Aufzeichnungsmedium und den Einstellungen [Camera
ID] oder [Reel Number]. Einzelheiten siehe Beschreibung unter [Clip Name Format] > [Auto Naming].

22.

Verschlussanzeige

Einzelheiten zum Verschluss siehe „Automatische Anpassung der Verschlusszeit“ und „Manuelle Anpassung der
Verschlusszeit“.

23.

Anzeige des AE-Modus/AE-Pegels

Einzelheiten zur automatischen Belichtung (AE) siehe „Einstellen des Zielpegels für die automatische Helligkeitseinstellung“.

24.

Wasserwaage
Zeigt die horizontale Neigung in Schritten von ±1° (bis ±15°) an.

25.

Audiopegel-Messer
Zeigt den Audiopegel jedes Kanals an.

26.

Videosignalmonitor
Zeigt eine Wellenform, ein Vektorskop oder ein Histogramm an.
Die orangefarbene Linie zeigt den eingestellten Wert der Helligkeitspegel-Markierung an.
In Log-Aufnahmemodi wird der LUT-Typ des Monitorziels über der Anzeige eingeblendet.

Einzelheiten siehe „Videosignalmonitor“.
Einzelheiten zu Log-Aufnahmemodi siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der Grundfunktionen“.

27.

Anzeige Base Sensitivity/Anzeige Base ISO
Im Modus Custom wird die Basisempfindlichkeit angezeigt, die mithilfe der Schaltfläche [ISO/Gain / Exposure Index] im Bereich für
grundlegende Kamerakonfiguration oder [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] im Kameramenü eingestellt wurde.
In Log-Aufnahmemodi wird die Base ISO-Empfindlichkeit angezeigt, die mithilfe der Schaltfläche [ISO/Gain / Exposure Index] im
Bereich für grundlegende Kamerakonfiguration oder [Shooting] > [ISO/Gain/EI] > [Base ISO] im Kameramenü eingestellt wurde.

Einzelheiten zur Basisempfindlichkeit siehe „Wahl der Basisempfindlichkeit“.
Einzelheiten zu Log-Aufnahmemodi siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der Grundfunktionen“.

28.

Monitoring Look-Anzeige
In Log-Aufnahmemodi wird die Einstellung der Monitor-LUT angezeigt.

Einzelheiten zur LUT-Einstellung siehe „Aufnehmen mit Look-Anpassung in der Postproduktion“ und verwandte Themen.
Einzelheiten zu Log-Aufnahmemodi siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der Grundfunktionen“.

29.

Anzeige grundlegender Look/Aufnahme-Look
Zeigt die grundlegende Look-Einstellung an.
In Log-Aufnahmemodi wird das Videosignal zur Aufzeichnung auf die Speicherkarten angezeigt.

Einzelheiten zum grundlegenden Look siehe „Überblick zum Look“ unter „Aufnehmen mit dem gewünschten Look“.
Einzelheiten zu Log-Aufnahmemodi siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der Grundfunktionen“.

30.

Anzeige des Proxy-Status31.

Anzeige des Aufzeichnungsformats (Codec)
Zeigt das Format für Aufzeichnung auf die Speicherkarten an.

32.

63



Während der Wiedergabe angezeigte Bildschirminformationen

Während der Wiedergabe werden folgende Informationen auf dem Bild eingeblendet:

Legen Sie das Aufzeichnungsformat (Codec) im Webmenü oder Kameramenü mithilfe der Einstellung [Project] > [Rec Format] >
[Codec] fest.
Anzeige für das Aufzeichnungsformat (Bildrate und Abtastmethode)33.

Anzeige des Aufzeichnungsformats (Bildgröße)
Zeigt die Bildgröße für die Aufzeichnung auf Speicherkarten an.
Legen Sie das Aufzeichnungsformat (Bildgröße) im Webmenü oder Kameramenü mithilfe der Einstellung [Project] > [Rec Format] >
[Codec] fest.

34.

Tally-Anzeige
Zeigt um das Bild je nach dem empfangenen externen Tally-Signal einen roten oder grünen Rahmen an.

35.

Hochladeanzeige/Anzeige verbleibender Dateien1.

Clip-Nummer2.

Anzeige des Wiedergabestatus3.

Anzeige für das Wiedergabeformat (Bildrate und Abtastmethode)4.

Wiedergabeformat (Bildgröße)5.

Wiedergabeformat (Codec)6.

Medium
Wenn die Speicherkarte schreibgeschützt ist, wird das Symbol  (geschützt) angezeigt.

7.

Zeitdaten-Anzeige8.

Clipnamen-Anzeige9.

Anzeige des Gammaassistenten10.

Audiopegel-Messer
Zeigt den Audiowiedergabepegel an.

11.

Anzeige grundlegender Look/Aufnahme-Look12.

Tally-Anzeige13.
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Verwandtes Thema
Informationen zur Dateiübertragung

Automatisch mithilfe der Web-App einstellen

Intermittierende Videoaufzeichnung (Interval Rec)
Konfigurieren der Grundfunktionen

Aufnehmen von RAW-Video

Zeitlupe & Zeitraffer
Verfolgung mittels Gesichts- und Augenerkennung (Face/Eye Detection AF)

Einstellen des Zoomtyps

Anschließen externer Monitore und Aufnahmegeräte
Verwendung des einmaligen Autofokus (Push Auto Focus (AF-S))

Festlegen von Zeitdaten

Überblick zum Look
Automatisches Anpassen der Blende

Manuelles Anpassen der Blende

Automatische Verstärkungsanpassung
Manuelle Verstärkungsanpassung

Automatische Anpassung der Verschlusszeit

Manuelle Anpassung der Verschlusszeit
Einstellen des Zielpegels für die automatische Helligkeitseinstellung

Videosignalmonitor

Aufnehmen mit Look-Anpassung in der Postproduktion
Clip Name Format

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aufrechte Montage an einer festen Stelle

In diesem Thema wird beschrieben, wie Sie das Gerät auf einem Schreibtisch oder Stativ montieren.

Installationshinweis
Lassen Sie zum Schutz von Objektiv und Objektiv-Anschlussblock am Gerät Kappen und Abdeckungen am Gerät angebracht, bis
Sie das Objektiv anbringen.
Um ein Versagen des Objektivs zu verhindern, halten Sie die Objektivteile nicht fest, wenn sich diese bewegen.
Um ein Versagen des Geräts zu verhindern, halten Sie bei der Arbeit den Kamerakopf nicht fest, wenn sich dieser bewegt.

Prüfen Sie den Montagefreiraum.

Bei Montage auf einem Schreibtisch
Montieren Sie das Gerät auf einer ebenen Oberfläche und beachten Sie den für die Drehung des Objektivs und für die
Verkabelung an der Rückseite des Geräts erforderlichen Freiraum.

Hinweis

Montieren Sie das Gerät an einer stabilen Stelle, die keinen Vibrationen ausgesetzt ist. Eine Montage an Stellen, die Vibrationen
ausgesetzt sind, kann zu Bildvibrationen führen.

Falls das Gerät auf einer geneigten Oberfläche montiert werden muss, halten Sie es im Bereich von ±15° um die Horizontale, um ein
Herunterfallen zu verhindern.

Bei Montage auf einem Stativ
Bringen Sie das Stativ an den Öffnungen für Stativgewinde an der Unterseite an.
Verwenden Sie eine Stativschraube mit dem nachfolgend genannten Überstand über die Montageoberfläche und ziehen Sie
diese mit einem Handschraubendreher an.

A: Stativschrauben 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Überstand (4,5 mm bis 5,5 mm)

Verwenden Sie zur Montage des Geräts an hohen Stellen keine Stativschrauben.

Hinweis

1
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Bringen Sie dann das Objektiv an. Siehe „Anbringen eines Objektivs“ unter Beachtung von „Vorsichtsmaßnahmen beim
Anbringen/Abnehmen eines Objektivs“, „Prüfen der Objektivschalter“ und „Vorsichtsmaßnahmen bei Verwendung eines
Zoomobjektivs“.

Verwandtes Thema
Vorsichtsmaßnahmen beim Anbringen/Abnehmen eines Objektivs

Prüfen der Objektivschalter
Vorsichtsmaßnahmen bei Verwendung eines Zoomobjektivs

Anbringen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation

Wählen Sie ein Stativ, das auch bei Drehungen des Objektivs nicht umkippt.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aufrechte Montage an einer hoch gelegenen, festen Stelle

In diesem Thema wird beschrieben, wie Sie das Gerät mithilfe der Deckenhalterung CIB-PCM1 (optional) aufrecht an einer hoch
gelegenen Stelle montieren.

Wenden Sie sich an ein professionelles Bauunternehmen, um das Gerät an einer hoch gelegenen Stelle zu montieren.
Stellen Sie bei der Montage an einer hoch gelegenen Stelle sicher, dass die Montageoberfläche und das Montagematerial
(ausgenommen Zubehör) mindestens 200 kg tragen können und montieren Sie das Gerät wie in dieser Hilfe beschrieben. Falls die
Montage nicht ausreichend fest erfolgt, kann das Gerät herunterfallen und schwere Verletzungen verursachen.
Bringen Sie das mitgelieferte Drahtseil zum Fallschutz an der Deckenhalterung CIB-PCM1 (optional) an, um das Gerät gegen
Fallen zu sichern.
Wenn das Gerät an einer hoch gelegenen Stelle montiert ist, prüfen Sie jährlich, ob es noch fest sitzt. Verkürzen Sie die
Prüfabstände je nach Verwendungsbedingungen.

Installationshinweis
Lassen Sie zum Schutz von Objektiv und Objektiv-Anschlussblock am Gerät die Objektivkappe und die Abdeckung angebracht, bis
Sie das Objektiv anbringen.
Um ein Versagen des Objektivs zu verhindern, halten Sie die Objektivteile nicht fest, wenn sich diese bewegen.
Um ein Versagen des Geräts zu verhindern, halten Sie bei der Arbeit den Kamerakopf nicht fest, wenn sich dieser bewegt.

Prüfen Sie das Zubehör für die Montage an einer hoch gelegenen Stelle und die Montagestelle.

Deckenhalterungssatz CIB-PCM1 (optional)
Prüfen Sie vor Beginn der Arbeiten, ob Ihnen die folgenden Teile vorliegen.

Gehäusehalterung (1)
Deckenhalterung (1)
Abdeckung der Objektivfreigabetaste (1)
Drahtseil zum Fallschutz (1)
Schrauben +PSW M3×8 (9)
Edelstahlschraube +PSW M4×8 für Drahtseil zum Fallschutz (1)

Hinweis
Das Drahtseil zum Fallschutz ist zum Tragen des Geräts vorgesehen, wenn es hängt. Belasten Sie es ausschließlich mit dem Gewicht des
Geräts.

Montagestelle

1
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Ziehen Sie zum Bestimmen der Montagestelle und -richtung die folgende Zeichnung hinzu. Beachten Sie den für die Drehung
des Objektivs und für die Verkabelung an der Rückseite des Geräts erforderlichen Freiraum.

A: Bewegungsbereich des Kamerakopfs (z. B. SEL70200GM2 (mit SEL20TC angebracht): Ø370)
B: Deckenhalterung (Loch auf Seite der Montageoberfläche (Ø150))
C: Loch zur Montageausrichtung

Hinweis

Montieren Sie das Gerät an einer stabilen Stelle, die keinen Vibrationen ausgesetzt ist. Eine Montage an Stellen, die Vibrationen
ausgesetzt sind, kann zu Bildvibrationen führen.

Falls das Gerät auf einer geneigten Oberfläche montiert werden muss, halten Sie es im Bereich von ±15° um die Horizontale, um ein
Herunterfallen zu verhindern.

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

Hinweis

Wenn die Schwenk-/Neigebewegung des Kamerakopfs nicht arretiert wird, obwohl sich der Arretierhebel in Stellung LOCK befindet,
bewegen Sie die Kamera manuell, bis sie in ihrer Position arretiert wird.

2
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Bringen Sie mithilfe der sechs mitgelieferten Schrauben (M3×8) die Gehäusehalterung an der Unterseite des Geräts an.

Verwenden Sie die mitgelieferten Schrauben. Wenn Sie andere als die mitgelieferten Schrauben verwenden, kann dadurch das
Innere des Geräts beschädigt werden.

3

Bringen Sie das Drahtseil zum Fallschutz an der Gehäusehalterung an.4
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A: mitgeliefertes Drahtseil　
B: mitgelieferte Kreuzschlitzschraube (M4×8)
C: Blechöse

Verwenden Sie die mitgelieferten Schraube. Wenn Sie eine andere als die mitgelieferten Schraube verwenden, kann dadurch die
Wirksamkeit der Drahtseilsicherung beeinträchtigt werden.

Bringen Sie die Deckenhalterung auf der Oberfläche an, auf der das Gerät montiert werden soll; beispielsweise ein
Regal.

5
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A: Wand　
B: △-Markierung (Vorwärtsrichtung der Kamera)
C: Loch für Verbindungskabel
D: Regal oder andere Montageoberfläche

Bringen Sie das Drahtseil zum Fallschutz an einer Stelle nahe der Montageoberfläche an.

Bringen Sie es mithilfe einer Innensechskantschraube M5 (3/16 Zoll; optional) an einem Objekt nahe des Regals bzw. der
Oberfläche an, auf dem bzw. der die Deckenhalterung angebracht ist.

6
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A: Drahtseil　
B: Innensechskantschraube (M5, 3/16 Zoll)

Richten Sie das 〇-Schraubenloch an der Vorderseite der Gehäusehalterung auf das ◇-Loch der Deckenhalterung aus.
Setzen Sie das Gerät ein und befestigen Sie die Gehäusehalterung vorübergehend in der Deckenhalterung, indem Sie
das Gerät im Uhrzeigersinn drehen.

7
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A: 〇-Loch
B: ◇-Loch

Bringen Sie die Gehäusehalterung und die Deckenhalterung mithilfe der drei mitgelieferten Dreharretierungsschrauben
an (M3×8).

8
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Bringen Sie dann das Objektiv an. Siehe „Anbringen eines Objektivs“ unter Beachtung von „Vorsichtsmaßnahmen beim
Anbringen/Abnehmen eines Objektivs“, „Prüfen der Objektivschalter“ und „Vorsichtsmaßnahmen bei Verwendung eines
Zoomobjektivs“.

Hinweis

Prüfen Sie nach dem Anbringen eines Objektiv dessen sicheren Sitz.
Das Objektiv verfügt über keinen Fallschutz. Sony kann keine Haftung für Objektive übernehmen, die vom Gerät abfallen.

Verwandtes Thema
Vorsichtsmaßnahmen beim Anbringen/Abnehmen eines Objektivs
Prüfen der Objektivschalter

Vorsichtsmaßnahmen bei Verwendung eines Zoomobjektivs

Anbringen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation

Prüfen Sie den Montagezustand.

Achten Sie insbesondere auf Folgendes: 

Montageschrauben korrekt angebracht
Drahtseil zum Fallschutz korrekt angebracht und nicht verdreht
Gerät ist eben montiert (ohne Neigung oder Buckel)
Gerät dreht sich nicht frei, wenn es gedreht wird

9
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montage an einer Decke

In diesem Thema wird beschrieben, wie Sie das Gerät mithilfe der Deckenhalterung CIB-PCM1 (optional) an einer Decke montieren.

Wenden Sie sich an ein professionelles Bauunternehmen, um das Gerät an einer Decke zu montieren.
Stellen Sie bei der Montage an einer Decke sicher, dass die Montageoberfläche und das Montagematerial (ausgenommen
Zubehör) mindestens 200 kg tragen können und montieren Sie das Gerät wie in dieser Hilfe beschrieben. Falls die Montage nicht
ausreichend fest erfolgt, kann das Gerät herunterfallen und schwere Verletzungen verursachen.
Bringen Sie das mitgelieferte Drahtseil zum Fallschutz an der Deckenhalterung CIB-PCM1 (optional) an, um das Gerät gegen
Fallen zu sichern.
Wenn das Gerät an einer Decke montiert ist, prüfen Sie jährlich, ob es noch fest sitzt. Verkürzen Sie die Prüfabstände je nach
Verwendungsbedingungen.

Installationshinweis
Lassen Sie zum Schutz von Objektiv und Objektiv-Anschlussblock am Gerät die Objektivkappe und die Abdeckung angebracht, bis
Sie das Objektiv anbringen.
Um ein Versagen des Objektivs zu verhindern, halten Sie die Objektivteile nicht fest, wenn sich diese bewegen.
Um ein Versagen des Geräts zu verhindern, halten Sie bei der Arbeit den Kamerakopf nicht fest, wenn sich dieser bewegt.

Prüfen Sie das Zubehör für die Deckenmontage und die Montagestelle.

Deckenhalterungssatz CIB-PCM1 (optional)
Prüfen Sie vor Beginn der Arbeiten, ob Ihnen die folgenden Teile vorliegen.

Gehäusehalterung (1)
Deckenhalterung (1)
Abdeckung der Objektivfreigabetaste (1)
Drahtseil zum Fallschutz (1)
Schrauben +PSW M3×8 (9)
Edelstahlschraube +PSW M4×8 für Drahtseil zum Fallschutz (1)

Hinweis
Das Drahtseil zum Fallschutz ist zum Tragen des Geräts vorgesehen, wenn es hängt. Belasten Sie es ausschließlich mit dem Gewicht des
Geräts.

Montagestelle

1

76



Ziehen Sie zum Bestimmen der Montagestelle und -richtung die folgende Zeichnung hinzu. Beachten Sie den für die Drehung
des Objektivs und für die Verkabelung an der Rückseite des Geräts erforderlichen Freiraum.

A: Bewegungsbereich des Kamerakopfs (z. B. SEL70200GM2 (mit SEL20TC angebracht): Ø370)
B: Deckenhalterung (Loch auf Deckenseite (Ø150))
C: Loch zur Montageausrichtung

Hinweis

Führen Sie die Montage an einer Decke (z. B. aus Beton) mit ausreichender Stärke durch.

Verwenden Sie bei Montage an Decken mit zu geringer Stärke eine ausreichende Verstärkung.

Montieren Sie das Gerät an einer stabilen Stelle, die keinen Vibrationen ausgesetzt ist. Eine Montage an Stellen, die Vibrationen
ausgesetzt sind, kann zu Bildvibrationen führen.

Falls das Gerät auf einer geneigten Oberfläche montiert werden muss, halten Sie es im Bereich von ±15° um die Horizontale, um ein
Herunterfallen zu verhindern.

Die Seite gegenüber dem △-Loch an der Deckenhalterung ist die Aufnahmerichtung (Vorderseite der Kamera).

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung UNLOCK, um die Schwenk-/Neigebewegung
freizugeben. Drehen Sie den Kamerakopf um 180° in die Neigerichtung.

2

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

3
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Kamerakopf um 180° gedreht

Hinweis
Wenn die Schwenk-/Neigebewegung des Kamerakopfs nicht arretiert wird, obwohl sich der Arretierhebel in Stellung LOCK befindet,
bewegen Sie die Kamera manuell, bis sie in ihrer Position arretiert wird.

Bringen Sie mithilfe der sechs mitgelieferten Schrauben (M3×8) die Gehäusehalterung an der Unterseite des Geräts an.4
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Verwenden Sie die mitgelieferten Schrauben. Wenn Sie andere als die mitgelieferten Schrauben verwenden, kann dadurch das
Innere des Geräts beschädigt werden.

Bringen Sie die Deckenhalterung auf einer Montageplatte (optional) an und bringen Sie dann die Platte an der Decke an.

A: Deckenhalterung
B: Decke
C: Montageplatte

5
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D: △-Loch
Bringen Sie die Halterung passend zur Ausrichtung der Deckenhalterung an.
Beachten Sie, dass sich bei Montage an einer Decke die Vorderseite der Kamera im Gegensatz zur normalen aufrechten
Montage auf der gegenüberliegenden Seite der Deckenhalterung befindet. Führen Sie die Montage anhand der Zeichnung zur
Montagerichtung ordnungsgemäß durch.

A: Vorderseite für aufrechte Montage (Ausrichtung △-Loch)
B: Vorderseite für Deckenmontage

Hinweis
Das Material der Montageoberfläche fällt in den Verantwortungsbereich des Kunden.

Bringen Sie das Drahtseil zum Fallschutz an der Decke an.

A: Deckenhalterung
B: Innensechskantschraube (M5, 3/16 Zoll)
C: Drahtseil (mitgeliefert)
D: Montageplatte
E: Decke

6

Ziehen Sie das Drahtseil zum Fallschutz durch das Loch in der Mitte der Deckenhalterung und bringen Sie es an der
Gehäusehalterung an.

Führen Sie das Drahtseil zum Fallschutz durch die Blechöse an der Gehäusehalterung und sichern Sie es mithilfe der
mitgelieferten Edelstahlschraube (M4×8) an der Halterung.

7
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A: mitgeliefertes Drahtseil
B: mitgelieferte Kreuzschlitzschraube (M4×8)
C: Blechöse

Verwenden Sie die mitgelieferten Schraube. Wenn Sie eine andere als die mitgelieferten Schraube verwenden, kann dadurch die
Wirksamkeit der Drahtseilsicherung beeinträchtigt werden.

Hinweis

Es wird empfohlen, dass eine Person das Gerät wie in der folgenden Abbildung gezeigt hält und eine andere Person das Gerät montiert.

Halten Sie bei der Montage das Gerät nicht am Kamerakopf oder an der Objektivabstützung. Wenn das Gerät herunterfällt oder fallen
gelassen wird, besteht die Gefahr von Verletzungen oder Sachschäden.

Achten Sie bei der Verkabelung darauf, dass elektrische Anschlüsse und Kabel nicht durch das Drahtseil zum Fallschutz kurzgeschlossen
werden.

Die Befestigung kann eine hängende Masse von bis zu 8,8 kg tragen (einschließlich Objektiv). Überschreiten Sie nicht die maximale
erwartete Masse, um zu verhindern, dass das Gerät herunterfällt.
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Richten Sie das Schraubenloch (A) an der Gehäusehalterung auf das ◇-Loch (B) an der Deckenhalterung aus. Setzen
Sie das Gerät ein und drehen Sie es etwa 60 Grad im Uhrzeigersinn, bis das Schraubenloch (A) und das Schraubenloch
(C) übereinander liegen.

A: Schraubenloch an der Gehäusehalterung
B: Schraubenloch an der Deckenhalterung (◇-Loch)
C: Schraubenloch
D: Decke
E: Montageplatte

8

Bringen Sie die Gehäusehalterung und die Deckenhalterung mithilfe der drei mitgelieferten Dreharretierungsschrauben
an (M3×8).

9
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Bringen Sie dann das Objektiv an. Siehe „Anbringen eines Objektivs“ unter Beachtung von „Vorsichtsmaßnahmen beim
Anbringen/Abnehmen eines Objektivs“, „Prüfen der Objektivschalter“ und „Vorsichtsmaßnahmen bei Verwendung eines
Zoomobjektivs“.

Hinweis

Um die Schwenk-/Neigefunktion ordnungsgemäß zu bedienen, wenn das Gerät an einer Decke montiert ist, setzen Sie [Pan-Tilt] > [Direction] >
[Ceiling] im Webmenü auf [On].

Prüfen Sie nach dem Anbringen eines Objektiv dessen sicheren Sitz.
Das Objektiv verfügt über keinen Fallschutz. Sony kann keine Haftung für Objektive übernehmen, die vom Gerät abfallen.

Verwandtes Thema
Vorsichtsmaßnahmen beim Anbringen/Abnehmen eines Objektivs

Prüfen der Objektivschalter

Vorsichtsmaßnahmen bei Verwendung eines Zoomobjektivs
Anbringen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation

Prüfen Sie den Montagezustand.

Achten Sie insbesondere auf Folgendes:

Montageschrauben korrekt angebracht
Drahtseil zum Fallschutz korrekt angebracht und nicht verdreht
Gerät ist eben montiert (ohne Neigung oder Buckel)
Gerät dreht sich nicht frei, wenn es gedreht wird

10
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Vorsichtsmaßnahmen beim Anbringen/Abnehmen eines Objektivs

Das Objektiv nicht auf die Sonne richten. Durch das Objektiv kann direktes Sonnenlicht einfallen, im Gerät einbrennen und einen
Brand auslösen.

Hinweis
Objektive nur bei ausgeschaltetem Gerät anbringen bzw. entfernen.

Objektive sind Präzisionskomponenten. Objektive nicht mit der Fassung nach unten ablegen. Bringen Sie die mitgelieferte Schutzkappe an der
Objektivfassung an.

Tipp
Informationen zu den von diesem Gerät unterstützten Objektiven erhalten Sie bei der zuständigen Sony-Kundendienstvertretung.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Prüfen der Objektivschalter

Je nach Typ des Objektivs sind folgende Prüfungen und Einstellungen erforderlich.

Bei Objektiven mit Fokusmodusschalter

Stellen Sie den Schalter auf AF/MF oder AF.
Wenn der Schalter auf MF oder Full MF steht, kann die Scharfstellung nur über den Ring am Objektiv eingestellt werden.

Hinweis
Bei Verwendung eines Objektivs mit A-Bajonett ist eine manuelle Einstellung über eine Fernbedienung ggf. nicht möglich.

Bei Objektiven mit Zoomschalter

Stellen Sie den Schalter auf SERVO.
Wenn der Schalter auf MANUAL steht, kann der Zoom nur über den Zoomring eingestellt werden. Zoomsteuerung über das Gerät hat
keine Wirkung.

Bei Objektiven mit „Auto Iris“-Schalter

Stellen Sie den Schalter auf AUTO.
Wenn der Schalter nicht auf AUTO steht, kann die Blende nur über den Ring am Objektiv eingestellt werden. Blendeneinstellungen
über das Gerät haben keine Wirkung.

Bei Objektiven mit Bildstabilisierungsschalter

Stellen Sie den Schalter auf OFF.
Wenn der Schalter auf ON steht, kann es bei Schwenk-/Neigebetrieb zu unerwartetem Verhalten kommen.

SELP28135G

A: Bewegen Sie den Fokusring in Vorwärtsposition (AF/MF-Modus).
B: Stellen Sie den Schalter ZOOM in Stellung SERVO.
C: Bewegen Sie den Blendenring in Stellung A und den Schalter IRIS LOCK in Stellung LOCK.
D: Stellen Sie den Bildstabilisierungsschalter auf OFF.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Vorsichtsmaßnahmen bei Verwendung eines Zoomobjektivs

Wenn Sie ein anderes Zoomobjektiv als ein Motorzoomobjektiv verwenden, kann sich die Zoomposition je nach Montageumgebung
ändern. Sichern Sie je nach Verwendungszweck den Zoomring in seiner Einstellung mit Klebeband.

Klebeband: 471 BLA 50 oder gleichwertig

5-041-957-64(1) Copyright 2022 Sony Corporation
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Anbringen eines Objektivs

In diesem Thema wird beschrieben, wie Sie ein Objektiv mit E- oder A-Bajonett anbringen.

Hinweis

Transportieren Sie das Gerät nicht, wenn das Objektiv noch angebracht ist.

Bei Verwendung eines Objektivs mit A-Bajonett wird die Blende manuell eingestellt und der Fokus ist auf MF eingestellt.

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

Hinweis
Wenn die Schwenk-/Neigebewegung des Kamerakopfs nicht arretiert wird, obwohl sich der Arretierhebel in Stellung LOCK befindet,
bewegen Sie die Kamera manuell, bis sie in ihrer Position arretiert wird.

1

Drehen Sie den Klemmhebel der Montageschraube für das Objektivstützgestell entgegen dem Uhrzeigersinn, um die
Arretierung zu lösen. Bewegen Sie dann die Montageschraube des Objektivstützgestells in eine Position, an der sie
nicht mit dem Objektiv kollidiert.

A: richtig
B: falsch

2

Drehen Sie den Arretierhebel des Kamerakopfs in Pfeilrichtung, um den Kamerakopf freizugeben.3
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Hinweis

Bis der Kamerakopf erneut arretiert wird, besteht die Gefahr, dass sich der Kamerakopf durch sein Eigengewicht bewegt. Stützen Sie beim
Durchführen dieser Aufgabe den Kamerakopf mit der Hand.

Schieben Sie den Kamerakopf in die vorderste Position.4

Drehen Sie den Arretierhebel des Kamerakopfs in Pfeilrichtung, um den Kamerakopf zu arretieren.

Hinweis
Stellen Sie sicher, dass der Arretierhebel des Kamerakopfs keine anderen Teile berührt, damit die Neigebewegung nicht gestört wird.

5
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Nehmen Sie Kappe und Abdeckung von Gerät und Objektiv ab.6

Richten Sie die Markierung zur Befestigung des Objektivs (weiß) am Gerät aus, setzen Sie das Objektiv vorsichtig in den
Kamerakopf ein und drehen Sie es dann im Uhrzeigersinn, bis es hörbar einrastet.

A: Befestigungsmarkierungen (weiß)

Hinweis

Bringen Sie zum Befestigen eines Objektivs mit A-Bajonett einen Objektivadapter (optional) am Gerät und dann das Objektiv mit A-Bajonett
an.

7

Drehen Sie den Arretierhebel des Kamerakopfs in Pfeilrichtung, um den Kamerakopf freizugeben.

Hinweis
Bis der Kamerakopf erneut arretiert wird, besteht die Gefahr, dass sich der Kamerakopf durch sein Eigengewicht bewegt. Stützen Sie beim
Durchführen dieser Aufgabe den Kamerakopf mit der Hand.

8

Halten Sie den Kamerakopf in Vorwärts-/Rückwärtsrichtung im Gleichgewicht, sodass die Gleitschiene waagerecht ist.9
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Falls Sie eines der folgenden Objektive verwenden, können Sie das Gerät zusammen mit dem Objektiv ungefähr anhand der
Skala auf der Gleitschiene ausbalancieren.

Hinweis
Verwenden Sie die Skala auf der Gleitschiene als Anhaltspunkt für das ungefähre Gleichgewicht.

Nehmen Sie beim Anbringen des Objektivs entsprechende Anpassungen des Gleichgewichts vor, sodass sich das Gerät nicht
vorwärts/zurück neigt.

Passen Sie das Gleichgewicht auf einer waagerechten Oberfläche an.

Entfernen Sie bei Verwendung des SELC1635G die Objektivstützeinheit.

Skalenposition Objektivbezeichnung

0,5 SEL70200GM (mit SEL20TC angebracht)

1,7 SEL70200GM

2,0 SEL70200GM2 (mit SEL20TC angebracht)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

5,0 oder höher SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Drehen Sie den Arretierhebel des Kamerakopfs in Pfeilrichtung, um den Kamerakopf zu arretieren.

Hinweis

10
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Stellen Sie sicher, dass der Arretierhebel des Kamerakopfs keine anderen Teile berührt, damit die Neigebewegung nicht gestört wird.
Prüfmethode: Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung UNLOCK, drehen Sie den Kamerablock per Hand so,
dass er aufwärts weist, und prüfen Sie visuell, dass er keine anderen Teile berührt. Gibt es Berührungen, drehen Sie den Arretierhebel des
Kamerakopfs erneut in Pfeilrichtung.

Drehen Sie die Klemmhebel der Objektivabstützung entgegen dem Uhrzeigersinn, um die Objektivstützeinheit zu lösen.

A: Klemmhebel der Objektivstützstange (2 Positionen)
B: Objektivstützeinheit

11

Bewegen Sie die Objektivstützeinheit so, dass das Objektivstützgestell auf dessen Montageschraube ausgerichtet ist.
Drehen Sie die Schraube dann im Uhrzeigersinn, um das Objektivstützgestell zu sichern.

Hinweis
Achten Sie darauf, dass das Objektivstützgestell senkrecht zu seiner Montageschraube ist, und ziehen Sie diese dann an.

12

Drehen Sie den Klemmhebel der Montageschraube für das Objektivstützgestell im Uhrzeigersinn, um die
Montageschraube zu arretieren.

A: Montageschraube für Objektivstützgestell
B: Bohrung für Montageschraube
C: Klemmhebel an Montageschraube für Objektivstützgestell

Tipp
Falls sich ein Klemmhebel schwer drehen lässt, geben Sie ihn frei und drehen Sie ihn in einen Winkel, in dem er sich leichter verwenden
lässt. Befindet er sich in der gewünschten Position, schließen Sie den Hebel.

13
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Verwandtes Thema
Kalibrieren eines Objektivs mit E-Bajonett

5-041-957-64(1) Copyright 2022 Sony Corporation

A: Klemmhebel an Montageschraube für Objektivstützgestell
B: Klemmhebel der Objektivstützstange

Drehen Sie die beiden Klemmhebel der Objektivstützstange im Uhrzeigersinn, um die Objektivstützeinheit zu sichern.14

Prüfen Sie, ob beide Hebel angezogen und nicht locker sind, ob das Objektiv ordnungsgemäß angebracht ist und ob die
Objektivschalter korrekt eingestellt sind.

Falls ein Hebel locker ist oder das Objektiv nicht ordnungsgemäß angebracht ist, kann das Objektiv herunterfallen und
beschädigt werden.
Wenn Sie ein Motorzoomobjektiv mit E-Bajonett verwenden, muss dieses außerdem separat kalibriert werden, um die in der
Kamera als Voreinstellungspositionen gespeicherten Zoompositionen wieder genau anfahren zu können. Einzelheiten siehe
„Kalibrieren eines Objektivs mit E-Bajonett“.

15
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Abnehmen eines Objektivs

Gehen Sie zum Abnehmen eines Objektivs umgekehrt wie beim Anbringen eines Objektivs vor.

Hinweis
Halten Sie das Objektiv gut fest, sodass es nicht herunterfallen kann.

Falls Sie nicht vorhaben, sofort ein anderes Objektiv anzubringen, setzen Sie stets die Gehäusekappe auf.

Verwandtes Thema
Anbringen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation

Stellen Sie sicher, dass die Schwenk-/Neigebewegung arretiert ist.1

Drehen Sie den Klemmhebel der Montageschraube für das Objektivstützgestell entgegen dem Uhrzeigersinn, um die
Arretierung zu lösen.

2

Entfernen Sie die Montageschraube für das Objektivstützgestell an der Objektivstützeinheit, und bewegen Sie die
Schraube in eine Position, in der sie nicht mit dem Objektiv kollidiert.

3

Geben Sie den Kamerakopf frei und schieben Sie ihn in die vorderste Position.

Einzelheiten siehe Schritte 3 bis 5 unter „Anbringen eines Objektivs“.

4

Halten Sie die Objektivfreigabetaste gedrückt und drehen Sie das Objektiv entgegen dem Uhrzeigersinn, während Sie es
stützen.

5

Ziehen Sie bei aufeinander ausgerichteten Montagemarkierungen (weiß) an Kamera und Objektiv das Objektiv nach vorn
heraus.

6
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Anschließen der Kabel

In diesem Thema werden die Kabelverbindungen beschrieben.

5-041-957-64(1) Copyright 2022 Sony Corporation

Verbinden Sie die erforderlichen Kabel mit den Anschlüssen an der Rückseite.

Um zu verhindern, dass das HDMI-Kabel abgezogen wird, entfernen Sie zunächst die Montageschraube für die Halteplatte für
HDMI-Kabel (M2.6×6, schwarz) vom Anschlussblock. Bringen Sie dann die mitgelieferte Halteplatte für HDMI-Kabel mithilfe der
Schraube an. Sichern Sie das HDMI-Kabel mithilfe eines handelsüblichen Kabelbinders oder -bands an der Halteplatte für HDMI-
Kabel.

A: Montageschraube der Halteplatte für HDMI-Kabel (M2.6×6, schwarz)
B: handelsüblicher Kabelbinder bzw. Kabelband
C: Halteplatte für HDMI-Kabel (mitgeliefert)

1
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Verbinden des Geräts per Kabel mit einem Netzwerkgerät

In diesem Thema wird beschrieben, wie das Gerät per Kabel mit einem Netzwerkgerät verbunden wird.

Mit einem Netzwerk ohne DHCP-Server verbinden

Das Gerät ist werkseitig so konfiguriert, dass es automatisch eine IP-Adresse von einem DHCP-Server bezieht.
Im Allgemeinen verfügen handelsübliche WLAN-Router über eine DHCP-Serverfunktion. Falls Sie jedoch eine Verbindung zu einem
Netzwerk ohne DHCP-Server herstellen, legen Sie wie nachfolgend beschrieben eine feste IP-Adresse fest.

Verbinden Sie das Gerät über ein LAN-Kabel der Kategorie 5e oder höher mit einem Netzwerkgerät (z. B. WLAN-
Zugangspunkt oder Switch).

1

Rufen Sie die Web-App auf und konfigurieren Sie die Anfangseinstellungen des Geräts.

Einzelheiten siehe „Von einem Webbrowser aus auf die Web-App zugreifen“ und „Ersteinrichtung des Geräts“.

2

Trennen Sie die Stromversorgung vom Gerät.1.
Stellen Sie den SETUP-Schalter 4 am Anschlussblock des Geräts auf „ON“ (Modus mit fester IP-Adresse).2.

Verbinden Sie die Stromversorgung mit dem Gerät.
Die IP-Adresse des Geräts wird unabhängig von der Einstellung im Webmenü auf 192.168.0.100 festgelegt.

3.

Legen Sie für den Einrichtungscomputer eine eindeutige IP-Adresse im gleichen Netzwerk fest, z. B. 192.168.0.200.4.
Verbinden Sie den Einrichtungscomputer über ein LAN-Kabel direkt mit dem Gerät.5.
Geben Sie am Einrichtungscomputer „192.168.0.100“ in die Adresszeile eines Webbrowsers ein.
Die Web-App des Geräts wird angezeigt. Sie werden dazu aufgefordert, Benutzername und Passwort einzugeben. Konfigurieren
Sie die Einstellungen wie unter „Ersteinrichtung des Geräts“ beschrieben.

6.

Konfigurieren Sie die folgenden Einstellungen mithilfe von [Network] > [Wireless LAN] > [IPv4] im Webmenü und drücken Sie auf
[OK].
Die Einstellungen sind lediglich Beispiele. Ändern Sie die Einstellungen passend zum Netzwerk, mit dem Sie die Verbindung
herstellen möchten.

7.
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Verwandtes Thema
Von einem Webbrowser aus auf die Web-App zugreifen

Ersteinrichtung des Geräts
Verwenden der Stromversorgung über PoE++
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Menüpunkt Einstellung Anmerkungen

[DHCP] [Off]

[IP Address] 192.168.0.101
Das letzte Oktett muss eine Nummer sein, die unter den anderen Geräten im gleichen
Netzwerk nur ein Mal vergeben ist.

[Subnet
Mask]

255.255.255.0

[Gateway] 192.168.0.1 Konfigurieren Sie die Einstellungen passend zum Netzwerk.

Warten Sie etwa 10 Sekunden und trennen Sie dann die Stromversorgung vom Gerät.8.
Stellen Sie den SETUP-Schalter 4 am Anschlussblock auf „OFF“.9.
Verbinden Sie das LAN-Kabel wieder mit dem Gerät.10.
Verbinden Sie die Stromversorgung mit dem Gerät.11.
Geben Sie die in Schritt 7 konfigurierte IP-Adresse in einen Webbrowser mit Netzwerkzugriff ein.
Der Bildschirm der Web-App wird angezeigt.

12.
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Verwendung von Wechselstrom

In diesem Thema wird beschrieben, wie Sie das Gerät mit Netzstrom betreiben.

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

1

Verbinden Sie das AC-Netzteil (mitgeliefert) mit dem DC IN-Anschluss am Gerät, und verbinden Sie das Netzkabel
(mitgeliefert) mit einer Netzstromquelle.

A: DC IN-Anschluss
B: Netzkabel
C: AC-Netzteil

2

Sichern Sie das Kabel des Netzteils mit der Kabelklemme, um zu verhindern, dass es getrennt wird.

Öffnen Sie die Kabelklemme, führen Sie das Kabel wie unten gezeigt durch die Klemme und schließen Sie die Klemme.

3
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Hinweis

Verwenden Sie nur das zum Gerät mitgelieferte AC-Netzteil und Netzkabel. Die Verwendung eines anderen Netzteils oder Netzkabels kann zu
Bränden oder Fehlfunktionen führen.

AC-Netzteile dürfen nicht auf engem Raum angeschlossen werden, etwa zwischen einer Wand und einem Möbelstück.

Die Metallkomponenten am Stecker des AC-Netzteils dürfen nicht kurzgeschlossen werden. Andernfalls kann es zu einer Fehlfunktion kommen.

Schließen Sie das AC-Netzteil an die nächstgelegene Netzstromquelle an. Falls während des Betriebs ein Problem auftritt, trennen Sie das
Netzkabel von der Netzstromquelle.

Fassen Sie zum Trennen des Netzteils vom Gerät den Stecker und ziehen Sie ihn gerade heraus. Ziehen Sie nicht am Kabel, da dies zu
Funktionsstörungen führen kann.

A: Kabelklemme
B: Raste für Kabelklemme
C: Kabel des Netzteils

Prüfen Sie, ob die Anzeige POWER an der Vorderseite des Geräts von grünem Blinken zu dauerhaftem grünen Leuchten
wechselt und der Start abgeschlossen wurde.

Wenn das Gerät normal gestartet wurde und die Verbindung zum Netzwerk hergestellt hat, leuchtet die Anzeige NETWORK grün.

Wenn Sie ein Objektiv verwenden, das keinen Schwenk-/Neigebetrieb unterstützt, verriegeln Sie den Arretierhebel für
Schwenken/Neigen und überspringen die folgenden Schritte. Informationen zu Objektiven, die Schwenk-/Neigebetrieb
unterstützen, erhalten Sie bei Ihrem Händler oder der zuständigen Sony-Kundendienstvertretung.

4

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung UNLOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs freizugeben.

5

Setzen Sie die Schwenk-/Neigefunktionen zurück.

Einzelheiten siehe „Zurücksetzen der Schwenk-/Neigefunktionen“.

6
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Verwandtes Thema
Zurücksetzen der Schwenk-/Neigefunktionen
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Verwenden der Stromversorgung über PoE++

Wenn das Gerät mit einer PoE++-kompatiblen Stromversorgung verbunden ist, wird es über ein handelsübliches Netzwerkkabel mit
Strom versorgt.
Auf diese Weise ist die Stromversorgung ohne zusätzliche Verkabelung in Bereichen möglich, in denen sich keine Steckdose in der
Nähe des Montageorts befindet.

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

1

Verbinden Sie das Gerät und eine PoE++-kompatible Stromversorgung mithilfe eines handelsüblichen Netzwerkkabels.

A: Netzwerkkabel
B: PoE++-kompatible Stromversorgung

2

Prüfen Sie, ob die Anzeige POWER an der Vorderseite des Geräts von grünem Blinken zu dauerhaftem grünen Leuchten
wechselt und der Start abgeschlossen wurde.

Wenn das Gerät normal gestartet wurde und die Verbindung zum Netzwerk hergestellt hat, leuchtet die Anzeige NETWORK grün.

Hinweis
Wenn die Stromversorgung über PoE++ erfolgt, wird die anfängliche Authentifizierung während des Zeitraums bis zum Ende des
Startvorgangs durchgeführt.

Wenn Sie ein Objektiv verwenden, das keinen Schwenk-/Neigebetrieb unterstützt, verriegeln Sie den Arretierhebel für Schwenken/Neigen
und überspringen die folgenden Schritte. Informationen zu Objektiven, die Schwenk-/Neigebetrieb unterstützen, erhalten Sie bei Ihrem
Händler oder der zuständigen Sony-Kundendienstvertretung.

3
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Hinweis

Das Gerät entspricht IEEE802.3bt Type 4 Class 8. Informationen zu geprüften PoE++-kompatiblen Stromversorgungen erhalten Sie bei Ihrem
Händler oder der zuständigen Sony-Kundendienstvertretung.

Das Gerät ist mit weicher Authentifizierung (LLDP) kompatibel, aber es ist ggf. erforderlich, Netzwerkgeräte zu konfigurieren (gemäß
IEEE802.3bt).

Schließen Sie kein AC-Netzteil an, wenn Sie eine Stromversorgung über PoE++ mit aktivierter weicher Authentifizierung (LLDP) verwenden.

Falls gleichzeitig ein AC-Netzteil und eine Stromversorgung über PoE++ angeschlossen sind, erfolgt die Versorgung über das AC-Netzteil.

Verwenden Sie zur Stromversorgung über PoE++ ein Netzwerkkabel der Kategorie 5e oder höher.

Warten Sie bei Stromversorgung über PoE++ etwa 10 Sekunden, bevor Sie das Gerät wieder einschalten.

Wenn Sie die Stromversorgung über PoE++ verwenden, verbinden Sie den Erdungsanschluss mit dem Erdkontakt.

Verlegen Sie bei Stromversorgung über PoE++ die Verkabelung nicht im Freien.

Wenn Sie die Stromversorgung über PoE++ verwenden, können Aufnahme und PTZ-Bildausschnitt-Steuerung nicht gleichzeitig verwendet
werden.

Verwandtes Thema
Zurücksetzen der Schwenk-/Neigefunktionen
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Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung UNLOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs freizugeben.

4

Setzen Sie die Schwenk-/Neigefunktionen zurück.

Einzelheiten siehe „Zurücksetzen der Schwenk-/Neigefunktionen“.

5
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Zurücksetzen der Schwenk-/Neigefunktionen

Sie können wie nachfolgend erläutert die Schwenk-/Neigefunktionen beispielsweise beim Wechseln des Objektivs zurücksetzen.
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Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung UNLOCK und stellen Sie sicher, dass die
Schwenk-/Neigebewegung des Kamerakopfs freigegeben ist.

1

Führen Sie die Funktion zum Zurücksetzen von Schwenken/Neigen aus.

Das Schwenken/Neigen kann von der Infrarot-Fernbedienung, der Web-App oder der Fernbedienung RM-IP500 aus (optional)
zurückgesetzt werden.

Bedienung über die Infrarot-Fernbedienung: Drücken Sie die Taste P/T RESET.
Bedienung über die Web-App: Drücken Sie die Taste  (Schwenken/Neigen zurücksetzen) auf der Registerkarte 
(Others) im Kamerasteuerbereich des Live-Betriebsbildschirms.
Bedienung über die RM-IP500: siehe Bedienungsanleitung der RM-IP500.

Hinweis

Beim Zurücksetzen des Schwenkens/Neigens drehen sich Kamerakopf und Objektiv. Achten Sie vor der Ausführung dieser Funktion
darauf, dass sich das Objektiv ungehindert bewegen kann.

Das Gerät verfügt über eine Funktion zur Begrenzung des Schwenk-/Neigebereichs. Diese Funktion ist jedoch nach dem Einschalten des
Geräts oder beim Zurücksetzen des Schwenkens/Neigens deaktiviert.

Tipp
Sobald das Zurücksetzen des Schwenkens/Neigens abgeschlossen ist, kehrt das Gerät in die Position vor der Ausführung des Vorgangs
zurück.

2
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Von einem Webbrowser aus auf die Web-App zugreifen

Indem Sie das Gerät mit einem Tablet oder Computer verbinden, können Sie es über einen Webbrowser konfigurieren und bedienen.

Prüfen Sie, ob Ihr Tablet oder Computer die Funktionen der Web-App unterstützt.

Hinweis
Falls die Voraussetzungen nicht erfüllt sind und abhängig von der Verwendung des Tablets/Computers kann die Videoanzeige in einem
Webbrowser beeinträchtigt sein.

Die Web-App dieses Geräts verwendet JavaScript. Falls Sie auf Ihrem Tablet/Computer Antivirensoftware verwenden, wird die Webseite
ggf. nicht korrekt angezeigt.

1

Menüpunkt Voraussetzung

Anzeige
1080×810 Pixel oder mehr empfohlen
Tablet-Bildschirmgröße: 10 Zoll oder größer empfohlen

Unterstütztes OS und Webbrowser

Windows
OS Windows 10 oder neuer

Webbrowser Google Chrome

Mac

OS macOS 10.15 oder neuer

Webbrowser
Google Chrome
Safari

iPad

OS iPadOS 16 oder neuer

Webbrowser
Google Chrome
Safari

Android
OS Android 12 oder neuer

Webbrowser Google Chrome

Stellen Sie sicher, dass Gerät, Tablet oder Computer sowie Peripheriegeräte eingeschaltet sind.2

Stellen Sie sicher, dass das Gerät per LAN verbunden ist.3

Stellen Sie sicher, dass das Tablet oder der Computer per WLAN oder LAN verbunden sind.4

Stellen Sie vom Webbrowser auf Ihrem Tablet oder Computer eine Verbindung zum Gerät her.

Verbindung mithilfe eines QR-Codes
Scannen Sie den auf der Medienabdeckung an der Seite des Geräts aufgedruckten QR-Code mit der Kamera des Tablets.

5
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Hinweis

Falls die HTTP-Portnummer auf einen anderen Wert als 80 geändert wurde, geben Sie in die Adresszeile „http://IP-Adresse des
Geräts:Portnummer“ ein.

Wenn Sie die Verbindung mithilfe eines QR-Codes oder durch Eingeben der URL in der Adresszeile eines Webbrowsers herstellen, verwenden

Sie ein Gerät, das mDNS* unterstützt.

Tipp
Sie können in der Folge schnell auf das Gerät zugreifen, indem Sie die Lesezeichenfunktion des Webbrowsers nutzen.

Verwandtes Thema
Ersteinrichtung des Geräts

Verbinden des Geräts per Kabel mit einem Netzwerkgerät

5-041-957-64(1) Copyright 2022 Sony Corporation

Öffnen Sie den angezeigten Link auf dem Tablet.
Der Webbrowser auf dem Tablet startet und zeigt den Web-App-Bildschirm des Geräts an.

Verbindung herstellen durch Eingabe einer URL in der Adresszeile eines Webbrowsers
Starten Sie einen Webbrowser auf Ihrem Tablet oder Computer und geben Sie die auf der Medienabdeckung an der Seite des
Geräts aufgedruckte URL ein.
Der Webbrowser sollte den Web-App-Bildschirm des Geräts anzeigen.

Verbindung herstellen durch Eingabe der IP-Adresse des Geräts in der Adresszeile eines Webbrowsers
Starten Sie einen Webbrowser auf Ihrem Tablet oder Computer und geben Sie in die Adresszeile „http://IP-Adresse des Geräts“
ein.
Der Webbrowser sollte den Web-App-Bildschirm des Geräts anzeigen.

mDNS: Kommunikationsprotokoll, das dazu verwendet wird, aus einem Host-Namen in einem lokalen Netzwerk die IP-Adresse zu bestimmen.*
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Ersteinrichtung des Geräts

Stellen Sie sicher, dass Sie das Gerät bei der ersten Verwendung wie nachfolgend beschrieben konfigurieren.
Einzelheiten zum Zugriff auf die Web-App siehe „Von einem Webbrowser aus auf die Web-App zugreifen“.

Tipp

Falls sich die Pufferbatterie vollständig entlädt, müssen Sie die Ersteinrichtung erneut durchführen.

Stellen Sie von einem Tablet oder Computer aus eine Verbindung zum Gerät her und starten Sie die Web-App.

Bei der ersten Verwendung des Geräts werden Sie aufgefordert, einen Benutzernamen und ein Passwort einzugeben. Geben Sie
die folgenden Einstellungen an.

Benutzername: admin
Passwort: (leer lassen)

Folgen Sie den Anweisungen auf dem Bildschirm, um die Ersteinrichtung durchzuführen.

1

Geben Sie den Administrator-Benutzernamen (Administrator) und das Passwort ein und drücken Sie dann auf die Taste
[OK].

1: Geben Sie den Administrator-Benutzernamen ein.
2: Legen Sie das Administrator-Passwort fest.
3: Geben Sie zur Bestätigung das Passwort erneut ein.

Hinweis

In Benutzernamen und Passwörtern können die folgenden Zeichen verwendet werden. Das Passwort muss mindestens einen
Großbuchstaben, einen Kleinbuchstaben und eine Ziffer enthalten sowie 8 bis 64 Zeichen lang sein.

Alphanumerische Zeichen
Sonderzeichen (!$%`*+-./<=>?@[]^_{|}~)

Ihr Webbrowser lädt die Seite erneut und Sie werden aufgefordert, den Benutzernamen und das Passwort einzugeben.

2
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Der Live-Bildschirm für Aufnahmevorgänge wird angezeigt. Fahren Sie mit der Konfiguration des Geräts für grundlegende Vorgänge je
nach Betriebsmodus fort.

Tipp
In einigen Fällen wie z. B. bei der Verwendung des Geräts zusammen mit einem Tablet ist es möglicherweise einfacher, eine feste IP-Adresse für
das Gerät zu verwenden.

Um eine feste IP-Adresse festzulegen, deaktivieren Sie zunächst [Network] > [Wired LAN] > [IPv4] > [DHCP] im Webmenü (Schiebeschalter in
Stellung links).

Die auf eine feste IP-Adresse bezogenen Einrichtungselemente werden angezeigt. Konfigurieren Sie die Elemente und drücken Sie dann die
Taste [OK] auf dem Bildschirm.

Verwandtes Thema
Von einem Webbrowser aus auf die Web-App zugreifen

Geben Sie den unter Schritt 2 konfigurierten Benutzernamen und das Passwort ein.

Der Bildschirm zum Einrichten von Sprache und Uhrzeit wird angezeigt.

3

Geben Sie die folgenden Einstellungen an und drücken Sie auf die Taste [OK].

[Language]
Wählen Sie die für die Anzeige von Web-App und Kamerabildschirm zu verwendende Sprache aus. Wenn Sie die Sprache
ändern, wird damit die Anzeigesprache der Web-App geändert.
[Date & Time Format]
Wählen Sie aus den folgenden Optionen das Anzeigeformat für Datum und Uhrzeit.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
Dabei stehen jeweils „yyyy“ für das Jahr, „mm“ für den Monat, „dd“ für den Tag, „hh“ für die Stunde, „mm“ für die Minute und „ss“
für die Sekunde.
[12 h/24 h]
Wählen Sie für die Zeitanzeige [12 h] (12-Stunden-Uhr) oder [24 h] (24-Stunden-Uhr) aus.
[Time Setting]
Wählen Sie die Methode zum Einstellen von Datum/Uhrzeit aus.
[Synchronize with PC]: Mit Datum/Uhrzeit von Computer oder Tablet synchronisieren.
[Manual setting]: Manuell einstellen. Wenn diese Methode ausgewählt wird, werden Felder für Datum und Uhrzeit angezeigt.
[Time Zone]
Wählen Sie die Zeitzone aus.

4
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Geräteeinstellungen zurücksetzen

In diesem Thema wird beschrieben, wie Sie das Gerät zurücksetzen.
Die Einstellungen, die zurückgesetzt werden, variieren je nach Einstellung des SETUP-Schalters 1 am Anschlussblock.

Verwandtes Thema
Anschlussblock

Reset

5-041-957-64(1) Copyright 2022 Sony Corporation

Verbinden Sie die Stromversorgung mit dem Gerät.1

Stellen Sie den SETUP-Schalter 1 am Anschlussblock des Geräts entsprechend ein.

Um nur die Netzwerkeinstellungen auf Standardwerte zurückzusetzen, stellen Sie den Schalter 1 auf OFF.
Um alle Einstellungen des Geräts auf Standardwerte zurückzusetzen, stellen Sie den Schalter 1 auf ON.

2

Halten Sie mit der Spitze eines Kugelschreibers oder einem anderen schmalen Gegenstand den RESET-Schalter
mindestens 5 Sekunden lang gedrückt.

Die Einstellungen werden zurückgesetzt und das Gerät wird neu gestartet.

3
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Konfigurieren der Grundfunktionen

In diesem Thema wird beschrieben, wie das Gerät für grundlegende Vorgänge konfiguriert wird.

Festlegen des Aufnahmemodus

Sie können den Aufnahmemodus des Geräts auswählen, um ihn an Ihrem Arbeitsablauf auszurichten.

Modus Custom: Bilder flexibel während der Aufnahme erstellen.
Log-Aufnahmemodi: zum aufnehmen von S-Log-Material.

Modus Flexible ISO: Belichtungseinstellungen werden durch ISO-Wertanpassungen festgelegt, die zur aufgenommenen Szene
passen.
Modus Cine EI/Modus Cine EI Quick: Gerät ähnlich wie eine Filmkamera betreiben (Bilder bei der Aufnahme nicht vollständig
erstellen), bei der das Material in der Postproduktion entwickelt wird.

Im Modus Cine EI Quick wird automatisch eine Basisempfindlichkeit ausgewählt, die für die Einstellung Exposure Index geeignet ist.
Wechseln Sie den Aufnahmemodus im Webmenü oder Kameramenü mithilfe der Einstellung [Project] > [Base Setting] > [Shooting
Mode].

Modus Custom
Sie können den Videostandard auswählen.
Zum Wechseln verwenden Sie [Project] > [Base Setting] > [Target Display] im Webmenü oder Kameramenü.

[SDR(BT.709)]: Aufnahme gemäß HD-Rundfunkstandard
[HDR(HLG)]: Aufnahme gemäß 4K-Rundfunkstandard der nächsten Generation

Einzelheiten siehe „Überblick zum Look“ und andere Themen unter „Aufnehmen mit dem gewünschten Look“.

Log-Aufnahmemodi
(Modus Flexible ISO/Modus Cine EI/Modus Cine EI Quick)
In Log-Aufnahmemodi wählen Sie den Basisfarbbereich für aufgenommene Signale und ausgegebene Signale. Der hier ausgewählte
Farbbereich gilt für die Videoausgabe, wenn die Einstellungen unter [LUT On/Off] auf [MLUT Off] eingestellt sind.
Sie können mithilfe von [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] im Kameramenü den Farbbereich wechseln.

[S-Gamut3.Cine/SLog3]: Einfach anzupassender Farbbereich für digitales Kino (DCI-P3).
[S-Gamut3/SLog3]: Großer Farbbereich von Sony, der den Farbraum ITU-R BT.2020 abdeckt.

Einzelheiten siehe „Aufnehmen mit Look-Anpassung in der Postproduktion“.
 
In der folgenden Tabelle sind die im jeweiligen Aufnahmemodus unterstützten Funktionen aufgeführt.
●: unterstützt, –: nicht unterstützt

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (verknüpft mit EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –
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Tipp

In den Modi Cine EI Quick und Cine EI erfolgt die Aufnahme mit einer ISO-Basisempfindlichkeit ohne Verwendung von Verstärkung, um die
Leistung des Bildsensors zu maximieren. Die Helligkeit wird mithilfe der Beleuchtung und dem ND-Filter angepasst, um die Lichtmenge zu
regulieren, die den Bildsensor erreicht.

Einstellen der Systemfrequenz

Zum Wechseln verwenden Sie [Project] > [Rec Format] > [Frequency] im Webmenü oder Kameramenü. Nach dem Wechseln startet
das Gerät je nach gewähltem Wert ggf. automatisch neu.

Hinweis
Während der Aufnahme oder Wiedergabe ist das Wechseln der Systemfrequenz nicht möglich.

Einstellen des Bildsensor-Abtastmodus

Sie können die effektive Bildgröße und Auflösung des Bildsensors einstellen.
Zum Wechseln verwenden Sie [Project] > [Rec Format] > [Imager Scan Mode] im Webmenü oder Kameramenü.
[FF]: Vollbildgröße.
[S35]: Größe Super 35mm.

Hinweis
Während der Aufnahme oder Wiedergabe kann der Abtastmodus des Bildsensors nicht geändert werden.

Bei Einstellung auf S35 ist das Videoformat auf 1920×1080 beschränkt.

Einstellen des Codec

Sie können den Codec für die Aufnahme festlegen.
Zum Wechseln verwenden Sie [Project] > [Rec Format] > [Codec] im Webmenü oder Kameramenü.

Hinweis
Während der Aufnahme oder Wiedergabe ist das Wechseln des Codecs nicht möglich.

Einstellen des Videoformats

Sie können das Videoformat für die Aufnahme und das Ausgabeformat für die Ausgabe der Kamera einstellen.

Wechseln Sie das Videoformat für die Aufnahme mithilfe der Einstellung [Project] > [Rec Format] > [Video Format] im Webmenü
oder Kameramenü.
Das Ausgabeformat an den Anschlüssen SDI OUT und HDMI OUT wechseln Sie mithilfe von [Monitoring] > [Output Format] im
Webmenü oder Kameramenü.

Hinweis
Während der Aufnahme oder Wiedergabe ist das Wechseln des Videoformats nicht möglich.

Je nach Einstellung für das Videoformat können für das Signal an den Anschlüssen SDI OUT und HDMI OUT Beschränkungen gelten.

Verwandtes Thema

Custom Flexible ISO Cine EI Cine EI Quick

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(ausgenommen Base Look)

● – – –
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Überblick zum Look

Aufnehmen mit Look-Anpassung in der Postproduktion

5-041-957-64(1) Copyright 2022 Sony Corporation
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Unterstützte Speicherkarten

Das Gerät kann Audio- und Videodaten auf in den Karteneinschüben eingesetzte CFexpress Type A-Speicherkarten oder SDXC-
Speicherkarten aufzeichnen (Karten jeweils separat erhältlich). Die Speicherkarten werden auch für Proxy-Aufzeichnung verwendet.

CFexpress Type A-Speicherkarten

Verwenden Sie die unter „Empfohlene Aufzeichnungsmedien“ aufgeführten CFexpress Type A-Speicherkarten* von Sony im Gerät.
Einzelheiten zum Betrieb mit Medien anderer Hersteller siehe Bedienungsanleitung der Medien oder Herstellerinformationen.

SDXC-Speicherkarten

Verwenden Sie die unter „Empfohlene Aufzeichnungsmedien“ aufgeführten SDXC-Speicherkarten* im Gerät.

Empfohlene Aufzeichnungsmedien

Die ordnungsgemäße Funktion hängt vom Aufzeichnungsformat und den Aufzeichnungseinstellungen ab.

CFexpress Type A
VPG400/200-konform
Für alle Aufzeichnungsformate des Geräts unterstützt.

SDXC
Unter den Bedingungen in der folgenden Tabelle unterstützt. „●“ bedeutet, dass der Betrieb geprüft wurde. „–“ bedeutet, dass der
Betrieb nicht garantiert wird.

RAW Out & XAVC-I, 4096×2160 Klasse 300, Normalmodus

RAW Out & XAVC-I, 3840×2160 Klasse 300, Normalmodus

In dieser Hilfe als „CFexpress-Karten“ bezeichnet.*

In dieser Hilfe als „SD-Karten“ bezeichnet.*

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Klasse 300, S&Q (60 fps oder weniger)

RAW Out & XAVC-I, 3840×2160 Klasse 300, S&Q (100 fps, 120 fps)
Geprüfte Medien nicht verfügbar.

XAVC-I, 4096×2160 Klasse 300, Normalmodus

XAVC-I, 4096×2160 Klasse 300, S&Q (60 fps oder weniger)

XAVC-I, 3840×2160 Klasse 300, Normalmodus

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●
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XAVC-I, 3840×2160 Klasse 300, S&Q (60 fps oder weniger)

XAVC-I, 3840×2160 Klasse 300, S&Q (100 fps, 120 fps)
Geprüfte Medien nicht verfügbar.

XAVC-I, 1920×1080 Klasse 100, Normalmodus

XAVC-I, 1920×1080 Klasse 100, S&Q (60 fps oder weniger)

XAVC-I, 1920×1080 Klasse 100, S&Q (100 fps, 120 fps)

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 1920×1080 Klasse 100, S&Q (150 fps, 180 fps)
Geprüfte Medien nicht verfügbar.

XAVC-I, 1920×1080 Klasse 100, S&Q (200 fps, 240 fps)
Geprüfte Medien nicht verfügbar.

XAVC-L, 3840×2160 420, Normalmodus

XAVC-L, 3840×2160 420, S&Q (60 fps oder weniger)

XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Normalmodus

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD50, S&Q (60 fps oder weniger)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●
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XAVC-L, 1920×1080 HD35, Normalmodus

XAVC-L, 1920×1080 HD35, S&Q (60 fps oder weniger)

XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●
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Systemfrequenz Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Einsetzen von Speicherkarten

In diesem Thema werden die Vorsichtsmaßnahmen beim Einsetzen von Speicherkarten beschrieben.

Öffnen Sie die Abdeckung des Karteneinschubbereichs.1

Setzen Sie eine Speicherkarte ein.

Bei CFexpress-Karten weist das Etikett nach oben.

Hinweis
Bei einem deckenmontierten Gerät weist das Etikett nach unten.

Bei SD-Karten weist das Etikett nach unten.

Hinweis

Bei einem deckenmontierten Gerät weist das Etikett nach oben.

Die Zugriffsanzeige leuchtet rot und wechselt dann zu grün, wenn die Karte verwendet werden kann.

Hinweis

Wenn die Zugriffsanzeige dauerhaft rot blinkt und nicht grün wird, schalten Sie das Gerät vorübergehend aus, entfernen Sie die
Speicherkarte, und setzen Sie sie erneut ein.

2

Schließen Sie die Medienabdeckung.3
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Hinweis

Die Speicherkarte, der Speicherkartenbereich und die Bilddaten auf der Speicherkarte können beschädigt werden, wenn die Karte falsch herum
eingesetzt wird.

Wenn Sie auf Medien in beiden Einschüben A und B für CFexpress Type A-/SD-Karten aufnehmen möchten, setzen Sie in beide Einschübe
Medien ein, die zum Betrieb mit dem beabsichtigten Aufnahmeformat empfohlen werden.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Auswerfen von Speicherkarten

Öffnen Sie die Medienabdeckung des Karteneinschubbereichs und drücken Sie sanft auf die Speicherkarte, um diese auszuwerfen.

Hinweis

Die Integrität der Daten auf der Karte kann nicht garantiert werden, wenn während des Zugriffs auf die Speicherkarte das Gerät ausgeschaltet
oder die Karte entnommen wird. Möglicherweise gehen alle Daten auf der Karte verloren. Stellen Sie stets sicher, dass die Zugriffsanzeige
entweder grün leuchtet oder erloschen ist, bevor Sie das Gerät ausschalten oder die Speicherkarte entfernen.

Wenn eine Speicherkarte direkt nach der Aufnahme entnommen wird, kann sie sich warm anfühlen. Das weist jedoch nicht auf ein Problem hin.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Formatieren (Initialisieren) von Speicherkarten

Beim Einsetzen einer unformatierten Speicherkarte oder einer auf einem anderen System formatierten Speicherkarte wird die Meldung
„Media Needs to be Formatted“ im Kamerabildbereich angezeigt.
Formatieren Sie die Karte wie folgt:

Hinweis

Beim Formatieren einer Speicherkarte gehen alle Daten verloren, einschließlich aufgezeichnete Videodaten und Einstellungsdateien.

Je nach Dauer des Formatierungsvorgangs werden während der Ausführung Meldungen angezeigt.

Die Formatierung schlägt fehl
Speicherkarten, die das Gerät nicht unterstützt, können nicht formatiert werden.
In dem Fall wird eine Warnmeldung angezeigt. Folgen Sie den Anweisungen, um die Karte durch eine unterstützte Speicherkarte zu
ersetzen.

Verwenden einer im Gerät formatierten Karte im Einschub eines anderen Geräts
Erstellen Sie zunächst eine Sicherheitskopie der Karte, und formatieren Sie die Karte dann in dem Gerät, in dem sie verwendet
werden soll.

5-041-957-64(1) Copyright 2022 Sony Corporation

Wählen Sie [TC/Media] > [Format Media] im Kameramenü aus.1

Wählen Sie Media(A) (Einschub A) oder Media(B) (Einschub B) aus. Wählen Sie dann die Formatierungsmethode aus
(Full Format oder Quick Format).

Es erscheint eine Bestätigungsmeldung.
[Full Format]: Initialisiert das Medium vollständig, einschließlich des Datenbereichs und der Datenverwaltungsinformationen.
[Quick Format]: Initialisiert nur die Datenverwaltungsinformationen des Mediums.

2

Wählen Sie [Execute] aus.

Während der Formatierung wird eine Meldung angezeigt, und die Zugriffsanzeige leuchtet rot.
Wenn die Formatierung beendet ist, wird eine Abschlussmeldung angezeigt.

3
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Überprüfen der verbleibenden Aufzeichnungszeit

Während der Aufzeichnung (Aufnahme/Standby) kann die verbleibende Kapazität der Speicherkarten in den Einschüben anhand der
Anzeigen für verbleibende Medienkapazität in Einschub A bzw. B im Kamerabildbereich überprüft werden.
Die verbleibende Aufnahmezeit errechnet sich aus der Restkapazität auf den Medien in den beiden Einschüben und dem aktuellen
Aufzeichnungsformat (Aufzeichnungs-Bitrate) und wird in Minuten angezeigt.

Wahl des Zeitpunkts zum Ersetzen von Speicherkarten
Wenn die Restkapazität auf den beiden Speicherkarten insgesamt unter 5 Minuten und fällt wird die Meldung „Media Near Full“
angezeigt und die Aufnahme-/Tally-Anzeige beginnt zu blinken.
Ersetzen Sie die Medien durch Speicherkarten mit ausreichend freiem Speicherplatz.
Wird die Aufzeichnung fortgesetzt, bis die verbleibende Gesamtaufnahmezeit Null erreicht, wechselt die Meldung zu „Media Full“, und
die Aufzeichnung wird angehalten.

Hinweis

Auf einer Speicherkarte können bis zu ca. 600 Clips gespeichert werden.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Wiederherstellen von Speicherkarten

Falls an einer Speicherkarte ein Fehler auftritt, muss sie vor erneutem Gebrauch wiederhergestellt werden.
Wenn Sie eine Speicherkarte laden, die wiederhergestellt werden muss, wird im Kamerabildbereich eine Abfrage angezeigt, ob Sie sie
wiederherstellen möchten.

So stellen Sie eine Karte wieder her
Wählen Sie im GUI-Steuerbereich mithilfe der Pfeiltasten [Execute] aus und drücken Sie die Taste [Set].
Während der Formatierung werden eine Meldung und ein Fortschrittsbalken (%) angezeigt, und die Zugriffsanzeige leuchtet rot.
Wenn die Wiederherstellung beendet ist, wird eine Abschlussmeldung angezeigt.

Wenn die Wiederherstellung fehlschlägt
Speicherkarten, an denen Speicherfehler aufgetreten sind, können nicht wiederhergestellt werden. In dem Fall wird eine
Warnmeldung angezeigt. Folgen Sie den Anweisungen, um die Speicherkarte zu ersetzen.
Speicherkarten, an denen Speicherfehler aufgetreten sind, können durch wiederholte Formatierung ggf. wieder funktionsfähig
werden.
In einigen Fällen können einige Clips wiederhergestellt werden, andere ggf. jedoch nicht. Die wiederhergestellten Clips können
normal wiedergegeben werden.

Hinweis
Verwenden Sie zur Wiederherstellung von Medien, die mit diesem Gerät aufgezeichnet wurden, auf jeden Fall dieses Gerät.

Medien, die mit einem anderen als diesem Gerät oder mit einem Gerät einer anderen Version aufgezeichnet wurden (auch wenn es das gleiche
Modell ist), können mit diesem Gerät nicht wiederhergestellt werden.

Clips, die kürzer als zwei Sekunden sind, können nicht wiederhergestellt werden.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Starten/Stoppen der Aufzeichnung

In diesem Thema wird beschrieben, wie Sie die Aufnahme starten/stoppen.

Bringen Sie die erforderlichen Geräte an und vergewissern Sie sich, dass das Gerät und die Peripheriegeräte mit Strom
versorgt werden.

1

Setzen Sie die Speicherkarte(n) ein.2

Prüfen Sie den Stromversorgungsstatus des Geräts oben links auf dem Bildschirm der Web-App.

Wenn die Stromversorgung eingeschaltet ist
Wenn das Gerät eingeschaltet ist, werden der Live-Betriebsbildschirm, der Wiedergabe-Betriebsbildschirm oder das Webmenü in
der Web-App angezeigt.

Die Anzeige POWER an der Vorderseite des Geräts leuchtet auf und das Kamerabild wird auf dem Live-Betriebsbildschirm der
Web-App angezeigt.

Hinweis
Falls Sie kein Administrator-Passwort konfiguriert haben, wird ein Bildschirm angezeigt, auf dem Sie hierzu aufgefordert werden. Siehe
„Ersteinrichtung des Geräts“.

Wenn die Stromversorgung im Bereitschaftszustand ist
Befindet sich die Stromversorgung des Geräts im Bereitschaftszustand, wird in der Web-App eine Meldung angezeigt, die dies
besagt.

Drücken Sie in diesem Zustand den Netzschalter und wählen Sie [Power ON] im Schaltermenü aus. Das Gerät wird
eingeschaltet, die Anzeige POWER an der Vorderseite des Geräts leuchtet grün auf und das Kamerabild wird auf dem Live-
Betriebsbildschirm der Web-App angezeigt.

Tipp
Sie können das Gerät auch über die Einschalttaste auf der mitgelieferten Infrarot-Fernbedienung einschalten.

3

Drücken Sie auf die Aufnahmetaste START/STOP.4
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Stromversorgung des Geräts in Bereitschaft schalten
Drücken Sie den Netzschalter in der Web-App und wählen Sie [Power Standby] aus, um die Stromversorgung des Geräts in den
Bereitschaftszustand zu versetzen.

Tipp

Sie können das Gerät auch über die Einschalttaste auf der mitgelieferten Infrarot-Fernbedienung in den Bereitschaftszustand versetzen.

Verwandtes Thema
Ersteinrichtung des Geräts

5-041-957-64(1) Copyright 2022 Sony Corporation

Die Aufzeichnung beginnt und die Aufnahme-/Tally-Anzeige (zwei Positionen) des Geräts leuchtet auf.
Während der Aufzeichnung leuchtet die Aufnahmetaste START/STOP. Es werden außerdem ein Symbol für das Zielmedium der
Aufzeichnung und [●Rec] angezeigt.

Um die Aufzeichnung anzuhalten, drücken Sie erneut die Aufnahmetaste START/STOP.

Die Aufzeichnung stoppt und die Aufnahme-/Tally-Anzeige (zwei Positionen) des Geräts erlischt.
Während der Aufnahmebereitschaft leuchtet die Aufnahmetaste START/STOP nicht. Es werden außerdem ein Symbol für das
Zielmedium der Aufzeichnung und [Stby] angezeigt.

Tipp
Sie können die Aufzeichnung auch mithilfe der Aufnahmetaste START/STOP auf der mitgelieferten Infrarot-Fernbedienung starten/stoppen.

5
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Wechseln zwischen Speicherkarten

Wenn zwei Speicherkarten eingesetzt sind, können Sie die Taste [Slot Select] im Wiedergabesteuerbereich der Web-App drücken, um
zwischen den Speicherkarten zu wechseln.

Tipp

Sie können zum Wechseln zwischen den Speicherkarten auch die Taste SLOT SEL (Auswahl des Speicherkarteneinschubs A/B) auf der
mitgelieferten Infrarot-Fernbedienung drücken.

Informationen zur unterbrechungsfreien Aufzeichnung

Bei der Aufzeichnung wechselt das Gerät, kurz bevor die erste Karte komplett voll ist, automatisch zur zweiten Speicherkarte
(unterbrechungsfreie Aufnahme). Sie können die kontinuierliche Aufzeichnung fortsetzen, indem Sie zwischen den Speicherkarten
umschalten und eine volle durch eine neue Speicherkarte ersetzen.

Hinweis
Im Wiedergabemodus ist es nicht möglich, zwischen den Speicherkarten zu wechseln. Auch die durchgehende Wiedergabe eines Clips, der sich
über die Speicherkarten in Einschub A und Einschub B erstreckt, wird nicht unterstützt.

Informationen zu aufgezeichneten Daten

Beim Anhalten der Aufnahme werden die Video- und Audiodaten sowie alle zugehörigen Daten von Anfang bis Ende der Aufzeichnung
in Form eines sogenannten Clips auf einer Speicherkarte gespeichert.

Clipname der aufgezeichneten Daten

Jedem mit dem Gerät aufgenommenen Clip wird mithilfe von [TC/Media] > [Clip Name Format] im Kameramenü automatisch ein Name
zugewiesen.

Maximale Cliplänge

Bis zu 6 Stunden pro Clip.
Die maximale Dauer einer kontinuierlichen Aufnahme ist gleich der maximalen Dauer eines Clips. Falls die Aufnahmedauer die
maximale Dauer eines Clips überschreitet, wird automatisch ein neuer Clip erstellt und die Aufnahme wird fortgesetzt. Der neue Clip
wird in der Miniaturbildanzeige als separater Clip angezeigt.
Bei der Aufzeichnung mit Speicherkartenwechsel werden mehrere Clips in Folge aufgezeichnet. Nach ca. 24 Stunden wird die
Aufnahme jedoch automatisch angehalten.

Hinweis

Speicherkarten nicht während der Aufzeichnung auswerfen. Wechseln Sie nur Speicherkarten in Einschüben, deren Zugriffsanzeige nicht
leuchtet.

Wenn die verbleibende Kapazität auf der aktuell verwendeten Speicherkarte unter eine Minute fällt und eine beschreibbare Speicherkarte in den
anderen Einschub eingesetzt wird, erscheint die Meldung „Will Switch Slots Soon“. Sobald der Speicherkarteneinschub gewechselt wurde, wird
die Nachricht ausgeblendet.

Die unterbrechungsfreie Aufzeichnung kann nicht garantiert werden, wenn bei Aufnahmebeginn weniger als eine Minute Kapazität auf der Karte
verbleibt. Um eine ordnungsgemäße Funktion gewährleisten zu können, ist vor Beginn der Aufzeichnung zu überprüfen, dass die verbleibende
Speicherkartenkapazität mehr als eine Minute beträgt.

Mit der Funktion des Geräts zur unterbrechungsfreien Aufzeichnung erstellte Videos können nicht unterbrechungsfrei auf dem Gerät
wiedergegeben werden.

Zum Verbinden von Videos, die mit der Funktion des Geräts zur unterbrechungsfreien Aufzeichnung erstellt wurden, kann das
Anwendungsprogramm „Catalyst Browse“ verwendet werden.
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Prüfen des Tons

Das Audiosignal wird an den SDI- und HDMI-Anschlüssen des Geräts ausgegeben. Wählen Sie mithilfe von [Audio] > [Audio Output] >
[HDMI/Stream Output CH] im Kameramenü die Kombination der am HDMI-Anschluss auszugebenden Audiokanäle aus.
CH1/CH2: Kombination von CH1 und CH2
CH3/CH4: Kombination von CH3 und CH4
Verwenden Sie zur Überwachung des Tons in der Web-App die Audiopegelanzeige unten rechts im Kamerabild.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Festlegen von Zeitdaten

In diesem Thema wird beschrieben, wie Sie Zeitdaten einstellen.

Einstellen des Zeitcodes

Legen Sie den aufzuzeichnenden Zeitcode mithilfe von [TC/Media] > [Timecode] im Kameramenü fest.

Festlegen von User-Bits

Sie können den aufgezeichneten Bildern eine achtstellige Hexadezimalzahl als User-Bits hinzufügen. Sie können die User-Bits auch
auf die aktuelle Zeit setzen. Zum Einstellen verwenden Sie [TC/Media] > [Users Bit] im Kameramenü.

Anzeigen von Zeitdaten

Legen Sie den anzuzeigenden Zeitcode mithilfe von [TC/Media] > [TC Display] > [Display Select] im Kameramenü fest.
Durch Drücken einer belegbaren Taste, der [DURATION/TC/U-BIT] zugewiesen ist, wechselt die Anzeige nacheinander zwischen
Zeitcode, Anwenderdaten und Dauer.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Prüfen der Aufnahme (Rec Review)

Sie können den zuletzt aufgezeichneten Clip auf dem Bildschirm prüfen (Prüfen der Aufnahme).

Hinweis

„Rec Review“ wird nicht unterstützt, wenn nach der Aufzeichnung des Clips das Videoformat geändert wird.

Startposition für Rec Review festlegen

Sie können mithilfe der Einstellung [Technical] > [Rec Review] im Kameramenü für den Wiedergabestart eine der folgenden Positionen
festlegen.

Letzte drei Sekunden des Clips
Letzte zehn Sekunden des Clips
Start des Clips

Tipp
Falls Sie nach dem Aufnehmen mehrerer Clips einen bestimmten prüfen möchten, drücken Sie die Taste [Thumbnail], um die Miniaturbildanzeige
aufzurufen und wählen Sie dann den wiederzugebenden Clip.

Sie können auch die Taste THUMBNAIL auf der mitgelieferten Infrarot-Fernbedienung drücken, um die Miniaturbildanzeige aufzurufen.

Methode zum Prüfen der Aufnahme

Weisen Sie zunächst im Bereich für die Anpassung der Grundfunktionen einer belegbaren Taste die Funktion „Rec Review“ zu.

Einzelheiten zur Zuweisung siehe „Belegbare Tasten“ unter „Nützliche Funktionen“.

Stoppen Sie die Aufnahme. Drücken Sie dann eine belegbare Taste, der die Funktion „Rec Review“ zugewiesen wurde, um die
Wiedergabe des zuvor aufgezeichneten Clips zu starten.
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Am Ende des Clips schaltet sich die „Rec Review“-Wiedergabe aus, und das Gerät kehrt in den Bereitschaftsmodus (Stby) zurück.

Beenden von „Rec Review“
Drücken Sie eine Taste, der die Funktion „Rec Review“ zugewiesen wurde oder drücken Sie die Taste [Cancel/Back].

Tipp
Sie können auch die Taste [Cancel/Back] auf der mitgelieferten Infrarot-Fernbedienung drücken, um die Funktion „Rec Review“ zu beenden.
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Verwandtes Thema
Belegbare Tasten

5-041-957-64(1) Copyright 2022 Sony Corporation
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Bildschirm zum Anpassen des Bildausschnitts

Der Bildausschnitt wird mithilfe der folgenden Elemente des Live-Betriebsbildschirms angepasst.
Wenn PTZ-Bildausschnitt-Steuerung deaktiviert ist

Wenn PTZ-Bildausschnitt-Steuerung aktiviert ist
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Hinweis

Je nach Ausrichtung der Kamera, Brennweite des Objektivs und Zoomposition sind gegebenenfalls Teile des Geräts oder mit dem
Anschlussblock verbundene Kabel sichtbar. Prüfen Sie vor der Aufnahme das Blickfeld mit dem verwendeten Objektiv und der eingestellten
Brennweite. Sie können den Schwenk-/Neigebereich auch mithilfe von [Pan-Tilt] > [P/T Range Limit] im Webmenü steuern. Wenn das Gerät
eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung ignoriert.
Einzelheiten siehe [Pan-Tilt] > [P/T Range Limit] im Webmenü.

Tipp
Sie können den Bildausschnitt auch mithilfe der mitgelieferten Infrarot-Fernbedienung steuern.

5-041-957-64(1) Copyright 2022 Sony Corporation

Steuerbereich für Voreinstellungspositionen1.

Registerkarte  (Main) / Registerkarte  (Others)2.

Steuerbereich für den Bildausschnitt3.
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Anpassen der Aufnahmerichtung mithilfe der Web-App

Die horizontale Bewegung der Kamera wird als Schwenken und die vertikale als Neigen bezeichnet.
Sie können die Aufnahmerichtung mithilfe von Schwenk-/Neigevorgängen einstellen.

Tipp
Falls unterhalb des Joysticks [Execute Pan-Tilt Reset] angezeigt wird, ist in den Ursprungsdaten des Geräts zur Schwenk-/Neigesteuerung eine
Inkonsistenz aufgetreten. Um die Ursprungsdaten zu aktualisieren, führen Sie die Funktion zum Zurücksetzen der Schwenk-/Neigefunktionen
aus. Einzelheiten siehe „Zurücksetzen der Schwenk-/Neigefunktionen“.

Um die Kamera wieder nach vorn auszurichten:
Drücken Sie die Taste  (Schwenk-/Neigeursprung) auf der Registerkarte  (Others) im Kamerasteuerbereich.

Hinweis

Je nach Ausrichtung der Kamera, Brennweite des Objektivs und Zoomposition sind gegebenenfalls Teile des Geräts oder mit dem
Anschlussblock verbundene Kabel sichtbar. Prüfen Sie vor der Aufnahme das Blickfeld mit dem verwendeten Objektiv und der eingestellten
Brennweite. Sie können den Schwenk-/Neigebereich auch mithilfe von [Pan-Tilt] > [P/T Range Limit] im Webmenü steuern. Wenn das Gerät
eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung ignoriert.
Einzelheiten siehe [Pan-Tilt] > [P/T Range Limit] im Webmenü.

Verwandtes Thema
Zurücksetzen der Schwenk-/Neigefunktionen

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie auf die Registerkarte  (Schwenken/Neigen/Zoom) im Steuerbereich für den Bildausschnitt, um den
Joystick anzuzeigen.

1

Ziehen Sie die Mitte des Joysticks in die gewünschte Betrachtungsrichtung, während Sie den Kamerabildbereich
überwachen.

Richtung und Geschwindigkeit der Kamera ändern sich je nach Richtung und Stärke des Ziehens.
Sie können die Schwenk-/Neigebewegung feiner steuern, indem Sie auf die äußeren Bereiche des Joysticks drücken.

2
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Einstellen der Schwenk-/Neigegeschwindigkeit

Sie können die Schwenk-/Neigegeschwindigkeit mithilfe des Schiebereglers [Pan-Tilt Speed] im Kamerasteuerbereich durch Bedienen
des Joysticks im Steuerbereich für den Bildausschnitt einstellen.

Hinweis
Falls sich im Bewegungsbereich der Kamera eine Wand oder ein anderes Hindernis befindet, achten Sie darauf, beim Schwenken/Neigen nicht
mit der Kamera oder dem Objektiv dagegen zu stoßen.

Die Schwenk-/Neigebeschleunigung hängt von physikalischen Gegebenheiten ab wie etwa der Gewichtsbalance des Objektivs. Sie können
mithilfe von [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] im Webmenü oder Kameramenü die Beschleunigungseinstellung ändern.

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie im Kamerasteuerbereich auf die Registerkarte  (Main).1

Wählen Sie aus der Liste den Schieberegler [Pan-Tilt Speed] aus.

Wenn der Schieberegler [Pan-Tilt Speed] nicht angezeigt wird, wählen Sie eine der beiden Schieberegler-Funktionswahltasten,
um den Schieberegler anzuzeigen.

2

Bewegen Sie den Schieberegler nach links oder rechts.

Bewegen nach links verringert die Geschwindigkeit, Bewegen nach rechts erhöht sie.

3
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Einstellen der Schwenk-/Neigebeschleunigung

Sie können mithilfe von [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] im Webmenü oder Kameramenü die Beschleunigung in neun
Abstufungen ändern. Um schnellere Geschwindigkeitsänderungen zu erzielen, erhöhen Sie den Wert; um sanftere
Geschwindigkeitsabstufungen zu erzielen, verringern Sie diesen.
Um beim Schwenken/Neigen eine größere Reaktivität zu erzielen, wählen Sie einen Wert im Bereich von 7 bis 9.
Um zu Beginn und Ende der Bewegung auf eine Voreinstellungsposition eine höhere Positioniergenauigkeit zu erzielen, wird ein Wert
im Bereich von 1 bis 6 empfohlen.

Einzelheiten zu Voreinstellungspositionen siehe „Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition“.

Hinweis
Wenn ein hoher Wert festgelegt wird, arbeitet die Funktion bei Verwendung eines schweren Objektivs möglicherweise nicht ordnungsgemäß.
Prüfen Sie den Betrieb vor dem tatsächlichen Einsatz.

Beziehung zwischen der Einstellung von [Ramp Curve] und der Schwenk-/Neigebewegung

Bei Schwenk-/Neigebetrieb

Bei Aufruf einer Voreinstellungsposition
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Anpassen der Aufnahmerichtung mithilfe der mitgelieferten Infrarot-Fernbedienung

Sie können die Aufnahmerichtung mithilfe der Schwenk-/Neigebedientasten auf der mitgelieferten Infrarot-Fernbedienung anpassen.

Um die Kamera wieder nach vorn auszurichten:
Drücken Sie die Taste HOME.

Hinweis
Je nach Ausrichtung der Kamera, Brennweite des Objektivs und Zoomposition sind gegebenenfalls Teile des Geräts oder mit dem
Anschlussblock verbundene Kabel sichtbar. Prüfen Sie vor der Aufnahme das Blickfeld mit dem verwendeten Objektiv und der eingestellten
Brennweite. Sie können den Schwenk-/Neigebereich auch mithilfe von [Pan-Tilt] > [P/T Range Limit] im Webmenü steuern. Wenn das Gerät
eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung ignoriert.
Einzelheiten siehe [Pan-Tilt] > [P/T Range Limit] im Webmenü.

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie die Pfeiltasten zum Steuern der Schwenk-/Neigebewegung.

Drücken Sie die Pfeiltaste der gewünschten Betrachtungsrichtung, während Sie das Kamerabild überwachen.
Um eine kurze Bewegung zu vollführen, drücken Sie die Pfeiltaste kurz.
Um eine längere Bewegung zu vollführen, halten Sie die Pfeiltaste gedrückt.
Um diagonale Bewegungen zu vollführen, halten Sie die Taste  (Pfeil aufwärts) oder  (Pfeil abwärts) gedrückt und drücken
Sie die Taste  (Pfeil links) oder  (Pfeil rechts).

1
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Einstellen des Zoomtyps

Legen Sie den Zoomtyp mithilfe von [Technical] > [Zoom] > [Zoom Type] im Kameramenü fest.
Der Zoomtyp variiert abhängig vom Typ des angebrachten Objektivs.

Hinweis
In den folgenden Fällen ist „Clear Image Zoom“ nicht verfügbar.

Wenn [Shooting] > [S&Q Motion] > [Setting] auf On gesetzt und die Einstellung [Frame Rate] im Kameramenü einen Wert von mehr als 60 fps
besitzt
Wenn [Project] > [Rec Format] > [Codec] im Kameramenü auf [RAW] oder eine andere Option eingestellt ist, die RAW umfasst

Die Betätigung des Wahlschalters SERVO/MANUAL an einem Objektiv setzt die Vergrößerung von „Clear Image Zoom“ auf 1× zurück.

AF-S wird während „Clear Image Zoom“ nicht unterstützt.

Clear Image Zoom

Das Gerät ist mit einer Zoomfunktion ausgestattet, bei der eine Bildsignalverarbeitung mit der Bezeichnung „Clear Image Zoom“
eingesetzt wird. Ist „Clear Image Zoom“ aktiviert, wird Zoom auch für Objektive mit Festbrennweite unterstützt. Damit kann außerdem
bei einem Motorzoomobjektiv der Zoombereich über den optischen Bereich hinaus erweitert werden.
Das maximale Zoomverhältnis bei Verwendung von „Clear Image Zoom“ variiert je nach Aufnahmeauflösung.

Bei QFHD/4K-Aufnahmeauflösung: 1,5×
Bei HD-Aufnahmeauflösung: 2×

5-041-957-64(1) Copyright 2022 Sony Corporation

Typ des angebrachten Objektivs
Einstellung [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objektiv mit Festbrennweite/manuelles
Zoomobjektiv

Zoombetrieb wird nicht
unterstützt.

„Clear Image Zoom“ wird unterstützt.

Motorzoomobjektiv
Es wird nur optischer Zoom
unterstützt.

Optischer Zoom und „Clear Image Zoom“
werden unterstützt.
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Zoom mithilfe der Web-App einstellen

Sie können den Zoom des Geräts mithilfe des optischen Zooms oder der Funktion „Clear Image Zoom“ anpassen. In diesem Thema
wird beschrieben, wie Sie Anpassungen mithilfe der Web-App vornehmen. Einzelheiten zu „Clear Image Zoom“ siehe „Einstellen des
Zoomtyps“.

Hinweis
Je nach Ausrichtung der Kamera, Brennweite des Objektivs und Zoomposition sind gegebenenfalls Teile des Geräts oder mit dem
Anschlussblock verbundene Kabel sichtbar. Prüfen Sie vor der Aufnahme das Blickfeld mit dem verwendeten Objektiv und der eingestellten
Brennweite. Sie können den Schwenk-/Neigebereich auch mithilfe von [Pan-Tilt] > [P/T Range Limit] im Webmenü steuern. Wenn das Gerät
eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung ignoriert.
Einzelheiten siehe [Pan-Tilt] > [P/T Range Limit] im Webmenü.

Die tatsächliche Zoomgeschwindigkeit und -genauigkeit variiert abhängig vom Objektiv. Prüfen Sie den Betrieb vor dem Einsatz.

Tipp
Sie können den Zoom eines manuellen Zoomobjektivs mithilfe eines Objektivcontrollers (Option) steuern, der mit diesem Gerät kompatibel ist.
Einzelheiten siehe „Anschließen eines Objektivcontrollers“ und „Zoom mithilfe eines Objektivcontrollers einstellen“.

Verwandtes Thema
Einstellen des Zoomtyps
Anschließen eines Objektivcontrollers

Zoom mithilfe eines Objektivcontrollers einstellen

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie auf die Registerkarte  (Schwenken/Neigen/Zoom) im Steuerbereich für den Bildausschnitt, um den
Schwenk-/Neigesteuerbereich anzuzeigen.

1

Schieben Sie zum Anpassen des Zooms den Schieberegler [Zoom] in Richtung [T] (Tele) oder [W] (Weitwinkel).

Die Zoomgeschwindigkeit variiert mit der Bewegung des Schiebereglers.

2
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Einstellen der Zoomgeschwindigkeit

Sie können die Zoomgeschwindigkeit des Schiebereglers [Zoom] im Steuerbereich für den Bildausschnitt mithilfe des Schiebereglers
[Zoom Speed] im Kamerasteuerbereich ändern.

Hinweis
Die tatsächliche Zoomgeschwindigkeit und -genauigkeit variiert abhängig vom Objektiv. Prüfen Sie den Betrieb vor dem Einsatz.

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie im Kamerasteuerbereich auf die Registerkarte  (Main).1

Wählen Sie aus der Liste den Schieberegler [Zoom Speed] aus.

Wenn der Schieberegler [Zoom Speed] nicht angezeigt wird, wählen Sie eine der beiden Schieberegler-Funktionswahltasten, um
den Schieberegler anzuzeigen.

 

2

Bewegen Sie den Schieberegler [Zoom Speed] nach links oder rechts.

Bewegen nach links verringert die Geschwindigkeit, Bewegen nach rechts erhöht sie.

3
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Einstellen des Zooms mithilfe der mitgelieferten Infrarot-Fernbedienung

Sie können den Zoom des Geräts mithilfe des optischen Zooms oder der Funktion „Clear Image Zoom“ anpassen. In diesem Thema
wird beschrieben, wie Sie Anpassungen mithilfe der mitgelieferten Infrarot-Fernbedienung vornehmen. Einzelheiten zu „Clear Image
Zoom“ siehe „Einstellen des Zoomtyps“.

Hinweis
Je nach Ausrichtung der Kamera, Brennweite des Objektivs und Zoomposition sind gegebenenfalls Teile des Geräts oder mit dem
Anschlussblock verbundene Kabel sichtbar. Prüfen Sie vor der Aufnahme das Blickfeld mit dem verwendeten Objektiv und der eingestellten
Brennweite. Sie können den Schwenk-/Neigebereich auch mithilfe von [Pan-Tilt] > [P/T Range Limit] im Webmenü steuern. Wenn das Gerät
eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung ignoriert.
Einzelheiten siehe [Pan-Tilt] > [P/T Range Limit] im Webmenü.

Tipp
Sie können den Zoom eines manuellen Zoomobjektivs mithilfe eines Objektivcontrollers (Option) steuern, der mit diesem Gerät kompatibel ist.
Einzelheiten siehe „Anschließen eines Objektivcontrollers“ und „Zoom mithilfe eines Objektivcontrollers einstellen“.

Verwandtes Thema
Einstellen des Zoomtyps

Anschließen eines Objektivcontrollers

Zoom mithilfe eines Objektivcontrollers einstellen

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie zum Anpassen des Zooms die Zoom-Taste.

Drücken Sie zum Anpassen des Zooms die Taste T (Tele) oder W (Weitwinkel), während Sie den Bildschirm beobachten.
Um hereinzuzoomen, drücken Sie die Taste T.
Um herauszuzoomen, drücken Sie die Taste W.

1
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Kalibrieren eines Objektivs mit E-Bajonett

Durch eine Kalibrierung werden die durch Unterschiede einzelner Objektive bedingten Differenzen der Zoomposition korrigiert, wenn
ein Motorzoomobjektiv mit E-Bajonett verwendet wird.
Um die Zoomposition genau zu berechnen, kalibrieren Sie Ihr Objektiv zur Korrektur von individuellen Differenzen wie nachfolgend
beschrieben.

Kalibrierungsdaten
Kalibrierungsdaten für bis zu fünf Objektive können im Gerät gespeichert werden. Wenn ein sechstes Objektiv oder weitere
kalibriert werden, so werden die ältesten Daten überschrieben.
Sie können prüfen, ob Kalibrierungsdaten für das angebrachte Objektiv vorliegen, indem Sie die Taste  (Kamerastatus) im
gemeinsamen Bereich des Web-App-Bildschirms drücken und [Lens] > [Calibration Data] auswählen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Falls das Objektiv über einen Wahlschalter SERVO/MANUAL verfügt, stellen Sie diesen auf SERVO.

Hinweis
Wenn sich der Schalter in der Stellung MANUAL befindet, kann das Objektiv keine Zoombefehle vom Gerät empfangen.

1

Führen Sie die Kalibrierung mithilfe von [Technical] > [Lens] > [Lens Calibration] im Kameramenü durch.

Während der Kalibrierung wird das Zoomobjektiv automatisch bewegt und eingemessen.

2

145



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Speichern/Wiederherstellen der Schwenk-/Neige-/Zoomposition und Fokuseinstellung mithilfe
der Web-App

Sie können über die Web-App (Funktion Voreinstellungsposition) die Schwenk-/Neige-/Zoomposition und die Fokuseinstellung
speichern und bei Bedarf wieder aufrufen.

Einzelheiten zu den speicher- und wieder aufrufbaren Elementen siehe „In Voreinstellungspositionen gespeicherte Elemente“.

Hinweis
Falls die Einstellung [Pan-Tilt] > [P/T Direction] > [Ceiling] im Webmenü geändert wird, werden alle gespeicherten Voreinstellungspositionen
gelöscht.

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

1

Bestimmen Sie durch Schwenk-/Neige- und Zoombedienungen die zu speichernde Position.2

Drücken Sie die Taste [+] im Steuerbereich für Voreinstellungspositionen.

Das Bild mit der gespeicherten Position wird im Steuerbereich für Voreinstellungspositionen angezeigt.

Tipp
Falls der Steuerbereich für Voreinstellungspositionen nicht angezeigt wird, drücken Sie die Taste  (Öffnen), um ihn einzublenden.

Positionen werden der Reihe nach beginnen mit [Preset1] gespeichert.

Falls sich innerhalb einer Reihe von Voreinstellungen ungenutzte Speicherplätze befinden, werden Positionen zuerst in diesen gespeichert.
Falls beispielsweise Voreinstellungspositionen in [Preset1] und [Preset3], jedoch nicht in [Preset2] gespeichert sind, werden die nächsten in
[Preset2] und dann in [Preset4] gespeichert.

Sie können bis zu 100 Voreinstellungspositionen speichern.

Sie können jede Voreinstellungsposition umbenennen. Einzelheiten siehe „Umbenennen von Voreinstellungspositionen mithilfe der Web-
App“.

3

Sie können eine gespeicherte Position wieder anfahren.4

146



So brechen Sie den Aufrufvorgang der Voreinstellungsposition ab
Drücken Sie während des Aufrufvorgangs der Voreinstellungsposition die im Steuerbereich für Voreinstellungspositionen angezeigte
Taste  (Aufrufen abbrechen). Verwenden Sie den Joystick und den Schieberegler [Zoom] zum Anpassen des Bildausschnitts.

Verwandtes Thema
In Voreinstellungspositionen gespeicherte Elemente
Umbenennen von Voreinstellungspositionen mithilfe der Web-App

Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition

Einstellen der Schwenk-/Neigebeschleunigung

Drücken Sie im Steuerbereich für Voreinstellungspositionen doppelt auf das Miniaturbild der aufzurufenden Position, um die
entsprechende Position wieder anzufahren.

Tipp

Sie können eine Position auch aufrufen, indem Sie auf das Bild drücken, auf die dann angezeigte Taste  (Voreinstellungspositionen-
Menü) drücken und [Recall] auswählen.

Die Geschwindigkeit des Übergangs zu einer gespeicherten Position wird durch die beim Speichern herrschende Einstellung von [Pan-Tilt]
> [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for Common] im Webmenü bestimmt. Sie können zudem die Übergangsgeschwindigkeit nach
dem Speichern ändern. Einzelheiten siehe „Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer
Voreinstellungsposition“.

Der Grad der Änderung der Schwenk-/Neigeposition beim Anfahren einer Voreinstellungsposition kann mithilfe der Einstellungen für die
Übergangsgeschwindigkeit und [Ramp Curve] angepasst werden. Einzelheiten siehe „Ändern der Übergangsgeschwindigkeit (Schwenken-
Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition“ und „Einstellen der Schwenk-/Neigebeschleunigung“.

Falls eine andere Voreinstellung während der Voreinstellungswiedergabe aufgerufen wird, so wird der Betrieb mit der ersten aufgerufenen
Voreinstellung beendet und mit der danach aufgerufenen gestartet.

Hinweis
Falls sich zwischen dem Speichern einer Voreinstellungsposition und ihrer Wiedergabe die Umgebungstemperatur wesentlich ändert,
können Abweichungen beim Bildausschnitt auftreten.

Während eine Voreinstellungsposition aufgerufen wird, können Sie keine anderen Vorgänge als Aufrufen oder Verwerfen der
Voreinstellungsposition durchführen.

Bei Aufruf einer Voreinstellungsposition eines Clear Image Zoom-Bereichs arbeitet der Zoom nicht ruckfrei (Voreinstellungsposition wird
sofort angefahren).
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Umbenennen von Voreinstellungspositionen mithilfe der Web-App

Sie können gespeicherte Voreinstellungspositionen umbenennen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

1

Drücken Sie auf die umzubenennende Voreinstellungsposition.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

2

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Rename].3

Geben Sie einen neuen Namen für die Voreinstellung ein.4
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Ersetzen einer gespeicherten Voreinstellungsposition durch eine neue mithilfe der Web-App

Sie können eine gespeicherte Voreinstellungsposition durch eine neue ersetzen.
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Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

1

Bestimmen Sie durch Schwenk-/Neige- und Zoombedienungen die zu speichernde Position.2

Drücken Sie im Steuerbereich für Voreinstellungspositionen auf das Bild der zu ersetzenden Position.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

3

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Replace].

Die neue Position ersetzt die aktuelle Einstellung.

4
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Löschen einer gespeicherten Voreinstellungsposition mithilfe der Web-App

Sie können gespeicherte Voreinstellungspositionen löschen.
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Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

1

Drücken Sie im Steuerbereich für Voreinstellungspositionen auf das Bild der zu löschenden Position.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

2

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Delete].

Die gespeicherte Position wird gelöscht.

3
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Synchronisieren von Schwenk-/Neigevorgang und Zoom-/Fokusvorgang beim Aufrufen einer
Voreinstellungsposition

Um beim Aufrufen einer Voreinstellungsposition den Bildausschnitt besser beizubehalten, können Sie den Schwenk-/Neigevorgang
und den Zoomvorgang synchronisieren.

Tipp
Sie können zunächst Einstellungen angeben, die zum Speichern einer Voreinstellungsposition verwendet werden. Setzen Sie im Webmenü die
Einstellung [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom Sync] auf [On].

Wenn [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Common] gesetzt ist, werden alle Voreinstellungspositionen mit der unter [Pan-
Tilt] > [P/T Preset] > [Pan-Tilt Speed for Common] eingestellten Geschwindigkeit aufgerufen.

Nachdem die Zoombewegung abgeschlossen ist, bewegt sich die Kamera auf die gespeicherte Fokusposition.

Nachdem die Bewegung abgeschlossen ist, wechselt [AF Transition Speed] wieder zur ursprünglichen Einstellung.

Hinweis

Je nach Geschwindigkeitsbereich des Objektivzooms wird der Zoomvorgang möglicherweise beendet, bevor der Schwenk-/Neigevorgang endet
oder aber der Zoomvorgang dauert darüber hinaus an. Prüfen Sie den Betrieb vorher.

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

1

Drücken Sie auf das Bild der Voreinstellungsposition, deren Übergangsgeschwindigkeit Sie ändern möchten.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

2

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Edit…].

Der Einrichtungsbildschirm für die ausgewählte Voreinstellungsposition wird angezeigt.

3

Schieben Sie den Schalter [Zoom Sync] nach rechts, um die Funktion einzuschalten und drücken Sie die Taste [OK].

Beim nächsten Aufrufen einer Position bewegt sich die Kamera mit der konfigurierten Geschwindigkeit.

4
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Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer
Voreinstellungsposition

Sie können die Übergangsgeschwindigkeit (bei Schwenken-Neigen/Zoom/Fokus) ändern, wenn Sie eine gespeicherte
Voreinstellungsposition aufrufen.

Tipp
Wenn [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Common] gesetzt ist, werden alle Positionen mit der unter [Pan-Tilt] > [P/T
Preset] > [Pan-Tilt Speed for Common] eingestellten Geschwindigkeit aufgerufen.

Nachdem die Zoombewegung abgeschlossen ist, bewegt sich die Kamera auf die gespeicherte Fokusposition.

Nachdem die Bewegung abgeschlossen ist, wechselt [AF Transition Speed] wieder zur ursprünglichen Einstellung.

Bei Aufruf einer Voreinstellungsposition eines Clear Image Zoom-Bereichs arbeitet der Zoom nicht ruckfrei (Voreinstellungsposition wird sofort
angefahren).

Setzen Sie im Webmenü die Einstellung [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Separate].1

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

2

Drücken Sie auf das Bild der Voreinstellungsposition, deren Übergangsgeschwindigkeit Sie ändern möchten.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

3

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Edit…].

Der Einrichtungsbildschirm für die ausgewählte Voreinstellungsposition wird angezeigt.

4

Wählen Sie [Pan-Tilt Speed Unit] > [Speed Table] und legen Sie die zu ändernden Übergangsgeschwindigkeiten
(Schwenken-Neigen/Zoom/Fokus) mithilfe der Schieberegler fest oder geben Sie Werte direkt ein und drücken dann die
Taste [OK].

Beim nächsten Aufrufen einer Position bewegt sich die Kamera mit der konfigurierten Geschwindigkeit.

5
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Ändern der Übergangsdauer (Schwenken-Neigen/Zoom) beim Aufrufen einer
Voreinstellungsposition

Sie können die Übergangsdauer (bei Schwenken-Neigen/Zoom) ändern, wenn Sie eine gespeicherte Voreinstellungsposition aufrufen.

Tipp
Wenn [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Common] gesetzt ist, werden alle Positionen mit der unter [Pan-Tilt] > [P/T
Preset] > [Pan-Tilt Speed for Common] eingestellten Geschwindigkeit aufgerufen.

Nachdem die Zoombewegung abgeschlossen ist, bewegt sich die Kamera auf die gespeicherte Fokusposition.

Nachdem die Bewegung abgeschlossen ist, wechselt [AF Transition Speed] wieder zur ursprünglichen Einstellung.

Falls [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom Sync] im Webmenü auf [On] gesetzt ist, arbeitet der Zoom ebenfalls mit der angegebenen
Dauer.

Wenn [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Common] gesetzt ist, wird die hier konfigurierte Übergangsdauer angewendet.

Sie können die Übergangsdauer in Schritten von 0,5 Sekunden einstellen.

Setzen Sie im Webmenü die Einstellung [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed Setting Way] auf [Separate].1

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Pos.] ein.

2

Drücken Sie auf das Bild der Voreinstellungsposition, deren Übergangsdauer Sie ändern möchten.

Oben rechts im Bild wird die Taste  (Voreinstellungspositionen-Menü) angezeigt.

3

Drücken Sie die Taste  (Voreinstellungspositionen-Menü) und wählen Sie im angezeigten Menü den Befehl [Edit…].

Der Einrichtungsbildschirm für die ausgewählte Voreinstellungsposition wird angezeigt.

4

Wählen Sie [Pan-Tilt Speed Unit] > [Time] und legen Sie die zu ändernden Übergangsdauern (Schwenken-Neigen/Zoom)
mithilfe der Schieberegler fest oder geben Sie Werte direkt ein und drücken dann die Taste [OK].

Beim nächsten Aufrufen einer Position bewegt sich die Kamera mit der konfigurierten Dauer.

5
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Bei Aufruf einer Voreinstellungsposition eines Clear Image Zoom-Bereichs arbeitet der Zoom nicht ruckfrei (Voreinstellungsposition wird sofort
angefahren).

Hinweis
Je nach Typ des Objektivs und Umgebungstemperatur können die maximale Beschleunigung und Genauigkeit abweichen und die Kamera
arbeitet ggf. nicht wie spezifiziert.

Je nach der Schwenk-/Neigedistanz kann sich ein Fehler in der spezifizierten Dauer ergeben.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Speichern/Wiederherstellen von Schwenk-/Neige- und Zoomposition mithilfe der mitgelieferten
Infrarot-Fernbedienung

Sie können über die mitgelieferte Infrarot-Fernbedienung die Schwenk-/Neige- und Zoomposition speichern und bei Bedarf wieder
anfahren.

Verwandtes Thema
Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition

5-041-957-64(1) Copyright 2022 Sony Corporation

Stellen Sie die Schwenk-/Neigeposition und den Zoom der Kamera ein.1

Stellen Sie in der Web-App den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für
Voreinstellungspositionen auf [Pos.] ein.

2

Halten Sie die Taste PRESET gedrückt und drücken Sie eine der Tasten 1 bis 3.

Die Ausrichtung der Kamera und die Zoomposition werden als Voreinstellungsposition gespeichert.

3

Sie können eine gespeicherte Voreinstellungsposition wieder anfahren.

Drücken Sie eine der Tasten 1 bis 3, um diese Voreinstellungsposition aufzurufen.

Tipp
Die Übergangsgeschwindigkeit beim Aufrufen einer Voreinstellungsposition wird von dem gespeicherten Wert [Pan-Tilt] > [P/T Preset] >
[Pan-Tilt Speed] im Webmenü bestimmt. Sie können die Übergangsgeschwindigkeit nach dem Speichern eines Werts ändern. Einzelheiten
siehe „Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition“.

4
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Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der Web-App

Sie können Bildausschnittvorgänge der Kamera mithilfe der Web-App aufzeichnen.

Stellen Sie die Kamera auf die Startposition des Vorgangs ein.1

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Trace] ein.

2

Drücken Sie die Taste [+] im Steuerbereich für Voreinstellungspositionen.

Ein Miniaturbild wird hinzugefügt und die Kamera wechselt in die Aufnahmebereitschaft.

Tipp
Um die Aufnahmebereitschaft zu verlassen und zum Normalbetrieb zu wechseln, können Sie die Taste  (Schließen) drücken.

3

Beginnen Sie den Bildausschnittvorgang mithilfe des Joysticks und des Schiebereglers [Zoom].4
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Tipp
Während der Aufzeichnung wird oben im Kamerabildbereich die verbleibende Aufzeichnungsdauer angezeigt.

Hinweis
Wenn Sie zur Deckenmontage wechseln, werden die aufgezeichneten Bildausschnittvorgänge gelöscht.

Bei Wechsel der Systemfrequenz werden aufgezeichnete Bildausschnittvorgänge ggf. gelöscht.

Wenn ein Objektivcontroller angeschlossen ist, wird die Zoombedienung nicht aufgezeichnet.

Die Höchstdauer für die Aufzeichnung eines einzelnen Bildausschnittvorgangs beträgt 3 Minuten. Die Aufzeichnung stoppt automatisch, sobald
die Aufzeichnungsdauer 3 Minuten erreicht.

Falls die Kamera während der Aufzeichnung eines Bildausschnittvorgangs von einem anderen Gerät aus bedient wird, so wird diese Bedienung
ebenfalls aufgezeichnet. Einzelheiten zu Aufnahmevorgängen mithilfe einer Fernbedienung eines Drittanbieters erhalten Sie vom
entsprechenden Hersteller.

Fokus- und Bildqualitätseinstellungen werden nicht mithilfe dieser Funktion aufgezeichnet.

Die beim Aufzeichnen eines Bildausschnittvorgangs erfassten Schwenk-/Neige-/Zoomvorgänge können während der Wiedergabe des Vorgangs
nicht exakt reproduziert werden.

Falls Sie nach Aufzeichnen eines Bildausschnittvorgangs die Begrenzungen des Schwenk-/Neigebewegungsbereichs mithilfe von [Pan-Tilt] >
[P/T Range Limit] im Webmenü festlegen, werden die Begrenzungen nicht während der Wiedergabe des Vorgangs angewendet. Wenn Sie einen
Bildausschnittvorgang und die Funktion zur Begrenzung des Schwenk-/Neigebewegungsbereichs zusammen einsetzen möchten, legen Sie die
Begrenzungen vor dem Vorgang fest.

Aufnahme/Wiedergabe von Bildausschnittvorgängen ist in den folgenden Fällen nicht verfügbar.
Wenn RAW-Videoausgabe ausgewählt ist
Wenn das Videosignal nicht am SDI-Ausgangsanschluss ausgegeben wird
Wenn PTZ-Bildausschnitt-Steuerung aktiviert ist

5-041-957-64(1) Copyright 2022 Sony Corporation

Die Aufzeichnung startet von dem Moment an, in dem der Bildausschnittvorgang beginnt.

Um die Aufzeichnung zu stoppen, drücken Sie die auf dem Miniaturbild angezeigte Taste  (Aufzeichnung stoppen).5
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Wiedergeben von Bildausschnittvorgängen der Kamera mithilfe der Web-App

Sie können einen aufgezeichneten Bildausschnittvorgang der Kamera mithilfe der Web-App wiedergeben.

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Trace] ein.

1

Wählen Sie das Miniaturbild des wiederzugebenden Bildausschnittvorgangs.

Auf dem Miniaturbild wird die Taste  (Vorbereiten) angezeigt.

2

Drücken Sie die Taste  (Vorbereiten).

Die Kamera bewegt sich an die Startposition des Bildausschnittvorgangs und wechselt in die Wiedergabebereitschaft.

3

Drücken Sie die Taste  (Wiedergabe) auf dem Miniaturbild.

Die Wiedergabe des Bildausschnittvorgangs beginnt.

4
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Tipp
Während der Wiedergabebereitschaft und Wiedergabe können Sie durch die folgenden Handlungen die Wiedergabe abbrechen und zum
Normalbetrieb zurückkehren.

Drücken der Taste  (Stopp) auf dem Miniaturbild oder im Steuerbereich für Voreinstellungspositionen.
Bedienen des Joysticks.
Bedienen des Schiebereglers [Zoom].

Während der Aufzeichnung wird oben im Kamerabildbereich die verstrichene Wiedergabedauer angezeigt.

Hinweis

Falls sich die Einstellung für „Clear Image Zoom“ zwischen Aufzeichnung und Wiedergabe von Bildausschnittvorgängen unterscheidet, kann
unerwartetes Verhalten auftreten.

Wenn ein Objektivcontroller angeschlossen ist, wird die Wiedergabe der Zoombedienung nicht unterstützt. Wenn Sie den Zoom bedienen, wird
die Wiedergabe von Bildausschnittvorgängen gestoppt.

Während der Wiedergabe von Bildausschnittvorgängen hat das Ändern der Begrenzungen des Schwenk-/Neigebewegungsbereichs mithilfe von
[Pan-Tilt] > [P/T Range Limit] im Webmenü keine Auswirkungen. Legen Sie die Begrenzungen des Schwenk-/Neigebewegungsbereichs fest,
bevor Sie einen Bildausschnittvorgang aufzeichnen.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Löschen von mit der Kamera aufgezeichneten Bildausschnittvorgängen mithilfe der Web-App

Sie können mit der Kamera aufgezeichnete Bildausschnittvorgänge mithilfe der Web-App löschen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Trace] ein.

1

Wählen Sie das Miniaturbild des zu löschenden Bildausschnittvorgangs.

Auf dem Miniaturbild wird die Taste  (Verfolgungsmenü) angezeigt.

2

Drücken Sie die Taste  (Verfolgungsmenü).

Das Menü wird angezeigt.

3

Wählen Sie [Delete] aus dem eingeblendeten Menü aus.

Der ausgewählte Bildausschnittvorgang wird gelöscht.

4
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Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-
Fernbedienung

Sie können Bildausschnittvorgänge der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung aufzeichnen.

Einzelheiten zur Wiedergabe eines aufgezeichneten Bildausschnittvorgangs siehe „Wiedergeben von Bildausschnittvorgängen der
Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung“.

Hinweis
Die Höchstdauer für die Aufzeichnung eines einzelnen Bildausschnittvorgangs beträgt 3 Minuten. Die Aufzeichnung stoppt automatisch, sobald
die Aufzeichnungsdauer 3 Minuten erreicht.

Falls die Kamera während der Aufzeichnung eines Bildausschnittvorgangs von einem anderen Gerät aus bedient wird, so wird diese Bedienung
ebenfalls als Teil des Bildausschnittvorgangs aufgezeichnet.

Falls während der Aufzeichnung eines Bildausschnittvorgangs die Bildqualität angepasst wird, so wird diese Änderung nicht aufgezeichnet.

Verwandtes Thema
Wiedergeben von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung

5-041-957-64(1) Copyright 2022 Sony Corporation

Rufen Sie den Live-Betriebsbildschirm der Web-App auf.1

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Trace] ein.

2

Stellen Sie die Kamera mithilfe der Infrarot-Fernbedienung auf die Startposition des Vorgangs ein.3

Halten Sie die Taste PRESET gedrückt und drücken Sie eine der Tasten POSITION1 bis 3.

Die Kamera wechselt in die Aufnahmebereitschaft.

4

Führen Sie den aufzuzeichnenden Bildausschnittvorgang durch.5

Um die Aufzeichnung zu beenden, halten Sie die Taste PRESET gedrückt und drücken Sie die in Schritt 4 gewählte Taste
POSITION.

6
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Wiedergeben von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-
Fernbedienung

Sie können aufgezeichnete Bildausschnittvorgänge der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung wiedergeben.

Hinweis
Durch Bedienung der Schwenk-/Neige/-Zoombewegung der Kamera wird die Wiedergabe gestoppt.

Verwandtes Thema
Aufzeichnen von Bildausschnittvorgängen der Kamera mithilfe der mitgelieferten Infrarot-Fernbedienung

5-041-957-64(1) Copyright 2022 Sony Corporation

Rufen Sie den Live-Betriebsbildschirm der Web-App auf.1

Stellen Sie den PTZ-Unterstützungsmodus in der Dropdown-Liste oben im Steuerbereich für Voreinstellungspositionen
auf [Trace] ein.

2

Wählen Sie eine der Tasten POSITION1 bis 3 aus, für die ein Bildausschnittvorgang aufgezeichnet wurde, und drücken
Sie diese.

Die Kamera nimmt durch Schwenk-/Neige/-Zoombewegung die Startposition der Wiedergabe ein.

3

Nachdem sich die Kamera zur Startposition der Wiedergabe bewegt hat, drücken Sie die gleiche Taste POSITION erneut.

Die Wiedergabe beginnt.

4
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Informationen zur PTZ-Bildausschnitt-Steuerung

Das Gerät verfügt über eine Funktion zur PTZ-Bildausschnitt-Steuerung. Mit dieser werden Personen erkannt und die Ausrichtung der
Kamera sowie die Zoomposition automatisch angepasst.
Die PTZ-Bildausschnitt-Steuerung besitzt zwei Modi: „Manueller Verfolgungsstart“, bei dem Sie die Verfolgung einer Person manuell
starten können, sowie „Automatischer Verfolgungsstart“, bei dem die Verfolgung einer Person automatisch beginnt, wenn sie in einen
zuvor manuell konfigurierten Bereich eintritt.
Legen Sie vor der Verwendung dieser Funktion den zu verwendenden Modus wie unter „Konfigurieren der Anfangseinstellungen für
PTZ-Bildausschnitt-Steuerung“ beschrieben fest.

Einzelheiten zum Betrieb der PTZ-Bildausschnitt-Steuerung bei manuellem Verfolgungsstart siehe „Motive für automatische
Verfolgung angeben (manueller Verfolgungsstart)“.
Einzelheiten zum Betrieb der PTZ-Bildausschnitt-Steuerung bei automatischem Verfolgungsstart siehe „Motive an bestimmter
Position auswählen und automatisch verfolgen (automatischer Verfolgungsstart)“.

Die PTZ-Bildausschnitt-Steuerung kann die folgenden sechs Zustände annehmen.

Sie können in den Zuständen [Detecting], [Tracking] und [Target Lost] ein Verfolgungsziel auswählen, indem Sie im Kamerabildbereich
auf eine Person tippen.
Sie können den Status der PTZ-Bildausschnitt-Steuerung mithilfe der Tally-Anzeige des Geräts überwachen. Einzelheiten siehe
„Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen“.

Hinweis
Konfigurieren Sie bei Verwendung der Bildausschnitt-Steuerung die folgenden Einstellungen in der Web-App.

[Pan-Tilt] > [P/T Speed] > [Speed Step]: [Extended]
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]: 7 bis 9

Während der PTZ-Bildausschnitt-Steuerung werden minimale Informationen auf dem Kamerabild angezeigt.

Während des Autofokus ist die verfolgte Person das Fokusziel. Um anstelle der verfolgten Person auf ein anderes Motiv zu fokussieren, stellen
Sie auf manuellen Fokus um.

Auf den Autofokus bezogene Einstellungen können während der PTZ-Bildausschnitt-Steuerung nicht geändert werden.

Gegebenenfalls funktioniert die automatische Verfolgung nicht ordnungsgemäß, wenn Kamerafokus oder Belichtung nicht korrekt eingestellt sind
oder aufgrund von Faktoren wie der Aufnahmeumgebung (z. B. Helligkeit), Aufnahmewinkel (extrem großer oder kleiner Winkel) oder Dichte,
Größe, Kleidung, Bewegung oder Verdeckung von Personen.

Wenn die folgenden Bedingungen nicht erfüllt sind, wird möglicherweise nicht die volle Effizienz der Gesichtserkennungsfunktion erreicht.
Zur Vorderseite weisend

Anzeige des Live-
Betriebsbildschirms Status

(keine Anzeige) PTZ-Bildausschnitt-Steuerung ist deaktiviert.

[Preparing] Vorbereitung für PTZ-Bildausschnitt-Steuerung.

[Return to Start Position] Bewegung auf konfigurierte Startposition (nur Modus „Automatischer Verfolgungsstart“).

[Detecting] Verfolgungsziel wird erkannt (nur Modus „Automatischer Verfolgungsstart“).

[Select Target]
Warten auf Auswahl des Verfolgungsziels. Tippen Sie im Kamerabildbereich auf eine zu
verfolgende Person.

[Tracking] Das Ziel wird verfolgt.

[Tracking Paused]
Die Verfolgung wird pausiert. Drücken Sie die Taste [Resume] oder tippen Sie im
Kamerabildbereich auf eine Person, deren Verfolgung fortgesetzt werden soll.

[Target Lost] Die Verfolgung des ausgewählten Ziels ist verloren gegangen.
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Normaler Gesichtsausdruck (geschlossene Augen, keine extremen Gesichtsausdrücke wie bei Ärger oder weinend)
Keine übermäßige Verdeckung des Gesichts (Sonnenbrille, Maske usw.)

Die tatsächliche Zoomgeschwindigkeit und -genauigkeit variiert abhängig vom Objektiv. Prüfen Sie den Betrieb vor dem Einsatz.

Falls das Objektiv gewechselt wurde oder die Einstellungen für [Zoom Type], [Imager Scan Mode], [S&Q Motion], [P/T Range Limit] oder [P/T
Direction] > [Ceiling] geändert wurden, ändern Sie die Einstellungen auf den Bildschirmen [Start Position] und [Detection Settings] des
Bildschirms zur Einrichtung von PTZ AFR. Einzelheiten siehe „Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung“.

Wenn Sie die Stromversorgung über PoE++ verwenden, können Aufnahme und PTZ-Bildausschnitt-Steuerung nicht gleichzeitig verwendet
werden.

PTZ-Bildausschnitt-Steuerung kann nicht ausgeführt werden während der Miniaturbildanzeige, der Wiedergabe, während Rec Review,
Farbbalkenanzeige, Objektivkalibrierung und wenn HDMI-Ausgabe nicht möglich ist.

Unmittelbar nach Ein-/Ausschalten der PTZ-Bildausschnitt-Steuerung folgen einige Sekunden, in denen keine Bedienung angenommen wird.

PTZ-Bildausschnitt-Steuerung kann nicht verwendet werden, wenn die HDMI-Ausgabe größer als 1920×1080 ist. Außerdem kann es nach dem
Ändern der Videoausgabeeinstellungen eine zehn Sekunden dauern, bis die PTZ-Bildausschnitt-Steuerung beginnt. Berücksichtigen Sie daher
vor dem Einsatz eine gewisse Zeitdauer.

PTZ-Bildausschnitt-Steuerung kann nicht verwendet werden, wenn im Webmenü sowohl [Stream] > [Stream] > [Stream Setting] > [Setting] auf
[RTSP] als auch [Stream] [Video Stream] > [Codec 2] auf eine andere Einstellung als [Off] gesetzt wurden.

PTZ-Bildausschnitt-Steuerung kann nicht verwendet werden, wenn im Webmenü sowohl [Stream] > [Stream] > [Stream Setting] > [Setting] auf
[NDI|HX] als auch [Stream] > [Video Stream] > [Frame Rate 2] auf eine höhere Einstellung als 10fps gesetzt wurden.

Verwandtes Thema
Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)

Motive an bestimmter Position auswählen und automatisch verfolgen (automatischer Verfolgungsstart)
Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen

5-041-957-64(1) Copyright 2022 Sony Corporation
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Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

In diesem Thema wird beschrieben, wie die Anfangseinstellungen der PTZ-Bildausschnitt-Steuerung konfiguriert werden.

Drücken Sie auf die Registerkarte [PTZ AFR Settings].

Der Bildschirm [Initial Setup] des Bildschirms zur Einrichtung von PTZ AFR wird angezeigt.

1

Prüfen Sie die Beschreibung auf dem Bildschirm und drücken Sie die Taste [Start].

Tipp
Die Taste [Start] wird nur bei der Erstkonfiguration der Einstellungen angezeigt.

Die Konfiguration der Einstellungen der PTZ-Bildausschnitt-Steuerung beginnt.

2

Passen Sie die Komposition für die PTZ-Bildausschnitt-Steuerung auf dem Bildschirm [Framing] an.3
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A: Schieberegler für die Körpergröße
B: Bereich zur Anpassung der Komposition
C: Kompositionsrahmen
Passen Sie die Größe und Position der Person innerhalb des Bilds an.
[Lead Room Effect]: Legt die Stärke des Effekts fest, der weiße Fläche in der Komposition entsprechend der Gesichtsorientierung
erzeugt.

Tipp
Indem Sie auf ein Symbol links vom Schieberegler für die Körpergröße doppelklicken, wird der Kompositionsrahmen auf die Größe
(Zoomverhältnis) und Position der Person für dieses Symbol gebracht.

Hinweis
Wenn der weiße Kompositionsrahmen den grauen Bereich überlappt, können Personen leicht verloren gehen, die sich in die andere
Richtung bewegen.

Wenn Sie Ihre Aufnahme so zusammenstellen, dass die Person groß erscheint, gehen Personen ggf. leicht verloren, wenn sie sich schnell
bewegen. Gestalten Sie in diesem Fall die Person kleiner und positionieren Sie diese so, dass genügend Bewegungsraum um sie
vorhanden ist.

Drücken Sie zum Abschluss der Konfiguration die Taste [Next].

Der nächste Einrichtungsbildschirm wird angezeigt.

4

Legen Sie auf dem Bildschirm [Tracking Operation] den Verfolgungsmodus fest.5
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Legt den Verfolgungsstart fest.

[Auto]: In diesem Modus beginnt die Verfolgung automatisch, wenn eine Person in den angegebenen Erkennungsbereich in
dem für die Startposition konfigurierten Sichtfeld eintritt (automatischer Verfolgungsstart). Wenn diese Einstellung ausgewählt
wird, ist es erforderlich, Konfigurationseinstellungen auf dem Bildschirm [Start Position] und [Detection Settings]
vorzunehmen.
[Manual]: In diesem Modus beginnt die Verfolgung erst, wenn Sie die zu verfolgende Person manuell angeben (manueller
Verfolgungsstart).

Drücken Sie zum Abschluss der Konfiguration die Taste [Next].

Der nächste Einrichtungsbildschirm wird angezeigt.

Wenn Sie [Auto] ausgewählt haben, fahren Sie mit Schritt 7 fort.
Wenn Sie [Manual] ausgewählt haben, fahren Sie mit Schritt 11 fort.

6

Legen Sie auf dem Bildschirm [Start Position] die Startposition für die automatische Verfolgung fest.

Konfigurieren Sie die Startposition, die verwendet wird, wenn die PTZ-Bildausschnitt-Steuerung mit automatischem
Verfolgungsstart arbeitet. Für den manuellen Verfolgungsstart ist diese Einstellung nicht erforderlich.
Sobald Sie auf dem Live-Betriebsbildschirm die Taste  (Neu starten) drücken oder die Verfolgung der Person verloren geht,
kehrt die Kamera zur Startposition zurück.

7
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A: Kamerabildbereich
B: Steuerbereich für den Bildausschnitt
Legen Sie die Startposition fest.

Verwenden Sie beim Festlegen der Startposition den Steuerbereich für den Bildausschnitt, um das Kamerabild zu schwenken,
neigen und zoomen. Beobachten Sie dabei das Bild im Kamerabildbereich. Sie können die Übergangsgeschwindigkeit beim
Schwenken/Neigen und Zoomen mithilfe der Schieberegler anpassen.
Standardmäßig ist die Schaltfläche [Move to the set start position] deaktiviert. Nach Abschluss der Anfangskonfiguration wird
sie aktiviert. Drücken Sie darauf, um zur aktuell konfigurierten Startposition zu gelangen.
Drücken Sie die Taste [Pan-Tilt Reset] zum Zurücksetzen der Schwenk-/Neigebewegung. Drücken Sie die Taste, wenn die
Anzeigen POWER und NETWORK gleichzeitig vorn am Gerät blinken oder wenn im Steuerbereich für den Bildausschnitt
[Execute Pan-Tilt Reset] angezeigt wird.

Hinweis

In den folgenden Fällen ist eine erneute Konfiguration erforderlich.
Wenn das Objektiv gewechselt wird oder die Einstellung [Imager Scan Mode] geändert wird
Wenn [Rec Format] > [Video Format] während des Clear Image Zoom-Betriebs von 1920×1080 auf 3840×2160 geändert wird
Wenn die Einstellung unter [Zoom Type] geändert wird
Wenn die Einstellung [S&Q Motion] > [Frame Rate] auf einen Wert oberhalb von 60fps gesetzt wird
Wenn [P/T Range Limit] geändert wird
Wenn [P/T Direction] > [Direction] > [Ceiling] geändert wird

Drücken Sie zum Abschluss der Konfiguration die Taste [Next].

Der nächste Einrichtungsbildschirm wird angezeigt.

8

Legen Sie auf dem Bildschirm [Detection Settings] die detaillierten Einstellungen für automatischen Verfolgungsstart
fest.

Für den manuellen Verfolgungsstart ist diese Einstellung nicht erforderlich.

9
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A: Einrichtungsbereich für Erkennungsbereich
Legt den Bereich zur Erkennung der zu verfolgenden Zielperson fest.

Legen Sie den Verfolgungsbereich fest, indem Sie die Kreise an den vier Ecken des orangefarbenen Rahmens ziehen,
während Sie das Kamerabild beobachten. Eine Person, die in den Bereich eintritt, wird zum Ziel für die automatische
Verfolgung.
Standardmäßig ist die Schaltfläche [Move to the set start position] deaktiviert. Nach Abschluss der Anfangskonfiguration wird
sie aktiviert. Drücken Sie darauf, um zur aktuell konfigurierten Startposition zu gelangen.
[Tracking Timeout]: Legen Sie die Dauer fest, nach der zur Startposition zurückgekehrt werden soll, wenn die Erkennung des
Gesichts vom Verfolgungsziel verloren gegangen ist. Legen Sie 0 Sekunden fest, um die Zeitablauffunktion zu deaktivieren
(Standardwert: 0 Sekunden). Dadurch wird die Zeit festgelegt, bis die Kamera die Verfolgung einer Person mit nicht
sichtbarem Gesicht, wie z. B. ein Zuschauer, der von Ihnen weg weist und versehentlich vom Verfolgungsziel werden könnte,
automatisch stoppt und zur Startposition zurückkehrt.
[Detection Restart Time]: Stellen Sie die Zeitspanne zwischen Beginn der automatischen Verfolgung und ihrem automatischen
Neustart ein. Legen Sie 0 Sekunden fest, um die Funktion zum automatischen Neustart zu deaktivieren (Standardwert: 0
Sekunden). Wenn Sie das Verfolgungsziel während der Aufnahme in regelmäßigen Intervallen wechseln möchten, anstatt nur
eine bestimmte Person zu verfolgen, können Sie eine Zeitdauer festlegen, nach der die Verfolgung automatisch gestoppt und
neu begonnen wird.

Hinweis
Wenn die Einstellung der Startposition geändert wird, ist eine erneute Konfiguration erforderlich.

Drücken Sie zum Abschluss der Konfiguration die Taste [Next].

Der nächste Einrichtungsbildschirm wird angezeigt.

10

Konfigurieren Sie die Einstellungen auf dem Bildschirm [Others].11
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Konfigurieren Sie die folgenden Einstellungen je nach Bedarf.

[Personal Identification]: Zum Normalbetrieb einschalten. Schalten Sie diese Einstellung aus, wenn die Kamera eine Person
automatisch immer verfolgen soll, ohne sie zu identifizieren.
[Wait Time]: Legen Sie die Wartezeit nach dem Verlust des Verfolgungsziels fest, bis das Schwenken/Neigen/Zoomen
eingestellt wird.
[PTZ AFR On when Power On]: Einschalten, um beim Einschalten des Geräts mit aktivierter PTZ-Bildausschnitt-Steuerung zu
starten.
[Detected Indicator]: Einschalten, um einen Rahmen um das Gesicht einer erkannten Person als Ziel oder Kandidat für
automatische Verfolgung anzuzeigen. Es wird auch der Erkennungsbereich für die Startposition angezeigt.

Drücken Sie zum Abschluss der Konfiguration die Taste [Done].

Der folgende Abschlussbildschirm wird angezeigt.

12
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Sobald Sie die Ersteinrichtung abgeschlossen haben, können Sie unter den Elementen links auf dem Einstellungsbildschirm PTZ AFR
jede Seite einzeln aufrufen. Wenn Sie Einstellungen geändert haben, drücken Sie auf der jeweiligen Seite auf [OK], um die
Einstellungen zu übernehmen.

Verwandtes Thema
Struktur des Einstellungsbildschirms PTZ AFR

5-041-957-64(1) Copyright 2022 Sony Corporation

Die Konfiguration der Anfangseinstellungen für die PTZ-Bildausschnitt-Steuerung ist damit abgeschlossen.
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Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)

In diesem Modus geben Sie zum Starten der Verfolgung manuell die zu verfolgende Person an.

Achten Sie darauf, dass auf dem Bildschirm zur Einrichtung von PTZ AFR der Verfolgungsmodus für Personen auf
manuellen Verfolgungsstart eingestellt ist.

Einzelheiten zur Art des Verfolgungsstarts siehe „Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung“.
Falls die Anfangseinstellungen nicht konfiguriert wurden, arbeitet das Gerät mit manuellem Verfolgungsstart.

1

Erfassen Sie mithilfe der Kamera die zu verfolgende Person in der Web-App im Steuerbereich für den Bildausschnitt.

Tipp

Sie können auch eine Voreinstellungsposition aufrufen und diese Bildausschnitt-Steuerung dazu verwenden, eine Person zu erfassen.

2

Schalten Sie auf dem Live-Betriebsbildschirm den Schalter [PTZ AFR] ein.

Der Bereich um die Taste [Pause] blinkt blau.

3

Tippen Sie im Kamerabildbereich auf eine zu verfolgende Person.

Der Bereich um die Taste [Pause] leuchtet blau.
Während der automatischen Verfolgung ist die Taste [Pause] aktiviert.
Sie können während der Bildausschnitt-Steuerung die zu verfolgende Person jederzeit ändern. Tippen Sie auf die zu verfolgende
Person, um das Verfolgungsziel auf diese Person wechseln zu lassen.

4

Drücken Sie die Taste [Pause], um das Schwenken/Neigen/Zoomen aufgrund der automatischen Verfolgung bei Bedarf
anzuhalten.

Der Bereich um die Taste [Pause] blinkt blau.

Wenn Sie während der Bildausschnitt-Steuerung auf die Taste [Pause] drücken, wird das Schwenken/Neigen/Zoomen
aufgrund der automatischen Verfolgung angehalten und die Taste verändert sich zur Taste [Resume]. Um die Bildausschnitt-
Steuerung fortzusetzen, drücken Sie die Taste [Resume].
Wenn Sie während der Bildausschnitt-Steuerung den Joystick/Zoom-Schieberegler bedienen oder eine
Voreinstellungsposition aufrufen, wird das Schwenken/Neigen/Zoomen aufgrund der automatischen Verfolgung angehalten
und die Taste verändert sich zur Taste [Resume]. Zur Fortsetzung drücken Sie die Taste [Resume].
Zur Fortsetzung können Sie auch auf eine zu verfolgende Person tippen, anstatt die Taste [Resume] zu verwenden.

5

Drücken Sie auf die Registerkarte  (Anpassung der AFR-Komposition) im Steuerbereich für den Live-Bildschirm, um
den Bereich zur Anpassung der AFR-Komposition anzuzeigen.

6

Passen Sie im Bereich zur Anpassung der AFR-Komposition die Größe der Person und die Lage der Komposition an.7
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Tipp
Sofern Sie keine bestimmte Präferenz haben, wird die Einstellung von Autofokus empfohlen. Die Verfolgungsleistung wird beeinträchtigt, wenn
nicht auf die Person fokussiert wird.

Bei manuellem Verfolgungsstart ist die Taste  (Neu starten) deaktiviert.

Verwandtes Thema
Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung

5-041-957-64(1) Copyright 2022 Sony Corporation

A: Schieberegler für die Körpergröße
B: Bereich zur Anpassung der Komposition
Passen Sie die Größe und Position der Person innerhalb des Bilds an.

Stellen Sie die Größe der Person innerhalb des Bilds mithilfe des Schiebereglers für die Körpergröße ein.
Stellen Sie die Position der Person innerhalb des Bilds mithilfe des Bereichs zur Anpassung der Komposition ein. Geben Sie
die Komposition an, indem Sie den weißen Kompositionsrahmen ziehen.

Hinweis
Wenn der weiße Kompositionsrahmen den umgebenden grauen Bereich überlappt, können Personen leicht verloren gehen, die sich in die
andere Richtung bewegen. Passen Sie als Grundsatz den Kompositionsrahmen so an, dass die Person nicht in den grauen Bereich eintritt.

Wenn Sie Ihre Aufnahme so zusammenstellen, dass die Person groß erscheint, gehen Personen ggf. leicht verloren, wenn sie sich schnell
bewegen. Gestalten Sie in diesem Fall die Person kleiner und positionieren Sie diese so, dass genügend Bewegungsraum um sie
vorhanden ist.
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Motive an bestimmter Position auswählen und automatisch verfolgen (automatischer
Verfolgungsstart)

Sie können eine Person, die an einer angegebenen Position erscheint, automatisch verfolgen lassen.

Tipp
Sofern Sie keine bestimmte Präferenz haben, wird die Einstellung von Autofokus empfohlen. Die Verfolgungsleistung wird beeinträchtigt, wenn
nicht auf die Person fokussiert wird.

Wenn Sie während der Bildausschnitt-Steuerung auf die Taste [Pause] drücken, wird das Schwenken/Neigen/Zoomen aufgrund der
automatischen Verfolgung angehalten und die Taste verändert sich zur Taste [Resume]. Um die Bildausschnitt-Steuerung fortzusetzen, drücken
Sie die Taste [Resume].

Wenn Sie während der Bildausschnitt-Steuerung den Joystick/Zoom-Schieberegler bedienen oder eine Voreinstellungsposition aufrufen, wird das
Schwenken/Neigen/Zoomen aufgrund der automatischen Verfolgung angehalten und die Taste verändert sich zur Taste [Resume]. Zur
Fortsetzung drücken Sie die Taste [Resume].

Während der Bildausschnitt-Steuerung können Sie die Komposition im Bereich zur Anpassung der AFR-Komposition anpassen. Einzelheiten
siehe „Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)“.

Falls bei automatischem Verfolgungsstart ein Verfolgungsziel manuell angegeben wurde, erhält die Verfolgung dieser Person Vorrang. Um zum
automatischen Verfolgungsstart zurückzukehren, drücken Sie die Taste  (Neu starten).

Falls die Kamera die Sicht auf eine manuell angegebene Person vollständig verliert, kehrt die Kamera zum automatischen Verfolgungsstart
zurück.

Verwandtes Thema

Achten Sie hierzu darauf, dass auf dem Bildschirm zur Einrichtung von PTZ AFR der Verfolgungsmodus für Personen
auf automatischen Verfolgungsstart eingestellt ist und die für die automatische Verfolgung erforderlichen Einstellungen
konfiguriert wurden.

Einzelheiten siehe „Konfigurieren der Anfangseinstellungen für PTZ-Bildausschnitt-Steuerung“.

1

Schalten Sie auf dem Live-Betriebsbildschirm den Schalter [PTZ AFR] ein.

Der Bereich um die Taste [Pause] blinkt blau.

Das Kamerabild bewegt sich automatisch auf die Startposition. Die automatische Verfolgung beginnt, sobald eine Person in den
Erkennungsbereich eintritt.
Während der automatischen Verfolgung ist die Taste [Pause] aktiviert und ihre Umgebung leuchtet blau.

Falls die Erkennung der verfolgten Person verloren geht, können Sie auf die Taste  (Neu starten) drücken, um zur
Startposition zurückzukehren und auf die Erkennnung eines Verfolgungsziels zu warten, damit die Verfolgung wieder
aufgenommen wird. Sie können außerdem das Schwenken/Neigen/Zoomen manuell bedienen, um das verfolgte Motiv wieder
ins Sichtfeld zu bringen. Drücken Sie dann die Taste [Resume], um die Verfolgung wieder aufzunehmen.

2
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Struktur des Einstellungsbildschirms PTZ AFR

Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)

5-041-957-64(1) Copyright 2022 Sony Corporation
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Kompositionsvoreinstellung einer PTZ-Bildausschnitt-Steuerung aufrufen

Wenn die PTZ-Bildausschnitt-Steuerung aktiviert ist, werden drei Kompositionsvoreinstellungen auf dem Live-Betriebsbildschirm
angezeigt.
Sie können die Komposition unmittelbar ändern, indem Sie eine Kompositionsvoreinstellung aufrufen, anstelle den Bereich zur
Anpassung der AFR-Komposition zu bedienen.
Das Gerät wird mit drei typischen Kompositionsvoreinstellungen ausgeliefert.

A: Nahaufnahmengröße
B: Taillengröße
C: Volle Körpergröße

So benennen Sie eine Kompositionsvoreinstellung um

Sie können eine Kompositionsvoreinstellung umbenennen. Einzelheiten siehe „Kompositionsvoreinstellung einer PTZ-Bildausschnitt-
Steuerung umbenennen“

So ändern Sie eine Kompositionsvoreinstellung

Sie können eine Kompositionsvoreinstellung ändern. Einzelheiten siehe „Ändern einer Kompositionsvoreinstellung der PTZ-
Bildausschnitt-Steuerung auf eine neue Voreinstellung“.

Tipp

Schalten Sie auf dem Live-Betriebsbildschirm den Schalter [PTZ AFR] ein.

Links auf dem Live-Betriebsbildschirm wird der Steuerbereich für Kompositionsvoreinstellungen angezeigt.

1

Drücken Sie auf die aufzurufende Kompositionsvoreinstellung.

Oben rechts im Bild wird die Taste  (Voreinstellungsrahmen-Menü) angezeigt.

2

Drücken Sie die Taste  (Voreinstellungsrahmen-Menü) und wählen Sie im angezeigten Menü den Befehl [Recall].

Die ausgewählte Kompositionsvoreinstellung wird im Steuerbereich für AFR-Kompositionsvoreinstellungen aufgerufen.

Tipp
Sie können auch doppelt auf eine Kompositionsvoreinstellung tippen, um sie aufzurufen.

3
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Die Anzahl der Kompositionsvoreinstellungen beträgt drei (festgelegt). Sie können nicht hinzugefügt oder gelöscht werden.

Verwandtes Thema
Kompositionsvoreinstellung einer PTZ-Bildausschnitt-Steuerung umbenennen
Ändern einer Kompositionsvoreinstellung der PTZ-Bildausschnitt-Steuerung auf eine neue Voreinstellung

5-041-957-64(1) Copyright 2022 Sony Corporation
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Kompositionsvoreinstellung einer PTZ-Bildausschnitt-Steuerung umbenennen

5-041-957-64(1) Copyright 2022 Sony Corporation

Schalten Sie auf dem Live-Betriebsbildschirm den Schalter [PTZ AFR] ein.

Links auf dem Live-Betriebsbildschirm wird der Steuerbereich für Kompositionsvoreinstellungen angezeigt.

1

Drücken Sie auf die umzubenennende Kompositionsvoreinstellung.

Oben rechts im Bild wird die Taste  (Voreinstellungsrahmen-Menü) angezeigt.

2

Drücken Sie die Taste  (Voreinstellungsrahmen-Menü) und wählen Sie im angezeigten Menü den Befehl [Rename].3

Geben Sie einen neuen Namen für die Kompositionsvoreinstellung ein.4
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Ändern einer Kompositionsvoreinstellung der PTZ-Bildausschnitt-Steuerung auf eine neue
Voreinstellung

Sie können eine vorhandene Kompositionsvoreinstellung durch eine neue ersetzen.

Tipp
[Framing] auf dem Einstellungsbildschirm PTZ AFR und dem Bereich zur Anpassung der AFR-Komposition sind verknüpft. Um zur
Standardkomposition zurückzukehren, ersetzen Sie die Komposition, indem Sie unter [Framing] eine typische Komposition festlegen.

Verwandtes Thema
Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)

5-041-957-64(1) Copyright 2022 Sony Corporation

Schalten Sie auf dem Live-Betriebsbildschirm den Schalter [PTZ AFR] ein.

Links auf dem Live-Betriebsbildschirm wird der Steuerbereich für Kompositionsvoreinstellungen angezeigt.

1

Passen Sie im Bereich zur Anpassung der AFR-Komposition die Größe und Lage der Person an.

Einzelheiten zur Anpassung siehe „Motive für automatische Verfolgung angeben (manueller Verfolgungsstart)“.

2

Wählen Sie die zu ersetzende Kompositionsvoreinstellung aus, drücken Sie die Taste  (Voreinstellungsrahmen-Menü)
und wählen Sie im angezeigten Menü den Befehl [Replace].

Die in Schritt 2 angepasste Komposition wird als Kompositionsvoreinstellung gespeichert.
Die Kompositionsvoreinstellung wechselt zur neuen Komposition.

Ersetzungsbeispiel

3
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Status der PTZ-Bildausschnitt-Steuerung aus der Ferne prüfen

Sie können den Status der PTZ-Bildausschnitt-Steuerung mithilfe der Tally-Anzeige des Geräts überwachen.

Verwandtes Thema
Tally

5-041-957-64(1) Copyright 2022 Sony Corporation

Setzen Sie im Webmenü die Einstellung [Technical] > [Tally] > [Tally Control] auf [PTZ AFR].

Die Tally-Anzeige wechselt wie folgt entsprechend dem Status der PTZ-Bildausschnitt-Steuerung.

Tipp
Bei automatischem Verfolgungsstart blinkt die Tally-Anzeige grün, bis eine Person in den Erkennungsbereich eintritt.

1

Tally-
Anzeige Status der PTZ-Bildausschnitt-Steuerung

Erloschen PTZ-Bildausschnitt-Steuerung ist deaktiviert.

Leuchtet
grün

Automatische Verfolgung geht vonstatten.

Blinkt grün PTZ-Bildausschnitt-Steuerung ist aktiviert, jedoch ist Benutzereingriff erforderlich. Prüfen Sie die im
Kamerabildbereich auf dem Live-Betriebsbildschirm angezeigte Meldung und greifen Sie wie erforderlich ein.
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Bildschirm für die Anpassung des Fokus

Die Fokussierung wird mithilfe der folgenden Elemente des Live-Betriebsbildschirms angepasst.

5-041-957-64(1) Copyright 2022 Sony Corporation

Kamerabildbereich
Sie können die Fokussierung anpassen, indem Sie auf das Kamerabild tippen. Sie können die Touch-Bedienung in der Web-App
deaktivieren, indem Sie den Schalter [Touch Focus] auf der Registerkarte  (Focus) im Kamerasteuerbereich ausschalten.

1.

Kamerasteuerbereich – Registerkarte  (Focus)2.

GUI-Steuerbereich3.
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Manuell mithilfe der Web-App einstellen

Sie können den Fokus beispielsweise in folgenden Situationen manuell einstellen.

Motive, die teilweise durch Wassertröpfchen verborgen werden
Motive, die sich nur schwach vom Hintergrund abheben
Motive hinter anderen, näher liegenden Motiven

Hinweis
Die manuelle Fokussierung kann während des Zoombetriebs nicht von der Web-App aus gesteuert werden.

Tipp

Sie können den Autofokus nutzen, auch wenn die Hauptbedienung manuell erfolgt. Einzelheiten siehe „Manuelles Einstellen des Autofokusziels
(AF Assist) mithilfe der Web-App“.

Verwandtes Thema
Prüfen der Objektivschalter

Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App

5-041-957-64(1) Copyright 2022 Sony Corporation

Wenn ein Objektiv mit Fokuswahlschalter verwendet wird, stellen Sie den Schalter auf die Position „AF/MF“ oder „AF“.

Hinweis
Wenn der Schalter auf „Full MF“ oder „MF“ steht, kann die Fokussierung des Objektivs nicht über das Gerät gesteuert werden. Siehe „Bei
Objektiven mit Fokusmodusschalter“ unter „Prüfen der Objektivschalter“.

1

Schieben Sie den Schalter [Auto Focus] im Kamerasteuerbereich nach links, um den Autofokus auszuschalten.

Der manuelle Fokusmodus wird aktiviert.

 (MF)

2

Nehmen Sie die Einstellung mithilfe des Schiebereglers unten auf der Registerkarte  (Focus) vor.3
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Fokus manuell mithilfe der mitgelieferten Infrarot-Fernbedienung einstellen

Sie können den Fokus mithilfe der mitgelieferten Infrarot-Fernbedienung manuell einstellen.

Tipp

Sie können den Autofokus nutzen, auch wenn die Hauptbedienung manuell erfolgt. Einzelheiten siehe „Manuelle Fokussierung während
Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung“.

Verwandtes Thema
Manuelle Fokussierung während Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie auf der Infrarot-Fernbedienung die Taste MF.1

Stellen Sie den Fokus manuell mithilfe der Tasten F (Fern) und N (Nah) ein.

Um auf ein fernes Motiv zu fokussieren, drücken Sie die Taste F.
Um auf ein nahes Motiv zu fokussieren, drücken Sie die Taste N.

2
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Fokus durch Angabe einer Fokusposition anpassen (Spot Focus)

Im manuellen Fokusmodus können Sie im Kamerabildbereich die Position bestimmen, an der Sie fokussieren möchten.

Hinweis

Die Spot-Fokus-Funktion funktioniert nicht, wenn das Objektiv auf manuelle Fokussierung gestellt ist.

Tipp

Im Spot-Fokus-Modus können Sie eine belegbare Taste drücken, der [Push AF/MF] zugewiesen wurde, um den Spot-Fokus vorübergehend zu
stoppen und den Autofokus so lange zu aktivieren, wie die Taste gedrückt wird. Wenn Sie die Taste loslassen, kehrt der Fokus zur manuellen
Fokussierung zurück.

5-041-957-64(1) Copyright 2022 Sony Corporation

Setzen Sie im Webmenü oder Kameramenü die Einstellung [Shooting] > [Focus] > [Touch Function in MF] auf [Spot
Focus].

1

Schieben Sie den Schalter [Touch Focus] auf der Registerkarte  (Focus) nach rechts, um ihn einzuschalten.2

Schieben Sie den Schalter [Auto Focus] auf der Registerkarte  (Focus) nach links, um ihn auszuschalten.3

Geben Sie die Fokusposition an.

Die Spot-Fokus-Markierung wird angezeigt und das Bild wird an dieser Position fokussiert.

Beispiel für das Angeben der Position per Touch-Bedienung

4
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Autofokus vorübergehend verwenden (Push Auto Focus (AF))

Im manuellen Fokusmodus können Sie mithilfe von Autofokus den Fokus vorübergehend anpassen. Solange Sie die Taste [Push
AF/MF] gedrückt halten, wird automatisch fokussiert.
Dies ist hilfreich, wenn Sie bei manuellem Fokus schnell von einem Motiv auf ein anderes scharfstellen möchten.

Hinweis

Der Autofokus auf Knopfdruck funktioniert nicht, wenn das Objektiv auf manuelle Fokussierung gestellt ist.

Tipp

Die gleiche Funktion wird erzielt, indem Sie eine belegbare Taste drücken, der [Push AF/MF] zugewiesen wurde.

5-041-957-64(1) Copyright 2022 Sony Corporation

Setzen Sie im Kameramenü die Einstellung [Shooting] > [Focus] > [Push AF Mode] auf [AF].1

Schieben Sie den Schalter [Auto Focus] auf der Registerkarte  (Focus) nach links, um ihn auszuschalten.2

Drücken Sie die Taste [Push AF/MF].

Solange die Taste gedrückt gehalten wird, ist der Autofokus aktiviert.

Sobald Sie die Taste loslassen, wird der Autofokus auf Knopfdruck wieder aufgehoben und zur manuellen Fokussierung
gewechselt.

3
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Verwendung des einmaligen Autofokus (Push Auto Focus (AF-S))

Sie können im manuellen Fokusmodus die Taste [Push AF/MF] drücken, um automatisch schnell zu fokussieren.
Diese Funktion ist hilfreich, wenn Sie vor der Aufzeichnung auf ein Motiv scharfstellen.

Hinweis
Der Autofokus auf Knopfdruck funktioniert nicht, wenn das Objektiv auf manuelle Fokussierung gestellt ist.

Bei Verwendung der Taste [Display] wird der Fokusbereichsrahmen nicht ausgeblendet.

Während des Clear Image Zoom-Betriebs kann die Position des [Focus Area (AF-S)]-Rahmens nicht festgelegt werden. Während des Autofokus
auf Knopfdruck gewährt außerdem der AF-Betrieb dem Bereich in der Mitte Vorrang.

Die [Focus Area (AF-S)]-Rahmenposition kann während der PTZ-Bildausschnitt-Steuerung nicht konfiguriert werden. Der AF-Betrieb gewährt
dem verfolgten Motiv Vorrang.

Tipp

Die gleiche Funktion wird erzielt, indem Sie eine belegbare Taste drücken, der [Push AF/MF] zugewiesen wurde.

Setzen Sie im Webmenü oder Kameramenü die Einstellung [Shooting] > [Focus] > [Push AF Mode] auf [Single-shot
AF(AF-S)].

1

Bestimmen Sie mithilfe von [Shooting] > [Focus] > [Focus Area (AF-S)] im Kameramenü die Position, an der Sie
fokussieren möchten.

Tipp
Sie können die Position ändern, indem Sie eine belegbare Taste drücken, der [Focus Setting] zugewiesen wurde. Daraufhin erhält der
Fokusbereich einen orangefarbenen Rahmen, und Sie können per Touch-Bedienung seine Position auswählen.

2

Schieben Sie den Schalter [Auto Focus] auf der Registerkarte  (Focus) nach links, um ihn auszuschalten.3

Drücken Sie die Taste [Push AF/MF].

Wenn Sie die Taste loslassen, bevor die Fokussierung abgeschlossen ist, stoppt der Autofokus auf Knopfdruck.

Während des Autofokus auf Knopfdruck wird der Status der Fokussierung von der Fokusanzeige signalisiert.
Ein: Der Fokus ist festgelegt.
Blinkt: Das Motiv ist unscharf. Da das Gerät nicht automatisch fokussiert, müssen Sie die Bildkomposition und die
Fokussierungseinstellungen ändern, um eine Scharfstellung zu erlangen.
Wenn Sie die Taste loslassen, kehrt der Fokus zur manuellen Fokussierung zurück.

4
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Es ist ebenfalls möglich, die Funktion [Push AF Mode] einer belegbaren Taste zuzuweisen.

Es ist ebenfalls möglich, die Funktion [Focus Area (AF-S)] einer belegbaren Taste zuzuweisen.

Sie können mithilfe von [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] im Kameramenü den Fokusbereichsrahmen ein- bzw.
ausblenden.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Automatisch mithilfe der Web-App einstellen

Des Gerät verwendet Phasenerkennungs-AF zur Hochgeschwindigkeitsfokussierung und Kontrast-AF zur Präzisionsfokussierung.
Durch die Kombination dieser beiden AF-Methoden wird eine automatische Fokussierung erreicht, die sowohl schnell als auch genau
ist.

Hinweis
Hierfür wird ein Objektiv benötigt, das die Autofokusfunktion unterstützt.

Je nach Aufnahmebedingungen wird die Genauigkeit ggf. nicht erreicht.

An einem Objektiv mit A-Bajonett kann der Fokus nicht automatisch eingestellt werden.

Tipp
Im Autofokusmodus können Sie den Fokus mithilfe des Schiebereglers Focus im Kamerasteuerbereich anpassen. Einzelheiten siehe „Manuelles
Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App“.

Verwandtes Thema
Prüfen der Objektivschalter

Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App

5-041-957-64(1) Copyright 2022 Sony Corporation

Wenn ein Objektiv mit Fokuswahlschalter verwendet wird, stellen Sie den Schalter auf die Position „AF/MF“ oder „AF“.

Hinweis
Wenn der Schalter auf „Full MF“ oder „MF“ steht, kann die Fokussierung des Objektivs nicht über das Gerät gesteuert werden. Siehe „Bei
Objektiven mit Fokusmodusschalter“ unter „Prüfen der Objektivschalter“.

1

Schieben Sie den Schalter [Auto Focus] im Kamerasteuerbereich nach rechts, um ihn einzuschalten.

Der Autofokusmodus wird aktiviert.

 (AF)

2
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Fokus automatisch mithilfe der mitgelieferten Infrarot-Fernbedienung einstellen

Sie können den Fokus mithilfe der mitgelieferten Infrarot-Fernbedienung automatisch einstellen.

Hinweis
Sie können den Autofokus nutzen, auch wenn die Hauptbedienung manuell erfolgt. Einzelheiten siehe „Manuelle Fokussierung während
Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung“.

Verwandtes Thema
Manuelle Fokussierung während Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie auf der Infrarot-Fernbedienung die Taste AF.

Der Fokus auf ein Motiv wird automatisch eingestellt.

1
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Einstellen des Bereichs und der Position für den Autofokus (Fokusbereich)

Sie können den Zielbereich für den Autofokus festlegen und die Fokussierung für diesen Bereich anpassen.

Drücken Sie die Taste [Menu] im GUI-Steuerbereich, um das Kameramenü zu öffnen.1

Legen Sie mithilfe von [Shooting] > [Focus] > [Focus Area] im Kameramenü den Zielbereich für den Autofokus fest.

[Wide]:
Sucht beim Fokussieren in einem weiten Winkel über das Bild nach einem Motiv. Es wird kein Rahmen angezeigt.

[Zone]:
Sucht automatisch innerhalb der angegebenen Zone nach einer Fokusposition.
Geben Sie nach der Auswahl die Position mithilfe der Pfeiltasten im GUI-Steuerbereich an.

Sie können zur Mittenposition zurückkehren, indem Sie die Taste [Set] gedrückt halten.
[Flexible Spot]:
Fokussiert auf eine angegebene Position im Bild.
Geben Sie nach der Auswahl die Position mithilfe der Pfeiltasten im GUI-Steuerbereich an.

2
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Hinweis
Bei Verwendung der Taste [Display] im Kamerabildbereich wird der Fokusbereichsrahmen nicht ausgeblendet.

Tipp
Sie können mithilfe von [Monitoring] > [Display On/Off] > [Focus Area Indicator] im Kameramenü den Fokusbereichsrahmen ein- bzw.
ausblenden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Sie können zur Mittenposition zurückkehren, indem Sie die Taste [Set] gedrückt halten.
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Schnelles Wechseln des Fokusbereichs (Fokuseinstellung)

Sie können Position und Größe des Autofokusbereichs während der Aufnahme schnell ändern, indem Sie einer belegbaren Taste die
Funktion [Focus Setting] zuweisen.

Einzelheiten zu belegbaren Tasten siehe „Belegbare Tasten“.

Die Funktion variiert je nach der Fokusbereichseinstellung.

Wenn im Kameramenü die Einstellung [Shooting] > [Focus] > [Focus Area] auf [Flexible Spot] oder
[Zone] gesetzt ist

Sie können die Position des Fokusbereichs ändern, indem Sie eine belegbare Taste drücken, der [Focus Setting] zugewiesen
wurde und dann die Anpassung mit den Pfeiltasten im GUI-Steuerbereich vornehmen. Sie können beim Anpassen der Position den
Fokusbereich auf die Mitte zurücksetzen, indem Sie die Taste [Set] drücken.
Sie können die Größe des Fokusbereichs ändern, indem Sie eine belegbare Taste gedrückt halten, der [Focus Setting] zugewiesen
wurde. Nach dem Ändern der Größe können Sie die Position des Fokusbereichs ändern, indem Sie die Taste [Set] drücken.
Drücken Sie abschließend auf die belegbare Taste, der [Focus Setting] zugewiesen wurde, um zum ursprünglichen Bildschirm
zurückzukehren.

Wenn im Kameramenü die Einstellung [Shooting] > [Focus] > [Focus Area] auf [Wide] gesetzt ist

Sie können die Größe des Fokusbereichs nur ändern, indem Sie eine belegbare Taste gedrückt halten, der [Focus Setting] zugewiesen
wurde. Die Position kann auch geändert werden, indem zuvor der Typ auf [Flexible Spot] oder [Zone] geändert wird.

Tipp

Wenn sowohl [Shooting] > [Focus] > [Push AF Mode] im Kameramenü auf [Single-shot AF(AF-S)] gesetzt ist als auch der Schalter [Auto Focus]
ausgeschaltet ist (manueller Fokusmodus), können Sie die [Focus Area (AF-S)]-Fokusbereichsposition ändern.

Der Rahmen des Fokusbereichs wird orangefarben angezeigt, wenn die Position des Fokusbereichs geändert werden kann.

Verwandtes Thema
Belegbare Tasten

5-041-957-64(1) Copyright 2022 Sony Corporation
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Fokusbereichsrahmen mittels Touch-Bedienung bewegen (Fokus-Berührbereich)

Sie können die Position des Fokusbereichs ändern, indem Sie eine belegbare Taste drücken, der [Focus Setting] zugewiesen wurde.
Daraufhin wird der Fokusbereich orangefarben angezeigt, und Sie können den Fokusbereichsrahmen per Touch-Bedienung im
Kamerabildbereich bewegen.
Tippen Sie auf den Bildschirm, um den Fokusbereich zu bewegen. Der Bereich wird an der angetippten Position zentriert. Ziehen Sie
den Fokusbereich auf dem Bildschirm mit dem Finger in die gewünschte Position.

Tipp
Sie können den Fokus-Berührbereich auf dem Aufnahmebildschirm mithilfe einer belegbaren Taste aktivieren/deaktivieren, der [Focus Setting]
zugewiesen wurde.

Tippen Sie auf eine beliebige Stelle.

Die angetippte Stelle wird zur Mitte des Fokusbereichs.

1

Finger über den Bildschirm ziehen, um den Fokusbereich auf die Endposition des Fingers zu bewegen.2
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Hinweis

Wenn Sie auf eine Position außerhalb des Einstellungsbereichs tippen oder den Fokusbereich auf eine solche ziehen, wird der Fokusbereich auf
die obere/untere/linke/rechte Grenze des Einstellungsbereichs gesetzt.

Diese Funktion ist in den folgenden Fällen nicht verfügbar.

Wenn im Kamerasteuerbereich der Schalter [Touch Focus] ausgeschaltet ist
Wenn der Fokusbereichsrahmen grau oder gar nicht angezeigt wird
Während der PTZ-Bildausschnitt-Steuerung

5-041-957-64(1) Copyright 2022 Sony Corporation
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Anpassen des Autofokusbetriebs (AF-Übergangsgeschwindigkeit, AF-
Motivwechselempfindlichkeit)

Sie können den Autofokusbetrieb anpassen, indem Sie die Übergangsgeschwindigkeit und Motivwechselempfindlichkeit ändern.

Einstellen der AF-Übergangsgeschwindigkeit

Sie können die Geschwindigkeit des Fokusantriebs beim Motivwechsel mithilfe der Taste [AF Transition Speed] im
Kamerasteuerbereich festlegen.

Wählen Sie die Geschwindigkeit im Bereich [Speed 1] (langsam) bis [Speed 7] (schnell) in Einerschritten aus. Drücken Sie die Taste <
zum Verringern des Werts (langsamer) oder die Taste > zum Erhöhen des Werts (schneller).
Bei Einstellung auf geringe Geschwindigkeit bewegt sich der Fokus langsam, wenn das zu fokussierende Motiv wechselt, wodurch
Aufnahmen mit beeindruckender Ausdrucksstärke erzielt werden.
Bei Einstellung auf hohe Geschwindigkeit wechselt der Fokus schnell zwischen Motiven. Im Beispiel unten wechselt der Fokus schnell
vom Gebäude im Hintergrund zur Person, die im Vordergrund läuft. Das in den Rahmen eintretende Motiv wird sofort fokussiert,
wodurch sich diese Einstellung ideal für Dokumentaraufnahmen eignet, bei denen schnell fokussiert werden muss.

AF-Motivwechselempfindlichkeit

Sie können die Empfindlichkeit für den Wechsel zwischen Motiven mithilfe der Taste [AF Subj. Shift Sens.] im Kamerasteuerbereich
festlegen.
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Wählen Sie die Empfindlichkeit im Bereich [Sens 1] (gekoppelt) bis [Sens 5] (reaktiv) in Einerschritten aus. Drücken Sie die Taste <
zum Verringern des Werts (langsam wechseln) oder die Taste > zum Erhöhen des Werts (schnell wechseln).
Bei Einstellung auf geringe Empfindlichkeit wechselt der Fokus nicht sofort, auch wenn ein anderes Motiv vor dem aktuell fokussierten
erscheint.

Bei Einstellung auf hohe Empfindlichkeit erhält das vordere Motiv Vorrang und der Fokus wechselt zu diesem.

Tipp

Wenn [AF Speed/Sens.] einer belegbaren Taste zugewiesen ist, werden bei jedem Tastendruck die Pegelbalken zum Einstellen von Werten in
der folgenden Reihenfolge im Kamerabildbereich angezeigt, wodurch Sie die Einstellungen für die AF-Übergangsgeschwindigkeit und AF-
Motivwechselempfindlichkeit ändern können.
AF-Übergangsgeschwindigkeit → AF-Motivwechselempfindlichkeit → Keine Anzeige …

5-041-957-64(1) Copyright 2022 Sony Corporation
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Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App

Nach dem Wechsel und der manuellen Einstellung des Fokus können Sie die Fokuskontrolle zur Feineinstellung dem Autofokus
überlassen.

Hinweis
Im Zustand „AF Assist“ ist der Wechsel des Fokus unabhängig von der Einstellung für [Shooting] > [Focus] > [AF Subj. Shift Sens.] im
Kameramenü schwierig.

Der Zustand „AF Assist“ wird in folgenden Fällen beendet.
Wenn das mit dem Schieberegler [Focus] fokussierte Motiv nicht mehr sichtbar ist
Beim Umschalten auf manuellen Fokus
Beim Starten von Echtzeitverfolgungs-AF

Tipp
Sie können den Zustand „AF Assist“ schnell beenden, indem Sie eine belegbare Taste drücken, der [Push AF/MF] zugewiesen wurde.

Echtzeitverfolgungs-AF stoppt, wenn der Schieberegler [Focus] bedient wird.

Im Modus „Face/Eye Only AF“ fokussiert der Autofokus auf das der Fokusposition des Schiebereglers [Focus] nächstgelegene Gesicht.

5-041-957-64(1) Copyright 2022 Sony Corporation

Setzen Sie im Kameramenü die Einstellung [Shooting] > [Focus] > [AF Assist] auf [On].1

Setzen Sie im Webmenü die Einstellung [Shooting] > [Focus] > [AF Assist Control] auf [On].2

Schieben Sie den Schalter [Auto Focus] im Kamerasteuerbereich nach rechts, um ihn einzuschalten.

Der Autofokusmodus wird aktiviert.

3

Legen Sie das Fokusziel mithilfe des Schiebereglers [Focus] im Kamerasteuerbereich fest.

[Near]: Fokussiert auf nahes Motiv.
[Far]: Fokussiert auf fernes Motiv.

Im Zustand „AF Assist“ wird ein Motiv in der mit dem Schieberegler [Focus] eingestellten Entfernung automatisch fokussiert.

4
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Manuelle Fokussierung während Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung

Wenn [Shooting] > [Focus] > [AF Assist] im Kameramenü auf [On] gesetzt ist, können Sie mithilfe der Tasten F (Fern) und N (Nah) auf
der mitgelieferten Infrarot-Fernbedienung auch bei aktiviertem Autofokus die Fokussierung auf ein Motiv anpassen.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Vorübergehende Verwendung des manuellen Fokus während Autofokus (Push Manual Focus)

Drücken Sie im Autofokusmodus die Taste [Push AF/MF], um bei gedrückter Taste manuell zu fokussieren. Wenn Sie die Taste
loslassen, kehrt der Fokus zur automatischen Fokussierung zurück.
Dadurch können Sie den Autofokus vorübergehend anhalten und manuell fokussieren, falls sich andere Objekte vor dem Motiv
vorüberbewegen.

Tipp
Die gleiche Funktion wird erzielt, indem Sie eine belegbare Taste drücken, der [Push AF/MF] zugewiesen wurde.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Verfolgung mittels Gesichts- und Augenerkennung (Face/Eye Detection AF)

Das Gerät kann innerhalb des Fokusbereichs die Gesichter und Augen von Personen als zu verfolgendes Ziel erkennen und den
Fokus dann auf die Gesichter bzw. Augen anpassen.
Sobald Gesichter erkannt werden, werden graue Gesichts-/Augenerkennungsrahmen angezeigt. Wenn automatische Fokussierung
möglich ist, wechselt die Farbe der Rahmen zu Weiß und die Verfolgung beginnt. Wenn Augen erkannt werden und der Fokus
eingestellt wird, so wird der Gesichts-/Augenerkennungsrahmen um die Augen angezeigt. Wenn mehrere Personen erkannt werden,
wird das Hauptmotiv automatisch bestimmt.
Diese Funktion ist nur verfügbar, wenn sich die Fokussierung im AF-Modus befindet oder während Autofokus auf Knopfdruck.

Tipp
Wenn der Fokusbereich auf [Zone] oder [Flexible Spot] eingestellt ist und sich die Gesichter oder Augen innerhalb des angegebenen
Fokusbereichs überschneiden, werden die Gesichts-/Augenerkennungsrahmen weiß angezeigt und das Gerät fokussiert automatisch auf diese
Gesichter/Augen.

Falls „Autofokus auf Knopfdruck (AF-S)“ verwendet wird, werden die Gesichts-/Augenerkennungsrahmen der fokussierten Gesichter/Augen grün
angezeigt.

Einstellen mithilfe der Taste [Face/Eye Detection AF] im Kamerasteuerbereich

Drücken Sie die Taste [Face/Eye Detection AF] und legen Sie den Gesichts-/Augenerkennungs-AF-Betrieb fest.

[Face/Eye Only AF]: Die Kamera erkennt die Gesichter/Augen von Motiven (Personen) und fokussiert und verfolgt nur ihre
Gesichter/Augen. Solange keine Gesichter/Augen erkannt werden, wird AF vorübergehend gestoppt und das Symbol  (Autofokus im
Face/Eye Only AF-Modus angehalten) wird angezeigt. Dieser Modus ist hilfreich, wenn Sie nur Gesichter/Augen automatisch
fokussieren und verfolgen möchten.
[Face/Eye Priority AF]: Die Kamera erkennt die Gesichter/Augen von Motiven (Personen) und gewährt der Fokussierung/Verfolgung
der Gesichter/Augen Vorrang. Falls keine Gesichter/Augen erkannt werden, erfolgt die Fokussierung im AF-Modus
(Standardeinstellung).
[AF]: Die Funktion Gesichts-/Augenerkennungs-AF ist deaktiviert.

Hinweis
Während des Autofokus auf Knopfdruck ist [Face/Eye Priority AF] auch dann aktiviert, wenn [Face/Eye Only AF] gegenwärtig ausgewählt ist.

Wenn der Schalter [Auto Focus] ausgeschaltet ist, ist Gesichts-/Augenerkennungs-AF deaktiviert (ausgenommen während Autofokus auf
Knopfdruck).

Wenn Sie den Camcorder ausschalten, während [Face/Eye Only AF] ausgewählt ist, wechselt der Modus beim nächsten Einschalten des
Camcorders automatisch zu [Face/Eye Priority AF].

Tipp
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Sie können den Betrieb mit Gesichts-/Augenerkennungs-AF mithilfe von [Shooting] > [Focus] > [Face/Eye Detection AF] im Kameramenü
festlegen.

Ausblenden der Gesichts-/Augenerkennungsrahmen
Sie können Gesichts-/Augenerkennungsrahmen mithilfe der Funktion [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] im
Kameramenü ein-/ausblenden.

Hinweis
Für Gesichter und Augen, die mithilfe von Autofokus auf Knopfdruck (AF-S) scharfgestellt sind, werden grüne
Gesichts-/Augenerkennungsrahmen angezeigt, die nicht mit der Taste [Display] oder bei Einstellung von [Face/Eye Detection Frame] auf [Off]
ausgeblendet werden.

Umschalten des Betriebs mit Gesichts-/Augenerkennungs-AF mithilfe einer belegbaren Taste
Weisen Sie [Face/Eye Detection AF] einer belegbaren Taste zu. Sie können dann die Funktionsweise des Betriebs mit
Gesichts-/Augenerkennungs-AF in der Reihenfolge [Face/Eye Priority AF], [Face/Eye Only AF] und [AF] per Tastendruck
durchschalten.

Einstellung mithilfe des Direktmenüs

Sie können die Funktionsweise des Gesichts-/Augenerkennungs-AF-Betriebs auch über das Direktmenü festlegen.

Einzelheiten zum Direktmenü siehe „Verwenden des Direktmenüs“.

Verwandtes Thema
Verwenden des Direktmenüs

5-041-957-64(1) Copyright 2022 Sony Corporation
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Ein bestimmtes Motiv verfolgen (Echtzeitverfolgungs-AF)

Sie können die Fokussierung auf ein bestimmtes Motiv beibehalten, indem Sie dieses durch Touch-Bedienung oder Auswahl eines
Gesichtserkennungsrahmens im Kamerasteuerbereich bestimmen.
Sobald ein Motiv ausgewählt wurde, wird ein weißer Verfolgungsrahmen angezeigt und die Verfolgung beginnt.

Tipp
Die Verfolgung wird unabhängig von der Einstellung des Fokusbereichs über den gesamten Bildbereich durchgeführt.

Wenn [Shooting] > [Focus] > [Touch Function in MF] im Webmenü oder Kameramenü auf [Tracking AF] eingestellt ist, wird Echtzeitverfolgungs-
AF auch im manuellen Fokusmodus unterstützt.

Je nach Betriebsmoduseinstellung des Gesichts-/Augenerkennungs-AF tritt Folgendes für das Verfolgungsziel ein.

[Face/Eye Only AF] oder [Face/Eye Priority AF]: Fokussierung und Verfolgung des bestimmten Motivs.
Ist das Verfolgungsziel eine Person und werden Gesicht bzw. Augen erkannt, fokussiert die Kamera auf dieses Gesicht/Auge.
Werden Gesicht bzw. Augen eines Verfolgungsziels erkannt, so wird das Gesicht des Verfolgungsziels gespeichert. Nach der
Speicherung wird das Symbol  (Verfolgungsgesicht gespeichert) angezeigt.

Hinweis
Wenn während des manuellen Fokus der Verfolgungs-AF gestartet wird, so wird das Gesicht des Verfolgungsziels nicht gespeichert.

[AF]: Zur Fokussierung und Verfolgung eines bestimmten Motivs verwenden. Gesichts-/Augenerkennung wird nicht durchgeführt, auch
wenn das Verfolgungsziel eine Person ist.

Hinweis
Die Funktion „Realtime Tracking AF“ (Echtzeitverfolgungs-AF) funktioniert nicht, wenn das Objektiv auf manuelle Fokussierung gestellt ist.

Echtzeitverfolgungs-AF starten

Wenn ein bestimmtes Motiv als Verfolgungsziel festgelegt wird, beginnt die Verfolgung dieses Ziels.

Bestimmen per Touch-Bedienung
Schieben Sie den Schalter [Touch Focus] auf der Registerkarte  (Focus) im Kamerasteuerbereich nach rechts, um ihn
einzuschalten. Tippen Sie dann auf das zu verfolgende Zielmotiv in einem der nachfolgend genannten Zustände.

Wenn der manuelle Fokusmodus aktiv ist oder während manuellem Fokus auf Knopfdruck und wenn [Shooting] > [Focus] > [Touch
Function in MF] im Webmenü oder Kameramenü auf [Tracking AF] gesetzt ist
Wenn der automatische Fokusmodus aktiv ist oder während Autofokus auf Knopfdruck (AF)

Bestimmen durch Auswahl des Gesichtserkennungsrahmens
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Bewegen Sie mithilfe der Pfeiltasten im GUI-Steuerbereich den Gesichtsauswahlcursor (orange unterstrichen) auf das zu verfolgende
Zielmotiv, und drücken Sie die Taste [Set].

A: Gesichtserkennungsrahmen (grau)
B: Verfolgungsrahmen
C: Gesichtsauswahlcursor (orange)

Hinweis

Während der manuellen Fokussierung kann die Verfolgung nicht durch Auswahl eines Gesichtserkennungsrahmens gestartet werden.

Tipp

Sie können das zu verfolgende Ziel auch während des Echtzeitverfolgungs-AF ändern.

Echtzeitverfolgungs-AF stoppen

Drücken Sie die Taste  (Stoppen des Echtzeitverfolgungs-AF).

Tipp
Der Echtzeitverfolgungs-AF stoppt in den folgenden Fällen:

Wenn der Schalter [Auto Focus] oder das Bedienelement AUTO/MANUAL am Objektiv betätigt wird
Wenn der Fokusmodus geändert wird
Wenn „AF Assist“ ausgeführt wird
Wenn die Einstellung des Fokusbereichs oder der Gesichts-/Augenerkennung-AF geändert wird
Wenn eine belegbare Taste gedrückt wird, der die Funktion [Push AF/MF] zugewiesen wurde
Wenn sich das Verfolgungsziel nicht innerhalb des Aufnahmebildschirms befindet oder wenn das Motiv für einige Sekunden außerhalb des
Fokus ist
Wenn der Schalter [PTZ AFR] betätigt wird

Wenn ein Verfolgungsgesicht gespeichert wurde (wenn das Symbol  (Verfolgungsgesicht gespeichert) angezeigt wird), wird der
Echtzeitverfolgungs-AF fortgesetzt, sobald das gespeicherte Verfolgungsgesicht in den Bildbereich gelangt. Um das Verfolgungsgesicht zu
löschen, stoppen Sie den Echtzeitverfolgungs-AF wie oben beschrieben.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Bildschirm für die Anpassung der Helligkeit

Sie können die Helligkeit durch Anpassen der Blende, Verstärkung und Verschlusszeit sowie durch Anpassen des Lichtpegels mithilfe
von ND-Filtern in den folgenden Steuerbereichen des Live-Betriebsbildschirms in der Web-App einstellen. Sie können die Helligkeit
auch automatisch anpassen.

Hinweis
Die Verstärkung kann nicht angepasst werden, wenn [Shooting Mode] auf [Cine EI Quick] oder [Cine EI] eingestellt ist. Außerdem kann bei
Einstellung auf [Cine EI Quick] oder [Cine EI] die Helligkeit nicht automatisch mithilfe der Verschlusszeit eingestellt werden. Die automatische
Einstellung der Helligkeit mit der Blende und dem ND-Filter wird unterstützt.

Tipp

Kamerasteuerbereich – Registerkarte  (Main)1.

Bereich für grundlegende Kamerakonfiguration
Zeigt den Status der Einstellungen für zur Aufnahme erforderliche Grundfunktionen auf Tasten an. Drücken Sie eine Taste, um den
entsprechenden Einrichtungsbildschirm für die jeweilige Funktion im Bereich für die Anpassung der Grundfunktionen unten
anzuzeigen.

2.

Bereich für die Anpassung der Grundfunktionen der Kamera
Zeigt den Bereich zur Anpassung des Einrichtungselements an, das im Bereich für grundlegende Kamerakonfiguration ausgewählt
wurde.

3.
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Der Modus Cine EI dient zur Aufnahme mit einer Basisempfindlichkeit ohne Verwendung von Verstärkung, um die Leistung des Bildsensors zu
maximieren. Die Helligkeit wird mithilfe der Beleuchtung und dem ND-Filter angepasst, um die Lichtmenge zu regulieren, die den Bildsensor
erreicht. Einzelheiten zu Exposure Index (EI) siehe „Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten Bild“.

Verwandtes Thema
Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten Bild

5-041-957-64(1) Copyright 2022 Sony Corporation
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Einstellen der Basisempfindlichkeit

Sie können die Basisempfindlichkeit einstellen, bevor Sie die Helligkeit anpassen.

Wenn [Shooting Mode] auf [Custom] gesetzt ist

Drücken Sie im Bereich für grundlegende Kamerakonfiguration die Taste [ISO/Gain] und setzen Sie [Base Sensitivity] im Bereich zur
Anpassung von ISO/Verstärkung auf [High] oder [Low].
Wählen Sie bei normaler Beleuchtung [Low] und bei schwacher Beleuchtung [High] aus.
Bildschirm, wenn [AGC] deaktiviert ist

Bildschirm, wenn [AGC] aktiviert ist

Wenn [Shooting Mode] auf [Flexible ISO] oder [Cine EI] gesetzt ist

Drücken Sie im Bereich für grundlegende Kamerakonfiguration die Taste [Base ISO/Exposure Index] und setzen Sie [Base ISO] im
Bereich zur Anpassung von Base ISO/Exposure Index auf [ISO 12800] oder [ISO 800].
Wählen Sie bei normaler Beleuchtung [ISO 800] und bei schwacher Beleuchtung [ISO 12800] aus.

Tipp
Sie können dies auch auf der Registerkarte  (Main) im Kamerasteuerbereich einstellen.

Dies kann auch im Kameramenü mithilfe von [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] oder [Base ISO] festgelegt werden.

Es ist ebenfalls möglich, die Funktion [Base ISO/Sensitivity] einer belegbaren Taste zuzuweisen.

Im Aufnahmemodus [Cine EI Quick] wird die Basisempfindlichkeit automatisch entsprechend der Einstellung von [Exposure Index] festgelegt.
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Einstellen des Zielpegels für die automatische Helligkeitseinstellung

Der Zielpegel für die automatische Helligkeitseinstellung wird mithilfe des Schiebereglers [AE Level] im Kamerasteuerbereich
eingestellt.
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Drücken Sie im Kamerasteuerbereich auf die Registerkarte  (Main).

Wenn der Schieberegler [AE Level] nicht angezeigt wird, wählen Sie eine der beiden Schieberegler-Funktionswahltasten aus und
dann aus der Liste den Schieberegler [AE Level].

Der Schieberegler [AE Level] wird angezeigt.

1

Stellen Sie mit dem Schieberegler den Zielpegel ein.

Um das Bild abzudunkeln, schieben Sie den Regler nach links. Um das Bild aufzuhellen, schieben Sie den Regler nach rechts.

Tipp
Dies kann auch im Kameramenü mithilfe von [Shooting] > [Auto Exposure] > [Level] festgelegt werden.

2
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Automatisches Anpassen der Blende

Sie können die Helligkeit automatisch anhand des Motivs anpassen. Es ist ein kompatibles Objektiv erforderlich.

Hinweis
An einem Objektiv mit A-Bajonett kann die Blende nicht automatisch eingestellt werden.

Tipp
Es ist ebenfalls möglich, die Funktion [Auto Iris] einer belegbaren Taste zuzuweisen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Wenn ein Objektiv mit einem Schalter „Auto Iris“ angebracht ist, stellen Sie den Schalter auf AUTO.1

Drücken Sie die Taste [Iris] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Iris] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Iris wird angezeigt.

2

Schieben Sie den Schalter [Auto] nach rechts, um ihn einzuschalten.

Die Blende wechselt in den Automatikmodus. Der automatisch angepasste Blendenwert wird rechts vom Schalter angezeigt.

3
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Manuelles Anpassen der Blende

Sie können die Helligkeit manuell anpassen.

Blende vorübergehend automatisch anpassen
Sie können auch die Taste [Push Auto] im Iris-Anpassungsbereich drücken, um die Blende automatisch einzustellen, solange die Taste
gedrückt wird.

Tipp

Wenn ein Objektiv mit einem Schalter „Auto Iris“ angebracht ist, stellen Sie den Schalter auf AUTO.

Hinweis
Wenn der Schalter „Auto Iris“ des Objektivs auf „MANUAL“ steht, haben die Funktionen [Auto Iris] und [Push Auto Iris] am Gerät keine
Auswirkungen. Auch manuelle Blendeneinstellungen am Gerät haben keine Auswirkungen.

1

Drücken Sie die Taste [Iris] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Iris] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Iris wird angezeigt.

2

Schieben Sie den Schalter [Auto] nach links, um ihn auszuschalten.

Die Blende wechselt in den manuellen Modus.

3

Passen Sie die Blende mithilfe des Schiebereglers [Iris] oder den [Iris]-Anpassungstasten an.

Tipp
Der Schieberegler und die Anpassungstasten sind miteinander verknüpft.

Sie können die Blendenfunktion auch dem Schieberegler auf der Registerkarte  (Main) im Kamerasteuerbereich zuweisen.

4
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Drücken Sie eine belegbare Taste, der die Funktion [Push Auto Iris] zugewiesen wurde, um die Blende automatisch anzupassen, solange die
Taste gedrückt wird.
Wenn Sie die Taste loslassen, wechselt die Blende wieder in den manuellen Einstellmodus.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Automatische Verstärkungsanpassung

Sie können die Helligkeit automatisch mithilfe der Verstärkungseinstellung anpassen, wenn [Shooting Mode] auf [Custom] oder
[Flexible ISO] gesetzt ist.
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Setzen Sie im Webmenü oder Kameramenü die Einstellung [Project] > [Shooting Mode] auf [Custom].1

Drücken Sie die Taste [ISO/Gain] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [ISO/Gain] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der ISO/Gain wird angezeigt.

2

Schieben Sie den Schalter [AGC] nach rechts, um ihn einzuschalten.

Die Verstärkung wechselt in den Automatikmodus. Der automatisch angepasste Verstärkungswert wird rechts vom Schalter
angezeigt.

Tipp
Sie können den gleichen Vorgang durchführen, indem Sie im Kameramenü die Einstellung [Shooting] > [Auto Exposure] > [AGC] auf [On]
setzen.

Es ist ebenfalls möglich, die Funktion [AGC] einer belegbaren Taste zuzuweisen.

3
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Manuelle Verstärkungsanpassung

Sie können die Helligkeit manuell mithilfe der Verstärkungseinstellung anpassen, wenn [Shooting Mode] auf [Custom] oder [Flexible
ISO] gesetzt ist.
Sie können den Verstärkungswert steuern, wenn die Belichtung bei Verwendung eines festen Blendenwerts angepasst werden soll,
oder wenn Sie verhindern möchten, dass der Verstärkungswert durch die AGC steigt.

Verstärkung vorübergehend manuell anpassen
Sie können die Verstärkung außerdem vorübergehend anpassen, indem Sie einer Schieberegler-Funktionswahltaste auf der
Registerkarte  (Main) im Kamerasteuerbereich die Funktion [ISO/Gain] zuweisen und den Schieberegler verwenden.
Dies ist nützlich, wenn Sie die Belichtung um eine Stufe ändern möchten, ohne die Schärfentiefe zu ändern.
Nach einem der folgenden Vorgänge wechselt das Anpassungsergebnis zu dem mit [ISO/Gain<L>] konfigurierten Voreinstellungswert
zurück.

Ändern von ISO/Gain-Anpassungselementen
Umschalten der Basisempfindlichkeit
Einschalten des AGC-Schalters
Stromversorgung des Geräts in Bereitschaft schalten

Verstärkung mithilfe einer belegbaren Taste vorübergehend automatisch anpassen

Setzen Sie im Webmenü oder Kameramenü die Einstellung [Project] > [Shooting Mode] auf [Custom].1

Drücken Sie die Taste [ISO/Gain] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [ISO/Gain] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der ISO/Gain wird angezeigt.

2

Schieben Sie den Schalter [AGC] nach links, um ihn auszuschalten.

Die Verstärkung wechselt in den manuellen Modus.

3

Passen Sie die Verstärkung mithilfe des Schiebereglers [ISO/Gain] oder den [ISO/Gain]-Anpassungstasten an.

Tipp

Der Schieberegler und die Anpassungstasten sind miteinander verknüpft.

4
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Drücken Sie eine belegbare Taste, der die Funktion [Push AGC] zugewiesen wurde, um die Verstärkung automatisch anzupassen,
solange die Taste gedrückt wird.
Wenn Sie die Taste loslassen, wechselt die Verstärkung wieder in den manuellen Einstellmodus.
Nach einem der folgenden Vorgänge wechselt das Anpassungsergebnis zu dem mit [ISO/Gain<L>] konfigurierten Voreinstellungswert
zurück.

Ändern von ISO/Gain-Anpassungselementen
Umschalten der Basisempfindlichkeit
Einschalten des AGC-Schalters
Stromversorgung des Geräts in Bereitschaft schalten

Hinweis
Diese Funktion kann nicht ausgeführt werden, wenn [Shooting] > [Iris] > [Bokeh Control] im Kameramenü auf [On] gesetzt ist.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Automatische Anpassung der Verschlusszeit

Sie können die Verschlusszeit automatisch anhand der Helligkeit des Bilds anpassen.
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Drücken Sie die Taste [Shutter] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Shutter] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Shutter wird angezeigt.

1

Drücken Sie die Taste [Shutter Type] und wählen Sie [Auto] aus der Liste aus.

Tipp
Sie können den gleichen Vorgang durchführen, indem Sie im Kameramenü die Einstellung [Shooting] > [Auto Exposure] > [Auto Shutter]
auf [On] setzen.

Es ist ebenfalls möglich, die Funktion [Auto Shutter] einer belegbaren Taste zuzuweisen.

2
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Manuelle Anpassung der Verschlusszeit

Sie können die Verschlusszeit manuell anpassen.
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Drücken Sie die Taste [Shutter] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Shutter] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Shutter wird angezeigt.

1

Drücken Sie die Taste [Shutter Type] und wählen Sie [Speed] aus der Liste aus.2

Passen Sie die Verschlusszeit mithilfe des Schiebereglers [Speed] oder den [Speed]-Anpassungstasten an.

Um die Belichtungszeit dem Einzelbildintervall anzupassen, wählen Sie in Schritt 2 [Off]. Sie können außerdem mithilfe von [ECS]
(Frequenz) einen festen Wert einstellen oder ihn mithilfe von [Auto] automatisch anpassen.
Beispiel: Einstellen mithilfe von [ECS] (Frequenz)

Tipp
Der Schieberegler und die Anpassungstasten sind miteinander verknüpft.

Um [Angle] anstelle von [Speed] oder [Off] zu verwenden, setzen Sie im Kameramenü die Einstellung [Shooting] > [Shutter] > [Mode] auf
[Angle].

3
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Informationen zum ND-Filter

In Umgebungen mit zu hoher Lichteinstrahlung kann die passende Helligkeit durch Auswechseln des ND-Filters eingestellt werden.
Bei der Aufzeichnung hell ausgeleuchteter Motive kann eine zu kleine Blende unter Umständen zu Beugungsunschärfe führen,
wodurch ein unscharfes Bild erzeugt wird (typische Erscheinung bei Kameras). Sie können diesen Effekt mit dem ND-Filter
unterdrücken, um bessere Aufnahmen zu erzielen.
Das Gerät verfügt über die folgenden ND-Filtermodi.
Voreinstellungsmodus

Siehe „Einstellung im Voreinstellungsmodus“.

Variabler Modus (automatische Einstellung)

Siehe „Automatische Einstellung im variablen Modus“.

Variabler Modus (manuelle Einstellung)

Siehe „Manuelle Einstellung im variablen Modus“.

Verwandtes Thema
Einstellung im Voreinstellungsmodus

Automatische Einstellung im variablen Modus
Manuelle Einstellung im variablen Modus

5-041-957-64(1) Copyright 2022 Sony Corporation
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Einstellung im Voreinstellungsmodus

Sie können für den ND-Filter drei Durchlässigkeitswerte vorauswählen und während der Aufnahme schnell zwischen diesen wechseln.

Tipp
Wenn eine belegbare Taste gedrückt wird, der [ND Filter Position] zugewiesen wurde, wechselt der ND-Filter in der Reihenfolge [Clear] →
[Preset1] → [Preset2] → [Preset3] → [Clear].
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Setzen Sie im Kameramenü die Einstellung [Shooting] > [ND Filter] > [Mode] auf [Preset].1

Drücken Sie die Taste [ND Filter] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [ND Filter] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der ND Filter wird angezeigt.

2

Drücken Sie die Taste [ND Filter] und wählen Sie eine der folgenden Optionen aus der Liste aus.

[Clear]: Kein ND-Filter.
[Preset1]: Die mithilfe von [Shooting] > [ND Filter] > [Preset1] im Kameramenü eingestellte Durchlässigkeit.
[Preset2]: Die mithilfe von [Shooting] > [ND Filter] > [Preset2] im Kameramenü eingestellte Durchlässigkeit.
[Preset3]: Die mithilfe von [Shooting] > [ND Filter] > [Preset3] im Kameramenü eingestellte Durchlässigkeit.

Wenn für den ND-Filter eine der Einstellungen [Preset1] bis [Preset3] ausgewählt wird, so wird der Durchlässigkeitswert neben
dem Namen des ND-Filters angezeigt.

3
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Automatische Einstellung im variablen Modus

Sie können die Belichtungsautomatik unter Verwendung des ND-Filters aktivieren.

Hinweis
Wenn während der Aufnahme der ND-Filter auf die oder aus der Position [Clear] geschaltet wird, wird der ND-Filterrahmen im Bild angezeigt und
es ist ein Betriebsgeräusch hörbar.

Tipp
Sie können auch einer belegbaren Taste die Funktion [Auto ND Filter] zuweisen und die Taste drücken, um zwischen [Auto] und [Manual]
umzuschalten.
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Setzen Sie im Kameramenü die Einstellung [Shooting] > [ND Filter] > [Mode] auf [Variable].1

Drücken Sie die Taste [ND Filter] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [ND Filter] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der ND Filter wird angezeigt.

2

Drücken Sie die Taste [ND Filter] und wählen Sie [Auto] aus der Liste aus.

Der automatisch angepasste Durchlässigkeitswert des ND-Filters wird neben der Taste [ND Filter] angezeigt.

3
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Manuelle Einstellung im variablen Modus

Sie können die manuelle Belichtungsanpassung unter Verwendung des ND-Filters durchführen.

Vorübergehend automatisch anpassen
Sie können die Funktion [Push Auto ND] auch einer belegbaren Taste zuweisen und den automatischen ND-Filter zeitweise aktivieren,
indem Sie die Taste gedrückt halten. Beim Loslassen der Taste wird der automatische ND-Filter wieder deaktiviert.
Setzen Sie den ND-Filter auf [Manual].

Hinweis
Wenn während der Aufnahme der ND-Filter auf die oder aus der Position [Clear] geschaltet wird, wird der ND-Filterrahmen im Bild angezeigt und
es ist ein Betriebsgeräusch hörbar.

Tipp
Sie können auch einer belegbaren Taste die Funktion [ND Filter Position] zuweisen und die Taste drücken, um zwischen [Manual] und [Clear]
umzuschalten.

Setzen Sie im Kameramenü die Einstellung [Shooting] > [ND Filter] > [Mode] auf [Variable].1

Drücken Sie die Taste [ND Filter] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [ND Filter] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der ND Filter wird angezeigt.

2

Drücken Sie die Taste [ND Filter] und wählen Sie [Manual] aus der Liste aus.3

Passen Sie mithilfe des Schiebereglers [ND Filter] oder der [ND Filter]-Anpassungstasten die Durchlässigkeit des ND-
Filters an.

Tipp
Der Schieberegler und die Anpassungstasten sind miteinander verknüpft.

Sie können den ND-Filter auch auf der Registerkarte  (Main) im Kamerasteuerbereich anpassen.

4
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Sie können auch die Taste [Push Auto] im Bereich zur Anpassung der ND Filter drücken, um den automatischen ND-Filter zu aktivieren, während
die Taste gedrückt gehalten wird.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Bildschirm für die Anpassung des Weißabgleichs

Sie können den Weißabgleich mithilfe des Live-Betriebsbildschirms der Web-App anpassen, um einen Weißabgleich zu erzielen, durch
den das Bild natürlicher wirkt.
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Bereich für grundlegende Kamerakonfiguration1.

Bereich für die Anpassung der Grundfunktionen der Kamera
Zeigt den Bereich zur Anpassung des Einrichtungselements an, das im Bereich für grundlegende Kamerakonfiguration ausgewählt
wurde.

2.
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Automatischer Weißabgleich

Sie können jederzeit einen geeignet angepassten Weißabgleich erzielen, indem Sie ATW verwenden (Auto Tracking White Balance,
automatisch nachgeführter Weißabgleich).
Bei aktiviertem ATW wird der Weißabgleich automatisch angepasst, wenn sich die Farbtemperatur der Lichtquelle ändert.

Hinweis
ATW kann nicht verwendet werden, wenn [Shooting Mode] auf [Cine EI] oder [Cine EI Quick] eingestellt ist.

Abhängig von den Lichtverhältnissen und dem Motiv kann die Farbe möglicherweise nicht per ATW angepasst werden.
Beispiele:

Das Motiv wird von einer Farbe dominiert, z. B. Himmel, Meer, Erdboden oder Blumen.
Die Farbtemperatur ist extrem hoch bzw. extrem niedrig.

Falls die ATW-Nachführgeschwindigkeit gering ist oder der gewünschte Effekt nicht erzielt werden kann, drücken Sie die Taste [WB SET], um den
automatischen Weißabgleich durchzuführen.

Tipp
Im ATW-Modus kann die Anpassungsgeschwindigkeit über die Funktion [Shooting] > [White Setting] > [ATW Speed] im Kameramenü aus fünf
Stufen (1, 2, 3, 4, 5) ausgewählt werden. Je geringer die Ziffer, desto höher ist die Anpassungsgeschwindigkeit.

Sie können die aktuelle Einstellung für den Weißabgleich festhalten, indem Sie einer belegbaren Taste die Funktion [ATW Hold] zuweisen und
diese Taste drücken, um ATW im ATW-Modus vorübergehend zu unterbrechen.
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Drücken Sie die Taste [White Balance] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [White Balance] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der White Balance wird angezeigt.

1

Drücken Sie die Taste [White Mode] und wählen Sie [ATW] aus der Liste aus.2
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Manueller Weißabgleich

Sie können den Weißabgleich manuell anpassen.

Drücken Sie die Taste [White Balance] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [White Balance] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der White Balance wird angezeigt.

1

Drücken Sie die Taste [White Mode] und wählen Sie eine der folgenden Optionen aus der Liste aus.

[Memory A (T/T)]

[Memory A (R/B)]

[Preset]

2

Passen Sie mithilfe der Schieberegler oder der Anpassungstasten den Weißabgleich an.

Tipp
Der Schieberegler und die Anpassungstasten sind miteinander verknüpft.

Der Unterschied zwischen [Memory A (T/T)] und [Memory A (R/B)] besteht darin, dass sich die Anpassungsachse unterscheidet, die
Anpassungsergebnisse jedoch miteinander verknüpft sind.

Für [Memory A (T/T)]
In diesem Modus wird der in Speicher A abgelegte Weißabgleich angepasst, indem die Farbtemperatur (Temp) und Tint
angepasst werden.
Sie können die Farbtemperatur im Bereich von 2000 K bis 5600 K in Schritten von 20 K einstellen. Werte oberhalb von 5600 K
können in Intervallen eingestellt werden, die der Farbänderung (Mired) von 5580 K bis 5600 K entsprechen.
Indem Sie die Taste [Reset] auf der rechten Seite von [Temp] oder [Tint] drücken, stellen Sie den Standardwert für die
entsprechende Einstellung wieder her.
Für [Memory A (R/B)]
In diesem Modus wird der in Speicher A abgelegte Weißabgleich angepasst, indem R Gain und B Gain angepasst werden.
Wenn Sie die Taste [Reset] drücken, wird die entsprechende Verstärkungseinstellung auf den Standardwert zurückgesetzt.
Für [Preset]

3
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In diesem Modus wird die Farbtemperatur auf einen voreingestellten Wert gesetzt.
Sie können den Wert in Schritten von 100 K einstellen.
Im Voreinstellungsmodus können Sie auch einer belegbaren Taste die Funktion [Preset White Select] zuweisen und zum Wechsel
zu einem vorkonfigurierten Voreinstellungswert die Taste drücken.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Ausführen des automatischen Weißabgleichs

Im Speichermodus A wird der zu speichernde Weißabgleich automatisch eingestellt.

Drücken Sie die Taste [White Balance] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [White Balance] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der White Balance wird angezeigt.

1

Drücken Sie die Taste [White Mode] und wählen Sie [Memory A (T/T)] oder [Memory A (R/B)] aus der Liste aus.

[Memory A (T/T)]

[Memory A (R/B)]

2

Platzieren Sie einen Bogen weißes Papier (oder ein anderes Objekt) an einen Ort mit derselben Lichtquelle und
denselben Lichtbedingungen wie das Motiv, und zoomen Sie dann das Papier heran, um den weißen Bereich auf dem
Bildschirm anzuzeigen.

3

Passen Sie die Helligkeit an.

Passen Sie die Blende wie unter „Manuelles Anpassen der Blende“ beschrieben an.

4

Drücken Sie im Bereich zur Anpassung des Weißabgleichs die Taste [WB SET].

[Memory A (T/T)]

[Memory A (R/B)]

5
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Hinweis
Wenn die Anpassung nicht erfolgreich ist, wird ca. drei Sekunden lang eine Fehlermeldung auf dem Bildschirm angezeigt. Kehrt die
Fehlermeldung auch nach wiederholten Versuchen zum Anpassen des Weißabgleichs zurück, wenden Sie sich an die zuständige Sony
Kundendienstvertretung.

Tipp
Sie können ihn auch im ATW-Modus ausführen. Verwenden Sie diese Möglichkeit, wenn Sie den Weißabgleich im ATW-Betrieb schnell anpassen
möchten. Nach der Anpassung wechselt der Modus zum normalen ATW-Betrieb.

Verwandtes Thema
Manuelles Anpassen der Blende
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Wenn sich der automatische Weißabgleich im Speichermodus befindet, wird das Ergebnis der automatischen Anpassung im
Speicher A gespeichert.
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Bildschirm zur Audiokonfiguration

Sie können den Pegel des vom Gerät aufzuzeichnenden Audiosignals auf dem Live-Betriebsbildschirm der Web-App anpassen.
Konfigurieren Sie die Schalter am Anschlussblock des Geräts und die Audioeinstellungen im Kameramenü oder im Webmenü.

5-041-957-64(1) Copyright 2022 Sony Corporation

Kamerasteuerbereich – Registerkarte  (Audio)1.
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Wählen des Audioeingangsgeräts

Stellen Sie die folgenden Schalter gemäß dem Gerät ein, das mit dem AUDIO IN-Anschluss verbunden ist.

Hinweis

In den Modi „Interval Rec“ und „Slow & Quick Motion“ wird kein Ton aufgezeichnet.

5-041-957-64(1) Copyright 2022 Sony Corporation

Wenn ein Mikrofon angeschlossen ist, stellen Sie den SETUP-Schalter 2 am Anschlussblock auf der Rückseite des
Geräts ein.

CH-1 und CH-2 besitzen gemeinsame Einstellungen.

1

Einstellung Beschreibung

OFF
(Standard)

Wählen Sie diese Einstellung aus, wenn Sie ein dynamisches oder batteriebetriebenes Mikrofon verwenden.
Dadurch werden die Phantomspeisung mit +48 V deaktiviert und der Eingang LINE oder MIC als Audioquelle
für CH-1 und CH-2 festgelegt.

ON
Wählen Sie diese Einstellung aus, wenn Sie ein mit einer Phantomspeisung mit +48 V kompatibles Mikrofon
verwenden. Dadurch werden die Phantomspeisung mit +48 V aktiviert und das mit der Phantomspeisung
kompatible Mikrofon als Audioquelle für CH-1 und CH-2 festgelegt.

Legen Sie den Typ des angeschlossenen Geräts mithilfe von [Audio] > [Audio Input] > [AUDIO IN Select] im
Kameramenü fest.

2

Wählen Sie im Webmenü oder Kameramenü mithilfe der Einstellung [Audio] > [Audio Input] > [CH1 Input Select] bis
[CH4 Input Select] den Audioeingang aus.

3
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Automatische Einstellung des Audioaufzeichnungspegels

Stellen Sie den Kanal, für den Sie den Audioaufzeichnungspegel automatisch einstellen möchten, auf der Seite [Audio] des Webmenüs
oder im Kameramenü mithilfe von [Audio] > [Audio Input] > [CH1 Level Control] bis [CH4 Level Control] auf [Auto].
Die für automatische Einstellung angegebenen Kanäle sind durch das Symbol  (Auto) neben dem entsprechenden Kanal auf der
Registerkarte  (Audio) des Live-Betriebsbildschirms gekennzeichnet.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Manuelle Einstellung des Audioaufzeichnungspegels

Sie können den Audioaufzeichnungspegel manuell einstellen.
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Stellen Sie den Kanal, für den Sie den Audioaufzeichnungspegel manuell einstellen möchten, auf der Seite [Audio] des
Webmenüs oder im Kameramenü mithilfe von [Audio] > [Audio Input] > [CH1 Level Control] bis [CH4 Level Control] auf
[Manual].

1

Drücken Sie im Kamerasteuerbereich auf die Registerkarte  (Audio).2

Legen Sie den Audioaufzeichnungspegel auf dem Bildschirm [Audio] im Kamerasteuerbereich manuelle mithilfe des
Schiebereglers oder der Anpassungstasten für den gewünschten Kanal fest.

Hinweis
Kanäle, für die das Symbol  (Auto) angezeigt wird, werden automatisch angepasst. Änderungen der Werte mithilfe des Schiebereglers
oder der Tasten werden nicht auf den aufgezeichneten Ton angewendet.

Tipp

Der Schieberegler und die Anpassungstasten in jeder Zeile sind miteinander verknüpft.

Sie können den Audioeingangspegel mithilfe der Audiopegelanzeige auf dem Aufnahmebildschirm in Echtzeit prüfen.

3
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Verwenden des Direktmenüs

Sie können den Status und die Einstellungen des Geräts dem Kamerabild überlagert prüfen sowie mithilfe der GUI-Steuertasten auf
der Infrarot-Fernbedienung Einstellungen auswählen und ändern.
Die folgenden Optionen können konfiguriert werden.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-Wert
[Auto Iris]
[Iris]-Wert
[AGC]
[Gain]-Wert
[ISO]-Wert
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-Wert
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] und [Frame Rate]

Tipp
Sie können die gleiche Funktion auch mithilfe einer belegbaren Taste und dem GUI-Steuerbereich der Web-App ausführen.
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Drücken Sie auf der Infrarot-Fernbedienung eine belegbare Taste, der [Direct Menu] zugewiesen ist.

Werkseitig ist der belegbaren Taste 1 die Funktion [Direct Menu] zugewiesen.
Es sind nur jene Optionen mit dem orangefarbenen Cursor auswählbar, die mit dem Direktmenü konfiguriert werden können.

1

Bewegen Sie mithilfe der Pfeiltasten im GUI-Steuerbereich den Cursor auf den einzustellenden Menüpunkt und drücken
Sie die Taste [Set].

Es wird entweder ein Menü angezeigt oder der Menüpunkt auf weißem Hintergrund angezeigt.

2

Wählen Sie mithilfe der Pfeiltasten eine Einstellung und drücken Sie die Taste [Set].

Das Menü oder der weiße Hintergrund wird ausgeblendet und die neue Einstellung wird mit orangefarbenem Cursor angezeigt.
Drücken Sie die mit der Direktmenü-Funktion belegte belegbare Taste erneut oder nehmen Sie drei Sekunden lang keine
Einstellung vor, um das Direktmenü zu verlassen.

3
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Belegbare Tasten

In der Web-App des Geräts gibt es zehn belegbare Tasten, denen Sie Funktionen zuweisen können.
Die belegbaren Tasten werden auf dem Live-Betriebsbildschirm und dem Wiedergabe-Betriebsbildschirm angezeigt.

Hinweis

Die Liste der belegbaren Tasten wird nicht beim Konfigurieren von Einstellungen im Bereich für grundlegende Kamerakonfiguration des Live-
Betriebsbildschirms angezeigt. Um den Vorgang zu beenden, drücken Sie die Taste [X] oben rechts im Einstellbereich.

Werkseitig sind den Tasten die folgenden Funktionen zugewiesen.
Taste 1: [Direct Menu]
Taste 2: [Focus Setting]
Taste 3: [Rec Review]

Tasten 1 bis 3 entsprechen den Tasten mit gleicher Ziffer auf der mitgelieferten Infrarot-Fernbedienung.

Taste 4: [Push Auto ND]
Taste 5: [Crop Select]
Taste 6: [Marker]
Taste 7: [Video Signal Monitor]
Taste 8: [Clip Flag OK]
Taste 9: [Color Bars]
Taste Focus Hold: [Focus Hold]

Die Taste Focus Hold ist funktionsidentisch mit der Taste „Focus Hold“ an Objektiven mit E-Bajonett.

Ändern der Tastenfunktion
Verwenden Sie [Project] > [Assignable Button] im Kameramenü.
Wenn Sie eine Zuweisung ändern, so ändert sich die Anzeige der Liste mit den belegbaren Tasten.
Einzelheiten zu zuweisbaren Funktionen siehe „Assignable Button“ unter „Kameramenü und detaillierte Einstellungen“.

Verwandtes Thema
Assignable Button
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Zeitlupe & Zeitraffer

Wenn das Aufzeichnungsformat auf einen der folgenden Werte gestellt ist, können Sie andere Werte für die Aufnahme- und
Wiedergabebildrate festlegen.
In der folgenden Tabelle sind die konfigurierbaren Bildraten aufgeführt.

Systemfrequenz: 59.94/50/29.97/25/23.98, Bildsensor-Abtastmodus: FF

Systemfrequenz: 59.94/50/29.97/25/23.98, Bildsensor-Abtastmodus: S35

Systemfrequenz: 24, Bildsensor-Abtastmodus: FF

Hinweis
Zeitlupe & Zeitraffer können nicht während der Aufzeichnung, Wiedergabe oder Miniaturbildanzeige festgelegt werden.

Im Zeitlupen- & Zeitraffermodus ist keine Audioaufnahme möglich.

Im Zeitlupen- & Zeitraffermodus ist die Blenden- und Verschlussautomatik deaktiviert.

Im Zeitlupen- & Zeitraffermodus unterliegt der Autofokus den folgenden Einschränkungen.

Einschränkungen aufgrund von Objektivmodell, Systemfrequenz und Aufnahmebildrate

Codec Videoformat konfigurierbare Bildraten

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Videoformat konfigurierbare Bildraten

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Videoformat konfigurierbare Bildraten

XAVC-I 4096×2160P 1–60

Sony-Objektiv Systemfrequenz AF-Verfügbarkeit

Andere als SEL16F28 – 7 fps oder mehr unterstützt

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps unterstützt

50,00/25,00 25, 50, 100, 200 fps unterstützt

24.00 Nicht unterstützt
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Wenn die Blende auf F18 oder höher eingestellt ist, wird die Autofokusfunktion vorübergehend deaktiviert.

Einzelheiten zur Verwendung der RAW-Ausgabe siehe „Aufnehmen von RAW-Video“.

Verwandtes Thema
Aufnehmen von RAW-Video
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Intermittierende Videoaufzeichnung (Interval Rec)

Die Funktion „Interval Rec“ ermöglicht die intermittierende Aufzeichnung von Videos im internen Speicher des Geräts. Diese Funktion
ist besonders gut zur Aufnahme von sich langsam bewegenden Motiven geeignet.
Wenn Sie mit der Aufzeichnung beginnen, zeichnet das Gerät automatisch eine festgelegte Anzahl von Einzelbildern (Number of
Frames) im festgelegten Zeitintervall auf (Interval Time).

A: Aufnahmeintervall (Interval Time)
B: Anzahl Einzelbilder einer Einstellung (Number of Frames)

Hinweis
Es kann gleichzeitig nur eine Spezial-Aufzeichnungsfunktion, z. B. Aufzeichnung im Modus „Interval Rec“, verwendet werden.

Wenn eine andere Spezial-Aufzeichnungsfunktion aktiviert wird, während „Interval Rec“ verwendet wird, wird „Interval Rec“ automatisch
deaktiviert.

Beim Ändern von Systemeinstellungen wie z. B. dem Videoformat wird der Modus „Interval Rec“ automatisch deaktiviert.

Einstellungen für Interval Rec können nicht während der Aufzeichnung, Wiedergabe oder Miniaturbildanzeige geändert werden.

Beschränkungen während der Aufzeichnung
Es wird kein Ton aufgezeichnet.
Das Prüfen der Aufnahme (Rec Review) ist nicht möglich.

Wenn das Gerät während der Aufnahme ausgeschaltet wird
Wenn die Stromversorgung des Geräts auf Bereitschaft gestellt wird, wird noch einige Sekunden lang auf das Medium zugegriffen,
um die bis zu diesem Moment im Speicher abgelegten Bilder aufzuzeichnen. Dann wechselt das Gerät automatisch in den
Bereitschaftszustand.
Wenn das DC-Netzkabel getrennt wird, die Stromversorgung des Netzteils ausgeschaltet wird oder die Stromversorgung über
PoE++ getrennt wird, können die bis zu diesem Zeitpunkt getätigten Aufnahmen verloren gehen (max. 10 Sekunden). Gehen Sie
umsichtig vor.

Anzahl Einzelbilder und Intervall zwischen den Aufnahmen festlegen

Setzen Sie im Webmenü die Einstellung [Project] > [Interval Rec] > [Setting] auf [On] und legen Sie [Number of Frames] und [Interval
Time] fest.
Das Gerät verlässt den Modus „Interval Rec“ beim Ausschalten; die Einstellungen für [Number of Frames] und [Interval Time] bleiben
jedoch erhalten. Wenn Sie den Modus „Interval Rec“ das nächste Mal verwenden, müssen Sie diese nicht erneut einstellen.

Tipp
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Dies kann auch im Kameramenü mithilfe von [Project] > [Interval Rec] festgelegt werden.

Starten der Aufzeichnung

Drücken Sie die Aufnahmetaste START/STOP, um mit der Aufzeichnung zu beginnen. Es werden abwechselnd „Int●Rec“ und
„Int●Stby“ angezeigt.

Stoppen der Aufzeichnung

Beenden Sie die Aufzeichnung.
Wenn die Aufnahme endet, werden die bis zu diesem Zeitpunkt im Speicher abgelegten Videodaten auf das Medium geschrieben.
Um den Modus „Interval Rec“ zu beenden, führen Sie eine der folgenden Handlungen aus.

Schalten Sie die Stromversorgung des Geräts in Bereitschaft.
Setzen Sie im Aufnahmebereitschaftsmodus die Einstellung [Project] > [Interval Rec] > [Setting] auf [Off].

Der Modus „Interval Rec“ wird außerdem automatisch deaktiviert, wenn das Gerät neu gestartet wird.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Aufzeichnen gepufferter Bilder (Picture Cache Rec)

Mithilfe der Funktion „Picture Cache Rec“ können Videos bereits einige Sekunden vor dem Betätigen einer Aufzeichnungsstarttaste
gespeichert werden, indem für einen bestimmten Zeitraum ein interner Pufferspeicher verwendet wird.

Festlegen der Puffergröße

Setzen Sie im Webmenü die Einstellung [Project] > [Picture Cache Rec] > [Setting] auf [On] und legen Sie unter [Cache Size] die
Puffergröße fest.

Hinweis
„Picture Cache Rec“ kann nicht zusammen mit „Interval Rec“, Simultanaufzeichnung in 2 Einschüben oder Proxy-Aufzeichnung verwendet
werden. Wenn „Picture Cache Rec“ auf On gesetzt wird, werden die anderen Spezialaufnahmemodi zwangsweise auf Off gesetzt.

Während der Aufzeichnung oder während der Funktion „Rec Review“ kann der Modus „Picture Cache Rec“ nicht gewählt werden.

Wenn „Picture Cache Rec“ auf On gesetzt ist, wird auch bei Einstellung auf [Regen] oder [Rec Run] der Zeitcode im Modus [Free Run]
aufgezeichnet.

Die Einstellung [Output Format] ist möglicherweise im Modus „Picture Cache Rec“ nicht konfigurierbar. Setzen Sie in diesem Fall „Picture Cache
Rec“ vorübergehend auf Off und ändern Sie dann die Einstellung.

Tipp
Je nach Aufnahmeformat kann die Pufferzeit kürzer sein. Prüfen Sie die im Webmenü unter [Project] > [Picture Cache Rec] > [Cache Rec Time]
angezeigte Zeit.

Dies kann auch im Kameramenü mithilfe von [Project] > [Picture Cache Rec] festgelegt werden.

Sie können [Picture Cache Rec] auch mithilfe einer belegbaren Taste zwischen On und Off umschalten.

Starten von „Picture Cache Rec“

Wenn [Picture Cache Rec] auf On gesetzt ist, wird „●Cache“ (● ist grün) angezeigt.
Beim Drücken der Aufnahmetaste START/STOP beginnt die Aufzeichnung, und das Videosignal (inklusive der im Pufferspeicher
gespeicherten Daten) wird auf Speicherkarten geschrieben.

Hinweis

Bei einer Änderung des Aufzeichnungsformats oder des grundlegenden Looks wird das bis zu diesem Zeitpunkt aufgezeichnete Video im
Pufferspeicher gelöscht, und es wird ein neues Video gepuffert. In dem Fall können Bilder, die vor der Formatänderung im Puffer gespeichert
wurden, nicht aufgezeichnet werden, selbst wenn Sie die Aufzeichnung direkt nach der Formatänderung starten.

Wenn „Picture Cache Rec“ unmittelbar nach dem Einlegen einer Speicherkarte auf „On“ oder „Off“ gesetzt wird, werden Pufferdaten
möglicherweise nicht auf der Karte gespeichert.

Videoaufnahmen werden im Pufferspeicher gespeichert, wenn die Funktion „Picture Cache Rec“ auf On gesetzt ist. Videoaufnahmen, die
aufgezeichnet wurden, ehe die Funktion auf On gesetzt wurde, werden nicht gepuffert.

Während des Zugriffs auf eine Speicherkarte, z. B. während der Wiedergabe, Überprüfung der Aufnahme oder Miniaturbildanzeige, werden keine
Videoaufnahmen im Pufferspeicher gespeichert. Während dieser Zeit ist die Bildpuffer-Aufzeichnung von Videoaufnahmen nicht möglich.

Einstellung [Cache Size] Pufferzeit (ca.)

[Short] 5 Sekunden

[Medium] 10 Sekunden

[Long] 20 Sekunden

[Max] Maximalwert für jedes Aufnahmeformat
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Abbrechen von „Picture Cache Rec“

Setzen Sie [Project] > [Picture Cache Rec] > [Setting] im Webmenü auf [Off] oder drücken Sie die belegbare Taste, der die Funktion
[Picture Cache Rec] zugewiesen ist.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Gleichzeitige Aufnahme auf Speicherkarten A und B (2-slot Simul Rec)

Sie können gleichzeitig auf Speicherkarte A und Speicherkarte B aufzeichnen, indem Sie [Project] > [Simul Rec] > [Setting] im
Webmenü oder Kameramenü auf [On] setzen.

Auf Speicherkarte A und Speicherkarte B separat aufzeichnen

Sie können die Aufzeichnung auf die verschiedenen Speicherkarten einzeln starten bzw. anhalten. Drücken Sie dazu die
Aufnahmetaste START/STOP oder die Taste [2nd Rec START/STOP] auf der Registerkarte  (Others).
Standardmäßig sind beide Tasten so eingerichtet, dass die simultane Aufzeichnung auf beiden Karten gestartet bzw. angehalten wird.
Wenn die Tasten für die Aufnahme auf verschiedenen Speicherkarten eingerichtet sind, folgt die Steuerung des Aufnahmestarts/-
stopps mittels [SDI/HDMI Rec Control] dem Aufzeichnungsstatus von Einschub A.

Ändern der Einstellung

Legen Sie mithilfe von [Project] > [Simul Rec] > [Rec Button Set] im Kameramenü Folgendes fest.
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Einstellung [Rec
Button Set] Tasten und Speicherkarten

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Durch Drücken einer dieser Tasten wird die simultane Auszeichnung auf Speicherkarte A und Speicherkarte
B gestartet bzw. angehalten.

Rec Button:<Slot A>
2nd Rec Button:
<Slot B>

Durch Drücken der Aufnahmetaste START/STOP wird die Aufzeichnung auf Speicherkarte A gestartet bzw.
angehalten. Durch Drücken der Taste [2nd Rec START/STOP] auf der Registerkarte  (Others) beginnt
bzw. endet die Aufzeichnung auf Speicherkarte B.

Rec Button:<Slot
B>
2nd Rec Button:
<Slot A>

Durch Drücken der Aufnahmetaste START/STOP wird die Aufzeichnung auf Speicherkarte B gestartet bzw.
angehalten. Durch Drücken der Taste [2nd Rec START/STOP] auf der Registerkarte  (Others) beginnt
bzw. endet die Aufzeichnung auf Speicherkarte A.
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Videosignalmonitor

Sie können den Typ des im Kamerabildbereich anzuzeigenden Videosignals über [Monitoring] > [Video Signal Monitor] > [Setting] im
Kameramenü auf Wellenform, Vektorskop oder Histogramm festlegen.
Die orangefarbene Linie zeigt die eingestellten Werte von [Level Marker 1] und [Level Marker 2] an.
Es ist ebenfalls möglich, die Funktion [Video Signal Monitor] einer belegbaren Taste zuzuweisen.

Zielanzeige der Prüfung
Im Log-Aufnahmemodi wird die Farbbereicheinstellung oder die Monitor LUT-Einstellung oben rechts im Videosignalmonitor angezeigt,
um das Monitorziel zu kennzeichnen.
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Clipkennzeichnungen

Sie können einem Clip die Kennzeichnung [OK] hinzufügen, indem Sie eine belegbare Taste drücken, der die Funktion [Clip Flag OK]
zugewiesen wurde, und dann [Add OK] auswählen.
[OK]-Clipkennzeichnungen löschen Sie, indem Sie die Taste zwei Mal drücken und [Delete Clip Flag] auswählen.

Tipp
Clipkennzeichnungen können Sie auch mithilfe von [Thumbnail] > [Set Clip Flag] im Kameramenü hinzufügen.

Die Miniaturbildanzeige kann nach Clipkennzeichnungstyp sortiert angezeigt werden (gefilterte Clip-Miniaturbildanzeige). Einzelheiten siehe
„Vorgänge mit aufgezeichneten Clips“ unter „Miniaturbildanzeige“.

Verwandtes Thema
Vorgänge mit aufgezeichneten Clips
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Kompensation des Fokuspumpens

Mithilfe von [Technical] > [Lens] > [Breathing Compensation] im Kameramenü können Sie festlegen, ob das Fokuspumpen des
Objektivs kompensiert werden soll.
Diese Funktion korrigiert das Phänomen, dass Bildwinkeländerungen bei Variation der Fokusposition auftreten.
Wird eine Kompensation des Fokuspumpens durchgeführt, so wird ein Teil des Bilds elektronisch beschnitten, um einen konstanten
Bildwinkel beizubehalten, sodass das Pump-Phänomen nicht auftritt.

Hinweis
Wenn die Kompensation des Fokuspumpens aktiviert ist, können Bildwinkel und Bildqualität leicht schwanken.

Je nach Objektiv ist es ggf. nicht möglich, die Änderung des Bildwinkels bei aktivierter Kompensation des Fokuspumpens zu korrigieren.

Die Kompensation ist nicht möglich, wenn ein Objektiv angebracht ist, das die Kompensation des Fokuspumpens nicht unterstützt.

In den folgenden Fällen ist diese Funktion (fest) auf Off eingestellt.
Wenn im Kameramenü die Einstellung [Technical] > [Lens] > [Distortion Comp.] auf [Off] gesetzt ist
Wenn im Webmenü oder Kameramenü die Einstellung [Shooting] > [S&Q Motion] > [Setting] auf [On] gesetzt ist
Wenn im Webmenü oder Kameramenü die Einstellung [Project] > [Rec Format] > [Codec] auf [RAW] oder [RAW & XAVC-I] gesetzt ist

5-041-957-64(1) Copyright 2022 Sony Corporation
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Überblick zur Proxy-Aufzeichnung

Mithilfe dieser Funktion können Sie gleichzeitig Proxy-Daten mit niedriger Auflösung und Original-Videodaten mit hoher Auflösung
aufzeichnen.

Einzelheiten zu unterstützten Speicherkarten, zum Formatieren von Speicherkarten und zum Prüfen der verbleibenden Kapazität
siehe „Unterstützte Speicherkarten“ unter „Vorbereiten von Speicherkarten“.

Hinweis zur aufgenommenen Datei
Die Dateinamenerweiterung lautet „.mp4“.
Der Zeitcode wird ebenfalls gleichzeitig aufgezeichnet.

Speicherzielort der aufgenommenen Datei
Die aufgenommene Datei wird im folgenden Verzeichnis gespeichert.

Hinweis zum Dateinamen
Der Dateiname besteht aus dem Namen des auf die Speicherkarte aufgezeichneten Clips und der Endung „S03“.
Clipnamen: siehe [TC/Media] > [Clip Name Format] im Kameramenü.

Verwandtes Thema
Unterstützte Speicherkarten
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Aufzeichnungsmedium Ordnerpfad

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Aufnehmen eines Proxy

Sie können mit der Aufnahme beginnen, wenn die Proxy-Aufzeichnung aktiviert ist.

Beenden der Aufzeichnung
Beenden Sie die Aufzeichnung.

Festlegen des Audiokanals für Proxy-Aufzeichnung
Legen Sie mithilfe von [Project] > [Proxy Rec] > [Audio Channel] im Kameramenü den Audiokanal für die Proxydaten-Aufzeichnung
fest.
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Setzen Sie im Webmenü oder Kameramenü die Einstellung [Project] > [Proxy Rec] > [Setting] auf [On].1

Setzen Sie eine Speicherkarte in einen Einschub für CFexpress Type A/SD-Karten ein.

Führen Sie CFexpress-Karten mit dem Etikett nach oben weisend ein.
Führen Sie SD-Karten mit dem Etikett nach unten weisend ein.

Hinweis
Proxy Rec kann nicht gleichzeitig mit S&Q Motion oder Interval Rec auf On gesetzt werden. Wenn „Proxy Rec“ auf On gesetzt wird, werden
die anderen Aufzeichnungsmodi zwangsweise auf Off gesetzt.

2

Drücken Sie auf die Aufnahmetaste START/STOP.

Die Proxy-Aufzeichnung beginnt.

Hinweis
Die Integrität der Daten auf der Karte kann nicht garantiert werden, wenn während des Zugriffs auf die Speicherkarte das Gerät
ausgeschaltet oder die Karte entnommen wird.
Möglicherweise gehen alle Daten auf der Speicherkarte verloren. Stellen Sie stets sicher, dass die Zugriffsanzeige der Speicherkarte
erloschen ist, bevor Sie das Gerät ausschalten oder die Speicherkarte entfernen.

Achten Sie darauf, dass die Speicherkarte beim Einsetzen oder Entnehmen nicht herausspringt.

3

248



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Überblick zum Look

Wenn sich das Gerät im Modus Custom befindet, können Sie Anpassungen am Schwarzpegel, der Matrix und an anderen Parametern
vornehmen, um ausgehend vom grundlegenden Look einen individuellen „Look“ zu gestalten.

Sie können außerdem schnell einen anderen Look auswählen, indem Sie verschiedene Kombinationen von Einstellungen in
Szenendateien speichern.
Das Gerät verfügt über insgesamt sieben voreingestellte Looks.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Auswählen eines Looks

In diesem Thema wird beschrieben, wie Sie einen Look auswählen.

Prüfen Sie, ob im Webmenü oder Kameramenü die Einstellung [Project] > [Base Setting] > [Shooting Mode] auf [Custom]
gesetzt ist.

Tipp
Im Modus [Custom] werden die Tasten [ISO/Gain] und [Scene File] im Bereich für grundlegende Kamerakonfiguration angezeigt.

1

Drücken Sie die Taste [Scene File] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Scene File] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Scene File wird angezeigt.

2

Drücken Sie darin die Taste [Scene File] und wählen Sie in der Liste eine Szenendatei mit dem gewünschten Look aus.

Die folgenden Voreinstellungen sind werkseitig konfiguriert.

Tipp
Sie können auch mithilfe von [Paint/Look] > [Scene File] > [Recall] im Kameramenü einen Look auswählen. Einen voreingestellten Look
können Sie außerdem mithilfe von [Scene File] > [Preset Recall] erneut aufrufen.

Hinweis
Bei der Softwareversion 2.0 oder höher ist die Voreinstellung der Szenendatei 5 auf [709tone] gesetzt. Bei der Aktualisierung von der
Softwareversion vor Version 2.0 wird dies angezeigt, wenn [Maintenance] > [Reset] > [Factory Default] im Webmenü ausgeführt wird.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Szenendatei 1 [S-Cinetone] [HLG Live]

Szenendatei 2 [Standard] [HLG Natural]

Szenendatei 3 [Still] (nicht registriert)

Szenendatei 4 [ITU709] (nicht registriert)

Szenendatei 5 [709tone] (nicht registriert)

Szenendateien 6 bis 16 (nicht registriert) (nicht registriert)
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Importieren eines gewünschten grundlegenden Looks

Sie können als grundlegenden Look eine auf einem Computer oder einem anderen Gerät erstellte 3D LUT-Datei importieren. Es
können bis zu 16 Dateien importiert werden.
Dateiformat: CUBE-Datei (*.cube) für eine mithilfe von Catalyst Browse, RAW Viewer oder DaVinci Resolve* (von Blackmagic Design
Pty. Ltd.) erstellte 17- oder 33-Raster-3D LUT.

Eingangsfarbbereich/Gamma: [S-Gamut3.Cine/S-Log3] oder [S-Gamut3/S-Log3]

Anpassen bei Unterbelichtung
Falls bei Verwendung des importierten grundlegenden Looks eine Tendenz zur Unterbelichtung herrscht, wenn automatische
Belichtung ausgewählt wurde, passen Sie den Look mithilfe von [Paint/Look] > [Base Look] > [AE Level Offset] im Webmenü an.

Hinweis

Überprüft mit Resolve V9.0, V10.0 und V11.0.*

Speichern Sie die 3D LUT-Datei auf dem Gerät, auf dem die Web-App ausgeführt wird.1

Öffnen Sie [Paint/Look] > [Base Look] im Webmenü.

Es wird eine Liste mit registrierten grundlegenden Looks angezeigt.

2

Drücken Sie in der Zeile, in der Sie die Datei importieren möchten, auf die Taste [Import].

Der Dialog zur Auswahl einer Datei wird angezeigt.

3

Wählen Sie die vorbereitete 3D LUT-Datei aus.

Die importierte 3D LUT-Datei wird zum grundlegenden Look des Geräts.

4

Wählen Sie mithilfe von [Paint/Look] > [Base Look] > [Select] im Kameramenü die importierte 3D LUT-Datei aus.5

Konfigurieren Sie [Paint/Look] > [Base Look] > [Input] und [Output] im Kameramenü so, dass die Attribute mit jenen der
importierten 3D LUT-Datei übereinstimmen.

6
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Das bloße Importieren einer 3D LUT-Datei wirkt sich nicht auf das Bild aus. Laden Sie mithilfe von [Paint/Look] > [Base Look] > [Select] im
Kameramenü die importierte 3D LUT-Datei.

Falls [Input] nicht korrekt konfiguriert wurde, wird der Look nicht ordnungsgemäß erzielt.

Die Einstellungen der Menüpunkte [Input], [Output] und [AE Level Offset] werden auf den mithilfe von [Select] ausgewählten grundlegenden Look
angewendet. Wenn Sie mehrere 3D LUT-Dateien importieren, wählen Sie mithilfe von [Select] jede 3D LUT-Datei aus und konfigurieren Sie
[Input], [Output] und [AE Level Offset] individuell für jede Datei.

Die für [Input], [Output] und [AE Level Offset] konfigurierten Einstellungen werden separat für jede 3D LUT-Datei gespeichert.

Die Optionen zur Auswahl von grundlegendem Look/LUT für importierte 3D LUT-Dateien gleichen denen für die Modi [SDR(BT.709)],
[HDR(HLG)] und Log-Aufnahmemodi, jedoch werden Farbbereich- und Gamma-Umwandlung nicht wie für diese Modi durchgeführt.

3D LUT-Dateien werden nicht gelöscht, wenn [Maintenance] > [Reset] > [All Reset (except for Network Settings)] im Webmenü ausgeführt wird.

Durch ein vor der [Base Look Name]-Anzeige erscheinendes -Symbol (Fehler beim Anhängen einer 3D LUT-Datei) wird signalisiert, dass
3D LUT-Dateien nicht an Clips angehängt werden können, die in Log-Aufnahmemodi aufgezeichnet wurden. Importieren Sie die 3D LUT-Datei
erneut.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Anpassen des Looks

Sie können mithilfe der Schieberegler [Master Black], [R Black] und [B Black] im Scene File-Anpassungsbereich des Bereichs für
grundlegende Kamerakonfiguration sowie mit [Paint/Look] > [Matrix] und anderen Einrichtungselementen im Kameramenü den Look
basierend auf einem grundlegenden Look anpassen.
Verbinden Sie das Gerät mit einem Fernsehgerät oder Monitor, und passen Sie die Bildqualität an, während Sie das Bild auf dem
Fernsehgerät oder Monitor betrachten.

1: Schieberegler/Anpassungstasten für [R Black]
2: Schieberegler/Anpassungstasten für [B Black]
3: Schieberegler/Anpassungstasten für [Master Black]

Hinweis
Wenn Sie eine 3D LUT-Datei importieren und auf das Bild anwenden, wird der in der 3D LUT-Datei definierte gewünschte Look nicht erzielt,
wenn [Paint/Look] > [Matrix] und andere als die grundlegenden Look-Einstellungen im Kameramenü geändert werden.

Sie können mithilfe von [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] im Kameramenü alle benutzerdefinierten Einstellungen
zurücksetzen.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Speichern eines Looks

Den aktuellen Look können Sie mittels [Paint/Look] > [Scene File] > [Store] im Kameramenü als Szenendatei im internen Speicher
ablegen.
Sie können einen gespeicherten Look schnell über den Bereich zur Scene File-Anpassung oder mithilfe von Funktionen des
Direktmenüs abrufen.

Hinweis
Falls Sie einen anderen Look auswählen, ohne den aktuellen zu speichern, wird der aktuelle verworfen.

Tipp
Sie können die voreingestellten Szenendateien überschreiben. Um eine voreingestellte Szenendatei wiederherzustellen, laden Sie den
wiederherzustellenden Look mithilfe von [Paint/Look] > [Scene File] > [Preset Recall] im Kameramenü, und speichern Sie dann die Szenendatei
mithilfe von [Scene File] > [Store].

Löschen eines gespeicherten Looks
Eine im internen Speicher abgelegte Szenendatei können Sie mittels [Paint/Look] > [Scene File] > [Delete] im Kameramenü löschen.

Tipp

Nach dem Löschen wird sie nicht mehr im Bereich zur Scene File-Anpassung oder im Direktmenü angezeigt.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Löschen eines grundlegenden Looks

Sie können importierte 3D LUT-Dateien mithilfe von [Paint/Look] > [Base Look] > [Delete] im Kameramenü einzeln löschen.
Sie können alle importierten 3D LUT-Dateien mithilfe von [Paint/Look] > [Base Look] > [Delete All] im Kameramenü löschen.

Hinweis

Stellen Sie vor dem Löschen sicher, dass der grundlegende Look nicht in Szenendateien verwendet wird. Wenn ein in Verwendung befindlicher
grundlegender Look gelöscht wird, so ist der Look der entsprechenden Szenendateien fehlerhaft.

Importierte 3D LUT-Dateien werden nicht gelöscht, wenn [Maintenance] > [Reset] > [All Reset (except for Network Settings)] im Webmenü
ausgeführt wird.

Ein gelöschter grundlegender Look kann nicht mehr als LUT in Log-Aufnahmemodi verwendet werden.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Aufnehmen mit Look-Anpassung in der Postproduktion

Indem Sie das Gerät in Log-Aufnahmemodi*1 verwenden und Abstufungen gleichmäßig von dunklen zu hellen Bereichen aufnehmen,
können Sie feine Anpassungen vornehmen wie beispielsweise die örtliche Wiederherstellung der Abstufungen von dunklen und hellen
Bereichen in der Postproduktion.
Wenn Sie die aufgezeichneten Bilder jedoch auf einem herkömmlichen Monitor betrachten, erscheint der Gesamtkontrast gering,
wodurch Fokus- und Belichtungsanpassungen erschwert werden.
Sie können eine LUT auf das Monitorziel des Geräts anwenden, um bei der Aufnahme verschiedene Anpassungen zu unterstützen.
Sie können die bei der Aufnahme verwendete LUT auch automatisch bei der Wiedergabe anwenden, um das Endergebnis schnell zu
überprüfen.
LUTs werden von den folgenden Systemen angewendet. Es kann jedoch nur eine LUT angewendet werden.

SDI-Ausgabe
HDMI-Ausgabe und Streaming
Auf Aufnahmemedium aufgezeichneter Proxy-Clip
Auf Aufnahmemedium aufgezeichneter hochauflösender (Haupt-) Clip

5-041-957-64(1) Copyright 2022 Sony Corporation

Allgemeine Bezeichnung für die Modi Flexible ISO/Cine EI/Cine EI Quick*1
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LUT auf HDMI-Ausgabe und Streaming anwenden

Sie können eine LUT auf HDMI-Ausgabe und Streaming anwenden.

Hinweis

Das Bild im Kamerabildbereich der Web-App wird ebenfalls in das Streaming-Bild aufgenommen.

Tipp

Dies kann auch im Kameramenü mithilfe von [Shooting] > [LUT On/Off] > [HDMI/Stream] festgelegt werden.

Die SDI-Ausgabe kann auf gleiche Weise eingestellt werden.

Für Video auf Aufnahmemedien können Sie dies unter [Shooting] > [LUT On/Off] > [Internal Rec] und [Proxy] im Kameramenü festlegen.

Durch ein vor der [Base Look/LUT]-Anzeige erscheinendes -Symbol (Fehler beim Anhängen einer 3D LUT-Datei) wird signalisiert, dass
3D LUT-Dateien nicht an Clips angehängt werden können, die in Log-Aufnahmemodi aufgezeichnet wurden. Importieren Sie die 3D LUT-Datei
erneut.
Dieses Symbol wird auch angezeigt, wenn das Anhängen aufgrund von vorübergehender Überlast bei der Verarbeitung fehlschlägt.

5-041-957-64(1) Copyright 2022 Sony Corporation

Prüfen Sie, ob im Webmenü oder Kameramenü die Einstellung [Project] > [Base Setting] > [Shooting Mode] auf [Flexible
ISO], [Cine EI] oder [Cine EI Quick] gesetzt ist.

Tipp
In Log-Aufnahmemodi werden die Tasten [Base ISO/Exposure Index] und [Base Look/LUT] im Bereich für grundlegende
Kamerakonfiguration angezeigt.

1

Drücken Sie die Taste [Base Look/LUT] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Base Look/LUT] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Base Look/LUT wird angezeigt.

2

Wählen Sie [HDMI/Stream] > [MLUT] aus.3
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Ändern einer LUT

Sie können die anzuwendende LUT ändern.

Tipp

Das Gerät stellt [s709], [709(800%)] und [S-Log3] als voreingestellte LUTs bereit.

Sie können auch eine 3D LUT-Datei importieren und anwenden. Einzelheiten siehe „Importieren eines gewünschten grundlegenden Looks“ und
„Löschen eines grundlegenden Looks“.

Dies kann auch im Kameramenü mithilfe von [Paint/Look] > [Base Look] > [Select] festgelegt werden.

Verwandtes Thema
Importieren eines gewünschten grundlegenden Looks

Löschen eines grundlegenden Looks

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie die Taste [Base Look/LUT] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Base Look/LUT] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Base Look/LUT wird angezeigt.

1

Drücken Sie die Taste [Base Look/LUT] und wählen Sie den anzuwendenden grundlegenden Look aus.2
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Ändern der Verteilung dunkler und heller Bereiche im aufgezeichneten Bild

Sie können in den Aufnahmemodi Cine EI und Cine EI Quick die Verteilung dunkler und heller Bereiche ändern, wenn Sie
beispielsweise dem Ton dunkler Bereiche Vorrang gegenüber hellen Bereichen verleihen möchten. Hierzu ändern Sie die Einstellung
Exposure Index von der Basisempfindlichkeit.

Drücken Sie die Taste [Base Look/LUT] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Base Look/LUT] wechselt die Farbe zu orange.

Der Bereich zur Anpassung der Base Look/LUT wird angezeigt.

1

Wählen Sie [HDMI/Stream] > [MLUT] aus.

Eine LUT wird auf die HDMI-Ausgabe und das Streaming angewendet.

2

Drücken Sie die Taste [Base ISO/Exposure Index] im Bereich für grundlegende Kamerakonfiguration.

Der Rahmen der Taste [Base ISO/Exposure Index] wechselt die Farbe zu orange.

Der Bereich zur Anpassung von Base ISO/Exposure Index wird angezeigt.

3

Passen Sie den Belichtungsindex gemäß der gewünschten Verteilung von hellen und dunklen Bereichen mithilfe des
Schiebereglers [Exposure Index] oder der [Exposure Index]-Anpassungstasten an.

Für [Cine EI]

Für [Cine EI Quick]
Die Basisempfindlichkeit wird automatisch entsprechend des angegebenen Werts für Exposure Index festgelegt.

4
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Tipp

Dies kann auch im Kameramenü mithilfe von [Shooting] > [ISO/Gain/EI] > [Exposure Index] festgelegt werden.

Die SDI-Ausgabe kann auf gleiche Weise verwendet werden.

Der zweite numerische Wert der Einstellung gibt an, wie viele Stufen der Helligkeitsinformation hellen Bereichen zugeordnet werden (Helligkeit
größer als 18% Grau). Hellere Bereiche als diese sind überbelichtet.
Beispiel: Bei „400EI/5.0E“ werden der hellen Seite 5,0 Stufen zugeordnet.

Sie können sich daran auch orientieren, um während der Aufnahme den Ton dunkler und heller Bereiche zu prüfen. Achten Sie darauf, den
ursprünglichen EI-Wert wieder einzustellen, nachdem Sie die Belichtung geprüft haben. Achten Sie außerdem im Modus Cine EI Quick darauf,
die Basisempfindlichkeit nicht nachteilig zu beeinflussen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Passen Sie die Beleuchtung und/oder den ND-Filter so an, dass die Kamerabildausgabe von [HDMI/Stream] die
geeignete Belichtung erhält.

5
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Aufnehmen von RAW-Video

Sie können das am Anschluss SDI OUT des Geräts ausgegebene RAW-Videosignal mit einem unterstützten externen Recorder
aufzeichnen.
Die unterstützten RAW-Ausgabeformate sind nachfolgend aufgeführt.

Systemfrequenz [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Verbinden Sie einen externen RAW-Recorder mit dem Anschluss SDI OUT des Geräts.1

Setzen Sie im Webmenü oder Kameramenü die Einstellung [Project] > [Base Setting] > [Shooting Mode] auf [Cine EI],
[Cine EI Quick] oder [Flexible ISO].

2

Legen Sie den Betrachtungswinkel (FF ausschließlich) im Webmenü oder Kameramenü mithilfe der Einstellung [Project]
> [Rec Format] > [Imager Scan Mode] fest.

3

Setzen Sie im Webmenü oder Kameramenü die Einstellung [Project] > [Rec Format] > [Codec] auf [RAW].

Durch Auswahl von [RAW & XAVC-I] werden gleichzeitig ein Videosignal auf einem externen RAW-Recorder und ein Videosignal
auf die Speicherkarten im Gerät aufgezeichnet.

4

Legen Sie die Auflösung im Webmenü oder Kameramenü mithilfe der Einstellung [Project] > [Rec Format] > [RAW
Output Format] fest.

5

Stellen Sie sicher, dass der externe Recorder eingeschaltet ist und drücken Sie die Aufnahmetaste START/STOP auf dem
Live-Betriebsbildschirm.

Der RAW-Videoaufnahmestatus wird durch ein Symbol im Kamerabildbereich signalisiert.

Hinweis

6
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Hinweis

Wenn an einem externen Recorder die Aufnahme gestartet wird, ohne hierzu die Aufnahmetaste START/STOP auf dem Live-Betriebsbildschirm
zu verwenden, werden Clips möglicherweise nicht ordnungsgemäß aufgezeichnet.

5-041-957-64(1) Copyright 2022 Sony Corporation

Das Aufnahmesteuerungssignal wird am Anschluss SDI OUT des Geräts ausgegeben, der Status des externen Recorders kann jedoch
nicht abgerufen werden. Dementsprechend kann das Gerät signalisieren, dass RAW-Video aufgezeichnet wird, obwohl der externe
Recorder nicht aufzeichnet. Prüfen Sie die Anzeige am externen Recorder selbst, um seinen Betriebszustand festzustellen.
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RAW-Video im Zeitlupen- und Zeitraffermodus aufzeichnen

Sie können RAW-Video im Zeitlupen- und Zeitraffermodus aufzeichnen.

Einzelheiten zu den unterstützten Aufnahmebildraten siehe „Zeitlupe & Zeitraffer“.

Verwandtes Thema
Zeitlupe & Zeitraffer

5-041-957-64(1) Copyright 2022 Sony Corporation
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Ein/Ausschalten der Bokeh-Steuerungsfunktion

Sie können den Bokeh-Grad einfach anpassen, indem Sie den ND-Filter und die Verstärkung mit der Blendeneinstellung verknüpfen.

Ein/Ausschalten der Bokeh-Steuerungsfunktion

Diese Funktion können Sie nur aktivieren, wenn Sie die Belichtung manuell einstellen. Setzen Sie den ND-Filter auf variablen Modus,
dann Blende, Verstärkung, Verschluss und ND-Filter auf manuelle Einstellung.
Sie können die Bokeh-Steuerungsfunktion mithilfe von [Shooting] > [Iris] > [Bokeh Control] im Kameramenü ein-/ausschalten.
Wenn die Bokeh-Steuerungsfunktion auf On gesetzt ist, wird das Symbol  (B) an den Anzeigen für ND-Filter und Verstärkung
eingeblendet.

Hinweis
Diese Funktion ist nur an Objektiven mit E-Bajonett aktiviert, die mit dem Gerät kommunizieren können.

Die maximale Wirkung dieser Funktion erzielen Sie, wenn Sie ein Sony-Objektiv mit E-Bajonett verwenden.

Die Bokeh-Steuerungsfunktion wird bei den folgenden Vorgängen auf Off gesetzt.
Wenn das Gerät ausgeschaltet wird
Wenn Blende, Verstärkung, Verschluss oder ND-Filter auf Auto gesetzt wird
Wenn der Aufnahmemodus geändert wird
Wenn der ND-Filter in den Klar- oder Voreinstellungsmodus versetzt wird
Wenn das Objektiv entfernt wird
Wenn das Gerät beispielsweise nach Umschalten der Frequenz neu gestartet wird

Tipp
Sie können die Funktion [Bokeh Control] auch einer belegbaren Taste zuweisen und die Bokeh-Steuerungsfunktion über diese Taste zwischen
On und Off umschalten.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Anpassen des Bokeh-Grads

Passen Sie die Einstellungen bei Bedarf in den Schritten 2 bis 4 an.

Hinweis

Das Erscheinungsbild kann je nach Bediengeschwindigkeit, Objektiv, Aufnahmeeinstellungen und Motiv variieren; außerdem kann die Helligkeit
schwanken. Wir empfehlen dringend, vor der Aufnahme einen Kameratest durchzuführen.

Die Helligkeit kann schwanken, wenn sich die Blendenbedienrichtung ändert, beispielsweise wenn die Blende nach dem Schließen geöffnet wird
oder umgekehrt. Nehmen Sie in diesem Fall vorgreifend etwas mehr Anpassung als erforderlich vor, nehmen Sie diese dann leicht zurück, prüfen
die Helligkeit und beginnen danach mit der Aufnahme. Wenn Sie die Blende auf F8 öffnen und den Hintergrund unscharf erscheinen lassen
möchten, schließen Sie zunächst die Blende weiter als F8, kehren zu F8 zurück, prüfen die Helligkeit und beginnen dann mit der Aufnahme.

Führen Sie Bokeh-Steuerungsvorgänge langsam durch. Falls Sie die Bedienung beschleunigen müssen, versuchen Sie, die Anpassung nach
und nach vorzunehmen, während Sie die Bildänderung überprüfen.

Tipp
Wenn die Bokeh-Steuerungsfunktion auf On gesetzt ist, wirken ND-Filter und Verstärkung gemeinsam ausgleichend auf Belichtungsänderungen
aufgrund von Blendeneinstellungen, wodurch Sie den Bokeh-Grad ändern können.

Die Bokeh-Steuerung wird in Reaktion auf die Betätigung der Blende zunächst mit dem ND-Filter verknüpft. Wenn der ND-Filter nicht weiter
verändert werden kann, wird die Verstärkung hinzugezogen.

Im MF-Modus empfehlen wir, dass Sie zunächst die Blende öffnen und dann den Fokus einstellen.

Falls Sie den automatischen ND-Filter anstelle der Bokeh-Steuerungsfunktion verwenden, folgt der ND-Filter der Änderung der Motivhelligkeit.

Anzeige während der Verknüpfung mit der Verstärkung
Wenn die Bokeh-Steuerungsfunktion auf On gesetzt ist, kann sich die Verstärkung mit der Blendeneinstellung ändern.
Wenn die Verknüpfung mit der Verstärkung aktiv ist und sich die Verstärkung ändert, wird oben auf dem Bildschirm eine Meldung
angezeigt, und an der Verstärkungsanzeige blinkt das Symbol  (B).

5-041-957-64(1) Copyright 2022 Sony Corporation

Setzen Sie die Bokeh-Steuerungsfunktion auf On.1

Öffnen Sie die Blende vollständig.2

Setzen Sie den ND-Filter auf 1/128.3

Setzen Sie die Verstärkung auf 0 dB und verwenden Sie Beleuchtung, um die ordnungsgemäße Belichtung zu erzielen.4

Passen Sie den Fokus an.5

Passen Sie die Blende an.

Der Bokeh-Grad ändert sich.

6
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Überblick zum Speichern und Laden von Konfigurationsdaten

Sie können mithilfe der Web-App die Einstellungen des Geräts als Konfigurationsdaten speichern. Dadurch können Sie schnell auf
einen für die jeweilige Situation geeigneten Satz Menüeinstellungen zurückgreifen.
Bei diesem Gerät können Sie fast alle Einstellungen bezüglich Kamerafunktionen, ausgenommen der nachfolgend genannten, als
ALL-Datei (Datei mit allen Einstellungen) speichern.

Hinweis
Einstellungen der Netzwerkfunktionen sowie Authentifizierungsdaten werden nicht gespeichert. Einzelheiten zu gespeicherten Elementen siehe
„Liste der Menüelemente“.

Verwandtes Thema
Liste der Menüelemente

5-041-957-64(1) Copyright 2022 Sony Corporation
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Speichern einer ALL-Datei

In diesem Thema wird beschrieben, wie Sie eine ALL-Datei speichern.

Hinweis

Eine ALL-Datei kann während des Betriebs der PTZ-Bildausschnitt-Steuerung nicht gespeichert werden. Deaktivieren Sie die PTZ-Bildausschnitt-
Steuerung und speichern Sie dann eine ALL-Datei.

5-041-957-64(1) Copyright 2022 Sony Corporation

Öffnen Sie [Project] > [All File] im Webmenü.1

Drücken Sie die Taste [Save All File] > [Save].

Der Webbrowser lädt daraufhin eine Datei mit dem Namen all-file.ALL herunter.

2

Geben Sie für die heruntergeladene Datei all-file.ALL einen Speicherort und einen Dateinamen an, und speichern Sie die
Datei.

Einzelheiten zu Dateivorgängen finden Sie in der Bedienungsanleitung zum Ihrem Gerät.

3
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Laden einer ALL-Datei

In diesem Thema wird beschrieben, wie Sie eine ALL-Datei laden.

Hinweis

Nach dem Laden von Konfigurationsdaten startet das Gerät automatisch neu. Laden Sie nach dem Neustart die Seite im Webbrowser erneut.

Eine ALL-Datei kann während des Betriebs der PTZ-Bildausschnitt-Steuerung nicht geladen werden. Deaktivieren Sie die PTZ-Bildausschnitt-
Steuerung und laden Sie dann eine ALL-Datei.
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Öffnen Sie [Project] > [All File] im Webmenü.1

Drücken Sie die Taste [Load All File] > [Load].

Der Dialog zum Öffnen von Dateien wird auf dem Gerät angezeigt, auf dem die Web-App ausgeführt wird.

2

Öffnen Sie die zu ladende Datei.

Einzelheiten zu Dateivorgängen finden Sie in der Bedienungsanleitung zum Ihrem Gerät.

3

Wenn der Bildschirm zur Bestätigung des Ladevorgangs angezeigt wird, drücken Sie auf die Taste [OK].4

Wenn der Ergebnisbildschirm zur Ausführung angezeigt wird, drücken Sie auf die Taste [OK].5

Warten Sie, bis das Gerät neu gestartet hat, und stellen Sie dann die Verbindung mit der Web-App wieder her.6
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Informationen zur Dateiübertragung

Sie können auf dem Gerät aufgezeichnete Proxy- oder Original-Clips auf einen Server im Internet oder im lokalen Netzwerk
übertragen.

Hinweis

Wenn die Stromversorgung des Geräts in den Bereitschaftszustand versetzt wurde, werden Dateiübertragungen ausgesetzt, auch wenn das
Gerät noch mit Strom versorgt wird.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Registrieren eines Ziels für die Dateiübertragung

Sie können einen Zielserver für die Dateiübertragung registrieren, bevor Sie diese starten.

Wählen Sie [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (oder [Server Settings2], [Server
Settings3]) im Webmenü aus.

Tipp
Der Name der Auswahloption ändert sich gemäß der im nächsten Schritt unter [Display Name] konfigurierten Angabe.

1

Konfigurieren Sie die folgenden Elemente für [Network] > [FTP Server 1] bis [FTP Server 3] im Webmenü.

[Display Name]
Geben Sie einen Namen ein, der in der Übertragungsliste angezeigt werden soll, wenn ein Zielserver für die Dateiübertragung
ausgewählt wird.
[Service]
Zeigt den Servertyp an.
[FTP]: FTP-Server
[Host Name]
Geben Sie die Adresse oder den Hostnamen des Servers ein.
[Port]
Geben Sie die Portnummer des Servers ein, zu dem eine Verbindung hergestellt werden soll.
[User Name]
Geben Sie den Benutzernamen ein.
[Password]
Geben Sie das Passwort ein.
[Passive Mode]
Zum Ein-/Ausschalten des passiven Modus.
[Destination Directory]
Geben Sie den Namen des Verzeichnisses auf dem Zielserver ein.

Hinweis

Falls in [Destination Directory] Zeichen eingegeben werden, die auf dem Zielserver ungültig sind, werden die Dateien in das
Heimverzeichnis des Benutzers übertragen. Welche Zeichen ungültig sind, hängt vom Server ab.

[Using Secure Protocol]
Stellen Sie ein, ob die sichere FTP-Übertragung ausgeführt werden soll.
[Root Certificate]
Laden/löschen Sie ein Zertifikat.
[Load]: Zertifikat einer Zertifizierungsstelle laden. Lädt Zertifikate im PEM-Format.
[Clear]: Zertifikat der Zertifizierungsstelle löschen.
[None]: Kein Zertifikat laden oder löschen.

Hinweis

Stellen Sie die Uhr des Geräts auf die korrekte Zeit ein, bevor Sie ein Zertifikat einer Zertifizierungsstelle laden.

Beim Aufzeichnen in XAVC-I 4096×2160P/3840×2160P 59.94/50P kann [Load] nicht ausgewählt werden.

[Root Certificate Status]: Zeigt den Ladestatus des Zertifikats an.
[Reset]: Setzt die Einstellungen unter Server Settings auf die Standardwerte zurück.

2
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Hochladen eines Proxy-Clips auf einer Speicherkarte über die Miniaturbildanzeige

Sie können Proxy-Clips auf einer Speicherkarte einzeln über die Miniaturbildanzeige hochladen.

Hinweis
Bis zu 200 Übertragungen können registriert werden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Drücken Sie die Taste [Thumbnail] auf dem Live-Betriebsbildschirm der Web-App.

Die Anzeige wechselt vom Kamerabild zur Miniaturbildanzeige.

1

Wählen Sie [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] im Kameramenü aus.

Um alle Proxy-Clips gleichzeitig zu übertragen, wählen Sie [Transfer Clip (Proxy)] > [All Clips] aus.
Clips können von der Miniaturbildanzeige oder der gefilterten Clip-Miniaturbildanzeige übertragen werden.

2

Wählen Sie mithilfe der Taste [Set] den zu übertragenden Clip aus und drücken Sie die Taste [Menu].

Ein Bestätigungsbildschirm für die Übertragung wird angezeigt.

3

Wählen Sie [Execute] aus.

Die dem ausgewählten Clip entsprechenden Dateien werden zur Übertragung registriert und hochgeladen.
Wenn die Übertragungsaufgabe erfolgreich registriert wurde, wird der Ergebnisbildschirm angezeigt.

4

Drücken Sie die Taste [OK].5
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Hochladen eines Originalclips auf einer Speicherkarte über die Miniaturbildanzeige

Sie können einen Originalclip auf einer Speicherkarte über die Miniaturbildanzeige hochladen.

Hinweis
Bis zu 200 Übertragungen können registriert werden.
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Drücken Sie die Taste [Thumbnail] auf dem Live-Betriebsbildschirm der Web-App.

Die Anzeige wechselt vom Kamerabild zur Miniaturbildanzeige.

1

Wählen Sie [Thumbnail] > [Transfer Clip] > [Select Clip] im Kameramenü aus.

Um alle Originalclips gleichzeitig zu übertragen, wählen Sie [Transfer Clip] > [All Clips] aus.
Clips können von der Miniaturbildanzeige oder der gefilterten Clip-Miniaturbildanzeige übertragen werden.

2

Wählen Sie mithilfe der Taste [Set] den zu übertragenden Clip aus und drücken Sie die Taste [Menu].

Ein Bestätigungsbildschirm für die Übertragung wird angezeigt.

3

Wählen Sie [Execute] aus.

Die dem ausgewählten Clip entsprechenden Dateien werden zur Übertragung registriert und hochgeladen.
Wenn die Übertragungsaufgabe erfolgreich registriert wurde, wird der Ergebnisbildschirm angezeigt.

4

Drücken Sie die Taste [OK].5
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Prüfen des Dateiübertragungsstatus

Sie können den Status der Dateiübertragung prüfen, indem Sie [Network] > [File Transfer] > [View Job List] im Kameramenü
auswählen.

Hinweis

Bis zu 200 Übertragungen können registriert werden.

Die Übertragungen bleiben gespeichert, wenn das Gerät in den Bereitschaftszustand versetzt wird. Es können jedoch bis zu 10 Minuten der
aktuellen Fortschrittsinformationen verloren gehen, wenn die Stromversorgung auf andere Weise getrennt wird.

Falls während der Dateiübertragung ein Fehler auftritt, kann die Übertragung eines Clips mit dem gleichen Namen wie der übertragene ggf. je
nach Einstellungen und Status des Zielservers der Übertragung nicht fortgesetzt werden. Prüfen Sie in diesem Fall die Einstellungen und den
Status des Zielservers der Übertragung.

Tipp

Falls [Network] > [File Transfer] > [Auto Upload (Proxy)] im Kameramenü auf [On] gesetzt ist und eine Netzwerkverbindung besteht, werden
Proxy-Dateien automatisch auf den mithilfe von [Default Upload Server] angegebenen Server hochgeladen, sobald die Aufnahme endet.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Hochladen mithilfe einer sicheren FTP-Übertragung

Sie können Dateien verschlüsselt mithilfe von FTPS im Explicit-Modus (FTPES) für die Verbindung mit dem Ziel-Dateiserver
hochladen.
Um eine sichere FTP-Übertragung zu erzielen, setzen Sie [Using Secure Protocol] auf dem Ziel-Dateiserver auf [On] und laden Sie ein
Zertifikat.

Einzelheiten zur Konfiguration siehe „Registrieren eines Ziels für die Dateiübertragung“.

Verwandtes Thema
Registrieren eines Ziels für die Dateiübertragung

5-041-957-64(1) Copyright 2022 Sony Corporation
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Informationen zum Streaming

Das Gerät kann gleichzeitig das am HDMI-Anschluss ausgegebene Video- und Audiosignal per Streaming übertragen.

Hinweis

Um das Streaming als Hauptvideo zu verwenden, setzen Sie [Monitoring] > [Output Display] > [SDI] auf [On] und [HDMI/Stream] im Webmenü
auf [Off]. Überwachen Sie den Kamerastatus auf einem SDI-Monitor.

Falls ein mit dem HDMI-Anschluss verbundener Monitor das mithilfe des [Monitoring]-Menüs im Webmenü oder Kameramenü konfigurierte
HDMI-Ausgabeformat nicht unterstützt, wird das Kamerabild nicht in der Web-App angezeigt. Streaming-Video kann ebenfalls nicht ausgegeben
werden.

Für das Streaming kann keine höhere Auflösung als jene des HDMI-Ausgangssignals festgelegt werden.

Das Bild kann bei der Betrachtung durch mehrere Benutzer je nach den Codec-Einstellungen verzerrt werden.

Das Gerät unterstützt die folgenden Streaming-Methoden. Die zur Auswahl stehenden Videocodecs sind in Klammern angegeben.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurieren Sie die Einstellungen für Streaming-Format, Videocodec und Audiocodec in dieser Reihenfolge.

●: aktiviert, –: deaktiviert

Tipp

Das Bild im Kamerabildbereich der Web-App ist ebenfalls ein Streaming-System.

5-041-957-64(1) Copyright 2022 Sony Corporation

Streaming-Format
Codec-Einstellung

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web-App – – ● –

RTMP kann ausgewählt werden, wenn [Stream] > [Audio Stream] im Webmenü auf [On] gesetzt ist.*1

Wenn die Systemfrequenz 59.94 oder 50 beträgt und das HDMI-Ausgabeformat 3840×2160 oder höher ist, so ist die Ausgabe von Video 2 nicht verfügbar.*2
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Einstellen des Streaming-Formats

Legen Sie mithilfe von [Stream] > [Stream] > [Stream Setting] > [Setting] im Webmenü das Streaming-Format fest.

Wenn [Setting] auf [RTSP] gesetzt ist

Beim RTSP-Streaming kann das Bild einer einzelnen Kamera von bis zu fünf Benutzern gleichzeitig betrachtet werden.
Sie können bis zu zwei Videocodec-Modi festlegen.
[Port Number]
Legt die für das RTSP-Streaming zu verwendende Portnummer fest. Der Standardwert ist 554.
Durch Ändern der Einstellung wird der RTSP-Server neu gestartet.
[Time Out]
Legt die Dauer für die Zeitüberschreitung des „Keep Alive“-Befehls für das RTSP-Streaming fest. Die Dauer der Zeitüberschreitung
kann im Bereich von 0 bis 600 Sekunden eingestellt werden. Der Standardwert ist 60 Sekunden.
Bei Einstellung auf 0 Sekunden tritt keine Zeitüberschreitung durch den „Keep Alive“-Befehl auf.
[Authentication]
Legt fest, ob Authentifizierung erforderlich ist.
[Video Port Number 1], [Video Port Number 2]
Legt die für das RTSP-Unicast-Streaming zu verwendende Portnummer für die Bilddatenkommunikation fest. Der werkseitige
Standardwert für Video Port Number 1 ist 51000. Der werkseitige Standardwert für Video Port Number 2 ist 53000. Geben Sie eine
gerade Zahl von 1024 bis 65534 ein. Die hier angegebene Nummer und die darauffolgende ungerade Nummer werden zu den zwei für
die Bilddatenkommunikation und die Steuerung verwendeten Portnummern.
[Video Port Number 1] und [Video Port Number 2] entsprechen [Stream] > [Video Stream] > [Video Stream 1] und [Video Stream 2].
[Audio Port Number]
Legt die für das RTSP-Unicast-Streaming zu verwendende Portnummer für die Audiodatenkommunikation fest. Der Standardwert ist
57000. Geben Sie eine gerade Zahl von 1024 bis 65534 ein. Die hier angegebene Nummer und die darauffolgende ungerade Nummer
werden zu den zwei für die Audiodatenkommunikation und die Steuerung verwendeten Portnummern.

Wenn [Setting] auf [RTMP] gesetzt ist

Für RTMP kann ausschließlich der Videocodec-Modus H.264 verwendet werden. Um RTMP zu verwenden, muss [Stream] > [Audio
Stream] im Webmenü auf [On] gesetzt werden.
[Server URL]
Legt die URL des Hochladeziels fest. Geben Sie eine Zeichenfolge ein, die mit „rtmp://“ oder „rtmps://“ beginnt.
[Stream Key]
Geben Sie den Stream-Schlüssel ein, den Sie von der von Ihnen verwendeten Seite erhalten haben. Wenn Sie auf die Taste [Clear]
drücken, wird der Eintrag gelöscht.

Hinweis
Gehen Sie sorgfältig mit dem Stream-Schlüssel um. Falls der Stream-Schlüssel einer fremden Person zur Kenntnis gelangt, besteht die Gefahr
der Verfälschung des Streams.

[Root Certificate]
Importiert das für Streaming mittels RTMPS-Protokoll erforderliche Stammzertifikat. Um das Stammzertifikat zu importieren, drücken
Sie die Taste [Load] und wählen ein Stammzertifikat aus. Drücken Sie im Dialog zum Auswählen der Datei auf die Taste [OK], um die
ausgewählte Datei in das Gerät zu importieren. Falls im Gerät ein importiertes Stammzertifikat vorhanden ist, wird es aktualisiert. Um
ein importiertes Stammzertifikat zu löschen, drücken Sie auf dem Einrichtungsbildschirm auf die Taste [Delete]. Unter [Root Certificate
Status] wird der Status des Stammzertifikats angezeigt.

Hinweis
Importieren Sie das vom Streaming-Dienst benötigte Stammzertifikat.

Wenn [Setting] auf [SRT-Caller] oder [SRT-Listener] gesetzt ist

Der Videocodec-Modus ist auf H.264 beschränkt.
[Destination]
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Wird angezeigt, wenn der Streaming-Modus auf [SRT-Caller] gesetzt ist. Legt die URL des Verbindungsziels fest.
[Port Number]
Wird angezeigt, wenn der Streaming-Modus auf [SRT-Listener] gesetzt ist. Legt die Portnummer für den Empfang fest. Der
Standardwert ist 4201.
[Latency]
Legt die Latenzzeit im Bereich von 20 ms bis 8000 ms fest. Der Standardwert ist 120.
[TTL]
Legt den TTL-Wert im Bereich von 1 bis 255 fest. Der Standardwert ist 64.
[Encryption]
Wählt die Verschlüsselungsmethode aus. Wählen Sie Off, AES128 oder AES256 aus. Der Standardwert ist Off.
[Passphrase]
Legt die für die Verschlüsselung verwendete Zeichenfolge fest. Wenn Sie auf die Taste [Clear] drücken, wird die konfigurierte
Zeichenfolge gelöscht.
[ARC]
Auf On setzen, um die Funktion „Adaptive Rate Control“ zu aktivieren.
Wen die Funktion „Adaptive Rate Control“ aktiviert ist, können durch Überbelegung des Kommunikationskanals bedingte
Bildunterbrechungen reduziert werden.

Wenn [Setting] auf [NDI|HX] gesetzt ist

In Softwareversion 3.00 und höher ist eine NDI|HX-Lizenz vorinstalliert.

Hinweis

Das Gerät ist konform mit NDI® HX2 von Vizrt NDI AB.

Das Gerät kann Videos über das Netzwerk an mit NDI® HX2 kompatible Softwareanwendungen und Hardware senden.

[License]
Zeigt die Lizenzinformationen an.
[Source Name]
Zeigt den Quellnamen an.
[Group]
Auf On setzen, um die NDI-Gruppierungsfunktion zu aktivieren.
[Group Name]: Legt den NDI-Gruppennamen fest. Mehrere Einstellungen können mit Kommata getrennt angegeben werden.
[Discovery Server 1], [Discovery Server 2]
Legt NDI Discovery Server 1 und NDI Discovery Server 2 fest.
[Reliable UDP Mode]
Auf On setzen, um den Reliable UDP-Modus zu aktivieren.
[Multicast Mode]
Auf On setzen, um das Multicast-Streaming zu aktivieren.
[Multicast Prefix]: Legt das für das Multicast-Streaming zu verwendende Präfix fest.
[Multicast Netmask]: Legt die Netzmaske fest, die den Multicast-Adressbereich bestimmt.
[Multicast TTL]: Legt den TTL-Wert für das Multicast-Streaming im Bereich von 1 bis 256 fest. Der Standardwert ist 3.
[Multi-TCP Mode]
Auf On setzen, um den Multi-TCP-Modus zu aktivieren.
[Unicast UDP Mode]
Auf On setzen, um den Unicast-UDP-Modus zu aktivieren.

Hinweise zu Software und Diensten von Drittanbietern
Es können verschiedene Benutzungsbedingungen gelten.

Die Bereitstellung von Diensten und Softwareaktualisierungen kann ohne Ankündigung unterbrochen oder eingestellt werden.
Die Beschreibung von Diensten und Software kann ohne Ankündigung geändert werden.
Es sind möglicherweise separate Registrierungen und Abonnements erforderlich.

Sony kann keine Haftung für Ansprüche jeder Art von Benutzern oder Dritten aufgrund der Nutzung von Diensten und Software
anderer Unternehmen übernehmen.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Festlegen des Videocodec für das Streaming

Legen Sie mithilfe von [Stream] > [Video Stream] im Webmenü den Videocodec fest.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Sie können bis zu drei Bildcodec-Modi einstellen. Konfigurieren Sie die folgenden Einstellungen separat für jeden Bildmodus.
[Video Stream 3] wird für die Anzeige des Kamerabildbereichs der Web-App verwendet.

Hinweis
Wenn [Stream] > [Stream Setting] > [Setting] auf [RTMP], [SRT-Caller] oder [SRT-Listener] gesetzt ist, besitzen einige der Einstellungen [Video
Stream 1], [Video Stream 2] und [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) Standardwerte.

[Codec 1], [Codec 2], [Codec 3]
Wählen Sie [H.264], [H.265] oder [Off] aus. Beachten Sie, dass [Codec 1] nicht auf [Off] gesetzt werden kann. Außerdem ist [Codec 3]
(fest) auf [JPEG] eingestellt.

Hinweis
Die folgenden Erscheinungen können je nach Kombination verschiedener Einstellungen wie Bildgröße, Bildrate und Bitrate von [Codec 1],
[Codec 2] und [Codec 3] auftreten.

Erhöhte Videolatenzzeit.
Überspringen von Einzelbildern während der Videowiedergabe.
Unterbrochener Ton.
Langsame Kamerareaktion auf verschiedene Befehle.
Langsame Kamerareaktion auf Bedienung über eine Fernbedienung.
Langsame Monitor-Bildschirmanzeige und Konfigurationsvorgänge.

Treten diese Erscheinungen auf, reduzieren Sie die Werte der Parameter für Bildgröße, Bildrate und Bitrate oder ändern Sie die Werte anderer
Einrichtungsparameter, um das Problem zu beseitigen.

Wenn [Stream] > [Stream Setting] > [Setting] auf [RTMP], [SRT-Caller] oder [SRT-Listener] gesetzt ist, so ist [Codec 1] (fest) auf [H.264]
eingestellt. [Codec 2] ist (fest) auf [Off] eingestellt.

Wenn die Bildgröße oder Systemfrequenz der HDMI-Ausgabe geändert werden, wird [Codec 2] auf [Off] gesetzt.

Wenn während der PTZ-Bildausschnitt-Steuerung [Stream] > [Stream] > [Stream Setting] > [Setting] im Webmenü auf [RTSP] gesetzt ist, wird
[Codec 2] (fest) auf [Off] eingestellt.

[Size 1], [Size 2], [Size 3]
Wählt die Bildgröße für das Streaming von der Kamera aus.
Die verfügbaren Optionen für die Bildgröße hängen von der Bildgröße der HDMI-Ausgabe ab.

Hinweis
Wenn die Bildgröße oder Systemfrequenz der HDMI-Ausgabe geändert werden, wird die maximale Bildgröße ausgewählt.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Legt die Bildrate für das Bild fest.
„fps“-Einheiten geben die Anzahl der pro Sekunde per Streaming übertragenen Einzelbilder an.
Die verfügbaren Optionen für die Bildrate hängen von der Bildgröße der HDMI-Ausgabe ab.

Hinweis
Wenn die Bildgröße oder Systemfrequenz der HDMI-Ausgabe geändert werden, wird die maximale Bildrate ausgewählt.

Während der PTZ-Bildausschnitt-Steuerung ist [Frame Rate 2] auf 10 fps oder weniger beschränkt.

[I-Picture Mode 1], [I-Picture Mode 2]
Legt die Methode für das Angeben des I-picture-Einfügeintervalls für H.264 und H.265 auf [Time] oder [Frame] fest.

280



Kann nicht für [Codec 3] festgelegt werden.
[Time]: Legt das I-picture-Einfügeintervall als Zeit fest.
[Frame]: Legt das I-picture-Einfügeintervall als Anzahl Einzelbilder fest.
[I-Picture Interval 1], [I-Picture Interval 2]
Legt das I-picture-Einfügeintervall in Sekunden fest. Legt einen Wert im Bereich von 1 Sekunde bis 5 Sekunden fest. Der Standardwert
ist 1 Sekunde.
Kann nicht für [Codec 3] festgelegt werden.
[I-Picture Ratio 1], [I-Picture Ratio 2]
Legt das I-picture-Einfügeintervall für H.264 und H.265 als Anzahl Einzelbilder im Bereich von 15 bis 300 fest. Der Standardwert ist
300 Einzelbilder.
Kann nicht für [Codec 3] festgelegt werden.
[Profile 1], [Profile 2]
Legt das H.264- oder H.265-Bildcodec-Profil fest.
[H.264]: Wählen Sie das Profil [high], [main] oder [baseline] aus.
[H.265]: Wählen Sie das Profil [main] oder [main10] aus. Wenn zwei Videocodecs aktiviert sind, ist nur die Profiloption [main] zur
Auswahl verfügbar.
Die Effizienz der Bildkompression nimmt in der Reihenfolge [high], [main] und [baseline] zu. Wählen Sie ein Profil aus, das von Ihrem
System unterstützt wird.
Wenn [H.265] auf [main10] gesetzt ist, erfolgt der Betrieb in [main10], wenn die HDMI-Ausgabe YCrCb ist oder in [main], wenn die
HDMI-Ausgabe RGB ist.
Kann nicht für [Codec 3] festgelegt werden.
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Wählen Sie [CBR] oder [VBR] aus.
Um eine konstante Bitrate beizubehalten, wählen Sie [CBR] aus. Um die Bildqualität beizubehalten, wählen Sie [VBR] aus.
Kann nicht für [Codec 3] festgelegt werden.

Hinweis
Die tatsächlich beim Streaming verwendete Bildrate und Bitrate kann abhängig von Bildgröße, Aufnahmeszene, Netzwerkumgebung und
anderen Faktoren von den festgelegten Werten abweichen.

Wenn [Stream] > [Stream Setting] > [Setting] auf [RTMP], [SRT-Caller] oder [SRT-Listener] gesetzt ist, so ist [Bit Rate Compression Mode 1]
(fest) auf [CBR] eingestellt.

[Bit Rate 1], [Bit Rate 2]
Sie können die Bitrate je Video-Stream festlegen, wenn [Bit Rate Compression Mode] auf [CBR] gesetzt ist. Durch Festlegen einer
hohen Bitrate können Sie Video mit hoher Bildqualität per Streaming übertragen.
Kann nicht für [Codec 3] festgelegt werden.
[Quality 1], [Quality 2], [Quality 3]
Legt die Bildqualität im Bereich von 1 bis 10 fest. Ein Wert von 10 legt die höchste Bildqualität fest. Der Standardwert ist 6.
Für [Quality 1] und [Quality 2] können Sie die H.264-Bildqualität festlegen, indem Sie [Bit Rate Compression Mode] auf [VBR] und
[Codec] auf [H.264] setzen. Sie können die H.265-Bildqualität festlegen, indem Sie [Bit Rate Compression Mode] auf [VBR] und
[Codec] auf [H.265] setzen.
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Festlegen des Audiocodec für das Streaming

Legen Sie mithilfe von [Stream] > [Audio Stream] im Webmenü den Audiocodec fest.
[Setting]
Auf On setzen, um das Audiostreaming zu aktivieren.

Hinweis
Um RTMP auszuwählen, setzen Sie stets zunächst diese Einstellung auf On.

[Codec]
Wählt den Typ des für das Audiostreaming zu verwendenden Codec aus.
[AAC (256kbps)]: Auswählen, um der Tonqualität Vorrang zu verleihen.
[AAC (128kbps)]: Auswählen, um der Datenkapazität Vorrang zu verleihen.
Diese Einstellung wirkt sich nicht auf den vom Gerät aufgezeichneten Clip oder das in das HDMI-/SDI-Signal eingebettete Audiosignal
aus.
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Starten/Stoppen des Streaming

Für [RTSP], [SRT-Listener] und [NDI|HX]

Das Gerät wartet auf eine Anfrage zur Streaming-Übermittlung.
Starten Sie eine Client-Anwendung zum Betrachten des Streaming und rufen Sie die in der folgenden Tabelle aufgeführte URL auf.
Geben Sie die am Gerät konfigurierten Angaben für Benutzername und Passwort ein.

<Kamera-Adresse>: IP-Adresse des Geräts
<Port>: Listener-Port, der unter [Port Number] konfiguriert wurde

Hinweis

Die Wiedergabe wird nicht in allen Anwendungen bzw. auf allen Geräten garantiert.

Für [RTMP] und [SRT-Caller]

Drücken Sie die Taste [Stream now] auf der Registerkarte  (Stream) des Live-Betriebsbildschirms, um das Streaming zu starten. Die
Taste ändert sich zu [Stop stream] und das Symbol [Stream] wird oben im Kamerabildbereich angezeigt.
Drücken Sie während des Streaming die Taste [Stop stream], um das Streaming zu stoppen. Die Taste ändert sich wieder zu [Stream
now] und das Symbol [Stream] oben im Kamerabildbereich wird ausgeblendet.

Hinweis
Die Wiedergabe wird nicht in allen Anwendungen bzw. auf allen Geräten garantiert.
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Streaming-Format URL

RTSP
Video Stream 1 rtsp://<Kamera-Adresse>:<Port>/video1

Video Stream 2 rtsp://<Kamera-Adresse>:<Port>/video2

SRT-Listener srt://<Kamera-Adresse>:<Port>

NDI|HX Siehe Bedienungsanleitung des NDI|HX-kompatiblen Client-Geräts.
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Miniaturbildanzeige

Wen Sie die Taste [Thumbnail] auf dem Wiedergabe-Betriebsbildschirm oder die Taste THUMBNAIL auf der Infrarot-Fernbedienung
drücken, werden die auf der Speicherkarte aufgezeichneten Clips im Kamerabildbereich angezeigt. Die Anzeige im Kamerabildbereich
wird als Miniaturbildanzeige bezeichnet.
Sie können einen Clip in der Miniaturbildanzeige wählen und die Wiedergabe des Clips starten.
Durch Drücken der Taste [Thumbnail] während der Anzeige der Miniaturbilder werden die Miniaturbildanzeige geschlossen und das
Aufnahmebild wieder angezeigt.

Hinweis
In der Miniaturbildanzeige werden nur Clips angezeigt, die im derzeit gewählten Aufzeichnungsformat aufgenommen wurden. Falls ein
aufgezeichneter Clip wider Erwarten nicht angezeigt wird, überprüfen Sie das Aufzeichnungsformat. Beachten Sie diesen Aspekt vor dem
Formatieren (Initialisieren) von Speichermedien.

Bildschirmaufbau

Das Miniaturbild eines ausgewählten Clips wird mit orangefarbenem Hintergrund angezeigt.
Informationen zum ausgewählten Clip werden unten im Bildschirm angezeigt.
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Ausgewählte Speicherkarte
Wenn die Speicherkarte schreibgeschützt ist, wird rechts ein Schloss-Symbol angezeigt.

1.

Clip-Nummer/Gesamtzahl der Clips2.

Miniaturbild (Indexbild)
Hier wird das Indexbild eines Clips angezeigt. Wenn ein Clip aufgezeichnet wird, wird sein erstes Einzelbild automatisch als
Indexbild gesetzt.
Unter dem Miniaturbild werden Informationen zum Clip/Bild angezeigt. Sie können mithilfe von [Thumbnail] > [Customize View] >
[Thumbnail Caption] im Kameramenü festlegen, welche Informationen angezeigt werden.

3.

Clipname
Zeigt den Namen des ausgewählten Clips an.

4.

Aufzeichnungsformat
Zeigt das Dateiformat des ausgewählten Clips an.

5.

Spezielle Aufzeichnungsinformationen
Der Aufzeichnungsmodus wird nur angezeigt, wenn der Clip in einem speziellen Aufzeichnungsmodus aufgenommen wurde.
Bei Zeitlupen- & Zeitrafferclips wird rechts die Bildrate angezeigt.

6.

Cliplänge7.

Erstellungsdatum8.
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Abspielen der aufgezeichneten Clips

Aufgezeichnete Clips können wiedergegeben werden, wenn sich das Gerät im Bereitschaftsmodus (Stby) befindet.
In diesem Thema wird beschrieben, wie Sie aufgezeichnete Clips mithilfe des GUI-Steuerbereichs wiedergeben.

Setzen Sie die wiederzugebende Speicherkarte ein.1

Drücken Sie die Taste [Thumbnail].

Die Clip-Miniaturbilder werden angezeigt.

2

Verwenden Sie die Pfeiltasten im GUI-Steuerbereich, um den Cursor auf das Miniaturbild des wiederzugebenden Clips
zu verschieben.

Hinweis
Clips können nicht per Touch-Bedienung ausgewählt werden.

3

286



Hinweis
An den Übergängen zwischen verschiedenen Clips kann es temporär zu einem Bildabbruch oder zur Anzeige von Standbildern kommen. Das
Gerät kann währenddessen nicht gesteuert werden.

Wenn Sie einen Clip in der Miniaturbildanzeige wählen und die Wiedergabe starten, kann es zu einer kurzzeitigen Bildverzerrung am Anfang des
Clips kommen. Um den Beginn des Clips ohne Verzerrung zu betrachten, halten Sie die Wiedergabe an, kehren durch Drücken der Taste 
(Vorhergehender) zum Anfang des Clips zurück und starten die Wiedergabe erneut.
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Drücken Sie die Taste [Set] im GUI-Steuerbereich.

Die Wiedergabe beginnt am Anfang des ausgewählten Clips.

4

Bedienen Sie den Wiedergabesteuerbereich wie gewünscht.

Tipp

Sie können die Bedienung auch mithilfe des GUI-Steuerbereichs vornehmen.
Wiedergabe: Drücken Sie die Taste [Set].
Wiedergabe anhalten: Drücken Sie die Taste [Set] während der Wiedergabe. Drücken Sie die Taste erneut, um zur normalen
Wiedergabe zurückzukehren.
Zum Beginn des Clips oder nächsten Clips springen: Drücken Sie die linke/rechte Taste.
Schneller Vor-/Rücklauf: Halten Sie die linke/rechte Taste gedrückt. Wenn Sie die Taste loslassen, kehrt die Wiedergabegeschwindigkeit
auf den Normalwert zurück.
Wiedergabe beenden: Drücken Sie die Taste [Cancel/Back].

5

Taste Funktion

Taste  (Wiedergabe/Pause) Gibt einen Clip wieder. Pausiert den Clip während der Wiedergabe.

Taste  (schneller Vorlauf), Taste
 (schneller Rücklauf)

Gibt einen Clip mit hoher Geschwindigkeit wieder. Wenn diese Taste gedrückt wird,
ändert sich die Wiedergabegeschwindigkeit in drei Stufen.

Taste  (Vorhergehender), Taste 
(Nächster)

Springt zum Beginn des Clips oder zum vorhergehenden/nächsten Clip.

Taste  (Stopp) Stoppt die Wiedergabe und wechselt zum Aufnahmebildschirm.
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Vorgänge mit aufgezeichneten Clips

In der Miniaturbildvorschau können die Clips über das Menü [Thumbnail] im Kameramenü gesteuert oder ihre Eigenschaften überprüft
werden.
Drücken Sie die Taste [Menu] auf dem Wiedergabe-Betriebsbildschirm, um im Kamerabildbereich das Kameramenü aufzurufen.
Mithilfe des Menüs [Thumbnail] im Kameramenü können Sie die folgenden Vorgänge durchführen.
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Tipp

Sie können auch die Taste [Menu] auf dem Live-Betriebsbildschirm drücken, um das Kameramenü aufzurufen.

Funktionen mithilfe des Menüs [Thumbnail] im Kameramenü

Wählen Sie im GUI-Steuerbereich mithilfe der Pfeiltasten eine Funktion aus und drücken Sie die Taste [Set].
Durch Drücken der Taste [Cancel/Back] gelangen Sie zum vorhergehenden Bildschirm.

Hinweis
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Einige Punkte können nicht gewählt werden, abhängig vom Zustand des Camcorders während der Menüanzeige.

Menüpunkte für Clipfunktionen

Das Menü [Thumbnail] im Kameramenü umfasst die folgenden Menüpunkte für Clipfunktionen.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Informationen zu den Menüpunkten siehe „Menü [Thumbnail]“.

Anzeigen des Bildschirms mit Clip-Eigenschaften
Wählen Sie im Kameramenü die Option [Thumbnail] > [Display Clip Properties], um den Bildschirm mit den Clip-Eigenschaften
anzuzeigen.
Drücken Sie die Taste  (Vorhergehender) oder  (Nächster), um zum vorhergehenden/nächsten Clip zu springen.

Hinzufügen von Clipkennzeichnungen
Sie können Clips mit Kennzeichnungen (OK, NG oder KP) versehen, um die Anzeige der Clips daran orientiert zu filtern.
Wählen Sie das Miniaturbild des zu kennzeichnenden Clips aus. Wählen Sie dann die Kennzeichnung mithilfe von [Thumbnail] > [Set
Clip Flag] im Kameramenü aus.

Tipp
Sie können zum Hinzufügen von Clipkennzeichnungen auch eine belegbare Taste verwenden, der die Funktion zur Clipkennzeichnung
zugewiesen wurde.

Anzeigen der gefilterten Clip-Miniaturbildanzeige
Wählen Sie im Kameramenü die Option [Thumbnail] > [Filter Clips] aus, und wählen Sie einen Clipkennzeichnungstyp, um nur Clips
mit dieser Kennzeichnung anzuzeigen.
Um alle Clips anzuzeigen, wählen Sie [All] aus.
Sie können auch die Taste [Display] drücken, um die Miniaturbildanzeige nach Clipkennzeichnung zu sortieren.

Löschen von Clips
Sie können Clips von Speicherkarten löschen.
Wählen Sie [Thumbnail] > [Delete Clip] > [Select Clip] oder [All Clips] im Kameramenü aus.
[Select Clip]: Der gewählte Clip wird gelöscht. Es können auch mehrere Clips ausgewählt werden.
[All Clips]: Alle angezeigten Clips werden gelöscht.

Ändern der in der Miniaturbildanzeige angezeigten Informationen
Sie können ändern, welche Informationen zum Clip bzw. Bild unter einem Miniaturbild angezeigt werden.
Wählen Sie im Kameramenü die Option [Thumbnail] > [Customize View] > [Thumbnail Caption], und wählen Sie die Informationen, die
angezeigt werden sollen.
[Date Time]: Zeigt das Datum und die Uhrzeit, zu der der Clip erstellt und wann er zuletzt geändert wurde.
[Time Code]: Zeigt den Zeitcode an.
[Duration]: Zeigt die Dauer des Clips an.
[Sequential Number]: Zeigt für jedes Miniaturbild eine fortlaufende Nummer an.
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Einstellung hinzugefügte Clipkennzeichnung

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Konfiguration des Kameramenüs

Wenn die Taste [Menu] im GUI-Steuerbereich oder die Taste MENU auf der Infrarot-Fernbedienung gedrückt wird, so wird im
Kamerabildbereich das Kameramenü zum Konfigurieren der verschiedenen, für die Aufnahme und Wiedergabe erforderlichen
Einstellungen angezeigt.

Das Menü ist in folgende Menüs gegliedert.

Menükonfiguration

Menü [User]
Enthält Menüpunkte, die vom Benutzer konfiguriert werden.
Kann mithilfe von [Edit User Menu] bearbeitet werden.
Menü [Edit User]
Enthält Menüpunkte zum Bearbeiten des [User]-Menüs.
Menü [Shooting]
Enthält Einstellungen für die Aufnahme.
Menü [Project]
Enthält grundlegende Projekteinstellungen.
Menü [Paint/Look]
Enthält Einstellungen für die Bildqualität.
Menü [Pan-Tilt]
Enthält Einstellungen für die Schwenk-/Neigefunktion.
Menü [TC/Media]
Enthält Einstellungen zu Zeitcodes und Aufzeichnungsmedien.
Menü [Monitoring]
Enthält Einstellungen zur Videoausgabe und für die Bildschirmanzeige.
Menü [Audio]
Enthält Einstellungen für die Audiosteuerung.
Menü [Thumbnail]
Enthält Einstellungen für die Miniaturbildanzeige.
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Menü [Technical]
Enthält technische Einstellungen.
Menü [Network]
Enthält Einstellungen zu Netzwerken.
Menü [Maintenance]
Enthält Geräteeinstellungen wie Uhrzeit und Sprache.

Konfiguration und Hierarchie des Kameramenüs

Ebene 1 Ebene 2

User
(Werkseinstellungen)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Ebene 1 Ebene 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration
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Ebene 1 Ebene 2

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Bedienen des Kameramenüs

Wenn die Taste [Menu] im GUI-Steuerbereich oder die Taste MENU auf der Infrarot-Fernbedienung gedrückt wird, so wird im
Kamerabildbereich das Kameramenü zum Konfigurieren der verschiedenen, für die Aufnahme und Wiedergabe erforderlichen
Einstellungen angezeigt.
Das Menü wird mithilfe der Tasten im GUI-Steuerbereich bedient.

Taste [Menu]: Drücken Sie diese Taste, um das Kameramenü aufzurufen. Während der Anzeige des Kameramenüs erneut drücken,
um das Menü auszublenden.
Pfeiltasten: Drücken Sie die Pfeiltasten, um den Cursor im Kameramenü nach oben/unten/links/rechts zu bewegen und Menüpunkte
oder Einstellungen auszuwählen.
Taste [Set]: Durch Drücken wird das gewählte Objekt übernommen.
Taste [Cancel/Back]: Drücken Sie diese Taste, um zum vorhergehenden Menü zu wechseln. Nicht bestätigte Änderungen werden
verworfen.

Hinweis

Einige Punkte können nicht gewählt werden, abhängig vom Zustand des Camcorders während der Menüanzeige.

Festlegen von Menüpunkten

Bewegen Sie mithilfe der Pfeiltasten im GUI-Steuerbereich den Cursor auf den einzustellenden Menüpunkt und drücken Sie die Taste
[Set], um die Einstellung zu übernehmen.

Im Auswahlbereich für Menüpunkte werden bis zu acht Zeilen angezeigt. Falls nicht alle verfügbaren Optionen für ein Element
gleichzeitig angezeigt werden können, blättern Sie durch die Liste, indem Sie den Cursor nach oben bzw. nach unten bewegen.
Bei Unteroptionen mit einem großen Einstellbereich (z. B. −99 bis +99) wird der Einstellbereich nicht angezeigt. Die aktuelle
Einstellung ist hervorgehoben, um den änderbaren Wert zu kennzeichnen.
Durch die Auswahl von [Execute] wird die entsprechende Funktion ausgeführt.
Bei Auswahl eines Elements, das vor der Ausführung bestätigt werden muss, wird das Menü vorübergehend durch eine
Bestätigungsmeldung überlagert. Überprüfen Sie die Meldung, und wählen Sie dann, ob die Funktion ausgeführt oder
abgebrochen werden soll.
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Eingeben einer Zeichenfolge

Wenn Sie ein Element wählen, für das eine Zeichenfolge eingegeben werden muss (z. B. ein Dateiname), wird ein Bildschirm zur
Zeicheneingabe eingeblendet.
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Wählen Sie mithilfe der Pfeiltasten im GUI-Steuerbereich die Zeichenart aus und übernehmen Sie die Einstellung.

[ABC]: Großbuchstaben
[abc]: Kleinbuchstaben
[123]: Ziffern
[!#$]: Sonderzeichen

1

Wählen Sie ein Zeichen aus und drücken Sie die Taste [Set], um die Einstellung zu übernehmen.

Der Cursor bewegt sich zum nächsten Feld.
[Space]: Fügt an der Cursorposition ein Leerzeichen ein.
[←] [→]: Ändert die Position des Cursors.
[BS]: Löscht das Zeichen links vom Cursor (Rücktaste).

2

Drücken Sie abschließend die Taste [Done], um die Einstellung zu übernehmen.

Die Zeichenfolge wird übernommen, und der Bildschirm zur Zeicheneingabe wird ausgeblendet.

3
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User

In diesem Thema werden die Funktionen und Einstellungen der einzelnen Menüpunkte beschrieben.

Hinweis

Sie können mithilfe des Menüs [Edit User] dem Menü [User] Elemente hinzufügen oder welche aus ihm entfernen. Bis zu 20 Menüpunkte können
konfiguriert werden.
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Menüpunkt Beschreibung

Base Setting Menüpunkt Project > Base Setting

Focus Menüpunkt Shooting > Focus

S&Q Motion Menüpunkt Shooting > S&Q Motion

LUT On/Off Menüpunkt Shooting > LUT On/Off

Simul Rec Menüpunkt Project > Simul Rec

Proxy Rec Menüpunkt Project > Proxy Rec

Interval Rec Menüpunkt Project > Interval Rec

Picture Cache Rec Menüpunkt Project > Picture Cache Rec

Assignable Button Menüpunkt Project > Assignable Button

Scene File Menüpunkt Project > Scene File

Base Look Menüpunkt Paint/Look > Base Look

P/T Acceleration Menüpunkt Pan-Tilt > P/T Acceleration

Clip Name Format Menüpunkt TC/Media > Clip Name Format

Format Media Menüpunkt TC/Media > Format Media

Video Signal Monitor Menüpunkt Monitoring > Video Signal Monitor

Marker Menüpunkt Monitoring > Marker

Zoom Menüpunkt Technical > Zoom

Lens Menüpunkt Technical > Lens

Edit User Menu Öffnet das Menü Edit User.
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Edit User

Das Menü [Edit User] wird auf der höchsten Ebene angezeigt, wenn im Menü [User] die Option [Edit User Menu] gewählt wird.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Add Item
Hinzufügen von Elementen
zum Menü [User]

– –
Fügt dem Menü [User] einen Menüpunkt der Ebene 2
hinzu.

Customize Reset
Zurücksetzen von Elementen
im Menü [User]

– –
Setzt die im Menü [User] festgelegten Menüpunkte auf
die Werkseinstellungen zurück.

Während der Bearbeitung
gewählter Menüpunkt der
Ebene 2

Delete –
Löscht den registrierten Menüpunkt der Ebene 2 im
Menü [User].

Move –
Ordnet die festgelegten Menüpunkte im Menü [User] neu
an.

Edit Sub Item –
Hierüber können Sie den registrierten Untermenüpunkt
der Ebene 3 im Menü [User] bearbeiten
(registrieren/löschen).
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ISO/Gain/EI

Zum Festlegen der Verstärkungseinstellungen.

Verwandtes Thema
Einstellungen und Standardwerte für ISO/Gain

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Mode ISO/dB dB
Wählt den Modus für die
Verstärkungseinstellung.

ISO/Gain<L>

Einzelheiten zu Einstellungen siehe
„Einstellungen und Standardwerte
für ISO/Gain“.

–
Legt den voreingestellten
Verstärkungswert für das <L>-Signal
fest.

Exposure
Index<L>

Wenn Base ISO auf ISO 800 gesetzt
ist:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Wenn Base ISO auf ISO 12800
gesetzt ist:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Wenn Base ISO auf ISO
800 gesetzt ist: 800EI /
6.0E
Wenn Base ISO auf ISO
12800 gesetzt ist: 12800EI
/ 6.0E

Legt den Exposure Index<L>-Wert fest.

Shockless
Gain

On / Off Off
Schaltet die nahtlose
Verstärkungsumschaltung ein bzw. aus.

Base
Sensitivity

High / Low Low
Legt die Basisempfindlichkeit für den
Modus Custom fest.

Base ISO ISO 12800 / ISO 800 ISO 800 Legt die ISO-Basisempfindlichkeit für
den Modus Cine EI/Flexible ISO fest.

300



5-041-957-64(1) Copyright 2022 Sony Corporation

301



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

ND Filter

Legt die Voreinstellungswerte für den ND-Filter fest.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Mode Preset / Variable Variable Legt den ND-Filtermodus fest.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Legt den Voreinstellungswert 1 für den ND-Filter fest.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Legt den Voreinstellungswert 2 für den ND-Filter fest.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Legt den Voreinstellungswert 3 für den ND-Filter fest.
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Shutter

Legt den Betrieb des elektronischen Verschlusses fest.
Wird verwendet, um bewegliche Motive deutlich aufzuzeichnen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Mode Speed / Angle Speed
Wählt den Modus zum Festlegen der
Verschlusszeit in Sekunden (Speed) oder als
Verschlusswinkel (Angle).

Shutter
Speed
On/Off

On / Off Off

Legt fest, ob die Belichtungszeit bei Auswahl
des Modus Speed dem Wert von [Shutter
Speed] folgt oder auf volle Belichtungszeit
gesetzt werden soll.

Shutter
Speed

64F bis 1/8000
Die verfügbaren Einstellungen hängen von der
Bildfrequenz des gewählten Videoformats ab.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250
/ 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Legt die Verschlussgeschwindigkeit fest,
wenn der Modus Speed gewählt ist.

Shutter Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° / 210.0° /
180.0° / 172.8° / 150.0° / 144.0° / 120.0° / 90.0° /
86.4° / 72.0° / 45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0° Legt den Verschlusswinkel fest, wenn der
Modus Angle gewählt ist.

ECS On/Off On / Off Off
Schaltet die „Extended Clear Scan“-Funktion
ein bzw. aus.

ECS
Frequency

23.99 bis 8000
Die verfügbaren Einstellungen hängen von der
Bildfrequenz des gewählten
Aufzeichnungsformats ab.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Stellt die ECS-Frequenz ein, wenn unter
„Mode“ die Option „ECS“ gewählt ist.
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Iris

Legt die Blendeneinstellungen fest.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Bokeh Control On / Off Off Schaltet die Bokeh-Steuerungsfunktion ein bzw. aus.
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Auto Exposure

Zum Einstellen der Belichtungsautomatik.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / ±0
/ −0.25 / −0.5 / −0.75 / −1.0 / −1.25 / −1.5 /
−1.75 / −2.0 / −2.25 / −2.5 / −2.75 / −3.0

±0
Legt den Helligkeitspegel für die automatisch
erkannte Belichtung fest.

Mode Backlight / Standard / Spotlight Standard

Legt den Betriebsmodus der Belichtungsautomatik
fest.
Backlight: Gegenlichtmodus (Modus zum
Verringern der Verdunkelung von Motiven, wenn
das Motiv im Gegenlicht steht)
Standard: Standardmodus
Spotlight: Punktlicht-Modus (Modus zum
Verringern der Lichtpunkte des Hauptmotivs, die im
Scheinwerferlicht entstehen)

Speed −99 bis +99 ±0
Legt die Geschwindigkeit der Belichtungsautomatik
fest.

AGC On / Off Off
Schaltet die AGC-Funktion (automatische
Verstärkungssteuerung) ein bzw. aus.

AGC Limit

Einzelheiten zu Einstellungen siehe
„Einstellungen und Standardwerte für
AGC Limit“.

–
Legt die maximale Verstärkung der AGC-Funktion
fest.

AGC Point F2.8 / F4 / F5.6 F2.8
Legt die F-Zahl der Blende fest, bei der die AGC-
Funktion einsetzt, sofern auf On gesetzt.

Auto Shutter On / Off Off
Schaltet die automatische Verschlussfunktion ein
bzw. aus.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Legt die kürzeste Belichtungszeit der
automatischen Verschlussfunktion fest.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Legt die F-Zahl der Blende fest, bei dem die
automatische Verschlussfunktion einsetzt.

Clip High light On / Off Off
Schaltet die Funktion, die Überbelichtungen
ignoriert und bei extremer Helligkeit ein „flacheres“
Ergebnis liefert, ein bzw. aus.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Legt den Belichtungsmessbereich fest, um die
Belichtung automatisch an die Helligkeit des Motivs
anzupassen. (Bei manueller Belichtung ist diese
Einstellung nicht verfügbar.)

Detect
Window
Indication

On / Off Off
Schaltet die Anzeige des Belichtungsmessbereichs
ein bzw. aus.

Custom Width 40 bis 999 500 Legt die Breite des Belichtungsmessbereichs fest.

305



Verwandtes Thema
Einstellungen und Standardwerte für AGC Limit

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Custom
Height

70 bis 999 500 Legt die Höhe des Belichtungsmessbereichs fest.

Custom H
Position

−479 bis +479 ±0
Legt die horizontale Position des
Belichtungsmessbereichs fest.

Custom V
Position

−464 bis +464 ±0
Legt die vertikale Position des
Belichtungsmessbereichs fest.
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White

Zum Festlegen der Weißwerteinstellungen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Preset White 2000K bis 15000K 3200K Legt den voreingestellten Wert für den Weißabgleich fest.

Color Temp
<A>

2000K bis 15000K 3200K

Legt die in Speicher A gespeicherte Farbtemperatur des Weißabgleichs
fest.

Hinweis

Da Color Temp im R Gain/B Gain-Betrieb bei 2000K und 15000K begrenzt
wird, ist es ggf. nicht möglich, den korrekten Color Temp-Wert für den R
Gain/B Gain-Wert anzuzeigen.

Tint<A> −99 bis +99 ±0

Legt den in Weißspeicher A abgelegten Farbtonwert des Weißabgleichs
fest.

Hinweis

Da Tint im R Gain/B Gain-Betrieb bei ±99 begrenzt wird, ist es ggf. nicht
möglich, den korrekten Farbtonwert für den R Gain/B Gain-Wert anzuzeigen.

R Gain <A> −99.0 bis +99.0 ±0.0 Legt den in Speicher A gespeicherten R-Verstärkungswert für den
Weißabgleich fest.

B Gain <A> −99.0 bis +99.0 ±0.0
Legt den in Speicher A gespeicherten B-Verstärkungswert für den
Weißabgleich fest.
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White Setting

Zum Anpassen der Weißwerteinstellungen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Shockless
White

Off / 1 / 2 / 3 2

Legt die Reaktionsgeschwindigkeit des Weißabgleichs beim Wechsel
in den Weißabgleich-Modus fest.
Off: Sofortiger Wechsel.
1 bis 3: Mit zunehmender Zahl verlangsamt sich die Geschwindigkeit.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Legt die Reaktionsgeschwindigkeit im Modus ATW fest.
Die schnellste Reaktionsgeschwindigkeit ist 1, die langsamste 5.
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Offset White

Zum Festlegen der Einstellungen für die Weißwert-Abweichung.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Offset White <A> On / Off Off
Legt fest, ob dem Weißabgleich in Speicher A ein Abweichwert
hinzugefügt werden soll (On) oder nicht (Off).

Offset Color
Temp<A>

−99 bis +99 ±0
Legt den Korrekturwert der Farbtemperatur fest, welcher dem
Weißabgleich in Speicher A hinzugefügt werden soll, wenn [Offset
White <A>] auf On eingestellt ist.

Offset Tint<A> −99 bis +99 ±0
Legt den Korrekturwert des Farbtons fest, welcher dem Weißabgleich
in Speicher A hinzugefügt werden soll, wenn [Offset White <A>] auf On
eingestellt ist.

Offset
White<ATW>

On / Off On
Legt fest, ob dem ATW-Weißabgleich ein Abweichwert hinzugefügt
werden soll (On) oder nicht (Off).

Offset Color
Temp<ATW>

−99 bis +99 ±0
Legt den Korrekturwert der Farbtemperatur fest, welcher dem ATW-
Weißabgleich hinzugefügt werden soll, wenn [Offset White<ATW>] auf
On eingestellt ist.

Offset Tint<ATW> −99 bis +99 ±0
Legt den Korrekturwert des Farbtons fest, welcher dem ATW-
Weißabgleich hinzugefügt werden soll, wenn [Offset White<ATW>] auf
On eingestellt ist.
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Focus

Zum Festlegen der Fokuseinstellungen.

Verwandtes Thema
Einstellen des Bereichs und der Position für den Autofokus (Fokusbereich)

Verfolgung mittels Gesichts- und Augenerkennung (Face/Eye Detection AF)

Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App
Manuelle Fokussierung während Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6
/ 7(Fast)

5
Legt die Geschwindigkeit des Fokusantriebs beim Motivwechsel im
Autofokusbetrieb fest.

AF Subj. Shift
Sens.

1(Locked On) / 2 / 3 / 4
/ 5(Responsive)

5(Responsive)
Legt die Empfindlichkeit für den Motivwechsel im Autofokusbetrieb
fest.

Focus Area
Wide / Zone / Flexible
Spot

Wide

Legt den Zielbereich für Autofokus und Autofokus auf Knopfdruck
(AF) fest.

Siehe „Automatische Einstellung des Fokus (Auto Focus)“ und
„Einstellen des Bereichs und der Position für den Autofokus
(Fokusbereich)“.

Wide: Sucht beim Fokussieren in einem weiten Winkel über das Bild
nach einem Motiv.
Zone: Sucht automatisch innerhalb der angegebenen Zone nach
einem Fokuspunkt.
Flexible Spot: Fokussiert auf eine angegebene Position im Bild.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Legt den Zielbereich für Autofokus auf Knopfdruck (AF-S) fest.

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF /
Off

Face/Eye
Priority AF

Aktiviert/deaktiviert Gesichtserkennung-AF.
Siehe „Verfolgung mittels Gesichts- und Augenerkennung
(Face/Eye Detection AF)“.

Push AF Mode
AF / Single-shot
AF(AF-S)

AF Legt den Modus für Autofokus auf Knopfdruck fest.

Touch Function
in MF

Tracking AF / Spot
Focus

Tracking AF
Legt die Reaktion fest, wenn Sie im MF-Modus das Kamerabild auf
dem Live-Betriebsbildschirm der Web-App auf das Bild tippen.

AF Assist On / Off On

Bei Einstellung auf On wird der Autofokus vorübergehend außer Kraft
gesetzt, und der Fokus kann manuell eingestellt werden.

Siehe „Manuelles Einstellen des Autofokusziels (AF Assist)
mithilfe der Web-App“ und „Manuelle Fokussierung während
Autofokus mithilfe der mitgelieferten Infrarot-Fernbedienung“.
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S&Q Motion

Zum Festlegen der Einstellungen für den Zeitlupen- & Zeitraffermodus (siehe „Zeitlupe & Zeitraffer“).

Verwandtes Thema
Zeitlupe & Zeitraffer

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet den Zeitlupen- & Zeitraffermodus ein bzw. aus.

Frame Rate
1fps bis 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Legt die Bildrate für Zeitlupen- & Zeitrafferaufnahmen fest.

Hinweis
Die verfügbaren Einstellungen hängen von der
ausgewähltem Systemfrequenz, dem Codec und dem
Videoformat ab.
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LUT On/Off

Zum Festlegen der Einstellungen für „LUT“.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

SDI MLUT On / MLUT Off MLUT Off
Legt fest, ob eine Monitor-LUT auf das SDI-Ausgabevideo
angewendet werden soll.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Legt fest, ob eine Monitor-LUT auf das HDMI- und Streaming-
Ausgabevideo angewendet werden soll.

Proxy MLUT On / MLUT Off MLUT Off
Legt fest, ob eine Monitor-LUT auf das Proxy-
Aufzeichnungsvideo angewendet werden soll.

Internal Rec MLUT On / MLUT Off MLUT Off
Legt fest, ob eine Monitor-LUT auf das Hauptaufzeichnungsvideo
angewendet werden soll.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
Legt die Zielausgabe fest, die über eine belegbare Taste
gesteuert werden soll, der die Funktion LUT On/Off zugewiesen
wurde.
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Noise Suppression

Zum Festlegen der Einstellungen für die Rauschunterdrückung.

Tipp

Die Einstellungen [Setting(Custom)] und [Level(Custom)] werden in der Einstellung [Target Display] widergespiegelt.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting(Custom) On / Off On
Schaltet die Rauschunterdrückungsfunktion im Modus Custom
ein bzw. aus.

Level(Custom) Low / Mid / High Mid
Legt den Grad der Rauschunterdrückung im Modus Custom
fest.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Schaltet die Rauschunterdrückungsfunktion im Log-
Aufnahmemodus ein bzw. aus.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Legt den Grad der Rauschunterdrückung im Log-
Aufnahmemodus fest.
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Flicker Reduce

Zum Festlegen der Einstellungen für die Flimmerkorrektur.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Mode Auto / On / Off Off Legt den Flimmerkorrekturmodus fest.

Frequency 50Hz / 60Hz 60Hz
Legt die Frequenz der Stromquelle fest, von der das Licht stammt, das
das Flimmern verursacht.
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SteadyShot

Zum Festlegen der Einstellungen für die Bildstabilisierung.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting Active / Standard / Off Off

Legt die Bildstabilisierungsfunktion fest.

Hinweis
Diese Funktion ist aktiviert, wenn ein kompatibles Objektiv angebracht ist.

Bei Einstellung auf Active oder Standard kann es bei
Schwenk-/Neigebetrieb zu unerwartetem Verhalten kommen.
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Base Setting

Zum Festlegen der Grundeinstellungen.

Verwandtes Thema
Konfigurieren der Grundfunktionen

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Zum Festlegen des Aufnahmemodus.
Siehe „Festlegen des Aufnahmemodus“ unter
„Konfigurieren der Grundfunktionen“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Legt den Farbbereich der Aufzeichnung/Ausgabe im Modus
Custom fest.
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Rec Format

Zum Festlegen der Einstellungen für das Aufzeichnungsformat.

Einstellungen für [RAW Output Format]

Standardwerte sind fett gedruckt.
Die Bedingungen, unter denen [RAW Output Format] nicht festgelegt werden kann, wurden weggelassen.

Einstellungen für [Video Format]

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Wählt die Systemfrequenz aus.

Imager Scan
Mode

FF / S35 FF Wählt die Bildsensorgröße aus.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L XAVC-I

Wählt den Codec für Aufnahme bzw. Wiedergabe
von Clips aus.

Hinweis
Wenn [Imager Scan Mode] auf [S35] gesetzt ist,
können [RAW] und [RAW & XAVC-I] nicht
ausgewählt werden.

RAW Output
Format

Die verfügbaren Einstellungen variieren je
nach Einstellung für [Frequency].

Siehe „Einstellungen für [RAW Output
Format]“ unten.

–

Legt die Größe des an einen externen RAW-
Recorder auszugebenden RAW-Bilds fest.

Hinweis

Wenn [Codec] auf [RAW & XAVC-I] eingestellt
ist, wechselt die Einstellung [Video Format] je
nach der Einstellung für [RAW Output Format].

Video Format

Die verfügbaren Einstellungen variieren je
nach den Einstellungen für [Frequency],
[Imager Scan Mode] und [Codec].

Siehe „Einstellungen für [Video Format]“
unten.

– Legt die Bildgröße und Bitrate fest.

Frequency Imager Scan Mode Codec Einstellung

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Standardwerte sind fett gedruckt.

5-041-957-64(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Einstellung

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Zum Festlegen von Einstellungen für den Log-Aufnahmemodus (siehe „Festlegen des Aufnahmemodus“ unter „Konfigurieren der
Grundfunktionen“).

Verwandtes Thema
Konfigurieren der Grundfunktionen

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Color Gamut
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Legt den Farbbereich für Log-Aufnahmemodi fest
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed LUT
File

On / Off On
Schaltet die Aufzeichnung von Metadaten für 3D LUT-
Dateien (CUBE-Dateien) ein/aus.
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Simul Rec

Zum Festlegen von Einstellungen für den Simultanaufzeichnungsmodus in 2 Einschüben (siehe „Gleichzeitige Aufnahme auf
Speicherkarten A und B (2-slot Simul Rec)“).

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off
Schaltet den
Simultanaufzeichnungsmodus in 2
Einschüben ein bzw. aus.

Rec Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:
<Slot A> <Slot B> / Rec Button:<Slot A> 2nd
Rec Button:<Slot B> / Rec Button:<Slot B>
2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot
B>

Weist die Aufnahmetasten zur
Steuerung der einzelnen
Aufzeichnungsmedien zu.
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Proxy Rec

Legt die Einstellungen des Proxy-Aufzeichnungsmodus fest (siehe „Proxy-Aufzeichnung“).

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off Zum Ein-/Ausschalten des Proxy-Aufnahmemodus.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Zum Auswählen des Audiokanals, der als Proxy-Daten
aufgenommen werden soll.
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Interval Rec

Zum Festlegen der Einstellungen für den Intervallaufzeichnungsmodus (siehe „Intermittierende Videoaufzeichnung (Interval Rec)“).

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off

Schaltet den Intervallaufzeichnungsmodus ein
bzw. aus. (Wenn dieser Modus auf On gesetzt
wird, werden alle anderen Spezialmodi auf Off
gesetzt.)

Interval Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1
Legt das Intervall zwischen Aufzeichnungen im
Modus „Interval Rec“ fest (wenn Interval Rec auf
On gesetzt ist).

Number of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Die verfügbaren Einstellungen
hängen von der Bildfrequenz des
gewählten Videoformats ab.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Legt die aufzuzeichnende Anzahl der
Einzelbilder pro Einstellung im Modus „Interval
Rec“ fest (wenn Interval Rec auf On gesetzt ist).
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Picture Cache Rec

Zum Festlegen der Einstellungen für den Bildpuffer-Aufzeichnungsmodus (siehe „Aufzeichnen gepufferter Bilder (Picture Cache
Rec)“).

Verwandtes Thema
Aufzeichnen gepufferter Bilder (Picture Cache Rec)

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet die Bildpufferfunktion ein bzw. aus.

Cache Size
Short / Medium / Long /
Max

Max
Legt die Zeit zum Sammeln von Bildmaterial im Bildpuffer fest (Zeit für
Aufzeichnung mit Bildpufferfunktion).

Cache Rec
Time

– –
Zeigt die Zeit zum Sammeln von Bildmaterial im Bildpuffer an (Zeit für
Aufzeichnung mit Bildpufferfunktion).
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SDI/HDMI Rec Control

Zum Festlegen der Einstellungen für die SDI-/HDMI-Aufnahmesteuerung.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

Legt die Steuerung von Aufzeichnungsstart und -stopp eines extern
angeschlossenen Geräts per SDI/HDMI-Ausgangssignal fest.
Off: Fernsteuerung nicht verwenden.
SDI/HDMI Remote I/F: Steuerung von Aufzeichnungsstart und -stopp
eines extern angeschlossenen Geräts, wenn kein Medium in das Gerät
eingelegt ist. Nicht einzelbildgenau mit dem Medium im Gerät
synchronisiert.
Parallel Rec: Steuerung von Aufzeichnungsstart und -stopp eines extern
angeschlossenen Geräts, wenn ein Medium in das Gerät eingelegt ist.
Einzelbildgenau mit dem Medium im Gerät synchronisiert.

Hinweis

Um die Steuerung über das HDMI-Ausgangssignal zu verwenden, setzen
Sie [TC/Media] > [HDMI TC Out] > [Setting] im Kameramenü auf [On].
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Assignable Button

Zum Zuweisen von Funktionen für die belegbaren Tasten (<1> bis <9>) und für [Focus Hold Button].
Die folgenden Funktion können zugewiesen werden.
[Off]: Keine Funktionszuweisung.
[Base ISO/Sensitivity]: Schaltet die Basisempfindlichkeit des Bildsensors um.
[AGC]: Schaltet die AGC-Funktion ein bzw. aus.
[Push AGC]: Aktiviert die AGC-Funktion bei gedrückter Taste.
[ND Filter]

Im variablen Modus: Passt die Durchlässigkeit des ND-Filters an. Gedrückt halten, um zwischen Clear/Manual/Auto umzuschalten.
Im Voreinstellungsmodus: Gedrückt halten, um zwischen Voreinstellungen umzuschalten.

[ND Filter Position]: Schaltet ND-Filter um.
[Auto ND Filter]: Schaltet die automatische ND-Filterfunktion ein bzw. aus.
[Push Auto ND]: Aktiviert bei gedrückter Taste die automatische ND-Filterfunktion.
[Auto Iris]: Schaltet die Blendenfunktion ein bzw. aus.
[Push Auto Iris]: Aktiviert bei gedrückter Taste die automatische Blendenfunktion.
[Bokeh Control]: Schaltet den Bokeh-Steuerungsmodus ein bzw. aus.
[Auto Shutter]: Schaltet die automatische Verschlussfunktion ein bzw. aus.
[AE Level/Mode]: Passt den AE-Pegel an. Gedrückt halten, um den AE-Modus umzuschalten.
[Backlight]: Schaltet zwischen Backlight und Standard um.
[Spotlight]: Schaltet zwischen Spotlight und Standard um.
[Preset White Select]: Schaltet den Wert für den Voreinstellungsmodus des Weißabgleichs um.
[ATW]: Schaltet die ATW-Funktion ein bzw. aus.
[ATW Hold]: Die ATW-Funktion wird angehalten.
[AF Speed/Sens.]: Schaltet die Einstellung für AF-Übergangsgeschwindigkeit und AF-Motivwechselempfindlichkeit um.
[Focus Setting]: Legt den Fokusbereich fest.
[Face/Eye Detection AF]: Schaltet die Einstellungen für Gesichtserkennung-AF um.
[Push AF Mode]: Schaltet die Einstellung für den Push AF-Modus um.
[Push AF/MF]: Im MF-Fokusmodus wird AF aktiviert, solange die Taste gedrückt gehalten wird. Im AF-Fokusmodus wird MF aktiviert,
solange die Taste gedrückt gehalten wird.
[Focus Hold]: Im AF-Fokusmodus wird der Fokus festgehalten, solange die Taste gedrückt gehalten wird.
[S&Q Motion]: Schaltet den Zeitlupen- & Zeitraffermodus ein bzw. aus. Stellt die Aufnahmebildrate ein, wenn gedrückt gehalten.
[LUT On/Off]: Schaltet die LUT-Funktion ein bzw. aus. Mithilfe von [Shooting] > [LUT On/Off] > [LUT On/Off Button Target] wird das
Umschaltziel festgelegt.
[SteadyShot]: Schaltet zwischen Active, Standard und Off um.
[Crop Select]: Schaltet den Imager Scan Mode. Das Umschalten ist innerhalb des Bereichs ohne Änderung des
Aufzeichnungsformats aktiviert.
[Rec]: Startet oder stoppt die Aufzeichnung.
[Picture Cache Rec]: Schaltet den Bildpuffer-Aufzeichnungsmodus ein bzw. aus.
[Rec Review]: Schaltet die Funktion zum Prüfen der Aufzeichnung ein bzw. aus.
[Clip Flag OK]: Führt Add OK aus. Durch zweimaliges Drücken wird die Funktion Delete Clip Flag ausgeführt.
[Clip Flag NG]: Führt Add NG aus. Durch zweimaliges Drücken wird die Funktion Delete Clip Flag ausgeführt.
[Clip Flag Keep]: Führt Add KEEP aus. Durch zweimaliges Drücken wird die Funktion Delete Clip Flag ausgeführt.
[Slot Select]: Schaltet zwischen Speicherkarteneinschub (A) und (B) um.
[Color Bars]: Schaltet die Farbbalken ein bzw. aus.
[DURATION/TC/U-BIT]: Schaltet zwischen Time Code, Users Bit und Duration um.
[Display]: Schaltet die Bildschirmanzeigen ein bzw. aus.
[Lens Info]: Schaltet die Schärfentiefenanzeige um.
[Video Signal Monitor]: Schaltet den Videosignalmonitor um (Wellenform-Monitor usw.).
[Marker]: Schaltet die Markierungsfunktion ein bzw. aus.
[Thumbnail]: Öffnet bzw. schließt die Miniaturbildanzeige.
[Auto Upload (Proxy)]: Schaltet die automatische Übertragung von Proxy-Dateien ein bzw. aus.
[Direct Menu]: Öffnet bzw. schließt das Direktmenü.
[User Menu]: Öffnet bzw. schließt das Menü User.

325



5-041-957-64(1) Copyright 2022 Sony Corporation

326



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Scene File

Zum Festlegen von Einstellungen bezüglich Szenendateien (siehe „Aufnehmen mit dem gewünschten Look“).
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Recall – –
Lädt eine im internen Speicher abgelegte
Szenendatei und übernimmt die Einstellungen als
gegenwärtige Bildqualitätseinstellungen.

Store – –
Speichert die gegenwärtigen
Bildqualitätseinstellungen als Szenendatei im
internen Speicher.

Delete – – Löscht eine Szenendatei aus dem internen
Speicher.

Preset
Recall

Wenn Shooting Mode auf Custom und
Target Display auf SDR(BT.709) gesetzt
ist: S-Cinetone / Standard / Still / ITU709/
709tone
Wenn Shooting Mode auf Custom und
Target Display auf HDR(HLG) gesetzt ist:
HLG Live / HLG Natural

–
Wendet voreingestellte Bildqualitätseinstellungen
(nicht überschreibbar) als aktuelle
Bildqualitätseinstellungen an.
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Base Look

Zum Festlegen der Einstellungen für den grundlegenden Look.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select

Wenn Shooting Mode auf Custom und
Target Display auf SDR(BT.709) gesetzt
ist: S-Cinetone / Standard / Still / ITU709
/ 709tone / User1 bis User16
Wenn Shooting Mode auf Custom und
Target Display auf HDR(HLG) gesetzt
ist: HLG Live / HLG Natural / User1 bis
User16
Wenn Shooting Mode auf Log-
Aufnahmemodi gesetzt ist: s709 /
709(800) / S-Log3 / User1 bis User16

Wenn Shooting Mode auf
Custom und Target Display auf
SDR(BT.709) gesetzt ist: S-
Cinetone
Wenn Shooting Mode auf
Custom und Target Display auf
HDR(HLG) gesetzt ist: HLG
Live
Wenn Shooting Mode auf Log-
Aufnahmemodi gesetzt ist:
s709

Wählt einen grundlegenden Look
aus.

Delete – –
Löscht den ausgewählten
grundlegenden Look.

Delete All – – Löscht alle grundlegenden Looks.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3
Legt den Eingabefarbbereich für den
mithilfe von [Select] ausgewählten
grundlegenden Look fest.

Output BT.709 / HLG BT.709

Legt den Ausgabefarbbereich für
den mithilfe von [Select]
ausgewählten grundlegenden Look
fest.

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Legt den Belichtungsreferenzwert
für den mithilfe von [Select]
ausgewählten grundlegenden Look
fest.
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Reset Paint Settings

Setzt die Einstellungen des [Paint/Look]-Menüs zurück, ausgenommen den grundlegenden Look.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Reset without Base
Look

Execute / Cancel –
Setzt die Einstellungen des [Paint/Look]-Menüs zurück,
ausgenommen den grundlegenden Look.
Execute: Funktion ausführen.
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Black

Zum Festlegen der Schwarzwerteinstellungen.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Master Black −99.0 bis +99.0 ±0.0 Legt den Master-Schwarzpegel fest.

R Black −99.0 bis +99.0 ±0.0 Legt den Schwarzpegel für die R-Signale fest.

B Black −99.0 bis +99.0 ±0.0 Legt den Schwarzpegel für die B-Signale fest.
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Knee

Zum Festlegen der Kniekorrektureinstellungen.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting

Wenn Target Display auf
SDR(BT.709) gesetzt ist: On /
Off / ---
Wenn Target Display auf
HDR(HLG) gesetzt ist: On / Off /
---

Wenn Target Display auf
SDR(BT.709) gesetzt
ist: Off
Wenn Target Display auf
HDR(HLG) gesetzt ist: Off

Schaltet die Kniekorrektur ein bzw. aus.

Hinweis
Nur aktiviert, wenn [Base Look] > [Select] auf
[Standard], [ITU709], [709tone], [HLG Live] oder
[HLG Natural] gesetzt ist.

Auto Knee

Wenn Target Display auf
SDR(BT.709) gesetzt ist: On /
Off / ---
Wenn Target Display auf
HDR(HLG) gesetzt ist: On / Off /
---

Wenn Target Display auf
SDR(BT.709) gesetzt
ist: On
Wenn Target Display auf
HDR(HLG) gesetzt ist: Off

Schaltet die automatische Kniefunktion ein bzw.
aus.

Hinweis
Nur aktiviert, wenn [Base Look] > [Select] auf
[Standard], [ITU709] oder [709tone] gesetzt ist.

Point 75% bis 109% 90% Legt den Kniepunkt fest.

Slope −99 bis +99 ±0 Legt die Kompressionsrate fest.
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Detail

Zum Festlegen der Einstellungen für die Detailanpassung.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off On Schaltet die Detail-Funktion ein bzw. aus.

Level −7 bis +7 ±0 Legt die Detailstufe fest.

Manual
Setting

On / Off / --- Off Schaltet die Funktion zur manuellen Detailanpassung ein bzw. aus.

H/V Ratio −2 bis +2 ±0

Legt die Balance zwischen horizontalem (H) und vertikalem (V) Detail für
die manuelle Detailanpassung fest.

Hinweis

Dieses Element variiert je nach Softwareversion.*1

B/W Balance
Type1 / Type2 / Type3 /
Type4 / Type5

Type3
Legt die Balance zwischen Schwarzdetail (B) für Bereiche mit geringer
Luminanz und Weißdetail (W) für Bereiche mit hoher Luminanz für die
manuelle Detailanpassung fest.

Limit 0 bis 7 7 Legt den Detail-Grenzpegel für die manuelle Detailanpassung fest.

Crispening 0 bis 7 0 Legt den Kantenkorrekturpegel für die manuelle Detailanpassung fest.

High Light
Detail 0 bis 4 0

Legt den Detailpegel von Bereichen mit hoher Luminanz für die manuelle
Detailanpassung fest.

In Softwareversion 1.00 lautet der Menüpunkt [V/H Balance]. In Softwareversion 1.10 oder höher lautet der Menüpunkt [H/V Ratio]. Der Einstellbereich ist
unverändert von −2 bis 0 bis +2, jedoch unterscheidet sich die Auswirkung auf die Bildqualität.
Softwareversion 1.00: Je höher der eingestellte Wert, desto höher das horizontale (H) Detail.
Softwareversion 1.10 oder höher: Je höher der eingestellte Wert, desto höher das vertikale (V) Detail.
Nach dem Aktualisieren von Softwareversion 1.00 auf 1.10 oder höher werden [All File], [Scene File] und andere Einstellungen übernommen, jedoch mit
invertierter Polarität (Bildqualität wird beibehalten).
Falls Sie den Menüpunkt [V/H Balance] im Menü [User] registriert haben, wird er nach dem Aktualisieren der Software automatisch durch den Menüpunkt [H/V
Ratio] im Menü [User] ersetzt.

*1
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Matrix

Zum Festlegen der Einstellungen für die Matrixkorrektur.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

User Matrix On / Off Off Schaltet die benutzerdefinierte Matrixkorrektur ein bzw. aus.

User Matrix Level −99 bis +99 ±0 Passt die Farbsättigung des gesamten Bilds an.

User Matrix Phase −99 bis +99 ±0 Passt den Farbton (Phase) des gesamten Bilds an.

User Matrix R-G −99 bis +99 ±0 Legt eine benutzerdefinierbare R-G-Benutzermatrix fest.

User Matrix R-B −99 bis +99 ±0 Legt eine benutzerdefinierbare R-B-Benutzermatrix fest.

User Matrix G-R −99 bis +99 ±0 Legt eine benutzerdefinierbare G-R-Benutzermatrix fest.

User Matrix G-B −99 bis +99 ±0 Legt eine benutzerdefinierbare G-B-Benutzermatrix fest.

User Matrix B-R −99 bis +99 ±0 Legt eine benutzerdefinierbare B-R-Benutzermatrix fest.

User Matrix B-G −99 bis +99 ±0 Legt eine benutzerdefinierbare B-G-Benutzermatrix fest.
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Multi Matrix

Zum Festlegen der Einstellungen für die Multimatrix-Korrekturfunktion.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet die Multimatrixkorrektur ein bzw. aus.

Area
Indication

On / Off Off

Aktiviert bzw. deaktiviert die Anzeigefunktion, mit welcher der
Zielbereich entsprechend der unter [Axis] gewählten
Zielfarbachse zur Einstellung gekennzeichnet wird.
Die Teile des erfassten Bilds außerhalb des Zielbereichs
werden einfarbig angezeigt.

Tipp
Auf dem Bildschirm zur Einrichtung der Multimatrixkorrektur
können Sie [Area Indication] mithilfe der Taste [Display]
ein-/ausschalten.

Hinweis

[Area Indication] wird auf alle Videoausgaben angewendet.
Beachten Sie dies, wenn Sie ein Videoausgangssignal als
Hauptsignal verwenden.

Area
Indication
Control

Menu Only / Menu & RCP Menu Only
Legt die Bedienschnittstelle fest, die [Area Indication] steuern
kann.

Reset Execute / Cancel –
Farbton und Sättigung jeder Achsenfarbe werden auf die
Standardwerte zurückgesetzt.

Axis
B / B+ / MG− / MG / MG+ / R /
R+ / YL− / YL / YL+ / G− / G / G+
/ CY / CY+ / B−

B Wählt die Achse.

Hue −99 bis +99 ±0
Legt den Farbton der für die Multimatrixkorrektur verwendeten
Farbe fest.

Saturation −99 bis +99 ±0
Legt die Sättigung der für die Multimatrixkorrektur
verwendeten Farbe fest.
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P/T Acceleration

Zum Festlegen der Einstellungen bezüglich der Beschleunigung für Schwenk-/Neigevorgänge.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Ramp
Curve

1 bis 9 8
Legt die Beschleunigung/Abbremsung für Schwenk-/Neigevorgänge fest.
Je höher die Zahl, desto höher ist die Beschleunigung.
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Timecode

Zum Festlegen der Einstellungen für den Zeitcode.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Mode Preset / Regen / Clock Preset

Legt den Ausführungsmodus für den Zeitcode fest.
Preset: Der Zeitcode beginnt ab einem vorgegebenen Wert.
Regen: Der Zeitcode startet mit dem Zeitcode am Ende des
vorhergehenden Clips.
Clock: Als Zeitcode wird die interne Uhr verwendet.

Run Rec Run / Free Run Rec Run
Rec Run: Der Zeitcode läuft nur während der Aufzeichnung.
Free Run: Der Zeitcode läuft durchgehend, unabhängig vom
Aufnahmebetrieb.

Setting – –
Stellt den Zeitcode auf einen beliebigen Wert ein.
Set: Wert einstellen.

Reset Execute / Cancel –
Setzt den Zeitcode auf 00:00:00:00 zurück.
Execute: Funktion ausführen.

TC Format DF / NDF DF
Wählt das Zeitcode-Format.
DF: Drop Frame
NDF: Non-Drop Frame
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TC Display

Zum Festlegen der Einstellungen für die Zeitdatenanzeige.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Display Select Timecode / Users Bit / Duration Timecode Schaltet die Zeitdatenanzeige um.
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Users Bit

Legt Einstellungen zu den Anwenderdaten fest.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Mode Fix / Time Fix

Legt den Anwenderdatenmodus fest.
Fix: In den Anwenderdaten wird ein beliebiger fester Wert verwendet.
Time: Verwendet die aktuelle Stunde, Minute und Sekunde in den
Anwenderdaten.

Setting – – Legt die Anwenderdaten auf einen beliebigen Wert fest.
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HDMI TC Out

Zum Festlegen der Einstellungen für das Zeitcode-Ausgangssignal bei Verwendung von HDMI.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off
Legt fest, ob der Zeitcode zu anderen Zwecken per HDMI an Geräte
weitergegeben werden soll.
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Clip Name Format

Legt Einstellungen zum Benennen und Löschen von Clips fest.
Wenn [Auto Naming] auf [Cam ID + Reel#] gesetzt ist, werden die ersten vier Zeichen von Clipnamen für jedes Aufzeichnungsmedium
bestimmt. Wenn ein neues Aufzeichnungsmedium eingesetzt wird oder der letzte Clip auf dem Aufzeichnungsmedium nicht mit den
Einstellungen [Camera ID] oder [Reel Number] übereinstimmt, blinkt der Clipname, um dies zu signalisieren.
Wenn [Auto Naming] auf [Title] gesetzt ist, können Sie eine beliebige Zeichenfolge als ersten Teil von Clipnamen verwenden.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Auto Naming Cam ID + Reel# / Title

Wählt das Format für Clip-Benennung aus.
Cam ID + Reel#: Camera ID + Reel Number + Shot Number +
Datum + Zufallszeichenfolge
Title: Beliebige unter [Title Prefix] angegebene Zeichenfolge +
Clip-Nummer

Camera ID A bis Z A

Legt die zum Erzeugen von Clipnamen verwendete Kamera-ID
fest.

Hinweis

Nur konfigurierbar, wenn [Auto Naming] auf [Cam ID + Reel#]
gesetzt ist.

Reel Number 001 bis 999 001

Legt die zum Erzeugen von Clipnamen verwendete
Spulennummer (Reel Number) fest.

Hinweis
Nur konfigurierbar, wenn [Auto Naming] auf [Cam ID + Reel#]
gesetzt ist.

Camera
Position

C / L / R C

Legt das erste Zeichen der zum Erzeugen von Clipnamen
verwendeten Einstellungsnummer (Shot Number) fest.

Hinweis

Nur konfigurierbar, wenn [Auto Naming] auf [Cam ID + Reel#]
gesetzt ist.

Title Prefix
nnn_(nnn steht für die letzten
drei Ziffern der Seriennummer)
(max. 7-stellige Anzeige)

nnn

Legt den Titelteil (4 bis 46 Zeichen) des Clipnamens fest.
Öffnet einen Bildschirm zur Zeicheneingabe.

Einzelheiten zum Festlegen von Titeln und zum Bildschirm
zur Zeicheneingabe siehe „So legen Sie den Titel fest“ unten
und „Eingeben einer Zeichenfolge“.

Hinweis

Nur konfigurierbar, wenn [Auto Naming] auf [Title] gesetzt ist.

Number Set 0001 bis 9999 0001

Legt die vierstellige numerische Endung des Clipnamens fest.

Hinweis

Nur konfigurierbar, wenn [Auto Naming] auf [Title] gesetzt ist.
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So legen Sie [Title Prefix] fest

Verwandtes Thema
Eingeben einer Zeichenfolge
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Wählen Sie im Bereich [Title Prefix] das an der Cursorposition einzufügende Zeichen im Zeichenauswahlbereich mithilfe
der Pfeiltasten im GUI-Steuerbereich aus (Zeichen wird hervorgehoben) und drücken Sie die Taste [Set] im GUI-
Steuerbereich.

Das ausgewählte Zeichen wird eingefügt und der Cursor nach rechts bewegt.

1

Wiederholen Sie Schritt 1, um den Titel festzulegen.

Verwenden Sie bei Bedarf [BS].

2

Nachdem Sie den Titel festgelegt haben, drücken Sie die Taste [Done], um den Bildschirm zur Zeicheneingabe zu
schließen.

Einzelheiten zur Bedienung auf dem Bildschirm zur Zeicheneingabe siehe „Eingeben einer Zeichenfolge“.

Die folgenden Zeichen können ausgewählt werden.
!#$%()+,-.;=@[ ]^_~ Leerzeichen
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Aktualisiert die Verwaltungsdatei auf Speicherkarten (siehe „Wiederherstellen von Speicherkarten“).

Verwandtes Thema
Wiederherstellen von Speicherkarten
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Media(A) Execute / Cancel –
Die Verwaltungsdatei auf der Speicherkarte in Einschub A wird
aktualisiert.
Execute: Funktion ausführen.

Media(B) Execute / Cancel –
Die Verwaltungsdatei auf der Speicherkarte in Einschub B wird
aktualisiert.
Execute: Funktion ausführen.
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Format Media

Zum Formatieren (Initialisieren) von Speicherkarten (siehe „Formatieren (Initialisieren) von Speicherkarten“).

Verwandtes Thema
Formatieren (Initialisieren) von Speicherkarten

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Media(A) Full Format / Quick Format / Cancel – Die Speicherkarte in Einschub A wird formatiert.

Media(B) Full Format / Quick Format / Cancel – Die Speicherkarte in Einschub B wird formatiert.
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Media Life

Zeigt die verbleibende Lebensdauer der Speicherkarten an.

Hinweis
Erfordert Speicherkarten, welche die Anzeige der verbleibenden Medienlebensdauer unterstützen.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Media(A) – –
Zeigt die verbleibende Lebensdauer der Speicherkarte in Einschub A
an.

Media(B) – –
Zeigt die verbleibende Lebensdauer der Speicherkarte in Einschub B
an.
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Output Format

Zum Festlegen der Einstellungen für das Ausgabeformat.

Verwandtes Thema
Ausgabeformate und Beschränkungen
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

SDI Einzelheiten zu Einstellungen siehe
„Ausgabeformate und Beschränkungen“.

– Legt die Auflösung des SDI- und des HDMI-
Ausgangssignals fest.HDMI –
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Display On/Off

Zum Festlegen der Einstellungen für die anzuzeigenden Elemente.
Um ein Anzeigeelement einzublenden, wählen Sie On. Um ein Anzeigeelement auszublenden, wählen Sie Off.

Menüpunkt Untergeordnete Einstellung Standardwert

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On
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Menüpunkt Untergeordnete Einstellung Standardwert

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Legt Videosignal-Monitoreinstellungen fest.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting Off / Waveform / Vector / Histogram Off Legt den Typ des Videosignal-Monitors fest.

Level Marker 1 0% bis 109% 70% Legt den Pegel der Luminanzpegelmarkierung 1 fest.

Level Marker 2 0% bis 109% 100% Legt den Pegel der Luminanzpegelmarkierung 2 fest.
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Marker

Zum Festlegen der Einstellungen für die Markierungsanzeige.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off On Schaltet sämtliche Markierungsanzeigen ein bzw. aus.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Wählt die Farbe des Markierungssignals.

Center Marker 1 / 2 / 3 / 4 / Off Off Wählt die Mittenmarkierung aus.

Safety Zone On / Off Off Schaltet die Sicherheitszonenmarkierung ein bzw. aus.

Safety Area 80% / 90% / 92.5% / 95% 90%
Wählt die Größe (Prozentsatz des gesamten
Bildschirms) der Sicherheitszonenmarkierung.

Aspect Marker Line / Mask / Off Off Wählt die Bildformatmarkierung.

Aspect Mask 0 bis 15 12
Legt den Pegel des Videosignals außerhalb der
Markierung fest.

Aspect Safety
Zone

On / Off Off
Schaltet die Bildformat-Sicherheitszonenmarkierung ein
bzw. aus.

Aspect Safety
Area

80% / 90% / 92.5% / 95% 90%
Wählt die Größe (Prozentsatz des gesamten
Bildschirms) der Bildformat-
Sicherheitszonenmarkierung aus.

Aspect Select
1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 /
Custom

2.39:1
Legt den Modus bei der Anzeige der
Bildformatmarkierung fest.

Custom
Aspect Ratio

Geben Sie einen beliebigen Wert ein. 01.00:01.00

Stellt das Bildformat auf einen beliebigen Wert ein.

Hinweis

Aktiviert, wenn [Aspect Select] auf [Custom] gesetzt
ist.

Guide Frame On / Off Off Schaltet die Rastermarkierung ein bzw. aus.

100% Marker On / Off Off Schaltet die 100%-Markierung ein bzw. aus.

User Box On / Off Off
Schaltet die Anzeige der Formatmarkierung ein bzw.
aus.

User Box
Width

3 bis 479 240
Legt die Breite der Formatmarkierung (Abstand von der
Mitte bis zur linken oder rechten Ecke) fest.

User Box
Height

3 bis 269 135
Legt die Höhe der Formatmarkierung (Abstand von der
Mitte bis zur oberen oder unteren Ecke) fest.

User Box H
Position −476 bis +476 0

Legt die horizontale Position der Mitte der
Formatmarkierung fest.

User Box V
Position

−266 bis +266 0
Legt die vertikale Position der Mitte der
Formatmarkierung fest.
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Audio Input

Zum Festlegen der Einstellungen für die Einspeisung der Audiosignale.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

AUDIO IN
Select

MIC / LINE MIC
Zum Auswählen des mit dem AUDIO IN-Anschluss verbundenen
Gerätetyps.

Phantom
Power +48V

On / Off Off Zeigt den Status der Phantomspeisung mit +48 V an.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Zeigt die Eingabequelle für die Aufzeichnung auf Kanal 1 an.

CH2 Input
Select

AUDIO IN CH1 / AUDIO
IN CH2

AUDIO IN
CH2

Setzt die Eingabequelle für die Aufzeichnung auf Kanal 2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Setzt die Eingabequelle für die Aufzeichnung auf Kanal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Setzt die Eingabequelle für die Aufzeichnung auf Kanal 4.

AUDIO IN CH1
MIC Ref.

−80dB / −70dB / −60dB /
−50dB / −40dB / −30dB

−50dB
Legt den Referenzaufzeichnungspegel für das XLR-
Mikrofoneingangssignal AUDIO IN CH1 fest.

AUDIO IN CH2
MIC Ref.

−80dB / −70dB / −60dB /
−50dB / −40dB / −30dB

−50dB
Legt den Referenzaufzeichnungspegel für das XLR-
Mikrofoneingangssignal AUDIO IN CH2 fest.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Zum Auswählen des bei Einstellung von [AUDIO IN Select] auf LINE
verwendeten Referenzeingangspegels.

Reference
Level

−20dB / −18dB / −16dB /
−12dB / EBUL

−20dB Wählt den Aufnahmepegel des 1-kHz-Referenztons aus.

CH1 Wind
Filter

On / Off Off
Aktiviert bzw. deaktiviert den Windfilter für die Aufzeichnung auf
Kanal 1.

CH2 Wind
Filter

On / Off Off
Aktiviert bzw. deaktiviert den Windfilter für die Aufzeichnung auf
Kanal 2.

CH3 Wind
Filter

On / Off Off
Aktiviert bzw. deaktiviert den Windfilter für die Aufzeichnung auf
Kanal 3.

CH4 Wind
Filter

On / Off Off
Aktiviert bzw. deaktiviert den Windfilter für die Aufzeichnung auf
Kanal 4.

CH1 Level
Control

Auto / Manual Auto
Wählt die automatische oder manuelle Einstellung des Audio-
Eingangspegels für Aufzeichnungskanal 1 aus.

CH2 Level
Control

Auto / Manual Auto
Wählt die automatische oder manuelle Einstellung des Audio-
Eingangspegels für Aufzeichnungskanal 2 aus.

CH3 Level
Control

Auto / Manual Auto
Wählt die automatische oder manuelle Einstellung des Audio-
Eingangspegels für Aufzeichnungskanal 3 aus.

CH4 Level
Control

Auto / Manual Auto
Wählt die automatische oder manuelle Einstellung des Audio-
Eingangspegels für Aufzeichnungskanal 4 aus.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

CH1 Input
Level

0 bis 99 49 Legt den Eingangspegel für die Aufzeichnung auf Kanal 1 fest.

CH2 Input
Level

0 bis 99 49 Legt den Eingangspegel für die Aufzeichnung auf Kanal 2 fest.

CH3 Input
Level

0 bis 99 49 Legt den Eingangspegel für die Aufzeichnung auf Kanal 3 fest.

CH4 Input
Level

0 bis 99 49 Legt den Eingangspegel für die Aufzeichnung auf Kanal 4 fest.

Master Input
Level

0 bis 99 99 Legt den Master-Audioeingangspegel fest.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB / −17dB

Off
Wählt den Begrenzerpegel für den Fall aus, dass bei manueller
Einstellung des Audioeingangspegels ein lautes Signal eingespeist
wird.

CH1&2 AGC
Mode Mono / Stereo Stereo

Legt den Modus für die automatische Pegelanpassung für
Aufzeichnungskanal 1 und Kanal 2 fest. Wenn Stereo eingestellt ist,
ist die AGC der Kanäle verknüpft.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Legt den Modus für die automatische Pegelanpassung für
Aufzeichnungskanal 3 und Kanal 4 fest. Wenn Stereo eingestellt ist,
ist die AGC der Kanäle verknüpft.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Wählt die Eigenschaften der automatischen Verstärkungssteuerung.

1kHz Tone on
Color Bars On / Off Off

Schaltet das 1-kHz-Referenzsignal beim Anzeigen von Farbbalken
ein bzw. aus.

Hinweis
Wenn diese Option auf [On] gesetzt ist, wird das 1-kHz-
Referenztonsignal für die Aufzeichnung auf Kanal 3 und 4 festgelegt,
auch wenn [CH3 Input Select] und [CH4 Input Select] auf [Off] gesetzt
sind.
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Audio Output

Zum Festlegen der Einstellungen für die Audioausgabe.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

HDMI/Stream Output
CH

CH1/CH2 / CH3/CH4 CH1/CH2
Legt die Kombination der Audiokanäle für die
HDMI-/Streaming-Ausgabe fest.
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Display Clip Properties

Zeigt den Bildschirm mit Clipeigenschaften an.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Display Clip Properties – – Zeigt den Bildschirm mit Clipeigenschaften an.
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Hilfe
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Set Clip Flag

Zum Festlegen der Einstellungen für die Clipkennzeichnung.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Add OK – – Fügt eine OK-Kennzeichnung hinzu.

Add NG – – Fügt eine NG-Kennzeichnung hinzu.

Add KEEP – – Fügt eine KEEP-Kennzeichnung hinzu.

Delete Clip Flag – – Alle Kennzeichnungen werden gelöscht.
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Lock/Unlock Clip

Zum Festlegen der Einstellungen zum Clip-Schutz.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select Clip – – Hierüber wird ein Clip ausgewählt und ge- bzw. entsperrt.

Lock All Clips – – Alle Clips werden gesperrt.

Unlock All Clips – – Alle Clips werden entsperrt.

356



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Löscht Clips.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select Clip – – Der gewählte Clip wird gelöscht.

All Clips – – Löscht alle Clips.
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Transfer Clip

Überträgt Clips.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select Clip – – Überträgt ausgewählte Clips.

All Clips – –

Überträgt alle Clips.

Hinweis
Bis zu 200 Übertragungen können registriert werden.
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Transfer Clip (Proxy)

Überträgt Proxy-Clips.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select Clip – – Überträgt die Proxy-Clips für die ausgewählten Clips.

All Clips – –

Überträgt die Proxy-Clips für alle Clips.

Hinweis
Bis zu 200 Übertragungen können registriert werden.
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Filter Clips

Zum Festlegen der Einstellungen für die anzuzeigenden Clips.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

OK – – Es werden nur Clips mit OK-Kennzeichnung angezeigt.

NG – – Es werden nur Clips mit NG-Kennzeichnung angezeigt.

KEEP – – Es werden nur Clips mit KEEP-Kennzeichnung angezeigt.

None – – Es werden nur Clips ohne Kennzeichnung angezeigt.

All – –
Es werden ohne Berücksichtigung von Kennzeichnungen alle Clips
angezeigt.
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Customize View

Schaltet die Ansicht der Miniaturbildanzeige um.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Ändert die Informationen, die unter den
Miniaturbildern angezeigt werden.
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Color Bars

Zum Festlegen der Einstellungen für die Farbbalken.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet die Farbbalken ein bzw. aus.

Type ARIB / 100% / 75% / SMPTE ARIB Wählt den Farbbalkentyp.
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Genlock

Zum Konfigurieren der Genlock-Statusanzeige (siehe „Synchronisieren der Phase des Videosignals (Genlock)“).

Verwandtes Thema
Synchronisieren der Phase des Videosignals (Genlock)
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Reference Internal / External(HD) / External(SD) – Zeigt den Typ des Genlock-Referenzsignals an.
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Tally

Legt Einstellungen für die Aufnahme-/Tally-Anzeige fest (siehe „Zuführen eines Tally-Signals“).

Verwandtes Thema
Zuführen eines Tally-Signals
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Tally Lamp
Brightness

High / Low / Off High Legt die Helligkeit der Aufnahme-/Tally-Anzeige fest.

G Tally Lamp Enable / Disable Enable Aktiviert/deaktiviert die grüne Tally-Anzeige.

Tally Control
External / Internal / PTZ
AFR Internal

Wählt das Ziel zur Auswertung der Steuerinformationen des Geräts
für die Aufnahme-/Tally-Anzeige aus.
External: Tally-Steuerung von außerhalb der Kamera.
Internal: Steuerung über Kamera-Aufnahmevorgang.
PTZ AFR: Steuerung über PTZ AFR-Betriebszustand.
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Interchangeable Lens Digital Camera
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Rec Review

Zum Festlegen von Einstellungen zur Prüfung der Aufzeichnung (siehe „Prüfen der Aufnahme (Rec Review)“).

Verwandtes Thema
Prüfen der Aufnahme (Rec Review)
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting 3s / 10s / Clip 3s
Zum Festlegen der Wiedergabedauer von soeben aufgenommenen
Clips zur Prüfung.

365



Hilfe
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Zoom

Legt die Zoomeinstellungen fest („Einstellen des Zooms“).
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Legt den Zoomtyp fest.
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Lens

Zum Festlegen der Einstellungen für Objektive.

Verwandtes Thema
Kompensation des Fokuspumpens
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Lens Calibration Execute / Cancel –
Führt die Funktion zur Korrektur von durch Unterschiede einzelner
Objektive bedingte Differenzen der Zoomposition durch, wenn ein
Motorzoomobjektiv verwendet wird.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Legt die Richtung für den Zoomring fest.

Hinweis
Diese Option ist nur dann aktiviert, wenn Sie ein Objektiv mit E-
Bajonett verwendet, bei dem die Richtung des Zoomrings
gewechselt werden kann.

Shading
Compensation

Auto / Off Auto Legt die automatische Schattierungskorrektur fest.

Chroma
Aberration Comp.

Auto / Off Auto Legt die automatische Korrektur der chromatischen Aberration fest.

Distortion Comp. Auto / Off Auto Legt die automatische Verzerrungskorrektur fest.

Breathing
Compensation

Auto / Off Off
Legt die Kompensation des Fokuspumpens für das Objektiv fest.

Siehe „Kompensation des Fokuspumpens“.

Distance Display Meter / Feet Meter
Legt die Anzeigeeinheiten für die Objektivdaten und die
Fokusposition fest.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Legt das Anzeigeformat für die Zoomposition fest.

367



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

APR

Ausführen der APR.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

APR Execute / Cancel –

Führt die APR (automatische Pixelkorrektur) für die automatische
Anpassung des Bildsensors aus.
Execute: Funktion ausführen.

Hinweis

Bringen Sie vor dem Ausführen der automatischen Pixelkorrektur stets die
Objektivkappe an.
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Wired LAN

Legt Einstellungen für kabelgebundene Netzwerkverbindungen fest.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

HTTP Port – 80 Zeigt den Port für HTTP-Zugriff an.

Detail
Settings

– – Zeigt Eigenschaften der verkabelten LAN-Verbindung an.

DHCP
On / Off

On Zeigt an, ob DHCP aktiviert (On) oder deaktiviert ist (Off).

IP Address –
Zeigt die IP-Adresse des Geräts an, wenn [DHCP] auf [Off] gesetzt
ist.

Subnet Mask –
Zeigt die Subnetzmaske des Geräts an, wenn [DHCP] auf [Off]
gesetzt ist.

Gateway – Zeigt das Standard-Gateway an, wenn [DHCP] auf [Off] gesetzt ist.

DNS Auto
On / Off

On Zeigt die Einstellung zum automatischen DNS-Bezug an.
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Interchangeable Lens Digital Camera
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File Transfer

Zum Festlegen der Einstellungen bezüglich Dateiübertragungen (siehe „Informationen zur Dateiübertragung“).

Verwandtes Thema
Informationen zur Dateiübertragung
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Auto Upload
(Proxy)

On / Off Off
Zum Ein-/Ausschalten des automatischen Hochladens von Proxy-
Dateien.

Default Upload
Server

Server Settings1 bis 3
> Display Name

–

Wählt den Upload-Server für Dateien aus. Der hier ausgewählte Server
wird zum Ziel für das automatische Hochladen von Proxy-Dateien und
zum Upload-Ziel für Dateien in der Miniaturbildanzeige.
Zeigt die unter [Server Settings1 bis 3] konfigurierten Einstellungen für
[Display Name] an.

Clear
Completed
Jobs

Execute / Cancel –
Löscht abgeschlossene Übertragungen aus der Liste.
Execute: Funktion ausführen.

Clear All Jobs Execute / Cancel –
Löscht alle Übertragungen aus der Liste.
Execute: Funktion ausführen.

View Job List – – Zeigt die Übertragungsliste an.
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Language

Legt die Sprache fest.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Select – –
Legt die Sprache fest.
Set: Wert einstellen.
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Clock Set

Zum Festlegen der Einstellungen für die innere Uhr.

Hinweis

Wenn Sie diese Einstellung vom Kameramenü aus ändern, schalten Sie die Stromversorgung des Geräts aus und starten das Gerät neu. Wenn
die Stromversorgungsbereitschaft mithilfe der Infrarot-Fernbedienung oder der Web-App eingeleitet wird, kann es zu unerwartetem Verhalten
kommen.
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Time Zone UTC −12:00 bis UTC +14:00 –
Stellt den Zeitzonen-Unterschied zu UTC in Schritten von 30
Minuten ein.

Date Mode
YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Wählt das Anzeigeformat für das Datum aus.
YYMMDD: Jahr, Monat, Tag
MMDDYY: Monat, Tag, Jahr
DDMMYY: Tag, Monat, Jahr

12H/24H 12H / 24H 24H
Wählt den Anzeigemodus für die Uhrzeit aus.
12H: 12-Stunden-Modus
24H: 24-Stunden-Modus

Date – –
Legt das aktuelle Datum fest.
Set: Wert einstellen.

Time – –
Stellt die aktuelle Uhrzeit ein.
Set: Wert einstellen.
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Hours Meter

Zeigt die akkumulierte Laufzeit an.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Hours(System) – –
Zeigt die Gesamtbetriebsstunden an (kann nicht zurückgesetzt
werden).

Hours(Reset) – – Zeigt die Gesamtbetriebsstunden an (kann zurückgesetzt werden).

Reset Execute / Cancel –
Setzt die Gesamtbetriebsdauer auf 0 zurück.
Execute: Funktion ausführen.
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Einstellungen und Standardwerte für ISO/Gain

Der Bereich der [ISO/Gain<L>]-Einstellungen und Standardwerte variieren je nach Einstellungen für [Mode], [Base Look] > [Select] und
[Base Sensitivity].
Standardwerte sind in der Tabelle fett gedruckt.

Wenn [Mode] auf [ISO] gesetzt ist

Wenn [Base Look] > [Select] auf [S-Cinetone], [Standard], [ITU709], [709tone] oder [Still] gesetzt
ist

Wenn [Base Look] > [Select] auf [HLG Live] oder [HLG Natural] gesetzt ist

Wenn [Base Look] > [Select] auf [User1] bis [User16] gesetzt ist

Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Wenn [Mode] auf [dB] gesetzt ist

Ein Wert im Bereich von −3dB bis +30dB kann in 1-dB-Schritten konfiguriert werden.
Der Standardwert ist 0dB.
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Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Einstellungen und Standardwerte für AGC Limit

Der Bereich der [AGC Limit]-Einstellungen und Standardwerte variieren je nach Einstellungen für [Mode], [Base Look] > [Select] und
[Base Sensitivity].
Standardwerte sind in der Tabelle fett gedruckt.

Wenn [Mode] auf [ISO] gesetzt ist

Wenn [Base Look] > [Select] auf [S-Cinetone], [Standard], [ITU709], [709tone] oder [Still] gesetzt
ist

Wenn [Base Look] > [Select] auf [HLG Live] oder [HLG Natural] gesetzt ist

Wenn [Base Look] > [Select] auf [User1] bis [User16] gesetzt ist

Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Wenn [Mode] auf [dB] gesetzt ist

Wählen Sie einen der Werte 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Der Standardwert ist 15dB.
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Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [Low] gesetzt ist Wenn [ISO/Gain/EI] > [Base Sensitivity] auf [High] gesetzt ist

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Für jeden Aufnahmemodus gespeicherte Bildqualitätseinstellungen

Der gegenwärtige Status von Konfigurationsmenüpunkten, die sich auf die Bildqualität beziehen, wird für jeden der folgenden
Aufnahmemodi gespeichert. Wenn Sie den Aufnahmemodus ändern, werden die für den gewünschten Aufnahmemodus gespeicherten
Einstellungen angewendet.

Custom-Modus, Zielanzeige SDR(BT.709)
Custom-Modus, Zielanzeige HDR(HLG)
Log-Aufnahme (Cine EI, Cine EI Quick, Flexible ISO)

Die für jeden Modus gespeicherten, auf die Bildqualität bezogenen Konfigurationsmenüpunkte werden in den nachfolgenden Tabellen
aufgeführt.
„Ja“ bedeutet, dass die Einstellung gespeichert wird. „Nein“ bedeutet, dass sie nicht gespeichert wird. „Ja“ über mehrere Spalten
bedeutet gemeinsame Einstellungen.

Menüpunkt

Aufnahmemodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting-Menü

ISO/Gain/EI

ISO/Gain Ja1) Ja Nein

Exposure Index Nein Nein Ja Ja

Base Sensitivity Ja Nein

Base ISO Nein Ja4) Nein3) Ja4)

White
Preset White Ja Ja

Andere als obige Ja

White Setting Ja

Offset White Ja Nein

LUT On/Off Nein Ja

Noise
Suppression

Setting(Custom) Ja Ja Nein

Level(Custom) Ja Ja Nein

Setting (Cine EI/Flex.
ISO)

Nein Ja

Level (Cine EI/Flex.
ISO)

Nein Ja
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Menüpunkt

Aufnahmemodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look-
Menü

Base Look

Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE Level Offset2) Ja

Black Ja Ja Nein

Knee
Auto Knee Ja Nein Nein

Andere als obige Ja Ja Nein

Detail Ja Ja Nein

Matrix Ja Ja Nein

Multi Matrix Ja Ja Nein

Für die Custom-Modi SDR(BT.709) und HDR(HLG) werden separate ISO-Empfindlichkeitseinstellungen gespeichert.1)

Einstellungen werden für jeden grundlegenden Look gespeichert und hängen nicht vom Aufnahmemodus ab.2)

Die ISO-Basisempfindlichkeit ändert sich in Abhängigkeit von der Einstellung für Exposure Index.3)

Allgemeiner Einstellungswert in den Aufnahmemodi Flexible ISO und Cine EI.4)
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Konfiguration des Webmenüs

Drücken Sie auf die Umschalt-Registerkarte [Settings], um den Einstellungsbildschirm anzuzeigen.
Konfigurieren Sie mithilfe des Webmenüs über den Einstellungsbildschirm die verschiedenen Einrichtungselemente des Geräts,
darunter Ersteinstellungen, Netzwerkeinstellungen, Aufnahme-/Wiedergabeeinstellungen.

Das Menü ist in folgende Menüs gegliedert.

Konfiguration und Hierarchie des Menüs

Ebene 1 Beschreibung Ebene 1 Ebene 2

Shooting Enthält Einstellungen für die Aufnahme. Focus

Project Enthält grundlegende Projekteinstellungen.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Enthält Einstellungen für die Bildqualität. Base Look
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Ebene 1 Beschreibung Ebene 1 Ebene 2

Pan-Tilt Enthält Einstellungen für die Schwenk-/Neigefunktion.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Enthält Einstellungen zur Videoausgabe und für die Bildschirmanzeige.
Output Format

Output Display

Audio Enthält Einstellungen für die Audiosteuerung. Audio

Technical Enthält technische Einstellungen.

Tracking Data Output

Tracking Data

Tally

IR Remote

RCP/MSU

Lens Controller

Network Enthält Einstellungen zu Netzwerken.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

SSH

Referer Check

Brute Force Attack Protection

Stream Enthält Einstellungen für das Streaming.

Stream

Video Stream

Audio Stream
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Hinweis
[Accessibility] ist nur bei Modellen für Nordamerika verfügbar.
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Ebene 1 Beschreibung Ebene 1 Ebene 2

Maintenance Enthält Geräteeinstellungen wie Uhrzeit und Sprache.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

Software
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Funktionen des Webmenüs

Drücken Sie auf die Umschalt-Registerkarte [Settings] des Betriebsbildschirms, um den Einstellungsbildschirm anzuzeigen.
Konfigurieren Sie auf diesem mithilfe des Webmenüs die verschiedenen Einrichtungselemente des Geräts, darunter Ersteinstellungen,
Netzwerkeinstellungen, Aufnahme-/Wiedergabeeinstellungen.
Konfigurieren Sie Einstellungen im Webmenü auf einem Tablet per Touch-Bedienung oder auf einem Computer per Mausbedienung.
Drücken Sie auf das Menü der zu konfigurierenden Elemente, um diese mit ihren Einstellungen anzuzeigen.

Konfigurationsmethode

Werteauswahl

Drücken Sie auf das Optionsfeld für ein Element. Das Optionsfeld eines ausgewählten Elements wird orangefarben angezeigt.

Element ein/aus

Menü (Ebene 1)1.

Menü (Ebene 2)2.

Einstellung3.
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Drücken Sie auf den Schalter, um das Element ein- bzw. auszuschalten. Der Schalter wird orangefarben dargestellt, wenn das
Element eingeschaltet ist und weiß, wenn es ausgeschaltet ist.

Werteauswahl aus einer Liste

Drücken Sie auf die Dropdown-Taste und wählen Sie ein Element aus der angezeigten Liste aus.

Numerische Werteauswahl

Drücken Sie < oder >, um den numerischen Wert zu ändern. Ist der numerische Wert unterstrichen, können Sie ihn auch direkt
eingeben.

Eingabe von Zeichen/Ziffern

Konfiguration auf separatem Bildschirm
Drücken Sie die Taste, um Einrichtungsvorgänge auf einem separaten Bildschirm durchzuführen.

Hilfsmeldung

Es werden Informationen angezeigt, die Sie dabei unterstützen, einige Einstellungen zu konfigurieren, außerdem Meldungen, die Sie
auf etwas aufmerksam machen.

Speichern einer Einstellung

Drücken Sie nach dem Konfigurieren einer Einstellung die Taste [OK], um die Einstellung zu speichern.
Drücken Sie die Taste [Cancel], um Änderungen einer Einstellung zu verwerfen und die vorhergehende Einstellung wiederherzustellen.
Drücken Sie die Taste [Reload], um die Bildschirmanzeige zu aktualisieren.

Hinweis
Falls Sie vor dem Speichern einer Einstellung die Taste [Reload] drücken, werden Änderungen der Einstellung verworfen.

Falls Sie vor dem Speichern einer Einstellung zu einer anderen Seite wechseln, werden Änderungen der Einstellung verworfen.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Focus

Zum Festlegen der Fokuseinstellungen.

Verwandtes Thema
Manuelles Einstellen des Autofokusziels (AF Assist) mithilfe der Web-App
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Push AF Mode
AF / Single-shot
AF(AF-S)

AF Legt den Modus für Autofokus auf Knopfdruck fest.

Touch Function
in MF

Tracking AF / Spot
Focus

Tracking AF
Legt den Vorgang nach Berühren des Bildschirms mit dem Kamerabild
im MF-Modus fest.

AF Assist
Control

On / Off On

Wenn diese Option auf [On] gesetzt ist, können Sie den
Fokusschieberegler in der Web-App während des Autofokus dazu
verwenden, die Fokusposition anzupassen.

Einzelheiten siehe „Manuelles Einstellen des Autofokusziels (AF
Assist) mithilfe der Web-App“.

Hinweis
Dieser Menüpunkt ist nur aktiviert, wenn [AF Assist] im Kameramenü auf
[On] gesetzt ist.
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Base Setting

Zum Festlegen der Grundeinstellungen.

Verwandtes Thema
Konfigurieren der Grundfunktionen
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Shooting
Mode

Custom / Flexible ISO / Cine EI Quick
/ Cine EI

Custom

Zum Festlegen des Aufnahmemodus.
Siehe „Aufnahmemodus“ unter „Konfigurieren der
Grundfunktionen“.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Legt den Farbbereich der Aufzeichnung/Ausgabe im
Modus Custom fest.
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Rec Format

Zum Festlegen der Einstellungen für das Aufzeichnungsformat.

Einstellungen für [RAW Output Format]

Standardwerte sind fett gedruckt.
Die Bedingungen, unter denen [RAW Output Format] nicht festgelegt werden kann, wurden weggelassen.

Einstellungen für [Video Format]

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Wählt die Systemfrequenz aus.

Hinweis
Wenn die Frequenz geändert wird, startet die
Kamera neu. Laden Sie nach dem Neustart die
Seite im Webbrowser erneut.

Imager Scan
Mode

FF / S35 FF Wählt die Bildsensorgröße aus.

Codec RAW / RAW & XAVC-I / XAVC-I / XAVC-L XAVC-I

Wählt den Codec für Aufnahme bzw. Wiedergabe
von Clips aus.

Hinweis

Wenn [Imager Scan Mode] auf [S35] gesetzt ist,
können [RAW] und [RAW & XAVC-I] nicht
ausgewählt werden.

RAW Output
Format

Die verfügbaren Einstellungen variieren je
nach Einstellung für [Frequency].

Siehe „Einstellungen für [RAW Output
Format]“ unten.

–

Legt die Größe des an einen externen RAW-
Recorder auszugebenden RAW-Bilds fest.

Hinweis
Wenn [Codec] auf [RAW & XAVC-I] eingestellt
ist, wechselt die Einstellung [Video Format] je
nach der Einstellung für [RAW Output Format].

Video Format

Die verfügbaren Einstellungen variieren je
nach den Einstellungen für [Frequency],
[Imager Scan Mode] und [Codec].

Siehe „Einstellungen für [Video Format]“
unten.

– Legt die Bildgröße fest.

Frequency Imager Scan Mode Codec Einstellung

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Standardwerte sind fett gedruckt.
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Frequency Imager Scan Mode Codec Einstellung

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Zum Festlegen von Einstellungen für den Simultanaufzeichnungsmodus in 2 Einschüben (siehe „Gleichzeitige Aufnahme auf
Speicherkarten A und B (2-slot Simul Rec)“).

Verwandtes Thema
Gleichzeitige Aufnahme auf Speicherkarten A und B (2-slot Simul Rec)
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off
Legt die Funktion für die simultane Aufnahme ein- bzw. ausgeschaltet
und das Medium für die Aufzeichnung fest.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Zeigt die Zuweisung der Aufnahmetasten für jedes
Aufzeichnungsmedium an.
Legen Sie im Kameramenü die Einstellung [Project] > [Simul Rec] >
[Rec Button Set] fest.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Legt die Einstellungen des Proxy-Aufzeichnungsmodus fest (siehe „Proxy-Aufzeichnung“).
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off Zum Ein-/Ausschalten des Proxy-Aufnahmemodus.
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Interval Rec

Zum Festlegen der Einstellungen für den Intervallaufzeichnungsmodus (siehe „Intermittierende Videoaufzeichnung (Interval Rec)“).

Verwandtes Thema
Intermittierende Videoaufzeichnung (Interval Rec)
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Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off

Schaltet den Intervallaufzeichnungsmodus ein
bzw. aus. (Wenn dieser Modus auf On gesetzt
wird, werden alle anderen Spezialmodi auf Off
gesetzt.)

Interval Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1
Legt das Intervall zwischen Aufzeichnungen im
Modus „Interval Rec“ fest (wenn Interval Rec auf
On gesetzt ist).

Number of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Die verfügbaren Einstellungen
hängen von der Bildfrequenz des
gewählten Videoformats ab.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Legt die aufzuzeichnende Anzahl der
Einzelbilder pro Einstellung im Modus „Interval
Rec“ fest (wenn Interval Rec auf On gesetzt ist).
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Picture Cache Rec

Zum Festlegen der Einstellungen für den Bildpuffer-Aufzeichnungsmodus (siehe „Aufzeichnen gepufferter Bilder (Picture Cache
Rec)“).

Verwandtes Thema
Aufzeichnen gepufferter Bilder (Picture Cache Rec)
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet die Bildpufferfunktion ein bzw. aus.

Cache Size
Short / Medium / Long /
Max

Max
Legt die Zeit zum Sammeln von Bildmaterial im Bildpuffer fest (Zeit für
Aufzeichnung mit Bildpufferfunktion).

Cache Rec
Time

– –
Zeigt die Zeit zum Sammeln von Bildmaterial im Bildpuffer an (Zeit für
Aufzeichnung mit Bildpufferfunktion).
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All File

Zum Durchführen von Vorgängen mit ALL-Dateien (siehe „Speichern und Laden von Konfigurationsdaten“).
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Load All
File

– –

Laden Sie eine ALL-Datei vom Gerät, auf dem die Web-App ausgeführt wird,
auf das Gerät herunter.

Hinweis

Wenn eine ALL-Datei in das Gerät geladen wird, startet das Gerät neu. Laden
Sie nach dem Neustart die Seite im Webbrowser erneut.

Eine ALL-Datei kann während des Betriebs der PTZ-Bildausschnitt-Steuerung
nicht geladen werden. Deaktivieren Sie die PTZ-Bildausschnitt-Steuerung und
laden Sie dann eine ALL-Datei.

Save All
File

– –

Speichern Sie die Einstellungen des Geräts als ALL-Datei auf dem Gerät,
auf dem die Web-App ausgeführt wird.

Hinweis
Eine ALL-Datei kann während des Betriebs der PTZ-Bildausschnitt-Steuerung
nicht gespeichert werden. Deaktivieren Sie die PTZ-Bildausschnitt-Steuerung
und speichern Sie dann eine ALL-Datei.
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Base Look

Sie können einen grundlegenden Look in das Gerät laden.
Eine Liste mit verfügbaren grundlegenden Looks wird auf dem Bildschirm angezeigt. Der gegenwärtig angewendete grundlegende
Look wird durch eine Markierung ● links von seiner Nummer gekennzeichnet.

[No.]: Nummer des grundlegenden Looks
[Base Look Name]: Name des grundlegenden Looks
[Input]: Eingangssignal des grundlegenden Looks
[Output]: Ausgangssignal des grundlegenden Looks
[AE Level Offset]: Belichtungsreferenz-Offsetwert des grundlegenden Looks

Hinzufügen eines grundlegenden Looks
Drücken Sie die Taste [Import], um einen neuen grundlegenden Look zu importieren. Folgen Sie den Anweisungen auf dem Bildschirm.
Legen Sie nach dem Importieren geeignete Werte für [Input], [Output] und [AE Level Offset] fest. Einzelheiten siehe „Importieren eines
gewünschten grundlegenden Looks“.

Verwandtes Thema
Importieren eines gewünschten grundlegenden Looks

5-041-957-64(1) Copyright 2022 Sony Corporation
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P/T Speed

Zum Festlegen der Einstellungen bezüglich der Schwenk-/Neigegeschwindigkeit.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Speed Step Normal / Extended Extended

Legt die Anzahl der Geschwindigkeitsstufen des Schwenk-/Neigeantriebs
fest.
Normal: Geschwindigkeit kann in einem 24-stufigen Bereich angegeben
werden. Verwenden Sie diese Einstellung für Kompatibilität mit vorhandenen
Fernkameras von Sony.
Extended: Geschwindigkeit kann in einem 50-stufigen Bereich angegeben
werden.

Speed
Mode

Normal / Slow Normal

Legt den Geschwindigkeitsmodus des Schwenk-/Neigeantriebs fest.
Nur aktiviert, wenn [Speed Step] auf [Normal] gesetzt ist.
Normal: Funktion im normalen Geschwindigkeitsbereich (Minimum bis
Maximum (60°/s)).
Slow: Funktion im niedrigen Geschwindigkeitsbereich (Minimum bis
Maximum (40°/s)).
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P/T Acceleration

Zum Festlegen der Einstellungen bezüglich der Schwenk-/Neigegeschwindigkeit.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Acceleration 1 bis 9 8
Legt die Beschleunigung/Abbremsung für Schwenk-/Neigevorgänge fest.
Je höher die Zahl, desto höher ist die Beschleunigung.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Range Limit

Zum Festlegen von Einstellungen bezüglich der Begrenzungen des Schwenk-/Neigebewegungsbereichs.
Mithilfe des folgenden Bildschirms legen Sie die Begrenzungen des Schwenk-/Neigebewegungsbereichs fest.

Hinweis

Wenn das Gerät eingeschaltet oder die Schwenk-/Neigefunktionen zurückgesetzt werden, so wird diese Einstellung der Bereichsbegrenzung
ignoriert. Diese Funktion kann nicht dazu verwendet werden, Hindernissen in der Nähe des Geräts auszuweichen.

Schalten Sie den Schalter [Setting] ein.

Die Funktion zur Begrenzung des Schwenk-/Neigebewegungsbereichs wird aktiviert.

1

Prüfen Sie mithilfe der Schwenk-/Neigesteuerung der Kamera das Bild.2

Um die Bewegungsgrenzen festzulegen, drücken Sie an den gewünschten Positionen die Tasten [Left], [Right], [Up],
[Down] > [Set Current Value].

[Left]: Linke Seite der Kamera
[Right]: Rechte Seite der Kamera
[Up]: Oberseite der Kamera
[Down]: Unterseite der Kamera

3
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Hinweis
Kamerapositionen außerhalb der Grenzen können nicht als Voreinstellung gespeichert werden.

Falls die Einstellung [Pan-Tilt] > [P/T Direction] > [Ceiling] geändert wird, werden die konfigurierten Grenzeinstellungen auf die Standardwerte
zurückgesetzt.

Die Einstellung kann in folgenden Situationen nicht geändert werden: während der Wiedergabe und der Miniaturbildanzeige, bei Auftreten eines
Schwenk-/Neigefehlers, wenn die Schwenk-/Neigebewegung nicht initialisiert wurde und wenn sie arretiert wurde.

5-041-957-64(1) Copyright 2022 Sony Corporation

Die Grenzen werden gesetzt und als numerische Werte (Winkel) angezeigt.
Um eine Grenze aufzuheben, drücken Sie die Taste [Reset] für die entsprechende Position.

Drücken Sie die Taste [OK].

Die Schwenk-/Neigebewegung wird auf den Bereich innerhalb der konfigurierten Grenzen beschränkt.

4
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Direction

Zum Festlegen der Einstellungen bezüglich der Schwenk-/Neigerichtung.

Hinweis
Wenn eine geänderte Einstellung für [Ceiling] übernommen wird, werden alle Voreinstellungspositionen gelöscht, da sich die
Schwenk-/Neigekoordinaten umkehren würden.

Der Bereich des Schwenk-/Neigeantriebs ändert sich abhängig von der Einstellung für [Ceiling] wie in der nachstehenden Abbildung
gezeigt.

A: Wenn[Ceiling] auf [Off] gesetzt ist
B: Wenn [Ceiling] auf [On] gesetzt ist

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Ceiling On / Off Off
Wenn das Gerät auf einem Tisch montiert ist, auf [Off] setzen. Wenn das
Gerät an einer Decke montiert ist, auf [On] setzen. Wenn [Ceiling] auf [On]
gesetzt wird, so wird [Pan Direction] automatisch auf [Opposite] gesetzt.

Pan
Direction

Normal / Opposite Normal
Legt die Richtung des Schwenkantriebs fest. Wenn die Einstellung geändert
wird, kehrt sich die Antriebsrichtung um.

Tilt Direction Normal / Opposite Normal Legt die Richtung des Neigeantriebs fest. Wenn die Einstellung geändert
wird, kehrt sich die Antriebsrichtung um.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

P/T Preset

Zum Festlegen der Einstellungen bezüglich Kameravoreinstellungen.

Pan-Tilt
Legt die Geschwindigkeit für Voreinstellungen fest.

Default
Legt die Voreinstellungswerte fest, die konfiguriert werden, wenn eine Voreinstellungsposition gespeichert wird.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Pan-Tilt Speed
Setting Way

Separate / Common Separate
Legt fest, ob voreingestellte Geschwindigkeiten separat konfiguriert
werden oder eine gemeinsame Einstellung verwendet werden soll.

Pan-Tilt Speed
for Common

1 bis 50 50

Legt die gemeinsame Geschwindigkeit für Voreinstellungen fest.

Hinweis
Die Maximalgeschwindigkeit 24 wird verwendet, falls bei Einstellung von
[Pan-Tilt] > [P/T Speed] > [Speed Step] auf [Normal] ein Wert von 25
oder höher festgelegt wurde.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Pan-Tilt Speed
Unit

Speed Table / Time Speed Table

Legt fest, ob die Geschwindigkeitseinheiten für die
Voreinstellungsposition mithilfe einer Geschwindigkeitstabelle oder als
Zeit konfiguriert werden, wenn Voreinstellungspositionen angefahren
werden.

Pan-Tilt Speed
for Separate

1 bis 50 50
Legt die Geschwindigkeit für Voreinstellungen fest, wenn die Methode zur
Auswahl der Geschwindigkeit für Voreinstellungen auf [Separate] gesetzt
ist.

Pan-Tilt Time
for Separate

1.0 bis 99.0 1
Legt die Geschwindigkeit für Voreinstellungen fest, wenn [Pan-Tilt Speed
Unit] auf [Time] gesetzt ist.

Zoom Sync On / Off On
Legt fest, ob Schwenk-/Neigevorgang und Zoomvorgang beim Aufrufen
einer Voreinstellungsposition synchronisiert werden sollen.

Zoom Speed 0 bis 32767 32767 Legt die Zoomgeschwindigkeit fest.

Focus Recall On / Off On Legt fest, ob Fokuseinstellungen wiederhergestellt werden.

MF Speed 0 bis 32767 32767 Legt die Geschwindigkeit für manuelle Fokussierung fest.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Format

Zum Festlegen der Einstellungen für das Ausgabeformat.

Verwandtes Thema
Ausgabeformate und Beschränkungen

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

SDI Einzelheiten zu Einstellungen siehe
„Ausgabeformate und Beschränkungen“.

– Legt die Auflösung des SDI- und des HDMI-
Ausgangssignals fest.HDMI –
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

Zum Festlegen der Einstellungen für Ausgangssignale.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

SDI On / Off Off
Legt fest, ob Menü und Status in das SDI-Ausgangssignal eingebettet
werden.

HDMI/Stream On / Off On

Legt fest, ob Menü und Status in das HDMI-Ausgangssignal eingebettet
werden.

Hinweis
Diese Einstellung wird auch auf das Bild des HDMI-Ausgangssignals, der
Streaming-Ausgabe und das Bild im Kamerabildbereich der Web-App
angewendet.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Input

Legt Einstellungen bezüglich der Audioeingänge CH1 bis CH4 fest.

Legt den Master-Audioeingangspegel fest. Der Master-Audioeingangspegel wird für alle Kanäle von CH1 bis CH4 verwendet.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Level
Control

Auto / Manual Auto
Wählt die automatische oder manuelle Einstellung des
Audio-Eingangspegels aus.

Level 0 bis 99 49 Legt den Eingangspegel fest.

Input Select
AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 und CH3: AUDIO
IN CH1
CH2 und CH4: AUDIO
IN CH2

Legt die Audioeingangsquelle fest.

Hinweis
CH1 ist (fest) auf [AUDIO IN CH1] eingestellt.

Wind Filter On / Off Off
Schaltet den Filter zur Reduktion von Windgeräuschen
ein/aus.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Master 0 bis 99 99 Legt den Master-Eingangspegel fest.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Audio Output

Zum Festlegen der Einstellungen für die Audioausgabe.

Hinweis

Diese Einstellung wird auch auf den Ton der Streaming-Ausgabe angewendet.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

HDMI/Stream Output
CH

CH1/CH2 / CH3/CH4 CH1/CH2
Legt die Kombination der Audiokanäle für die
HDMI-/Streaming-Ausgabe fest.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data Output

Zum Festlegen von Einstellungen bezüglich der Ausgabe von Verfolgungsdaten.

Destinations

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

IPv4 Address IPv4-Adresse – Legt die Ziel-IP-Adresse für die Verfolgungsdaten fest.

Port 1024 bis 65534 40000 Legt die Ziel-Portnummer für die Verfolgungsdaten fest.

Output On / Off Off Schaltet die Ausgabe von Verfolgungsdaten ein bzw. aus.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tracking Data

Zum Festlegen von Einstellungen bezüglich des Inhalts von Verfolgungsdaten.

Camera ID

Camera Position

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Camera ID 0 bis 255 255 Legt die ID des Geräts fest.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

X −131072.0 bis 131071.9 0.0 Legt die X-Koordinate der Kamera fest (Einheit: 1 mm)

Y −1310720 bis 1310719 0.0 Legt die Y-Koordinate der Kamera fest (Einheit: 1 mm)

Z −1310720 bis 1310719 0.0 Legt die Z-Koordinate der Kamera fest (Einheit: 1 mm)
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Legt Einstellungen für die Aufnahme-/Tally-Anzeige fest (siehe „Zuführen eines Tally-Signals“).

Tally
Legt Einstellungen bezüglich der Aufnahme-/Tally-Anzeige fest.

TSL UMD
Legt die Tally-Steuermethode über das TSL UMD-Protokoll fest.

Verwandtes Thema
Zuführen eines Tally-Signals

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Tally Lamp
Brightness

High / Low / Off High Legt die Helligkeit der Aufnahme-/Tally-Anzeige fest.

G Tally Lamp Enable / Disable Enable Aktiviert/deaktiviert die grüne Tally-Anzeige.

Tally Control
External / Internal / PTZ
AFR

Internal
Wählt das Ziel zur Auswertung der Steuerinformationen des Geräts
für die Aufnahme-/Tally-Anzeige aus.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off Aktiviert/deaktiviert die Tally-Steuerung über das TSL UMD-Protokoll.

Index 0 bis 65534 1
Legt die Indexnummer für den Empfang von Tally-Steuerbefehlen über
das TSL UMD-Protokoll fest.

Port
Number

1024 bis 65534 8900
Legt die Portnummer für den Empfang von Tally-Steuerbefehlen über
das TSL UMD-Protokoll fest.

407



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

IR Remote

Zum Festlegen der Einstellungen bezüglich der Infrarot-Fernbedienung.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off On
Aktiviert/deaktiviert die Bedienung des Geräts über die Infrarot-
Fernbedienung.

Pan-Tilt
Speed

Normal / Max Normal
Legt die Geschwindigkeit von Schwenk-/Neigevorgängen fest, die von
der Infrarot-Fernbedienung gesendet wurden.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

RCP/MSU

Zum Konfigurieren der Einstellung, wenn ein RCP/MSU (Option) angeschlossen ist.
Einzelheiten siehe „Anschließen einer RCP/MSU (Option)“.

Hinweis
Konfigurieren Sie Einstellungen am RCP/MSU wie erforderlich.

Für ein System mit mehreren Kameras ist eine MSU erforderlich.

Bei Verwendung mehrerer MSU legen Sie eine als Master und alle anderen als Clients fest.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

CNS Mode
Off / Bridge / MCS / PC
Control

Off Legt den Verbindungsmodus für das RCP/MSU fest.

Master IP
Address

IPv4-Adresse 0.0.0.0
Legt beim Aufbau eines LAN-basierten Systems mit mehreren
Kameras die IP-Adresse des Master-Geräts fest.

Camera No. Camera No. (1 bis 96) 1 Legt beim Aufbau eines LAN-basierten Systems mit mehreren
Kameras eine eindeutige Kameranummer im System fest.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lens Controller

Legt Einstellungen für einen angeschlossenen Objektivcontroller (Option) fest.
Einzelheiten siehe „Anschließen eines Objektivcontrollers“.

Hinweis
Wenn [Setting] geändert wird, startet das Gerät neu. Laden Sie die Seite im Webbrowser erneut.

Tipp
Stellen Sie bei Verwendung der PTZ-Bildausschnitt-Steuerung die Beschleunigung/Abbremsung auf das Maximum ein. Beachten Sie außerdem,
dass die Genauigkeit abhängig vom Objektiv variiert. Prüfen Sie den Betrieb vor dem Einsatz.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off Off Legt fest, ob der Objektivcontroller (Option) verwendet werden soll.

Mode 0 bis 15 0

Legt den Betriebsmodus des Objektivcontrollers (Option) fest.
Es sind Werte im Bereich von 0 bis 15 verfügbar, aber die tatsächlich
auswählbaren Werte variieren je nach Objektivcontroller (Option).
Einzelheiten siehe Bedienungsanleitung zum Objektivcontroller.

Reverse On / Off Off Kehrt die Rotationsrichtung des Objektivcontrollers (Option) um.

Initialize – – Initialisiert den Objektivcontroller (Option).
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Camera Name

Zum Festlegen der Einstellungen bezüglich des Kameranamens (Gerätename).

Es können für Camera Name bis zu acht (0 bis 8) der folgenden Zeichen verwendet werden.
Alphanumerische Zeichen
Sonderzeichen (Leerzeichen und !#$`*+-./;<=>?@[\]^_`{|})

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Camera Name – FR7 Legt den Kameranamen fest.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

User

Zum Festlegen der Einstellungen bezüglich des Benutzerzugriffs auf das Gerät.

Einstellungen bezüglich Administrator-Benutzern (Administrator) (erforderlich)

Einstellungen bezüglich allgemeiner Benutzer (User 1 bis User 9) (optional)

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

User Name – admin Legt den Benutzernamen fest.

Current Password – –
Beim Ändern des Passworts geben Sie das aktuelle Passwort
ein.

New Password – – Geben Sie das neue Passwort ein.

Re-Type
Password

– – Geben Sie zur Bestätigung das neue Passwort erneut ein.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

User Name – – Legt den Benutzernamen fest.

Current Password – –
Beim Ändern des Passworts geben Sie das aktuelle Passwort
ein.

New Password – – Geben Sie das neue Passwort ein.

Re-Type
Password – – Geben Sie zur Bestätigung das neue Passwort erneut ein.
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Status
Zeigt den Netzwerkstatus an.

IPv4
Zum Festlegen der Einstellungen bezüglich des IPv4-Netzwerks.

IPv6
Zum Festlegen der Einstellungen bezüglich des IPv6-Netzwerks.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Host Name – – Zeigt den Hostnamen an.

MAC Address – – Zeigt die MAC-Adresse des Geräts an.

Ethernet Status – – Zeigt die aktuelle Kommunikationsgeschwindigkeit an.

IP Address – – Zeigt die IP-Adresse des Geräts an.

Subnet Mask – – Zeigt die Subnetzmaske des Geräts an.

Gateway – – Zeigt das IPv4-Standard-Gateway des Geräts an.

Primary DNS Server – – Zeigt den primären DNS-Server des Geräts an.

Secondary DNS Server – – Zeigt den sekundären DNS-Server des Geräts an.

IPv6 Address 1 – – Zeigt die IPv6-Adresse 1 des Geräts an.

IPv6 Address 2 – – Zeigt die IPv6-Adresse 2 des Geräts an.

IPv6 Gateway – – Zeigt das IPv6-Standard-Gateway des Geräts an.

Link-local IPv6 Address – – Zeigt die IPv6-Link-Local-Adresse des Geräts an.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

DHCP On / Off On Schaltet die Funktion [DHCP] ein bzw. aus.

IP Address – – Legt die IPv4-Adresse fest, wenn [DHCP] auf Off gesetzt ist.

Subnet
Mask

– – Legt die Subnetzmaske fest, wenn [DHCP] auf Off gesetzt ist.

Gateway – –
Legt das IPv4-Standard-Gateway fest, wenn [DHCP] auf Off gesetzt
ist.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Obtain an IP Address
Automatically

On / Off On Schaltet automatischen Bezug der IPv6-Adresse ein/aus.
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Common
Zum Festlegen von gemeinsamen Einstellungen für IPv4-/IPv6-Netzwerke.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

IP Address – –
Legt die IPv6-Adresse fest, wenn [Obtain an IP Address
Automatically] auf Off gesetzt ist.

Prefix Length – –
Legt das Präfix fest, wenn [Obtain an IP Address
Automatically] auf Off gesetzt ist.

Gateway – –
Legt das IPv6-Standard-Gateway fest, wenn [Obtain an IP
Address Automatically] auf Off gesetzt ist.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

HTTP Port 80, 1024 bis 65534 80 Legt die HTTP-Portnummer fest.

DNS Auto On / Off On
Legt fest, ob DNS-Adressen vom DHCP-Server bezogen
werden sollen.

Primary DNS Server IPv4/IPv6-Adresse –
Legt den primären DNS-Server fest, wenn [DNS Auto] auf Off
gesetzt ist.

Secondary DNS
Server

IPv4/IPv6-Adresse –
Legt den sekundären DNS-Server fest, wenn [DNS Auto] auf
Off gesetzt ist.
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File Transfer

Zum Festlegen der Einstellungen für Dateiübertragungen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Auto Upload
(Proxy)

On / Off Off
Zum Ein-/Ausschalten des automatischen Hochladens von Proxy-
Dateien.

Default Upload
Server

Server Settings1 bis 3
> Display Name

Server
Settings1

Wählt den Upload-Server für Dateien aus. Der hier ausgewählte Server
wird zum Ziel für das automatische Hochladen von Proxy-Dateien und
zum Upload-Ziel für Dateien in der Miniaturbildanzeige.
Zeigt die unter [Server Settings1 bis 3] konfigurierten Einstellungen für
[Display Name] an.
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Interchangeable Lens Digital Camera
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FTP Server 1 bis 3

Zum Festlegen der Einstellungen für FTP-Übertragungen.
Die Einstellungen sind für FTP Server 1 bis 3 gleich.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Display Name – –
Legt den Anzeigenamen im Setup-Menü für das Übertragungsziel
fest.

Service – – Zeigt den Typ des Servers an.

Host Name – –
Legt den Hostnamen des Servers fest, der das Ziel für die
Übertragung ist.

Port
21, 990, 1024 bis
65534

21
Legt die Portnummer des Servers fest, der das Ziel für die
Übertragung ist.

User Name – –
Legt den Benutzernamen für die Authentifizierung der Verbindung
zum Server fest, der das Ziel für die Übertragung ist.

Password – –
Legt das Passwort für die Authentifizierung der Verbindung zum
Server fest, der das Ziel für die Übertragung ist.

Passive Mode On / Off Off Schaltet den passiven Modus ein/aus.

Destination
Directory

– – Legt den Namen des Zielverzeichnisses für die Übertragung fest.

Using Secure
Protocol

On / Off Off
Legt fest, ob sichere FTP-Übertragung verwendet werden soll (On)
oder nicht (Off).

Root Certificate – –

Lädt das Stammzertifikat für sichere FTP-Übertragung.
Drücken Sie die Taste [Load] und wählen Sie auf dem angezeigten
Bildschirm ein Stammzertifikat aus.
Drücken Sie die Taste [Delete], um das geladene Stammzertifikat zu
löschen.

Root Certificate
Status

– – Hier wird der Ladestatus des Stammzertifikats angezeigt.

Reset – –
Setzt die Einstellungen unter [Server Settings] auf die Standardwerte
zurück.
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SSL

Legt Einstellungen bezüglich SSL fest.

SSL
Aktiviert/deaktiviert die SSL-Funktion.

SSL Server Authentication
Legt Einstellungen bezüglich der SSL-Serverauthentifizierung fest.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Function
Disable / Enable / Enable (Allow HTTP connection for some
clients)

Disable
Aktiviert/deaktiviert die SSL-
Funktion.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Certificate
Options

Use a self-signed certificate
(For test use) / Use an
external certificate

– Legt die Installationsmethode für das SSL-Serverzertifikat fest.

Status – –
Zeigt die Gültigkeit des SSL-Serverzertifikats an, wenn
[Certificate Options] auf [Use a self-signed certificate (For test
use)] gesetzt ist.

Issuer DN – –
Zeigt den eindeutigen Namen des Herausgebers des SSL-
Serverzertifikats an, wenn [Certificate Options] auf [Use a self-
signed certificate (For test use)] gesetzt ist.

Subject DN – –
Zeigt den eindeutigen Namen des Gegenstands des SSL-
Serverzertifikats an, wenn [Certificate Options] auf [Use a self-
signed certificate (For test use)] gesetzt ist.

Available Period – –
Zeigt die Gültigkeitsperiode des SSL-Serverzertifikats an, wenn
[Certificate Options] auf [Use a self-signed certificate (For test
use)] gesetzt ist.

Extended Key
Usage

– –
Zeigt die erweiterte Schlüsselverwendungsmethode an, wenn
[Certificate Options] auf [Use a self-signed certificate (For test
use)] gesetzt ist.

Delete – –
Diese Taste wird angezeigt, wenn [Certificate Options] auf [Use
a self-signed certificate (For test use)] gesetzt ist.
Löscht das installierte SSL-Serverzertifikat.

Import – –
Installiert ein externes SSL-Serverzertifikat aus einer Liste,
wenn [Certificate Options] auf [Use an external certificate]
gesetzt ist.

Private Key
Password

– –
Legt das Passwort für die private Schlüsselinformation des
SSL-Serverzertifikats fest, wenn[Certificate Options] auf [Use
an external certificate] gesetzt ist.

Reset – –
Diese Taste löscht die Anzeige des privaten
Schlüsselpassworts zur Eingabe eines neuen Passworts.
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Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Self-Signed
Certificate
Generation

– –
Drücken Sie die Taste [Generate], um ein selbstsigniertes
Zertifikat zu erzeugen, wenn [Certificate Options] auf [Use a
self-signed certificate (For test use)] gesetzt ist.
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SSH

Legt Einstellungen bezüglich SSH fest.

Hinweis

SSH muss aktiviert werden, um das Gerät in Anwendungen zu verwenden, die das Camera Remote SDK nutzen. Aktivieren Sie dies nur für
Anwendungen, denen Sie vertrauen. Sony übernimmt keine Haftung für Verluste, die durch den Betrieb der Anwendung verursacht werden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off  Schaltet die SSH-Funktion ein bzw. aus.

User Name – – Legt den Benutzernamen fest/zeigt ihn an.

Password – – Legt das Passwort fest.
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Interchangeable Lens Digital Camera
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Referer Check

Zum Festlegen der Einstellungen für Referer-Checks.

Exception List
Zum Festlegen der Einstellungen für die Ausnahmeliste der Referer-Checks.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off On Aktiviert/deaktiviert die Referer Check-Funktion.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

No. 1 bis 10 – Legt die Ausnahmenummer aus der Liste fest.

Host Name – – Legt den Hostnamen der Ausnahme fest.

Port
Number

– – Legt die Portnummer der Ausnahme fest.

Set – –
Drücken, um die konfigurierte Ausnahme in der Ausnahmeliste zu
registrieren.

Delete – –
Wählen Sie die zu löschende Ausnahme aus und drücken Sie die Taste,
um sie aus der Liste zu löschen.
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Brute Force Attack Protection

Zum Festlegen von Einstellungen bezüglich des Schutzes vor Brute-Force-Angriffen.

Wenn ein Angriff erkannt wird, wird die Angreiferliste angezeigt.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Setting On / Off On Schaltet die Funktion [Brute Force Attack Protection] ein bzw. aus.

Count 3 bis 100 8
Legt die Anzahl von Versuchen fest, die als Angriff gewertet werden.
Aktiviert, wenn [Setting] auf On gesetzt ist.

Release
Mode Always / Timer Timer

Legt die Freigabebedingung fest.
Aktiviert, wenn [Setting] auf On gesetzt ist.
Always: Nicht von Angreiferliste löschen.
Timer: Von Angreiferliste löschen, nachdem die mithilfe von [Release
Time] festgelegte Freigabezeit verstrichen ist.

Release
Time

30 bis 86400 s 60

Legt die Freigabezeit fest.
Aktiviert, wenn [Setting] auf On gesetzt ist.
Wenn Release Mode auf [Timer] gesetzt ist, werden Einträge aus der
Angreiferliste gelöscht, nachdem die Freigabezeit verstrichen ist.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Zum Festlegen von Einstellungen für das Streaming (siehe „Informationen zum Streaming“).

Stream Setting
Zum Festlegen der Einstellungen bezüglich des Streaming-Protokolls.

Hinweis

Um RTMP zu verwenden, setzen Sie zunächst [Stream] > [Audio Stream] > [Setting] auf [On].

RTSP
Die folgenden Elemente werden angezeigt, wenn [Stream Setting] auf [RTSP] gesetzt ist.
Zum Festlegen der Einstellungen bezüglich des RTSP-Streaming.

RTMP
Die folgenden Elemente werden angezeigt, wenn [Stream Setting] auf [RTMP] gesetzt ist.
Zum Festlegen der Einstellungen bezüglich des RTMP-Streaming.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP Legt das Streaming-Protokoll fest.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Port Number 554, 1024 bis 65534 554 Legt die RTSP-Portnummer fest.

Time Out 0 bis 600 60
Legt die Zeitüberschreitung des Befehls Keep Alive für das
RTSP-Streaming fest.

Authentication On / Off On Schaltet die RTSP-Authentifizierungsfunktion ein bzw. aus.

Video Port
Number 1

1024 bis 65534 51000 Legt die Portnummer für das Senden von Video 1 für RTSP-
Unicast-Streaming fest.

Video Port
Number 2

1024 bis 65534 53000
Legt die Portnummer für das Senden von Video 2 für RTSP-
Unicast-Streaming fest.

Audio Port
Number

1024 bis 65534 57000
Legt die Portnummer für das Senden von Audio für RTSP-
Unicast-Streaming fest.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Server URL – – Legt die Ziel-URL der RTMP- oder RTMPS-Verbindung fest.

Stream Key – – Legt den von der RTMP-Serverseite erhaltenen Stream-Schlüssel fest.
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SRT
Die folgenden Elemente werden angezeigt, wenn [Stream Setting] auf [SRT-Caller] oder [SRT-Listener] gesetzt ist.
Zum Festlegen der Einstellungen bezüglich des SRT-Streaming.

NDI|HX
Die folgenden Elemente werden angezeigt, wenn [Stream Setting] auf [NDI|HX] gesetzt ist.
Zum Festlegen der Einstellungen bezüglich NDI|HX.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Root
Certificate

– –

Lädt das für die Verbindung mit dem RTMP-Server erforderliche
Stammzertifikat.
Drücken Sie die Taste [Load] und wählen Sie auf dem angezeigten
Bildschirm ein Stammzertifikat aus.
Drücken Sie die Taste [Delete], um das geladene Stammzertifikat zu
löschen.
Unter [Root Certificate Status] wird der Status angezeigt.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Destination – –
Legt die URL des Verbindungsziels fest, wenn das Gerät als
Anrufer fungiert.

Port
Number

1024 bis 65534 4201
Legt die Portnummer für den Empfang fest, wenn das Gerät als
Angerufener fungiert.

Latency 20 bis 8000 ms 120 Legt die Latenzzeit fest.

TTL 1 bis 255 64 Legt den TTL-Wert fest.

Encryption Off / AES128 / AES256 Off
Aktiviert/deaktiviert die Verschlüsselung und legt deren
Methode fest.

Passphrase
0 oder Zeichenfolge mit 10 bis 79
Zeichen

0
Legt die für die Verschlüsselung verwendete Zeichenfolge fest.
Drücken Sie auf Reset, um die eingegebene Zeichenfolge zu
löschen.

ARC On / Off On Schaltet die Funktion Adaptive Rate Control ein bzw. aus.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

License – – Zeigt den Installationsstatus des NDI-Lizenzschlüssels an.

Source Name – – Zeigt den NDI-Quellnamen an.

Group On / Off Off Schaltet die NDI-Gruppierungsfunktion ein bzw. aus.

Group Name – –
Wird angezeigt, wenn die NDI-Gruppierungsfunktion auf On
gesetzt ist.
Legt den Gruppennamen fest.

Discovery Server
1

– – Legt den NDI Discovery Server 1 fest.

Discovery Server
2

– – Legt den NDI Discovery Server 2 fest.

Multicast Mode On / Off Off Schaltet das Multicast-Streaming ein bzw. aus.

Multicast Prefix 239.255.0.0 239.255.0.0
Wird angezeigt, wenn [Multicast Mode] auf On gesetzt ist.
Legt das für das Multicast-Streaming zu verwendende Präfix
fest.
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Verwandtes Thema
Informationen zum Streaming

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Multicast
Netmask

255.255.0.0 255.255.0.0
Wird angezeigt, wenn [Multicast Mode] auf On gesetzt ist.
Legt die Netzmaske fest, die den Multicast-Adressbereich
bestimmt.

Multicast TTL 1 bis 255 3
Wird angezeigt, wenn [Multicast Mode] auf On gesetzt ist.
Legt den TTL-Wert für das Multicast-Streaming fest.

Multi-TCP Mode On / Off Off Schaltet den Multi-TCP-Modus ein/aus.

Unicast UDP
Mode

On / Off On Schaltet den Unicast-UDP-Modus ein/aus.
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Video Stream

Zum Festlegen der Einstellungen bezüglich der Streaming-Videocodecs.

Video Stream 1
Zum Festlegen der Einstellungen bezüglich des Videocodec 1.

Video Stream 2
Zum Festlegen der Einstellungen bezüglich des Videocodec 2.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Codec 1 H.264 / H.265 H.264 Legt den Codec für Bild 1 fest.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Legt die Bildgröße für Bild 1 fest.

Frame Rate 1

Einzelheiten zu unterstützten Bildraten
siehe „Festlegen des Videocodec für das
Streaming“.

– Legt die Bildrate für Bild 1 fest.

I-Picture Mode 1 Time / Frame Time
Legt das IDR-Frame-Einfügeintervall für
Bild 1 als Zeit oder Anzahl Einzelbilder fest.

I-Picture Interval 1 1 / 2 / 3 / 4 / 5 s 1

Wird angezeigt, wenn [I-Picture Mode 1] auf
Time gesetzt ist.
Legt das IDR-Frame-Einfügeintervall für
H.264 und H.265 als Zeit fest.

I-Picture Ratio 1 15 bis 300 Einzelbilder 30

Wird angezeigt, wenn [I-Picture Mode 1] auf
Frame gesetzt ist.
Legt das IDR-Frame-Einfügeintervall für
H.264 und H.265 als Anzahl Einzelbilder
fest.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Legt das H.264- oder H.265-Profil fest.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Legt den Modus der Bitratenkompression
für Bild 1 fest.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

Wird angezeigt, wenn [Bit Rate
Compression Mode 1] auf On gesetzt ist.
Legt den Zielwert der Bitrate fest, wenn der
Modus der Bitratenkompression auf „CBR“
gesetzt ist.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Legt die H.264- oder H.265-Qualität fest.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Codec 2 H.264 / H.265 / Off Off Legt den Codec für Bild 2 fest.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Legt die Bildgröße für Bild 2 fest.
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Video Stream 3
Zum Festlegen der Einstellungen bezüglich des Videocodec 3.

Verwandtes Thema

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Frame Rate 2

Einzelheiten zu unterstützten Bildraten
siehe „Festlegen des Videocodec für
das Streaming“.

–
Wird angezeigt, wenn [Codec 2] nicht auf Off
gesetzt ist.
Legt die Bildrate für Bild 2 fest.

I-Picture Mode 2 Time / Frame Time

Wird angezeigt, wenn [Codec 2] nicht auf Off
gesetzt ist.
Legt das IDR-Frame-Einfügeintervall für Bild 2
als Zeit oder Anzahl Einzelbilder fest.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Wird angezeigt, wenn sowohl [Codec 2] nicht
auf Off gesetzt ist als auch [I-Picture Mode 2]
auf [Time] gesetzt ist.
Legt das IDR-Frame-Einfügeintervall für H.264
und H.265 als Zeit fest.

I-Picture Ratio 2 15 bis 300 Einzelbilder 30

Wird angezeigt, wenn sowohl [Codec 2] nicht
auf Off gesetzt ist als auch [I-Picture Mode 2]
auf [Frame] gesetzt ist.
Legt das IDR-Frame-Einfügeintervall für H.264
und H.265 als Anzahl Einzelbilder fest.

Profile 2
H.264: high / main / baseline
H.265: main

– Legt das H.264- oder H.265-Profil fest.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Wird angezeigt, wenn [Codec 2] nicht auf Off
gesetzt ist.
Legt den Modus der Bitratenkompression für
Bild 2 fest.

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000
/ 6000 / 7000 / 8000 / 16000 / 24000 /
32000 / 50000 / 64000 / 80000 kbps

8000

Wird angezeigt, wenn sowohl [Codec 2] nicht
auf Off gesetzt ist als auch [Bit Rate
Compression Mode 2] auf [On] gesetzt ist.
Legt den Zielwert der Bitrate fest, wenn der
Modus der Bitratenkompression auf „CBR“
gesetzt ist.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Wird angezeigt, wenn sowohl [Codec 2] auf
H.264 gesetzt ist als auch [Bit Rate
Compression Mode 2] auf Off gesetzt ist.
Legt die H.264- oder H.265-Qualität fest.

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Codec 3 JPEG JPEG Legt den Codec für Bild 3
fest.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Legt die Bildgröße für Bild
3 fest.

Frame Rate
3

Einzelheiten zu unterstützten Bildraten siehe „Festlegen des
Videocodec für das Streaming“. –

Legt die Bildrate für Bild 3
fest.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Legt die Qualität fest.
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Festlegen des Videocodec für das Streaming

5-041-957-64(1) Copyright 2022 Sony Corporation
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Audio Stream

Zum Festlegen der Einstellungen bezüglich des Streaming-Audiocodec.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Setting On / Off Off Schaltet die Audio Streaming-Ausgabe ein bzw. aus.

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
Wird angezeigt, wenn [Setting] auf On gesetzt ist.
Legt den Audiocodec für das Streaming fest.
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Language

Legt die Sprache fest.

Hinweis
Die verfügbaren Sprachen können je nach Land oder Region variieren.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Language – – Legt die Sprache fest.
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Accessibility

Zum Festlegen von Einstellungen bezüglich Audiovorlesen (Text zu Sprache).

Hinweis
Diese Funktion ist nur bei in Nordamerika vertriebenen Modellen verfügbar. Die Bildschirmlesefunktion kann nur verwendet werden, wenn als
Sprache Englisch eingestellt ist (Stand zum Herausgabedatum).

Aktivieren Sie die Bildschirmlesefunktion des Webbrowsers auf dem Gerät, auf dem die Web-App ausgeführt wird.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Screen
Reader

On / Off Off 
Schaltet die Bildschirmlesefunktion im Kamerabildbereich
der Web-App ein/aus.

Speech Rate
Slow2 / Slow1 / Normal / Fast1 / Fast2
/ Fast3 / Fast4

Normal
Legt die Geschwindigkeit der Bildschirmlesefunktion fest.
Eine Beispielpassage wird mit der konfigurierten
Geschwindigkeit laut vorgelesen.

Speech
Volume

1 bis 15 7

Legt die Lautstärke der Bildschirmlesefunktion der Web-
App fest.
Eine Beispielpassage wird mit der konfigurierten
Lautstärke laut vorgelesen.
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Clock Set

Zum Festlegen der Einstellungen für die innere Uhr.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Current Date &
Time

– –
Zeigt die gegenwärtig am Gerät konfigurierte Uhrzeit
an.

PC Clock – –
Zeigt die gegenwärtige Zeit des zur Konfiguration
verwendeten Tablets oder Computers an.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-mm-dd Legt das Anzeigeformat für Datum und Uhrzeit fest.

12 h / 24 h 12 h / 24 h 24 h Legt für die Uhrzeit das 12-Stunden- oder 24-Stunden-
Format fest.

Time Setting
Keep current setting / Synchronize with
PC / Manual setting / Synchronize with
NTP

–
Legt die Konfigurationsmethode für Datum und Uhrzeit
fest.

yy-mm-dd
hh:mm:ss

yy: 19 bis 37
mm: 01 bis 12
dd: 01 bis 31
hh: 00 bis 23
mm: 00 bis 59
ss: 00 bis 59 (Sekunden)

–
Wird angezeigt, wenn [Time Setting] auf Manual
setting gesetzt ist.
Zum manuellen Festlegen von Datum und Uhrzeit.

NTP Auto On / Off Off

Wird angezeigt, wenn [Time Setting] auf Synchronize
with NTP gesetzt ist.
Legt fest, ob die IP-Adresse des NTP-Servers vom
DHCP-Server bezogen werden soll.

NTP Server IPv4/IPv6-Adresse oder Hostname –

Wird angezeigt, wenn sowohl [Time Setting] auf
[Synchronize with NTP] als auch [NTP Auto] auf Off
gesetzt sind.
Legt den für die Zeitsynchronisation verwendeten
NTP-Server fest.

Time Zone UTC −12:00 bis UTC +14:00 – Zum Auswählen der Zeitzone.

431



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset

Initialisiert das Gerät.

Reboot
Startet das Gerät neu.

Reset
Setzt die Einstellungen des Geräts zurück.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete Einstellung Standardwert Beschreibung

Reboot Execute –

Startet das Gerät neu.
Execute: Funktion ausführen.

Hinweis

Laden Sie nach dem Neustart die Seite im Webbrowser erneut.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

All Reset (except for
Network Settings)

Execute –

Setzt die Einstellungen des Geräts zurück (ausgenommen
Netzwerkeinstellungen).
Execute: Funktion ausführen.

Hinweis
Importierte grundlegende Looks und LUT-Dateien werden nicht
gelöscht.

Network Reset Execute –

Setzt die Netzwerkeinstellungen des Geräts zurück.
Execute: Funktion ausführen.

Hinweis
Nach dem Ausführen von Network Reset startet das Gerät neu.
Laden Sie nach dem Neustart die Seite im Webbrowser erneut.

Factory Default Execute –

Setzt die Einstellungen des Geräts auf den werkseitigen
Standardzustand zurück.
Execute: Funktion ausführen.

Hinweis
Nach dem Ausführen von Factory Default startet das Gerät neu.
Laden Sie nach dem Neustart die Seite im Webbrowser erneut.
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Information

Zeigt Informationen zu Kamera und Objektiv an. Wird auch zur Aktualisierung der Software verwendet.

Camera
Zeigt Informationen zur Kamera an und dient zur Aktualisierung der Software.

Lens
Zeigt Informationen zum Objektiv an und dient zur Aktualisierung der Software.

Verwandtes Thema
Aktualisieren der Software eines Objektivs mit E-Bajonett

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Model Name – – Zeigt den Modellnamen der Kamera an.

Serial
Number

– – Zeigt die Seriennummer der Kamera an.

Version
Number

– – Zeigt die Software-Version der Kamera an.

Version Up – –

Drücken Sie die Taste [Choose File] und folgen Sie den Anweisungen auf
dem Bildschirm, um die Kamera-Software zu aktualisieren.

Hinweis
Nach dem Aktualisieren startet das Gerät neu. Laden Sie nach dem
Neustart die Seite im Webbrowser erneut.

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Model Name – – Zeigt den Modellnamen des Objektivs an.

Serial
Number

– – Zeigt die Seriennummer des Objektivs an.

Version
Number

– – Zeigt die Software-Version des Objektivs an.

Version Up – –

Drücken Sie die Taste [Choose File] und folgen Sie den Anweisungen auf
dem Bildschirm, um die Objektiv-Software zu aktualisieren.

Einzelheiten siehe „Aktualisieren der Software eines Objektivs mit E-
Bajonett“.

Hinweis

Nach dem Aktualisieren des Objektivs startet das Gerät neu. Laden Sie
nach dem Neustart die Seite im Webbrowser erneut.
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System Log

Zum Festlegen der Einstellungen bezüglich des Systemprotokolls.

Das erstellte Protokoll wird wie unten abgebildet angezeigt.

Verwandtes Thema
Aktualisieren der Software eines Objektivs mit E-Bajonett

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Legt die Protokollierungsschwelle für das Systemprotokoll fest.

Log Size 200 bis 1024 1024
Legt die Größe des im Systemprotokoll zu speichernden
Protokolls fest.

Download as
File – –

Drücken Sie die Taste [Download] und speichern Sie das
Systemprotokoll vom angezeigten Bildschirm aus auf einem
Tablet oder Computer.
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HTTP Access Log

Zum Festlegen der Einstellungen bezüglich des HTTP-Zugriffsprotokolls.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Legt die Protokollierungsschwelle für das HTTP-Zugriffsprotokoll
fest.

Log Size 200 bis 1024 1024
Legt die Größe des im HTTP-Zugriffsprotokoll zu speichernden
Protokolls fest.

Download as
File – –

Drücken Sie die Taste [Download] und speichern Sie das HTTP-
Zugriffsprotokoll vom angezeigten Bildschirm aus auf einem
Tablet oder Computer.
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Service

Zum Abrufen von Informationen über das Gerät. Verwenden Sie diese Funktionen, wenn Sie sich an Ihre Sony-
Kundendienstvertretung wenden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Menüpunkt Untergeordnete
Einstellung Standardwert Beschreibung

I agree to download
device information.

– –

Aktivieren Sie dieses Kontrollkästchen, um der Gerätedatenerfassung
zuzustimmen, und drücken Sie die Taste [OK].
Drücken Sie auf die angezeigte Taste [Download]. Der Webbrowser
lädt daraufhin eine Datei mit dem Namen deviceinformation.dat
herunter.

Hinweis
Nach dem Herunterladen startet das Gerät neu. Falls das Gerät nicht
automatisch einen Neustart durchführt, starten Sie es manuell neu.
Laden Sie nach dem Neustart die Seite im Webbrowser erneut.
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Software

Zeigt die Softwarelizenz an.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Anschließen externer Monitore und Aufnahmegeräte

Zum Anzeigen von Aufzeichnungs-/Wiedergabebildern auf einem externen Monitor legen Sie das Ausgangssignal für diesen fest und
schließen ihn mit einem geeigneten Kabel an.
Sie können auch einen externen Recorder anschließen und das Ausgangssignal des Geräts aufzeichnen.
Auf einem externen Monitor können dieselben Informationen angezeigt werden, die im Kamerabildbereich erscheinen, z. B.
Statusinformationen und Menüs. Legen Sie mithilfe von [Monitoring] > [Output Display] im Webmenü für den gewünschten Systemtyp
für die Bildschirmanzeige die Einstellung On fest.

Hinweis
Falls ein mit dem HDMI-Anschluss verbundener Monitor das mithilfe des [Monitoring]-Menüs im Webmenü oder Kameramenü konfigurierte
HDMI-Ausgabeformat nicht unterstützt, wird das Kamerabild nicht in der Web-App angezeigt. Streaming-Video kann ebenfalls nicht ausgegeben
werden. Auch PTZ-Bildausschnitt-Steuerung ist nicht in Funktion.

Sie können sowohl [Output Display] > [SDI] als auch [HDMI/Stream] auf [Off] setzen, dies verhindert jedoch die Verwendung des Kameramenüs
und von Funktionen, die von der Bildschirmanzeige abhängig sind. Außerdem beschränken sich Fehlermeldungen des Geräts auf die physischen
Anzeigen des Geräts (leuchtend oder blinkend) und die Anzeige des Benachrichtigungssymbols oben rechts in der Web-App. Um Statusdetails
anzuzeigen, setzen Sie [Output Display] auf [On].

Tipp
Standardmäßig sind [Output Display] > [SDI] auf [Off] und [HDMI/Stream] auf [On] gesetzt. Um das Streaming als Hauptvideo zu verwenden,
setzen Sie [SDI] auf [On] und [HDMI/Stream] auf [Off]. Überwachen Sie den Kamerastatus auf einem SDI-Monitor.

Anschluss SDI OUT (BNC-Ausführung)

Legen Sie im Webmenü oder Kameramenü mithilfe des Menüs [Monitoring] das Ausgabeformat fest.
Verwenden Sie für den Anschluss ein handelsübliches 75-Ω-Koaxialkabel.

Hinweis
Stellen Sie vor dem Einschalten unbedingt eine Erdungsverbindung zwischen Gerät und externem Gerät her.

Wir empfehlen, vor dem Einschalten des Geräts und des externen Geräts erst ein 75-Ω-Koaxialkabel anzuschließen.
Wenn Sie ein externes Gerät an das Gerät anschließen, während das Gerät eingeschaltet ist, schließen Sie das 75-Ω-Koaxialkabel
erst an das externe Gerät an und dann an das Gerät.

Synchronisierte Aufnahme auf dem Gerät und einem externen Gerät starten
Wenn der SDI-Signalausgang ausgewählt wurde, setzen Sie [Project] > [SDI/HDMI Rec Control] > [Setting] im Kameramenü auf
[SDI/HDMI Remote I/F] oder [Parallel Rec], um die Ausgabe eines REC-Auslösersignals an das externe Gerät am Anschluss SDI OUT
zu ermöglichen. Dadurch wird die Aufzeichnung auf dem externen Gerät mit dem Gerät synchronisiert.

Hinweis
Wenn ein angeschlossenes externes Gerät nicht auf das REC Auslösesignal anspricht, kann das Gerät nicht bedient werden.

Wenn im Kameramenü die Einstellung [Project] > [SDI/HDMI Rec Control] > [Setting] auf [SDI/HDMI Remote I/F] gesetzt ist, wird nur das REC-
Auslösesignal ausgegeben, wenn aktuell kein Medium eingesetzt ist und die Aufnahmetaste START/STOP betätigt wird.

Anschluss HDMI OUT (Typ A)

Stellen Sie im [Monitoring]-Menü des Kameramenüs für den Ausgang On/Off ein, und legen Sie das Ausgabeformat fest.

Synchronisierte Aufnahme auf dem Gerät und einem externen Gerät starten
Wenn der HDMI-Signalausgang ausgewählt wurde, setzen Sie [TC/Media] > [HDMI TC Out] > [Setting] auf [On] und [Project] >
[SDI/HDMI Rec Control] > [Setting] im Kameramenü auf [SDI/HDMI Remote I/F] oder [Parallel Rec], um die Ausgabe eines REC-
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Auslösersignals an das externe Gerät am Anschluss HDMI OUT zu ermöglichen. Dadurch wird die Aufzeichnung auf dem externen
Gerät mit dem Gerät synchronisiert.

Hinweis

Wenn ein angeschlossenes externes Gerät nicht auf das REC Auslösesignal anspricht, kann das Gerät nicht bedient werden.

Wenn im Kameramenü die Einstellung [Project] > [SDI/HDMI Rec Control] > [Setting] auf [SDI/HDMI Remote I/F] gesetzt ist, wird nur das REC-
Auslösesignal ausgegeben, wenn aktuell kein Medium eingesetzt ist und die Aufnahmetaste START/STOP betätigt wird.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Verbinden mit RCP/MSU/CNA-2

Einige der Gerätefunktionen können ferngesteuert werden, indem ein Fernbedienfeld (RCP) wie das RCP-3500/3501, eine
Hauptkonfigurationseinheit (MSU) wie das MSU-3500 oder ein Netzwerkadapter zur Kamerasteuerung wie der CNA-2 über ein LAN-
Kabel mit dem Gerät verbunden wird.
Die Verbindungsmethode hängt von der Konfiguration verwandter Geräte und der Anwendung ab.

Einzelheiten zu einer 1:1-Verbindung zwischen Gerät und RCP siehe „1:1-Verbindung zwischen Gerät und RCP“.
Einzelheiten zum Verbinden mehrerer Kameras mithilfe einer MSU oder Software zur Kamerafernsteuerung siehe „Verwenden des
Geräts in einer Umgebung mit mehreren Kameras mit MSU/Software zur Kamerafernsteuerung“.

Verwandtes Thema
1:1-Verbindung zwischen Gerät und RCP

Verwenden des Geräts in einer Umgebung mit mehreren Kameras mit MSU/CNA-2/Software zur Kamerafernsteuerung

5-041-957-64(1) Copyright 2022 Sony Corporation
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1:1-Verbindung zwischen Gerät und RCP

Hinweis

Konfigurieren Sie unter Berücksichtigung der „Liste unterstützter Funktionen“ das Gerät so, dass es die Betriebsbedingungen für die zu
verwendenden Funktionen erfüllt. Aktivieren Sie dann die Verbindung mit einem RCP wie nachfolgend beschrieben.

Verwandtes Thema
Liste unterstützter Funktionen

5-041-957-64(1) Copyright 2022 Sony Corporation

Schalten Sie jedes Gerät ein.1

Setzen Sie im Webmenü der Kamera die Einstellung [Technical] > [RCP/MSU] > [CNS Mode] auf [Bridge].2

Konfigurieren Sie am RCP die folgenden Einstellungen.

Einzelheiten zur Konfiguration finden Sie in der Bedienungsanleitung des RCP.

3

Legen Sie als Verbindungsmodus dem Bridge-Modus fest.1.
Registrieren Sie die IP-Adresse der Kamera.2.
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Verwenden des Geräts in einer Umgebung mit mehreren Kameras mit MSU/CNA-2/Software zur
Kamerafernsteuerung

Sie können mehrere Kameras mithilfe einer MSU oder Software zur Kamerafernsteuerung verbinden.

Hinweis
Konfigurieren Sie unter Berücksichtigung der „Liste unterstützter Funktionen“ das Gerät so, dass es die Betriebsbedingungen für die zu
verwendenden Funktionen erfüllt. Aktivieren Sie dann die Verbindung mit einer MSU oder Software zur Kamerafernsteuerung wie nachfolgend
beschrieben.

Verwandtes Thema
Liste unterstützter Funktionen

5-041-957-64(1) Copyright 2022 Sony Corporation

Schalten Sie jedes Gerät ein.1

Konfigurieren Sie die Systemnetzwerkeinstellungen mithilfe einer MSU oder Software zur Kamerafernsteuerung.

Einzelheiten zur Konfiguration finden Sie in der Bedienungsanleitung der MSU oder Software zur Kamerafernsteuerung.

2

Konfigurieren Sie die folgenden Einstellungen mithilfe von [Technical] > [RCP/MSU] im Webmenü der Kamera.3

Wenn Sie eine MSU oder einen CNA-2 verwenden, setzen Sie [CNS Mode] auf [MCS]. Wenn Sie eine Software zur
Kamerafernsteuerung verwenden, setzen Sie [CNS Mode] auf [PC Control].

1.

Legen Sie die IP-Adresse der Master-MSU oder Software zur Kamerafernsteuerung unter [Master IP Address] fest.2.
Legen Sie die Kameranummer, für welche die Kamera registriert werden soll, unter [Camera No.] fest.3.
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Liste unterstützter Funktionen

Die folgende Tabelle führt die unterstützten Funktionen und ihre entsprechenden Betriebsbedingungen auf.

Bedienfeld Funktionen des Geräts Betriebsbedingungen

IRIS Manuelles Anpassen der Blende –

AUTO IRIS Ein-/Ausschalten von Auto Iris –

ND
Anpassen der Durchlässigkeit im variablen ND-
Modus und Wechsel von Voreinstellungspositionen

–

MASTER
GAIN

Manuelle Einstellung der Verstärkung (Einheiten von
3 dB)

Aktiviert, wenn sowohl der Aufnahmemodus auf Custom als
auch [Shooting] > [ISO/Gain/EI] > [Mode] im Kameramenü
auf [dB] gesetzt sind.

WHITE
(R/B)

Manueller Weißabgleich (R Gain/B Gain)

Aktiviert, wenn [White Mode] auf [Memory A (R/B)] oder
[Memory A (T/T)] gesetzt ist.WHITE

(Color
Temp)

Manueller Weißabgleich (Farbtemperatur/Farbton)
RCP > [Color Temp]: Farbtemperatur des
Weißabgleichs
RCP > [Balance]: Farbtonwert des Weißabgleichs

AWB Automatische Anpassung des Weißabgleichs –

ATW
Ein-/Ausschalten der Funktion ATW (Auto Tracing
White Balance)

Aktiviert, wenn der Aufnahmemodus auf Custom gesetzt ist.

BLACK R/B Anpassen des Schwarzabgleichs Aktiviert, wenn der Aufnahmemodus auf Custom gesetzt ist.

MASTER
BLACK

Festlegen des Master-Schwarzpegels

Aktiviert, wenn der Aufnahmemodus auf Custom gesetzt
ist.
H/V Ratio und Crispening werden aktiviert, wenn
[Paint/Look] > [Detail] > [Manual Setting] im
Kameramenü auf [On] gesetzt wird.
Um die Anzeigefunktion, die zwischen den Zielbereichen
der Multimatrixkorrektur unterscheidet, von einem RCP
aus zu aktivieren/deaktivieren, setzen Sie [Paint/Look] >
[Multi Matrix] > [Area Indication Control] im
Kameramenü auf [Menu & RCP].
Die Anzeigefunktion, die zwischen den Zielbereichen der
Multimatrixkorrektur unterscheidet, und BARS arbeiten
nur im Bridge-Modus.

DETAIL

Ein/Ausschalten der Detail-Funktion
Festlegen der Detailstufe
Festlegen von H/V Ratio
Festlegen von Crispening

User Matrix

Ein-/Ausschalten der benutzerdefinierten
Matrixkorrektur
Festlegen der Matrixkorrekturwerte (R-G/R-B/G-
R/G-B/B-R/B-G)

Multi Matrix

Ein-/Ausschalten der Multimatrixkorrektur
Festlegen von Farbton und Sättigung der für die
Multimatrixkorrektur verwendeten Farbe
Ein-/Ausschalten der Anzeigefunktion, die
zwischen den Zielbereichen der
Multimatrixkorrektur unterscheidet

Knee
Ein-/Ausschalten der Kniekorrektur
Ein-/Ausschalten der automatischen Kniefunktion
Einstellen von Kniepunkt und Kniesteigung

BARS Ein-/Ausschalten der Farbbalken
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Hinweis

Nachdem Sie das Gerät so konfiguriert haben, dass die Betriebsbedingungen für die zu verwendende Funktion hergestellt wurden, stellen Sie die
Verbindung zwischen Gerät und RCP/MSU/CNA-2 her. Falls die Betriebsbedingungen nach Herstellen der Verbindung angepasst werden, kann
unbeabsichtigtes Verhalten auftreten.

5-041-957-64(1) Copyright 2022 Sony Corporation

Bedienfeld Funktionen des Geräts Betriebsbedingungen

SHUTTER

Ein/Ausschalten der Verschlussfunktion
Festlegen des Verschlusszeitwerts
(Ein-/Ausschalten der Verschlussautomatik,
Festlegen des Winkelverschlusses, Festlegen des
langsamen Verschlusses und Festlegen von ECS
werden nicht unterstützt.)

Hinweis
Die RCP-Verschlusseinstellungen werden je
nach konfiguriertem Verschlusszeitwert ggf.
nicht angezeigt.

Die RCP-Verschlusseinstellungen werden ggf.
nicht korrekt angezeigt, wenn der Verschluss
nicht von der RCP aus bedient werden kann.

Wenn die Verschlussautomatik aktiv ist, arbeitet sie auch
dann weiterhin, wenn Sie den Verschluss ein-/ausschalten
oder den Verschlusszeitwert von der RCP aus ändern.
Wenn der Verschluss auf [Angle] eingestellt ist, wird das
Ein-/Ausschalten des Verschlusses sowie das Ändern der
Verschlusszeiteinstellung von der RCP aus nicht unterstützt.

CALL/Tally Unterstützt die Anzeige der CALL-/Tally-Funktion
Aktiviert, wenn im Webmenü die Einstellung [Technical] >
[Tally] > [Tally Control] auf [External] gesetzt ist.
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Betrieb mit einer Fernbedienung RM-IP500 (Option)

Sie können das Gerät mit einer Fernbedienung RM-IP500 bedienen, auf der die Softwareversion 2.2 oder höher ausgeführt wird. Die
Geräte kommunizieren mittels VISCA over IP (LAN).
Je nach zu bedienendem Element müssen Sie gegebenenfalls die Bildschirmanzeige des Geräts aufrufen. Bereiten Sie einen Monitor
vor, mit dem Sie die Bildschirmanzeige prüfen können.
Von einer Fernbedienung RM-IP500 aus werden die folgenden Vorgänge unterstützt.

Auswählen der Zielkamera
Anpassen des Bildausschnitts (Schwenken, Neigen, Zoom)
Anpassen des Fokus (ausgenommen mit Touch-Bedienung)
Registrieren und Aufrufen von Voreinstellungspositionen
Bedienen des Menüs des Geräts (ausgenommen Webmenü)
Anpassen der Helligkeit
Anpassen des Weißabgleichs
Anpassen des Schwarzabgleichs
Anpassen des Audioeingangspegels
Starten/Stoppen der Aufzeichnung
Ausführen von Funktionen der belegbaren Tasten des Geräts
Initialisierungsvorgänge des Objektivcontrollers
Betrieb der PTZ-Bildausschnitt-Steuerung
* Funktion in RM-IP500 Version 2.30 und neuer.

Einzelheiten zur Bedienung der RM-IP500 finden Sie in deren Bedienungsanleitung.

Hinweis

Wenn während des Schwenk-/Neigebetriebs der Bildausschnitt-Steuerung die Taste PRESET gedrückt wird, pausiert der erste Druck die
Bildausschnitt-Steuerung. Stellen Sie sicher, dass die Schwenk-/Neigevorgänge gestoppt haben. Drücken Sie dann erneut die Taste PRESET,
um eine Voreinstellung aufzurufen.

Tipp
Nutzen Sie bei Verwendung einer RM-IP500 die zu dieser mitgelieferte Schablone für dieses Gerät.

RM-IP500 (Schablone für dieses Gerät verwenden)
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Verbinden einer Fernbedienung RM-IP500

Einzelheiten zum Zuweisen von Funktionen siehe Bedienungsanleitung der RM-IP500.

5-041-957-64(1) Copyright 2022 Sony Corporation

Stellen Sie den SETUP-Schalter 3 des Geräts in die Position „ON“, um VISCA over IP-Kommunikation zu aktivieren.

Hinweis
Die Schalterstellung wird beim nächsten Einschalten des Geräts übernommen.

1

Verbinden Sie die RM-IP500 mit dem gleichen Netzwerk wie das Gerät.2

Gehen Sie wie in der Bedienungsanleitung zur RM-IP500 beschrieben vor, um die VISCA over IP (LAN)-Verbindung an
der RM-IP500 zu konfigurieren.

Weisen Sie dieses Gerät mithilfe des RM-Menüs > AUTO IP SETUP > ASSIGN CAM zu.

3

Weisen Sie je nach Bedarf Tasten und Reglern Funktionen dieses Geräts mithilfe der folgenden RM-Menüpunkte der RM-
IP500 zu.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Informationen zum Camera Remote SDK

Das Camera Remote SDK (Software Development Kit) ist eine Entwicklungsumgebung, die für Softwareentwickler bereitgestellt wird,
um Lösungen und Anwendungen unter Verwendung von Sony-Kameras zu entwickeln. Mithilfe dieses SDK können Entwickler Sony-
Kameras von einem Host-Computer aus fernsteuern und individuelle Anwendungen für die Aufnahme und Bildübertragung entwickeln.
Das SDK stellt außerdem viele Funktionen wie z. B. Ändern der Kameraeinstellungen, Aufnahmestart/-stopp, Live-Überwachung usw.
zur Verfügung.
Einzelheiten siehe folgende Webseite.
https://www.sony.net/CameraRemoteSDK/

5-041-957-64(1) Copyright 2022 Sony Corporation
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Informationen zur Synchronisierung mit einem externen Gerät

Wenn Sie mithilfe mehrerer Geräte aufnehmen, können diese über ihre GENLOCK-Anschlüsse mit einem bestimmten Referenzsignal
oder Zeitcode synchronisiert werden.

Einzelheiten zum Genlock siehe „Synchronisieren der Phase des Videosignals (Genlock)“.
Einzelheiten zum Synchronisieren von Zeitcodes siehe „Anwenden des Zeitcodes auf andere Geräte“.

Verwandtes Thema
Synchronisieren der Phase des Videosignals (Genlock)

Anwenden des Zeitcodes auf andere Geräte

5-041-957-64(1) Copyright 2022 Sony Corporation

450



Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronisieren der Phase des Videosignals (Genlock)

Sie können am GENLOCK-Anschluss zur Synchronisation ein Referenzsignal zuführen.
Die verwendbaren Eingangsreferenzsignale hängen von der Systemfrequenz des gewählten Aufzeichnungsformats ab.

Sie können mithilfe von [Technical] > [Genlock] > [Reference] im Kameramenü den Status der externen Synchronisation prüfen.

Hinweis
Falls das Referenzsignal instabil ist, kann keine Synchronisation erreicht werden.

Der Unterträger wird nicht synchronisiert.

Wenn Sie externe Synchronisation in einer störungsreichen Umgebung verwenden, wird Tri-Level-Synchronisation aufgrund ihrer hohen
Störfestigkeit empfohlen.

5-041-957-64(1) Copyright 2022 Sony Corporation

Systemfrequenz des Aufzeichnungsformats Unterstützte Eingangsreferenzsignale

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Anwenden des Zeitcodes auf andere Geräte

Versetzen Sie das Gerät, das den Zeitcode liefert, in einen Modus, in dem die Ausgabe des Zeitcodes weiterläuft (z. B. Free Run oder
Clock).

Hinweis

Stellen Sie sicher, dass die zugeführten Referenzsignale für Zeitcode und Video in einer Phasenbeziehung gemäß SMPTE-Zeitcodestandard
stehen.

Nach Herstellung der externen Synchronisierung wird der Zeitcode sofort mit dem externen Zeitcode synchronisiert, und im Anzeigebereich für
Zeitdaten wird der Wert des externen Zeitcodes angezeigt. Beginnen Sie jedoch nicht gleich mit der Aufnahme. Warten Sie einige Sekunden mit
dem Start der Aufzeichnung, bis sich der Zeitcodegenerator stabilisiert hat.

Wenn die Frequenz des Referenzvideosignals und die Bildfrequenz auf dem Gerät nicht gleich sind, kann keine Synchronisation erreicht werden,
und es ist keine einwandfreie Funktion des Geräts möglich. In diesem Fall erfolgt keine korrekte Verbindung des Zeitcodes mit dem externen
Zeitcode.

Wenn die externe Zeitcodequelle getrennt wird, kann sich der Zeitcode im Verhältnis zum Referenzzeitcode um ein Einzelbild pro Stunde
verschieben.

Aufheben der externen Zeitcodesynchronisation
Ändern Sie die Einstellung für [TC/Media] > [Timecode] im Kameramenü.
Die externe Synchronisation wird auch aufgehoben, wenn Sie die Systemfrequenz ändern oder beginnen, in einem
Spezialaufnahmemodus (Slow & Quick Motion oder Interval Rec) aufzunehmen.
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Legen Sie unter [TC/Media] > [Timecode] im Kameramenü Folgendes fest.

Setzen Sie [Mode] auf [Preset].
Setzen Sie [Run] auf [Free Run].

1

Drücken Sie die belegbare Taste, der die Funktion [DURATION/TC/U-BIT] zugewiesen ist, um den Zeitcode auf dem
Bildschirm anzuzeigen.

2

Führen Sie am GENLOCK-Anschluss ein HD- oder SD-Referenzvideosignal und am TC IN-Anschluss den
Referenzzeitcode zu.

Der Zeitcodegenerator Ihres Geräts synchronisiert sich mit dem Referenzzeitcode, und die Meldung „EXT-LK“ wird auf dem
Bildschirm angezeigt.
Etwa 10 Sekunden nach Herstellung der Verbindung bleibt die externe Verbindung auch dann bestehen, wenn der
Referenzzeitcode vom externen Gerät wegfällt, weil dieses vom Camcorder getrennt wird.

3
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Anschließen eines externen Mikrofons oder Audiogeräts

Sie können dem Gerät das Signal eines externen Mikrofons oder Audiogeräts zuführen und es in das aufgezeichnete oder
ausgegebene Video des Geräts einbetten.

Schließen Sie ein externes Mikrofon oder Audiogerät mithilfe eines XLR-Kabels an.

Wenn das Audiosignal mithilfe von [Audio] > [Audio Input] > [AUDIO IN Select] im Kameramenü auf [LINE] gesetzt ist, fungiert der
Anschluss AUDIO IN als Anschluss AUDIO IN CH-1 und AUDIO IN CH-2.

1

Kontakt Nr. Funktion

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Schalten Sie das Gerät aus und verbinden Sie das XLR-Kabel mit dem AUDIO IN-Anschluss.2

Stellen Sie bei Bedarf den SETUP-Schalter 2 so ein, dass die Phantomspeisung aktiviert wird.

Schalten Sie die Stromversorgung mit +48 V (Phantomspeisung) wie unten beschrieben ein/aus.
Schalter 2
Legt fest, ob die Stromversorgung mit +48 V (Phantomspeisung) ein-/ausgeschaltet wird, wenn ein Audioeingabegerät
angeschlossen wird.

Hinweis

3

Einstellung Beschreibung

OFF
(Standard)

Dadurch werden die Phantomspeisung mit +48 V deaktiviert und der Eingang LINE oder MIC als Audioquelle
für CH-1 und CH-2 festgelegt.

ON
Dadurch werden die Phantomspeisung mit +48 V aktiviert und das mit der Phantomspeisung kompatible
Mikrofon als Audioquelle für CH-1 und CH-2 festgelegt.
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Wenn Sie diesen Schalter in Stellung ON bringen und ein Mikrofon anschließen, das nicht mit einer +48-V-Quelle kompatibel ist, kann es
zu Schäden am angeschlossenen Gerät kommen. Überprüfen Sie die Einstellung, bevor Sie das Gerät anschließen.

Schalten Sie das Gerät ein und legen Sie mithilfe von [Audio] > [Audio Input] > [AUDIO IN Select] im Kameramenü den
Typ des angeschlossenen Geräts fest.

4
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Verwalten und Bearbeiten von Clips auf einem Computer

Sie können Clips mithilfe eines Computers verwalten/bearbeiten.

Importieren von Clips mithilfe eines Kartenlesers (optional erhältlich)

Verbinden Sie einen Kartenleser für CFexpress Type A-Karten oder für SD-Karten mit Ihrem Computer und importieren Sie die Clips
mit Software, die das Aufzeichnungsformat dieses Geräts unterstützt, z. B. Catalyst Browse.

Verwenden eines nichtlinearen Bearbeitungssystems

Ein nichtlineares Bearbeitungssystem erfordert ein optionales Bearbeitungsprogramm, das mit den Aufnahmeformaten des Geräts
kompatibel ist.
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Ausgeben eines faseroptischen Signals

Sie können ein in eine optisches Signal umgewandeltes SDI-Signal ausgeben, indem Sie ein SFP+-Modul (optional) mit dem
OPTICAL-Anschluss des Geräts verbinden. Verwenden Sie ein SFP+-Modul, das zum Signalband des jeweiligen Formats passt.
Signalband

4K (59.94p, 50p): 12G
4K (außer 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (außer 59.94p, 50p): 1.5G

Hinweis
Verwenden Sie ein Modul, das den folgenden Standards entspricht.

SFF-Standards
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-Standards
ST297/ST292/ST424/ST425/ST2081/ST2082

An das SFP+-Modul wird das gleiche Signal wie am SDI-Ausgangsanschluss ausgegeben.

Das Gerät unterstützt keine faseroptische Signaleingabe.

Verwenden Sie ein SFP+-Modul für faseroptische Signalausgabe. Einzelheiten zu geprüften SFP+-Modulen erhalten Sie bei Ihrem Händler oder
der zuständigen Sony-Kundendienstvertretung.
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* Energiestufe I (1,0 W)
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Zuführen eines Tally-Signals

In diesem Thema wird die Steuerung des Tally-Signals beschrieben.

Tally-Anzeige mithilfe eines Signals von einer Fernbedienung steuern

Sie können die Tally-Anzeige mithilfe eines VISCA over IP-Befehls von einem externen Gerät aus steuern, beispielsweise der RM-
IP500.
Setzen Sie im Webmenü oder Kameramenü die Einstellung [Technical] > [Tally] > [Tally Control] auf [External].

Tally-Anzeige von einem externen Gerät aus steuern

Sie können die Tally-Anzeige von einem externen Gerät aus gesteuert rot oder grün aufleuchten lassen, beispielsweise der RM-IP500
oder einem Schalter. Sie können die Tally-Anzeige mit Befehlen steuern, die über das Netzwerk gesendet werden oder hierzu ein Tally-
Signal verwenden, das Sie am OPTION-Anschluss des Geräts zuführen.
Setzen Sie im Webmenü oder Kameramenü die Einstellung [Technical] > [Tally] > [Tally Control] auf [External].
Wenn Sie ein Tally-Signal am OPTION-Anschluss zuführen, verbinden Sie Kontakt Nr. 7 mit GND (entweder Kontakt 4 oder 5), um die
Tally-Anzeige grün aufleuchten zu lassen oder Kontakt Nr. 8 mit GND (entweder Kontakt 4 oder 5), um sie rot aufleuchten zu lassen.

Hinweis

Wenn [Tally Control] auf [External] gesetzt ist, wird der Aufzeichnungsstatus des Geräts nicht von der Tally-Anzeige signalisiert.

Wenn gleichzeitig ein rotes und ein grünes Tally-Signal zugeführt werden, leuchtet die Tally-Anzeige des Geräts rot auf.

Kontaktbelegung des OPTION-Anschlusses

Kontakt Nr. Signalrichtung Signalspezifikation

1 – RS-232C TX-Signal (für Objektivcontroller)

2 – RS-232C RX-Signal (für Objektivcontroller)

3 OUT

Ausgang grüne Tally-Anzeige
Führt niedrigen Pegel, wenn grüne Tally-Anzeige leuchtet.
Hochohmig (Open-Drain-Ausgang), wenn grüne Tally-Anzeige nicht leuchtet.

4 – GND (Masse)

5 – GND (Masse)

6 OUT

Ausgang rote Tally-Anzeige
Führt niedrigen Pegel, wenn rote Tally-Anzeige leuchtet.
Hochohmig (Open-Drain-Ausgang), wenn rote Tally-Anzeige nicht leuchtet.

7 IN
Externer Steuereingang für grüne Tally-Anzeige
Verbindung mit Masse (Kontakt 4 oder 5) lässt Tally-Anzeige des Geräts grün aufleuchten.
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Steuern der Tally-Anzeige eines externen Geräts mithilfe eines von diesem Gerät ausgesandten Signals

Sie können die Tally-Anzeige eines externen Geräts mithilfe eines von diesem Gerät ausgesandten Signals steuern, indem Sie wie
unten gezeigt die Kontakte 3 und 6 des OPTION-Anschlusses miteinander verbinden.
Beispiel für die Verbindung der Kontakte 3 und 6 des OPTION-Anschlusses

Hinweis
Legen Sie keine Spannung an die Kontakte 7 und 8 an.

Verbinden Sie kein externes Gerät mit dem OPTION-Anschluss, das Spannung an diesen liefert.

Falls eine Spitzenspannung oder verpolte Spannung über dem Grenzwert an Kontakt 3 oder 6 angelegt wird, kann dies zu Fehlfunktionen,
Rauchentwicklung oder Bränden führen.

Legen Sie im Webmenü oder Kameramenü mithilfe von [Technical] > [Tally] > [Tally Control] das Ausgangssignal fest.
[Internal]: Status des Aufzeichnungsvorgangs des Geräts
[External]: Logische ODER-Verknüpfung der roten/grünen Tally-Signale, die durch das Gerät über die IN-Signale und von den Fernbedienungen
ausgehend empfangen werden.

5-041-957-64(1) Copyright 2022 Sony Corporation

Kontakt Nr. Signalrichtung Signalspezifikation

8 IN
Externer Steuereingang für rote Tally-Anzeige
Verbindung mit Masse (Kontakt 4 oder 5) lässt Tally-Anzeige des Geräts rot aufleuchten.
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Ausgabe von Verfolgungsdaten

Das Gerät kann Verfolgungsdaten in Bezug auf Schwenken/Neigen/Zoom, Fokus und Blende mit einem Synchronisierungssignal
synchronisiert ausgeben.
Diese Funktion gibt das Industriestandard-Protokoll free-d aus.

Tipp
Um zwei oder mehr Ausgabeziele festzulegen, wiederholen Sie die Unterschritte 3 bis 6 von Schritt 2 für [Destinations] > [2], [3] und [4] jedes
zusätzlichen Ausgabeziels.

Die Ausgabeziele für Verfolgungsdaten können nur unter Verwendung von IPv4 konfiguriert werden.

Sie können mithilfe von [Tracking Data] > [Camera Position] > [X][Y][Z] Kamerakoordinaten für die XYZ-Position der Verfolgungsdaten festlegen.

Datenausgabeformat

Tipp
Technische Einzelheiten entnehmen Sie dem „free-d Integration manual for AR/VR systems (Integrationshandbuch für free-d für AR-/VR-
Systeme)“. Wenden Sie sich an eine Sony-Vertriebsvertretung.

Die vom Gerät ausgegebenen Verfolgungsdaten umfassen die Daten gemäß dem in Type D1 des Protokolls free-d angegebenen
Format.

Hinweis

In den folgenden Situationen können die Verfolgungsdaten verzögert oder Werte nicht aktualisiert werden:

Wenn „S&Q Motion“ aktiviert ist
Wenn das Kameramenü angezeigt wird
Wenn die Miniaturbildanzeige angezeigt wird
Wenn aufgezeichnete Clips abgespielt werden
Wenn das Webmenü angezeigt wird

Setzen Sie für Ziele, an die keine Verfolgungsdaten gesendet werden müssen, die Einstellung [Output] auf [Off].

Bei der Ausgabe an mehrere Clients tritt eine konstante Verzögerung beim Zeitverlauf der Übertragung an das zweite und jedes folgende Ziel im
Vergleich zum Genlock-Signal auf. (Die Verzögerung nimmt für jeden weiteren folgenden Client zu. Die Latenz kann je nach Netzwerkumgebung
zunehmen.)

5-041-957-64(1) Copyright 2022 Sony Corporation

Rufen Sie die Web-App auf.1

Legen Sie die Methode zur Ausgabe der Verfolgungsdaten fest.2

Legen Sie im Webmenü mithilfe von [Technical] > [Tracking Data] > [Camera ID] die ID des Geräts fest.1.
Geben Sie unter [Destinations] > [1] > [IPv4 Address] die IP-Adresse des Ausgabeziels an.2.
Geben Sie unter [Destinations] > [1] > [Port] den Port des Ausgabeziels an.3.
Setzen Sie [Destinations] > [1] > [Output] auf [On].4.
Drücken Sie die Taste [OK].5.
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Anschließen eines Objektivcontrollers

Sie können den Zoom eines manuellen Zoomobjektivs über die Web-App, die RM-IP500 (Option) oder die Infrarot-Fernbedienung
bedienen, indem Sie einen handelsüblichen Objektivcontroller (Option) anschließen, der mit dem Gerät kompatibel ist.
Einzelheiten zum Anschließen eines Objektivcontrollers siehe Bedienungsanleitung zum Objektivcontroller.
Einzelheiten zum Einstellen des Zooms mithilfe eines Objektivcontrollers siehe „Zoom mithilfe eines Objektivcontrollers einstellen“.

Hinweis
Lesen Sie vor der Verwendung eines Objektivcontrollers dessen Bedienungsanleitung aufmerksam durch und stellen Sie sicher, dass Sie seine
Verwendung vollständig überblicken. Sony übernimmt keinerlei Haftung für Schäden, die durch die Verwendung eines Objektivcontrollers
entstehen.

„Clear Image Zoom“ ist nicht verfügbar, wenn ein Objektivcontroller aktiv ist. Es wird empfohlen, das „Clear Image Zoom“-Verhältnis auf 1,0×
einzustellen oder „Clear Image Zoom“ zu deaktivieren.

Wenn der Objektivcontroller aktiv ist, können keine Bildausschnittvorgänge der Kamera aufgezeichnet oder wiedergegeben werden.

Verwandtes Thema
Zoom mithilfe eines Objektivcontrollers einstellen

5-041-957-64(1) Copyright 2022 Sony Corporation
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Zoom mithilfe eines Objektivcontrollers einstellen

Gehen Sie wie folgt vor, um einen Objektivcontroller (Option) anzubringen und den Zoom einzustellen.

Prüfen des Objektivcontroller-Status
Drücken Sie die Taste  (Kamerastatus) im gemeinsamen Bereich des Web-App-Bildschirms, um den Kamerastatusbildschirm
aufzurufen.

Verbinden Sie einen Objektivcontroller mit dem Anschluss OPTION am Anschlussblock des Geräts.

Einzelheiten zum Anbringen siehe Bedienungsanleitung zum Objektivcontroller.

1

Richten Sie den Objektivcontroller für Ihr Zoomobjektiv ein.

Einzelheiten siehe Bedienungsanleitung zum Objektivcontroller.

2

Arretieren Sie die Schwenk-/Neigebewegung des Geräts und bringen Sie das Zoomobjektiv an.

Einzelheiten siehe „Anbringen eines Objektivs“.

3

Stellen Sie den Objektivcontroller so ein, dass er das Zoomobjektiv betätigen kann.4

Halten Sie den Kamerakopf in Vorwärts-/Rückwärtsrichtung im Gleichgewicht, sodass die Gleitschiene waagerecht ist.

Einzelheiten siehe Bedienungsanleitung zum Objektivcontroller und unter „Anbringen eines Objektivs“.

5

Setzen Sie im Webmenü die Einstellung [Technical] > [Lens Controller] > [Setting] auf [On] und drücken Sie die Taste
[OK].

Das Gerät startet neu. Warten Sie, bis der Vorgang zum Zurücksetzen von Schwenken/Neigen abgeschlossen ist.

6

Drücken Sie die Taste  (Objektivcontroller initialisieren) auf der Registerkarte  (Others) im
Kamerasteuerbereich auf dem Live-Betriebsbildschirm der Web-App.

Der Objektivcontroller bewegt sich, um den Zoombereich zu erfassen. Einzelheiten siehe Bedienungsanleitung zum
Objektivcontroller.
Wenn oben links im Kamerabildbereich die Anzeige  (Fehler am Objektivcontroller) zu  (Objektivcontroller bereit) wechselt,
ist die Vorbereitung abgeschlossen.

Hinweis

Beachten Sie den Betriebsbereich des Objektivs, wenn Sie den Objektivcontroller initialisieren.

7

Stellen Sie den Zoom mithilfe des Schiebereglers [Zoom] in der Web-App oder der Zoom-Steuertasten an der Infrarot-
Fernbedienung ein.

8
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Auf diesem Bildschirm können Sie den Status des Objektivcontrollers prüfen.

Hinweis
Wenn Sie das Objektiv wechseln, initialisieren Sie den Objektivcontroller.

„Clear Image Zoom“ ist nicht verfügbar, wenn ein Objektivcontroller aktiv ist. Es wird empfohlen, das „Clear Image Zoom“-Verhältnis auf 1,0×
einzustellen oder „Clear Image Zoom“ zu deaktivieren.

Tipp
Stellen Sie bei Verwendung der PTZ-Bildausschnitt-Steuerung die Beschleunigung/Abbremsung auf das Maximum ein. Beachten Sie außerdem,
dass die Genauigkeit abhängig vom Objektiv variiert. Prüfen Sie den Betrieb vor dem Einsatz.

5-041-957-64(1) Copyright 2022 Sony Corporation

Status Beschreibung

Off Power-Zoom in einem Objektiv mit E-Bajonett verwenden.

Communication
Error

Zwischen Gerät und Objektivcontroller ist ein Kommunikationsfehler aufgetreten.
Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller. Schlagen Sie dann in der
Bedienungsanleitung des Objektivcontrollers nach und initialisieren Sie diesen.

Uninitialized Führen Sie die Initialisierung durch.

Initializing Warten Sie, bis die Initialisierung abgeschlossen ist.

Initialization
Failed

Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller. Schlagen Sie dann in der
Bedienungsanleitung des Objektivcontrollers nach und initialisieren Sie diesen.

Working Zoom mithilfe des Objektivcontrollers steuern.

Rotation Error
Der gespeicherte Zoom-Bewegungsbereich und der Objektiv-Bewegungsbereich stimmen möglicherweise nicht
überein. Initialisieren Sie den Objektivcontroller.

System Error Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller. Schlagen Sie in der Bedienungsanleitung des
Objektivcontrollers nach und initialisieren Sie diesen, oder schalten Sie Gerät und Objektivcontroller aus und
erneut ein.Unknown Error
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Vorsichtsmaßnahmen bei Betrieb

Datenschutzhinweis
Die Verfolgungsfunktion der Kamera nutzt KI und Gesichtserkennungstechnologie, um Motive automatisch zu identifizieren und die
Schwenk-, Neige- und Zoomfunktionen zu steuern, damit das Motiv im Bild bleibt. Diese Funktion verarbeitet „biometrische“
Gesichtsdaten von Motiven, die vom Benutzer als Verfolgungsziele ausgewählt wurden. Diese Erkennungsdaten werden für ein festes
Intervall in der Kamera gespeichert und nicht an Sony gesendet. In der Kamera werden keine anderen erfassten Skelett- oder
Gesichtsinformationen gespeichert. Diese Erkennungsdaten können gelöscht werden, indem die Kamera ausgeschaltet, in den
Bereitschaftszustand versetzt oder die Verfolgungsfunktion gestoppt wird.
Durch die Verwendung dieser Kamerafunktion erklären Sie sich damit einverstanden, dass Sie für die Erfassung und Verwendung von
Bildern und Daten von Motiven gemäß den geltenden Datenschutzgesetzen verantwortlich sind. Es wird empfohlen, dass Sie
Personen vor der Aufnahme über die von dieser Kamera verwendete Verfolgungs- und Gesichtserkennungstechnologie informieren.
Bei Fragen wenden Sie sich an den Sony-Kundendienst.

Hinweise zur Verwendung
Respektieren Sie die Privatsphäre Anderer und halten Sie sich an alle lokalen Datenschutzgesetze, -vorschriften und moralischen
Standards der Aufnahmeorte, wenn Sie mit dieser Kamera Aufnahmen tätigen.
Verwenden Sie diese Kamera nicht für illegale oder unangemessene Zwecke.
Verwenden Sie diese Kamera nicht, um andere zu diffamieren, zu missbrauchen, zu belästigen, zu verfolgen, zu bedrohen oder
ihre gesetzlichen Rechte einschließlich der Rechte auf Privatsphäre und Öffentlichkeit zu verletzen.
Diese Kamera ist nicht für militärische oder polizeiliche Zwecke vorgesehen.

Vorsichtsmaßnahmen bei Transport und Verpackung
Sorgen Sie dafür, dass bei Transport und Verpackung des Geräts die folgenden Bedingungen eingehalten werden und schützen Sie
das Gerät vor starken Vibrationen und Stößen.

Nehmen Sie das Objektiv ab und setzen Sie die Gehäusekappe auf.
Bewegen Sie den Kamerakopf (A) nach vorn. Drehen Sie den Arretierhebel (B) des Kamerakopfs in Pfeilrichtung, um den
Kamerakopf zu arretieren.

Richten Sie den Kamerakopf so aus, dass er zur Vorderseite weist und arretieren Sie ihn mithilfe des Arretierhebels für
Schwenken/Neigen.

Ziehen Sie die Verbindungskabel ab.

Kondensation
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Wenn das Gerät aus einer kalten Umgebung in einen warmen Raum gebracht wird oder die Umgebungstemperatur schnell ansteigt,
kann sich auf der Oberfläche des Geräts bzw. im Inneren des Geräts Feuchtigkeit ansammeln (Kondensation). Schalten Sie in diesem
Fall das Gerät aus, und warten Sie, bis die Kondensation verdunstet ist, ehe Sie das Gerät verwenden. Die Verwendung des Gerätes
bei gebildetem Kondenswasser kann zu Beschädigungen führen.

CMOS-Bildsensorphänomene der Kamera

Hinweis
Die folgenden Phänomene, die bei Bildern auftreten können, sind typisch für Bildsensoren. Sie stellen keine Fehlfunktion dar.

Weiße Flecken
Obwohl Bildsensoren mit Präzisionstechnologie gefertigt werden, können in seltenen Fällen kleine weiße Flecken auf dem
Bildschirm erscheinen, die durch kosmische Strahlungseinflüsse usw. hervorgerufen werden.
Dies ist durch das Funktionsprinzip von Bildsensoren bedingt und stellt keine Fehlfunktion dar. Führen Sie regelmäßig APR aus.
Diese weißen Flecken treten vornehmlich in folgenden Fällen auf:

bei Betrieb mit hoher Umgebungstemperatur
bei erhöhter Verstärkung (höherer Empfindlichkeit)

Flimmern
Beim Aufnehmen unter Beleuchtung von Leuchtstoff-, Natrium- oder Quecksilberdampflampen oder LEDs können
Bildschirmflimmern und Farbabweichungen auftreten.

Objektiv und Schwenk-/Neigeantriebe
Wenn das Objektiv und der Schwenk-/Neigeantrieb für längere Zeit nicht bewegt werden, steigt die Viskosität des im Innern
aufgebrachten Schmierfetts an. Dadurch wird die Bewegung des Mechanismus verhindert. Bewegen Sie das Objektiv und den
Schwenk-/Neigeantrieb regelmäßig.

Hinweise zu Verschleißteilen
Lüfter und interner Akku des Geräts sind Verbrauchsmaterialien, die regelmäßig ersetzt werden müssen.
Wenn das Gerät bei Raumtemperatur betrieben wird, sollten die Teile ca. alle 5 Jahre ersetzt werden. Diese Ersatzfristen stellen
jedoch nur eine allgemeine Richtlinie und keine Garantie der Lebensdauer dieser Teile dar.
Weitere Informationen zum Austausch von Komponenten erhalten Sie bei Ihrem Händler.

Die Lebensdauer des Netzteils und des Elektrolytkondensators beträgt bei normalen Betriebstemperaturen und normaler
Verwendung etwa 5 Jahre (8 Stunden pro Tag; 25 Tage pro Monat). Falls die Nutzung die normale Nutzungshäufigkeit
überschreitet, ist die Lebensdauer ggf. entsprechend geringer.

Regelmäßige Kontrollen werden empfohlen, um richtige Funktion und lange Lebensdauer des Geräts sicherzustellen. Wenden Sie sich
für weitere Auskünfte über Kontrollen am Gerät an Ihren Sony-Kundendienst.

Informationen zum integrierten Akku
Das Gerät verfügt über einen internen Akku zum Speichern von Datum, Uhrzeit und anderen Einstellungen, während das Gerät
ausgeschaltet ist. Wenn das Gerät unter Verwendung des Netzteils an eine Steckdose angeschlossen oder über PoE++ mit Strom
versorgt wird, wird der integrierte Akku nach 24 Stunden geladen, unabhängig davon, ob das Gerät ein- oder ausgeschaltet ist. Wenn
das Netzteil nicht mit der Stromversorgung verbunden ist, entlädt sich der Akku innerhalb von ca. 2 Monaten vollständig. Verwenden
Sie das Gerät nach dem Laden des Akkus. Selbst wenn der Akku nicht geladen ist, können Sie das Gerät problemlos verwenden,
solange Sie das Datum nicht aufnehmen müssen.

Umgebungsbedingungen und Lagerung
Lagern Sie das Gerät an einem ebenen, belüfteten Ort.
Vermeiden Sie den Gebrauch und die Lagerung des Geräts an den folgenden Orten.

Orte, die Regen oder Wasser ausgesetzt sind (auch unter Dachüberhängen)
Im Freien und an Orten, die wärmer als 40 °C sind
Beachten Sie, dass in warmen Gegenden im Sommer die Temperatur im Innern eines Fahrzeugs mit geschlossenen Fenstern
leicht 50 °C übersteigen kann.
Orte, die kälter als 0 °C sind.
Feuchte oder staubige Orte. Orte, an denen das Gerät Regen ausgesetzt sein könnte
Orte, die Vibrationen oder Stößen ausgesetzt sind
Orte, an denen Strahlung, Röntgenstrahlen und starke Magnetfelder erzeugt werden.
Nahe an Radio- oder Fernsehsendern, die starke elektromagnetische Felder erzeugen.
Orte mit direkter Sonneneinstrahlung oder längere Zeit nahe an Heizungen
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Hinweis zu Laserstrahlen
Laserstrahlen können den CMOS-Bildsensor beschädigen. Wenn Sie eine Szene aufnehmen, in der Laserstrahlen zur Anwendung
kommen, achten Sie darauf, dass die Laserstrahlen nicht direkt in den CMOS-Bildsensor der Kamera gerichtet sind. Insbesondere
Laserstrahlen hoher Energie von medizinischen oder anderen Geräten können Schäden durch reflektiertes oder gestreutes Licht
verursachen.

So verhindern Sie elektromagnetische Interferenzen durch tragbare Kommunikationsgeräte
Die Verwendung von Mobiltelefonen und anderen Kommunikationsgeräten in der Nähe dieses Geräts kann zu Fehlfunktionen und der
Störung von Audio- und Videosignalen führen. Es wird empfohlen, mobile Kommunikationsgeräte in der Nähe des Geräts
auszuschalten.

Dieses Produkt nicht in der Nähe von medizinischen Geräten aufstellen
Dieses Produkt (einschließlich der Zubehörteile) enthält einen oder mehrere Magnete, die Herzschrittmacher, programmierbare Shunt-
Ventile für die Behandlung von Hydrozephalus oder andere medizinische Geräte beeinträchtigen können. Stellen Sie dieses Produkt
nicht in der Nähe von Personen auf, die solche medizinischen Geräte verwenden. Konsultieren Sie Ihren Arzt vor der Benutzung
dieses Produkts, falls Sie ein solches medizinisches Gerät verwenden.

Sicherheitsmaßnahmen
SONY KANN KEINE HAFTUNG FÜR SCHÄDEN JEDER ART DURCH UNTERLASSENE GEEIGNETE
SICHERHEITSMASSNAHMEN AN ÜBERTRAGUNGSGERÄTEN, DURCH UNVERMEIDBARE DATENPREISGABE AUFGRUND
DER ÜBERTRAGUNGSSPEZIFIKATIONEN ODER DURCH SICHERHEITSPROBLEME JEGLICHER ART ÜBERNEHMEN.
Je nach Betriebsumgebung können unbefugte Dritte im Netzwerk unter Umständen auf dieses Gerät zugreifen. Achten Sie beim
Verbinden des Geräts mit dem Netzwerk darauf, dass das Netzwerk gut abgesichert ist.
Vom Sicherheitsstandpunkt sollten Sie unbedingt über einen Webbrowser auf das Steuerfenster zugreifen und die werkseitig
eingestellten Werte für die Zugriffseinschränkung ändern, wenn das Gerät mit dem Netzwerk verbunden ist. Außerdem wird
empfohlen, ein Passwort mit einer ausreichend langen, für andere schwer zu erratenden Zeichenkette zu setzen und sicher
aufzubewahren.
Schließen Sie dieses Produkt beim Verbinden mit einem Netzwerk über ein System an, das eine Schutzfunktion bietet, wie etwa
ein Router oder eine Firewall. Andernfalls können Sicherheitsprobleme auftreten.

Stromversorgung
Das Gerät ist nicht mit einem Netzschalter ausgestattet. Um das Gerät auszuschalten, stellen Sie sicher, dass alle Vorgänge
beendet wurden und sich das Gerät im Bereitschaftszustand befindet. Trennen Sie dann das Netzteil. Bei Verwendung einer
Stromversorgung über PoE++ trennen Sie das LAN-Kabel.
Verwenden Sie möglichst eine Stromquelle an einem gut erreichbaren Ort und ziehen Sie den Netzstecker.
Wenn Sie eine Steckdose in staubiger Umgebung verwenden, reinigen Sie den Bereich um die Steckdose regelmäßig, um
Kriechströme zu vermeiden.
Trennen Sie bei Nichtgebrauch die Stromversorgung ab.

Vorsichtsmaßnahmen für bewegliche Teile
Achten Sie darauf, dass keine Fremdkörper in bewegliche Teile gelangen.
Üben Sie keine übermäßige Kraft aus, wenn Sie Teile per Hand bewegen. Andernfalls kann es zu einer Fehlfunktion kommen.
Stören Sie die Bewegung von Teilen im Betrieb nicht. Andernfalls kann es zu Verletzungen oder Fehlfunktionen kommen.
Wenn das Gerät längere zeit nicht verwendet wurde, funktionieren bewegliche Teile möglicherweise nicht ordnungsgemäß.
Betätigen Sie die Schwenk-/Neigefunktionen des Geräts regelmäßig.

Vorsichtsmaßnahmen für Dauerbetrieb
Das Gerät kann dauerhaft 365 Tage im Jahr betrieben werden (Bereitschaftszustand der Stromversorgung).
Führen Sie stets einen Aufnahmetest durch und überprüfen Sie, ob das Gerät normal funktioniert.

Durchgehende Aufnahmen über Zeiträume von mehr als 24 Stunden werden nicht garantiert.
Falls Sie länger als 24 Stunden aufzeichnen, versetzen Sie das Gerät in den Bereitschaftszustand und starten es erneut.

Beachten Sie, dass Sony keinerlei Haftung für den Bildinhalt übernimmt, wenn Sie während der Verwendung dieses Geräts
aufgrund einer Fehlfunktion keine Aufzeichnungen anfertigen können.
Bestätigen Sie vor dem Gebrauch immer, dass das Gerät richtig arbeitet. SONY KANN KEINE HAFTUNG FÜR SCHÄDEN JEDER
ART, EINSCHLIESSLICH ABER NICHT BEGRENZT AUF KOMPENSATION ODER ERSTATTUNG, AUFGRUND VON VERLUST
VON AKTUELLEN ODER ERWARTETEN PROFITEN DURCH FEHLFUNKTION DIESES GERÄTS ODER AUS JEGLICHEM
ANDEREN GRUND, ENTWEDER WÄHREND DER GARANTIEFRIST ODER NACH ABLAUF DER GARANTIEFRIST,
ÜBERNEHMEN.
SONY KANN KEINE HAFTUNG FÜR ANSPRÜCHE JEDER ART VON DEN BENUTZERN DIESES GERÄTS ODER VON
DRITTER SEITE ÜBERNEHMEN.
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SONY KANN KEINE HAFTUNG FÜR DIE BEENDIGUNG ODER EINSTELLUNG VON DIENSTLEISTUNGEN BEZÜGLICH
DIESES GERÄTS GLEICH AUS WELCHEM GRUND ÜBERNEHMEN.

Vorsichtsmaßnahmen für die Aufnahmefunktion
Führen Sie immer eine Probeaufnahme aus, und bestätigen Sie, dass die Aufnahme erfolgreich war. SONY KANN KEINE
HAFTUNG FÜR SCHÄDEN JEDER ART, EINSCHLIESSLICH ABER NICHT BEGRENZT AUF KOMPENSATION ODER
ERSTATTUNG, AUFGRUND VON FEHLFUNKTION DIESES GERÄTS ODER SEINER DATENTRÄGER ODER JEGLICHEN
ANDEREN DATENTRÄGERN ODER SPEICHERSYSTEMEN ZUR AUFNAHME VON INHALTEN JEDER ART ÜBERNEHMEN.
Bestätigen Sie vor dem Gebrauch immer, dass das Gerät richtig arbeitet. SONY KANN KEINE HAFTUNG FÜR SCHÄDEN JEDER
ART, EINSCHLIESSLICH ABER NICHT BEGRENZT AUF KOMPENSATION ODER ERSTATTUNG, AUFGRUND VON VERLUST
VON AKTUELLEN ODER ERWARTETEN PROFITEN DURCH FEHLFUNKTION DIESES GERÄTS ODER AUS JEGLICHEM
ANDEREN GRUND, ENTWEDER WÄHREND DER GARANTIEFRIST ODER NACH ABLAUF DER GARANTIEFRIST,
ÜBERNEHMEN.
SONY KANN KEINE HAFTUNG FÜR ANSPRÜCHE JEDER ART VON DEN BENUTZERN DIESES GERÄTS ODER VON
DRITTER SEITE ÜBERNEHMEN.
SONY KANN KEINE HAFTUNG FÜR VERLUST, RETTUNG ODER WIEDERHERSTELLUNG VON DATEN IM INTERNEN
SPEICHERSYSTEM, AUF AUFZEICHNUNGSMEDIEN ODER ANDEREN MEDIEN BZW. SPEICHERSYSTEMEN
ÜBERNEHMEN.
SONY KANN KEINE HAFTUNG FÜR DIE BEENDIGUNG ODER EINSTELLUNG VON DIENSTLEISTUNGEN BEZÜGLICH
DIESES GERÄTS GLEICH AUS WELCHEM GRUND ÜBERNEHMEN.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Ausgabeformate und Beschränkungen

In diesem Thema werden die Ausgabeformate und Beschränkungen beschrieben.

Hinweis

Die Auflösung des Ausgabeformats wird durch die Einstellungen unter [Project] > [Rec Format] > [Frequency], [Codec] und [Video Format] im
Webmenü oder Kameramenü beschränkt.

Die Auflösung des Ausgabeformats wird außerdem durch die Kombination mit der Einstellung für „S&Q Frame Rate“ beschränkt. Zusätzlich zur
Tabelle mit Ausgabeformaten für den Anschluss SDI OUT/HDMI OUT wechselt die HDMI-Ausgabe zu „Full HD“ oder geringer, wenn alle der
folgenden Bedingungen zutreffen.

[Shooting] > [S&Q Motion] > [Setting] ist auf [On] gesetzt
[Shooting] > [S&Q Motion] > [Frame Rate] ist höher als 60fps

Treffen die obigen Bedingungen zu, dann sind die Auswahloptionen 4096×2160P und 3840×2160P für die HDMI-Ausgabe unter [Monitoring] >
[Output Format] > [SDI/HDMI] grau unterlegt und können nicht ausgewählt werden.

Das Bild wird nicht ausgegeben, wenn eine Auflösung konfiguriert wurde, die höher als jene des Wiedergabebilds ist.

Ausgabeformate für den Anschluss SDI OUT/HDMI OUT

bei Systemfrequenz 50/59.94 Hz

Einstellung auswählbares Ausgabeformat

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (Standard)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (Standard)
1920×1080i
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bei Systemfrequenz 25/29.97 Hz

Einstellung auswählbares Ausgabeformat

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (Standard)
1920×1080P (Standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (Standard) 1920×1080P (Standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A) (Standard)
1920×1080P (Standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Ausgabe angehalten)
720×480P2)

720×576P3)

Die Bildschirmanzeige kann nicht überlagert werden.1)

bei Systemfrequenz 59.94 Hz2)

bei Systemfrequenz 50 Hz3)

Einstellung Output Format (Ausgabeauflösung)

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (Standard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i (Standard)
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bei Systemfrequenz 23.98 Hz

bei Systemfrequenz 24 Hz

Einstellung Output Format (Ausgabeauflösung)

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (Standard) 1920×1080i (Standard)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (Standard) 1920×1080i (Standard)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Einstellung Output Format (Ausgabeauflösung)

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (Standard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (Standard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P (Standard) 1920×1080P (Standard)

1920×1080PsF 1920×1080P

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (Standard) 1920×1080P (Standard)

1920×1080PsF 1920×1080P

1920×1080
1920×1080P (Standard) 1920×1080P (Standard)

1920×1080PsF 1920×1080P
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Einstellung Output Format (Ausgabeauflösung)

Aufnahme-/Wiedergabemodus RAW-Ausgabeauflösung/
Interne Aufnahmeauflösung SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (Standard)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (Standard)

4096×2160P
1920×1080P (Standard)
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Interchangeable Lens Digital Camera
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Fehlerbehebung

Stromversorgung

Bildausgabe

Symptom Ursache Lösung

Das Gerät kann nicht
eingeschaltet werden.

Das Netzteil ist nicht ordnungsgemäß mit dem DC IN-
Anschluss verbunden.

Stecken Sie das Stromversorgungskabel bis zum
Anschlag ein.

Das Netzkabel ist nicht ordnungsgemäß mit dem
Netzteil oder der Steckdose verbunden.

Stecken Sie das Stromversorgungskabel bis zum
Anschlag ein.

Das LAN-Kabel ist nicht ordnungsgemäß mit der
PoE++-Stromversorgung oder dem Gerät verbunden.

Stellen Sie sicher, dass das Kabel bis zum
Einrasten eingesteckt wurde.

Das LAN-Kabel ist mit dem OPTION-Anschluss
anstelle des LAN-Anschlusses verbunden.

Verbinden Sie das LAN-Kabel ordnungsgemäß mit
dem LAN-Anschluss.

Das Gerät ist mit einer Stromversorgung verbunden,
die PoE++ (IEEE802.3bt, gemäß Type 4, Class 8)
nicht unterstützt.

Verbinden Sie das Gerät mit einer
Stromversorgung, die PoE++ (IEEE802.3bt,
gemäß Type 4, Class 8) unterstützt.

Die Gesamtleistungsaufnahme übersteigt den
Maximalwert der PoE++-Stromversorgung.

Siehe Bedienungsanleitung der PoE++-
Stromversorgung.

Es ist ein Netzwerkkabel einer Kategorie
angeschlossen, die keine PoE++-Stromversorgung
unterstützt.

Verwenden Sie zur Verbindung mit dem LAN-
Anschluss ein Netzwerkkabel der Kategorie 5e
oder höher.

Kamera, PoE++-Stromversorgung und
Peripheriegeräte sind nicht geerdet.

Verbinden Sie Kamera, PoE++-Stromversorgung
und Peripheriegeräte mit der Erdung.

Symptom Ursache Lösung

Es wird kein Bild
ausgegeben.

Die verbundenen Geräte sind nicht richtig angeschlossen.
Stellen Sie die Verbindungen der
Geräte ordnungsgemäß her.

Die Ersteinrichtung wurde nicht abgeschlossen.
Schließen Sie mithilfe der Web-App
die Ersteinrichtung ab.

Am HDMI-Anschluss wird
kein Bild ausgegeben.

Es wurde ein Signal konfiguriert, das vom Zielgerät der HDMI-
Ausgabe nicht unterstützt wird.

Ändern Sie die Einstellung des
HDMI-Ausgabeformats oder
verwenden Sie ein Gerät, welches
das Ausgabesignal unterstützt.

Es wird ein Kabel verwendet, das den HDMI-
Ausgabestandard nicht unterstützt.

Verwenden Sie ein Kabel, das den
HDMI-Ausgabestandard unterstützt.
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Fernbedienung

Infrarot-Fernbedienung

Symptom Ursache Lösung

Am SDI-Anschluss wird
kein Bild ausgegeben.

Es wird ein Kabel verwendet, das den SDI-Ausgabestandard
nicht unterstützt.

Verwenden Sie ein Kabel, das den
SDI-Ausgabestandard unterstützt.

Der mit dem SDI-Anschluss verbundene Monitor unterstützt
das Ausgabesignal nicht.

Verwenden Sie einen Monitor, der
den SDI-Ausgabestandard
unterstützt.

Das Aufzeichnungsformat ist auf RAW-Ausgabe eingestellt.
Ändern Sie das Aufzeichnungsformat
auf eine andere Einstellung als RAW-
Ausgabe.

Die HDMI-Ausgabe ist auf SD-Auflösung eingestellt.
Ändern Sie die HDMI-Ausgabe auf
eine andere als SD-Auflösung.

An der Glasfaser wird kein
Bild ausgegeben oder das
Bild ist verzerrt.

Das verwendete Modul stimmt nicht mit den SFF- oder
SMPTE-Standards überein oder erfüllt nicht die Energiestufe I
(1,0 W).

Siehe „Ausgeben eines
faseroptischen Signals“.

Bei Verwendung der
externen Synchronisation
wird ein verzerrtes oder gar
kein Bild ausgegeben.

Es wird kein für das konfigurierte Videosignalformat
geeignetes externes Synchronisationssignal zugeführt.

Führen Sie ein für das konfigurierte
Videosignalformat geeignetes
externes Synchronisationssignal zu.

Der Ton ist gestört.

Kamera, PoE++-Stromversorgung und Peripheriegeräte sind
nicht geerdet.

Verbinden Sie Gerät, PoE++-
Stromversorgung und
Peripheriegeräte mit der Erdung.

Das Gerät wird in einer Umgebung mit Geräten verwendet,
die starke elektromagnetische Felder erzeugen (wie z. B.
TV-/Radiosendeantennen, Amateurfunksender,
Klimaanlagenmotoren, Stromversorgungstransformatoren).

Halten Sie das Gerät fern von
Geräten, die starke
elektromagnetische Felder erzeugen.

Objektiv, Objektivabstützung und Antriebseinheit sind in
Kontakt mit dem Gerät oder mit einem Gegenstand in der
Umgebung und es treten unnormale Geräusche auf.

Bringen Sie das Objektiv
ordnungsgemäß an.

Prüfen Sie, ob sich in der Nähe
der Kamera Hindernisse
befinden.

Symptom Ursache Lösung

Die Infrarot-Fernbedienung funktioniert
bei Betätigung nicht.

Der Betrieb der Infrarot-Fernbedienung ist
deaktiviert.

Setzen Sie im Webmenü die Einstellung
[Technical] > [IR Remote] > [Setting] auf
[On].

Die Batterie ist leer oder falsch eingelegt.

Betätigen Sie die Infrarot-
Fernbedienung in der Nähe des IR-
Sensors am Gerät. Wenn die Power-
LED blinkt, ersetzen Sie die Batterie.

Die Ersteinrichtung wurde nicht
abgeschlossen.

Schließen Sie mithilfe der Web-App die
Ersteinrichtung ab.

Die Schwenk-/Neigegeschwindigkeit ist
gering.

Die Schwenk-/Neigegeschwindigkeit der
Infrarot-Fernbedienung ist auf den
Normalmodus eingestellt.

Setzen Sie im Webmenü die Einstellung
[Technical] > [IR Remote] > [Pan-Tilt
Speed] auf [Max].

Die Bedienung zielte auf eine andere
als die gewünschte Kamera ab.

Das Infrarotsignal wurde von einer anderen als
der gewünschten Kamera empfangen.

Setzen Sie [Technical] > [IR Remote] >
[Setting] im Webmenü der nicht zu
steuernden Kamera auf [Off].
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RM-IP500

Web-App

Symptom Ursache Lösung

Die Kamera kann nicht von der
Fernbedienung RM-IP500 aus bedient
werden.

Die Stromversorgung der
Kamera ist nicht
angeschlossen.

Prüfen Sie, ob die Anzeige POWER des Geräts grün
oder orangefarben leuchtet.

Kamera oder Fernbedienung
sind nicht mit dem Netzwerk
verbunden.

Prüfen Sie die Verbindungen des Geräts und der
Fernbedienung.

Die Ersteinrichtung der Kamera
wurde nicht abgeschlossen.

Schließen Sie mithilfe der Web-App die
Ersteinrichtung ab.

Die VISCA over IP-
Kommunikation ist nicht
aktiviert.

Stellen Sie den SETUP-Schalter 3 am Anschlussfeld
des Geräts in die Position „ON“ und starten Sie das
Gerät neu.

Die IP-Adresse der Kamera hat
sich geändert.

Prüfen Sie die IP-Adresse der Kamera mithilfe von
[Network] > [Wired LAN] im Webmenü oder
Kameramenü.

Die IP-Adresse der Kamera wurde
mithilfe von AUTO IP SETUP auf der
Fernbedienung RM-IP500 geändert.

Seit dem Start der Kamera sind
mindestens 20 Minuten
vergangen.

Starten Sie das Gerät neu. Die IP-Adresse kann in
den ersten 20 Minuten nach dem Start des Geräts
mithilfe von AUTO IP SETUP geändert werden.
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Die Verbindung mithilfe eines
Webbrowsers kann nicht hergestellt
werden.

Es ist kein LAN-Kabel der
Kategorie 5e oder höher
angeschlossen.

Schließen Sie ein LAN-Kabel der Kategorie 5e
oder höher an.

Keine ordnungsgemäße
Verbindung mit einem LAN oder
LAN funktioniert nicht
ordnungsgemäß.

Prüfen Sie, ob die Link-LED für den LAN-
Anschluss leuchtet. Falls die Link-LED nicht
leuchtet, wenden Sie sich an Ihren
Systemadministrator.

Die Stromversorgung der Kamera
ist nicht angeschlossen.

Siehe Abschnitt „Stromversorgung“ oben.

Es ist keine gültige IP-Adresse für
das Gerät konfiguriert.

Setzen Sie die Netzwerkeinstellungen zurück.
Einzelheiten zum Zurücksetzen der
Netzwerkeinstellungen siehe
„Geräteeinstellungen zurücksetzen“.

Stellen Sie das Gerät auf den Modus mit fester
IP-Adresse ein und verbinden Sie es direkt mit
einem Computer, dem die Adresse
192.160.0.200 oder eine andere eindeutige
Adresse zugewiesen wurde. Geben Sie
192.160.0.100 in einen Webbrowser ein, um die
Web-App zu öffnen.

Einzelheiten siehe „Verbinden des Geräts per
Kabel mit einem Netzwerkgerät“.

Die konfigurierte IP-Adresse wird
von einem anderen Gerät
verwendet.

Prüfen Sie, ob die IP-Adressen von
Peripheriegeräten eindeutig sind.

Schließen Sie zuerst das Gerät direkt an einen
Computer an, auf dem ein Webbrowser geöffnet
ist und starten Sie dann das Gerät im Modus mit
fester IP-Adresse.

Einzelheiten siehe „Verbinden des Geräts per
Kabel mit einem Netzwerkgerät“.

Es ist ein IP-Adresskonflikt
aufgetreten, weil ein Gerät, das für
den Modus mit fester IP-Adresse
konfiguriert wurde, mit dem
gleichen Netzwerk verbunden
wurde.

Stellen Sie den SETUP-Schalter 4 (Modus mit
fester IP-Adresse) in die Position „OFF“ und
starten Sie das Gerät neu.

Die konfigurierte Subnetzmaske
stimmt nicht mit dem verwendeten
Subnetz überein.

Setzen Sie die Netzwerkeinstellungen zurück.
Einzelheiten zum Zurücksetzen der
Netzwerkeinstellungen siehe
„Geräteeinstellungen zurücksetzen“.

Es wird aus dem gleichen lokalen
Netzwerk über einen Proxy-Server
auf das Gerät zugegriffen.

Ändern Sie die Konfiguration so, dass kein
Proxy-Server verwendet wird.

Das für das Gerät konfigurierte
Standard-Gateway ist fehlerhaft.

Setzen Sie die Netzwerkeinstellungen zurück.
Einzelheiten zum Zurücksetzen der
Netzwerkeinstellungen siehe
„Geräteeinstellungen zurücksetzen“.
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Die eingegebene URL ist
fehlerhaft.

Geben Sie die korrekte URL ein und versuchen
Sie es erneut.

URL der Web-App siehe „Von einem
Webbrowser aus auf die Web-App
zugreifen“.

Der HTTP-Port ist fehlerhaft.

Rufen Sie das Kameramenü auf einem externen
Monitor auf und prüfen Sie die Einstellung
[Network] > [Wired LAN] > [HTTP Port]. Fall ein
anderer Wert als 80 konfiguriert wurde, fügen Sie
zu der im Webbrowser eingegebenen IP-
Adresse oder dem Hostnamen die HTTP-
Portnummer hinzu.
Beispiel: Wenn „HTTP Port“ auf 8080 gesetzt ist,
geben Sie http://<IP-Adresse>:8080 ein

Die HTTP-Portnummer des Geräts
wird gefiltert oder blockiert.

Ändern Sie die HTTP-Portnummer des Geräts
auf einen Port, der nicht gefiltert oder blockiert
wird.

Alte Cache-Inhalte des
Webbrowsers wirken sich
nachteilig aus.

Löschen Sie den Cache-Speicher des
Webbrowsers.

Verbindung zur Web-App kann nicht
mithilfe des 2D-Codes (QR-Code)
hergestellt werden.

Das verwendete Gerät unterstützt
mDNS nicht.

Verwenden Sie ein Gerät, das mDNS unterstützt.
Wenn Sie ein Gerät verwenden, das mDNS nicht
unterstützt, geben Sie die IP-Adresse direkt in
den Webbrowser ein.

Tablet oder Computer sind mit
einem anderen Netzwerk als die
Kamera verbunden.

Verbinden Sie Tablet oder Computer mit dem
gleichen lokalen Netzwerk wie das Gerät.

Verbindung zur Web-App kann nicht durch
manuelle Eingabe der URL hergestellt
werden.

Das verwendete Gerät unterstützt
mDNS nicht.

Verwenden Sie ein Gerät, das mDNS unterstützt.

Tablet oder Computer sind mit
einem anderen Netzwerk als die
Kamera verbunden.

Verbinden Sie Tablet oder Computer mit dem
gleichen lokalen Netzwerk wie das Gerät.

Der Authentifizierungsbildschirm wird
dauerhaft angezeigt.

Benutzername und Passwort
wurden nicht korrekt eingegeben.

Geben Sie den registrierten Benutzernamen und
das Passwort ein. Falls Sie die gespeicherten
Benutzerdaten vergessen haben, schlagen Sie
unter „RESET-Schalter“ in „Anschlussblock“
nach, um die Benutzerdaten für die
Netzwerkverbindung zu initialisieren.

Benutzername und Passwort
wurden ggf. von einem Benutzer
geändert, der sich mit einem
anderen Webbrowser angemeldet
hat.

Wenden Sie sich an den Geräteadministrator,
um die richtigen Angaben für Benutzername und
Passwort zu prüfen.
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Kamerabild wird nicht in der Web-App
angezeigt.

Die HDMI-Ausgabe der Kamera ist
auf 720×480 oder 720×576
eingestellt.

Ändern Sie die Auflösung der HDMI-Ausgabe
des Geräts.

Es ist ein HDMI-Monitor
angeschlossen, der das HDMI-
Ausgabesignal der Kamera nicht
unterstützt.

Entfernen Sie den HDMI-Monitor oder
verwenden Sie einen, der die Einstellungen für
das HDMI-Ausgabesignal unterstützt.

Das Gerät wurde neu gestartet
und die Sitzung wurde getrennt.

Warten Sie etwa eine Minute und laden Sie den
Inhalt des Webbrowsers neu.

Alte Cache-Inhalte des
Webbrowsers wirken sich
nachteilig aus.

Löschen Sie den Cache-Speicher des
Webbrowsers.

Auflösung des in der Web-App
angezeigten Kamerabilds ist gering.

Die Auflösung für den von der
Web-App verwendeten Video-
Stream 3 ist niedrig eingestellt.

Erhöhen Sie den Wert mithilfe von [Stream] >
[Video Stream] > [Size 3] im Webmenü.

Kameramenü wird auf Drücken der Taste
[Menu] nicht angezeigt.

Das Kameramenü ist so
konfiguriert, dass es nicht in das
HDMI-Ausgabesignal eingebettet
wird.

Setzen Sie im Webmenü die Einstellung
[Monitoring] > [Output Display] > [HDMI/Stream]
auf [On].

Wert einer Einstellung auf dem
Einstellungsbildschirm wird nicht
ordnungsgemäß aktualisiert/angezeigt.

Der Einstellungsbildschirm der
Web-App spiegelt die in einer
anderen Web-App geänderten
Einstellungen nicht automatisch
wider.

Drücken Sie die Taste [Reload] unten auf dem
Einstellungsbildschirm der Web-App. Die Werte
der Einstellungen auf dem angezeigten
Einrichtungsbildschirm werden erneut geladen
und aktualisiert.

Möglicherweise wirken sich die
Einstellungen bezüglich
temporärer Internet-Dateien
negativ aus.

Löschen Sie den Cache-Speicher des
Webbrowsers.

Konfigurations- oder Protokolldatei kann
nicht heruntergeladen werden.

Die Funktion des Webbrowsers
zum Herunterladen von Dateien ist
deaktiviert.

Aktivieren Sie die Funktion des Webbrowsers
zum Herunterladen von Dateien.

Auf den Einstellungsbildschirm der Web-
App kann zugegriffen werden, es können
jedoch keine Funktionen auf dem Live-
Betriebsbildschirm und dem Wiedergabe-
Betriebsbildschirm verwendet werden.

Der Betriebsbildschirm der Web-
App ist gesperrt.

Stellen Sie den Sperrschalter für die
Bildschirmbedienung oben rechts in der Web-
App in die Position  (Bedienung freigeben).

Es dauert einige Zeit, bis der Bildschirm
der Web-App angezeigt wird.

Das Streaming-Bild des Geräts
wird von mehreren Benutzern
gleichzeitig betrachtet.

Verringern Sie die Anzahl der Benutzer, die
gleichzeitig auf die Web-App zugreifen können.
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Aufnehmen

Kamera

Schwenken/Neigen

Symptom Ursache Lösung

Das Bild wird verzerrt oder ruckartig
dargestellt.

Die Videodaten werden durch
Überbelegung des
Kommunikationskanals bedingt
nicht ordnungsgemäß übertragen.

Verringern Sie die Streaming-Bitrate, setzen Sie
[Video Stream 3] > [Size] auf die kleinste Option
oder reduzieren Sie die Rate, um eine Reserve
im Kommunikationskanal zu schaffen.

Mehrere Webbrowser werden auf
dem Tablet ausgeführt und
belegen Speicher.

Schließen Sie Webbrowser-Instanzen, die im
Hintergrund ausgeführt werden.

Es sind zu viele Webbrowser-
Registerkarten geöffnet, wodurch
der Betrieb verlangsamt wird.

Schließen Sie die nicht mehr benötigten
Registerkarten.

Der Betrieb wird durch eine
übermäßige Anhäufung von
Cache- und Verlaufsinhalten des
Webbrowsers verlangsamt.

Löschen Sie den Cache-Speicher des
Webbrowsers.

Symptom Ursache Lösung

Bei Beginn und Ende von
Schwenk-/Neigebewegungen erscheint das
Bild verzerrt.

Das Bild kann verzerrt werden, wenn die
Bildstabilisierungsfunktion des Objektivs
aktiviert ist.

Deaktivieren Sie die
Bildstabilisierungsfunktion des
Objektivs.

Betrachtungswinkel hat sich ohne
Benutzeraktion geändert.

Es ist ein Fokuspumpen des Objektivs
aufgetreten.

Siehe „Kompensation des
Fokuspumpens“.

Fokus, Zoom oder Blende können nicht
bedient werden.

Die Einstellungen von Schaltern am Objektiv
sind ggf. fehlerhaft.

Siehe „Prüfen der Objektivschalter“.

Symptom Ursache Lösung

Schwenk-/Neigefunktionen
können nicht zurückgesetzt
werden.

Arretierhebel für Schwenken/Neigen
befindet sich in der Stellung LOCK.

Schieben Sie den Arretierhebel für
Schwenken/Neigen in die Stellung UNLOCK.

Kamera stoppt nicht in der
erwarteten Position.

Kamerablock ist nicht im
Gleichgewicht.

Bewegen Sie wie unter „Anbringen eines Objektivs“
beschrieben den Kamerablock vorwärts/rückwärts in
eine geeignete Position und schalten Sie das Gerät
dann erneut ein.

Es ist ein Objektiv angebracht, das
Schwenk-/Neigebewegungen nicht
unterstützt.

Schlagen Sie in den Angaben zur
Objektivkompatibilität nach und bringen Sie ein
Objektiv an, das Schwenk-/Neigebewegungen
unterstützt. Schalten Sie das Gerät dann wieder ein.

Der Befehl zum Zurücksetzen der
Schwenk-/Neigefunktionen kann nicht
ausgeführt werden.

Führen Sie das Zurücksetzen der
Schwenk-/Neigefunktionen wie unter „Zurücksetzen
der Schwenk-/Neigefunktionen“ durch.

Eine unerwartete Kraft wurde auf den
Kamerakopf ausgeübt, was einen
Steuerungsfehler der
Schwenk-/Neigefunktionen verursacht
hat.
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Die Kamera kehrt nicht zur
Vorderseite zurück, wenn die
Taste 
(Schwenk-/Neigeursprung)
gedrückt wird.

Der Deckenmontagemodus wurde
aktiviert.

Stellen Sie [Pan-Tilt] > [P/T Direction] > [Ceiling] im
Webmenü der tatsächlichen Installation entsprechend
ein und schalten Sie das Gerät wieder ein. Bei
Deckenmontage befindet sich der Anschlussblock an
der Vorderseite der Kamera.

Schwenk-/Neigefunktionen sind
beschränkt.

Es wurde eine Begrenzung der
Schwenk-/Neigebewegungen
konfiguriert.

Löschen Sie falls erforderlich die Begrenzungen des
Schwenk-/Neigebewegungsbereichs wie unter „P/T
Range Limit“ beschrieben.

Eine unerwartete Kraft wurde auf den
Kamerakopf ausgeübt, was einen
Schwenk-/Neigefehler verursacht hat.

Führen Sie das Zurücksetzen der
Schwenk-/Neigefunktionen wie unter „Zurücksetzen
der Schwenk-/Neigefunktionen“ durch.

Die Schwenk-/Neigebewegungen
werden in die entgegengesetzte
Richtung ausgeführt.

Die Einstellung für den
Deckenmontagemodus stimmt nicht
mit der tatsächlichen Montage überein.

Stellen Sie [Pan-Tilt] > [P/T Direction] > [Ceiling] im
Webmenü der tatsächlichen Installation entsprechend
ein.

Einstellungen bezüglich der
Schwenk-/Neigerichtung wurden
geändert.

Prüfen Sie die Einstellungen unter [Pan-Tilt] > [P/T
Direction] im Webmenü.

Bei Beginn und Ende von
Schwenk-/Neigebewegungen
bewegt sich das Bild nicht
ruckfrei.

Die Einstellung der
Beschleunigung/Abbremsung für
Schwenk-/Neigevorgänge ist zu hoch
eingestellt.

Verringern Sie mithilfe von [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] im Webmenü oder
Kameramenü die Einstellung der
Beschleunigung/Abbremsung für
Schwenk-/Neigevorgänge, um die Bewegung bei
Beginn und Ende sanfter zu gestalten. Beachten Sie,
dass dadurch das Objektiv länger braucht, um die
Maximalgeschwindigkeit zu erreichen.

Schwenk-/Neigefunktionen
wurden gestoppt.

Kamerablock ist nicht im
Gleichgewicht.

Bewegen Sie wie unter „Anbringen eines Objektivs“
beschrieben den Kamerablock vorwärts/rückwärts in
eine geeignete Position und schalten Sie das Gerät
dann erneut ein.

Die Einstellung der Rampenkurve
(Beschleunigung/Abbremsung) ist für
das angebrachte Objektiv zu hoch.

Falls ein großes Objektiv angebracht ist, verringern
Sie den Wert von [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] im Webmenü oder Kameramenü.

Es wird ein großes Objektiv verwendet.
Wenden Sie sich an Ihre Sony-
Kundendienstvertretung.

Gerät wird bei
Schwenk-/Neigebewegung
behindert.

Der Klemmhebel an der
Montageschraube für das
Objektivstützgestell stößt gegen die
Kamera.

Drehen Sie den Klemmhebel so, dass er nach oben
weist.

Der Klemmhebel der
Objektivabstützung stößt gegen die
Kamera.

Drehen Sie den Klemmhebel so, dass er nach oben
weist.

Der Arretierhebel des Kamerakopfs
stößt gegen die Kamera.

Stellen Sie sicher, dass sich der Arretierhebel des
Kamerakopfs ganz in der Stellung LOCK befindet.
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PTZ-Bildausschnitt-Steuerung
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Während der
Schwenk-/Neigebewegung treten
unnormale Geräusche auf.

Kamera ist nicht im Gleichgewicht.
Bewegen Sie den Kamerakopf vorwärts/rückwärts in
eine geeignete Position, sodass die Gleitschiene
waagerecht ist.

Die Einstellung der Rampenkurve
(Beschleunigung/Abbremsung) ist für
das angebrachte Objektiv zu hoch.

Falls ein großes Objektiv angebracht ist, verringern
Sie den Wert von [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] im Webmenü oder Kameramenü.

Der Kamerakopf ist nicht in seiner
Position befestigt und es tritt im Betrieb
ein Bewegungsgeräusch auf.

Bringen Sie den Arretierhebel des Kamerakopfs in die
Stellung LOCK.

Der Bildausschnitt ist versetzt,
wenn eine
Voreinstellungsposition
wiedergegeben wird.

Die Umgebungstemperatur hat sich
zwischen dem Speichern einer
Voreinstellungsposition und ihrer
Wiedergabe möglicherweise
wesentlich verändert.

Speichern Sie die Voreinstellungsposition erneut.

Die Objektivkalibrierung wird nicht
durchgeführt.

Führen Sie die Kalibrierung mithilfe von [Technical] >
[Lens] > [Lens Calibration] im Kameramenü durch.

Es wurde ein anderes als das Objektiv
angebracht, was beim Speichern der
Voreinstellung angebracht war.
Möglicherweise ist auch die Position
des manuellen Zooms unterschiedlich.

Speichern Sie die Voreinstellungsposition erneut.

Schwenken/Neigen und Zoom
werden bei Aufruf einer
Voreinstellungsposition nicht
synchronisiert.

Der Geschwindigkeitsbereich des
Objektivzooms liegt außerhalb des
Geschwindigkeitsbereichs der
Schwenk-/Neigebewegung.

Passen Sie die Geschwindigkeit der
Schwenk-/Neigebewegung oder die Bewegungsdauer
so an, dass der Bereich innerhalb des Zoom-
Geschwindigkeitsbereichs liegt.

Der Steuerbereich für den
Bildausschnitt in der Web-App ist
grau unterlegt und kann nicht
bedient werden.

Während der Miniaturbildanzeige und
der Wiedergabe sind
Schwenk-/Neigebewegungen nicht
verfügbar.

Rufen Sie den Bildschirm zur Wiedergabesteuerung
auf und verlassen Sie die Miniaturbildanzeige oder
stoppen Sie die Wiedergabe.

Die Schwenk-/Neigebewegungen sind
nicht verfügbar, wenn das Kamerabild
nicht in der Web-App angezeigt
werden kann.

Siehe „Web-App“ unter „Fehlerbehebung“.

Arretierhebel für Schwenken/Neigen
befindet sich in der Stellung LOCK.

Schieben Sie den Arretierhebel für
Schwenken/Neigen in die Stellung UNLOCK.

„Execute Pan-Tilt Reset“ wird in
der Web-App unter dem
Steuerbereich für den
Bildausschnitt angezeigt.

Eine unerwartete Kraft wurde auf den
Kamerakopf ausgeübt, was einen
Schwenk-/Neigefehler verursacht hat.

Führen Sie das Zurücksetzen der
Schwenk-/Neigefunktionen wie unter „Zurücksetzen
der Schwenk-/Neigefunktionen“ durch.
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PTZ-Bildausschnitt-Steuerung
kann nicht aktiviert werden.

Es ist kein Objektiv mit E-Bajonett
angebracht, das mit dem Gerät
kommunizieren kann.

Bringen Sie ein Objektiv mit E-Bajonett an, das mit
dem Gerät kommunizieren kann.

Das HDMI-Ausgabeformat ist größer
als 1920×1080.

Ändern Sie das HDMI-Format auf 1920×1080 oder
kleiner.

Die Stream-Einstellung lautet [RTSP]
und [Video Stream] > [Codec 2] ist auf
eine andere Einstellung als [Off]
gesetzt.

Setzen Sie im Webmenü die Einstellung [Stream] >
[Video Stream] > [Codec 2] auf [Off].

Die Stream-Einstellung lautet [NDI|HX]
und [Video Stream] > [Frame Rate 2]
ist auf eine Einstellung von mehr als
10fps gesetzt.

Setzen Sie [Stream] > [Video Stream] > [Frame Rate
2] auf 10fps oder weniger.

Aufnahme, Wiedergabe oder
Formatierung einer Speicherkarte
wurden während der PoE++-
Stromversorgung durchgeführt.

Stoppen Sie Aufnahme, Wiedergabe oder
Formatierung einer Speicherkarte und führen Sie
dann den Vorgang durch.

Der Schwenk-/Neige-/Zoombetrieb
stoppt nicht.

Aktivieren Sie die PTZ-Bildausschnitt-Steuerung
erneut, nachdem Sie Schwenken/Neigen/Zoom
gestoppt haben.

Die Verfolgung startet nicht.
Es wurde kein Verfolgungsziel
ausgewählt.

Tippen Sie auf eine Person.

Der Gesichtsrahmen einer
Person ist grün, aber sie wird
nicht verfolgt.

Der Betrieb wird pausiert.
Drücken Sie die Taste [Resume] im PTZ AFR-
Steuerbereich oder tippen Sie auf die zu verfolgende
Person.

Das Bild ist leicht verwaschen. [Speed Step] ist auf [Normal] gesetzt. Setzen Sie [Speed Step] auf [Extended].

Die Verfolgungsreaktion verläuft
schleppend. Der Beginn der
Bewegung ist verzögert.

[Ramp Curve] ist auf 6 oder geringer
gesetzt.

Setzen Sie [Ramp Curve] auf 7 oder höher.

Die Zoomreaktion erfolgt bei
Verwendung eines
Objektivcontrollers (Option)
schleppend.

Der Betriebsmodus des
Objektivcontrollers (Option) ist auf
sanfte Beschleunigung und
Abbremsung eingestellt.

Stellen Sie den Betriebsmodus mithilfe von [Lens
Controller] > [Mode] auf maximale
Beschleunigung/Abbremsung ein.

Die Verfolgung wird
unterbrochen.

Die Person ist in der Komposition zu
groß.

Verkleinern Sie die Person beispielsweise, sodass
mehr Platz in Bewegungsrichtung vorhanden ist.

Die Verfolgung stoppt plötzlich.
[Personal Identification] ist aktiviert
und Gesichtserkennung funktioniert.

Falls dieser Vorgang unbeabsichtigt ist, deaktivieren
Sie [Personal Identification].

Die Verfolgung wechselt zu einer
Person mit ähnlichem Gesicht,
wenn sie auf dem Bildschirm
erscheint.

[Personal Identification] ist aktiviert
und Gesichtserkennung funktioniert.

Falls dieser Vorgang unbeabsichtigt ist, deaktivieren
Sie [Personal Identification].

Die Kamera bewegt sich nicht auf
die Voreinstellungsposition.

Automatische Verfolgung mithilfe von
PTZ-Bildausschnitt-Steuerung ist aktiv.

Wenn während des Schwenk-/Neigebetriebs der
Bildausschnitt-Steuerung die Taste PRESET gedrückt
wird, pausiert der erste Druck die Bildausschnitt-
Steuerung. Stellen Sie sicher, dass die
Schwenk-/Neigevorgänge gestoppt haben. Drücken
Sie dann erneut die Taste PRESET, um eine
Voreinstellung aufzurufen.
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Aufnahme/Wiedergabe

Dateiübertragung

IP-Streaming

Symptom Ursache Lösung

Auf das Verfolgungsziel oder
andere Personen kann nicht
fokussiert werden, da sich
mehrere Personen innerhalb des
Blickfelds befinden.

Autofokus ist aktiv. Verwenden Sie die manuelle Fokussierung.

Symptom Ursache Lösung

Die Aufnahme beginnt nicht,
wenn Sie die Aufnahmetaste
START/STOP drücken.

Die Speicherkarte ist voll.
Speicherkarte durch neue mit ausreichend
Speicherplatz ersetzen.

Die Speicherkarte muss wiederhergestellt
werden.

Stellen Sie die Speicherkarte wie unter
„Wiederherstellen von Speicherkarten“ beschrieben
wieder her.

Die Aufnahme-/Tally-Anzeige ist als Tally-
Anzeige konfiguriert, sodass der
Aufzeichnungsstatus nicht über die Anzeige
bestimmt werden kann.

Konfigurieren Sie die Aufnahme-/Tally-Anzeige als
Aufnahmeanzeige wie unter „Zuführen eines Tally-
Signals“.

Audioaufnahme ist nicht
möglich.

Kein Mikrofon angeschlossen.
Verbinden Sie ein Mikrofon oder Audiogerät mit dem
AUDIO IN-Anschluss am Anschlussblock.

Die Einstellung [Master Input Level] besitzt
ihren Minimalwert.

Passen Sie [Master Input Level] an.

Aufgenommener Ton ist
verzerrt.

Die Einstellung des Audioeingangspegels ist
zu hoch.

Passen Sie [CH1 Input Level] bis [CH4 Input Level]
und [Master Input Level] an.

Wenn Sie ein Mikrofon in lauter Umgebung wie
beispielsweise bei einer Live-Musikveranstaltung
verwenden, passen Sie zunächst [AUDIO IN CH1
MIC Ref.] und [AUDIO IN CH2 MIC Ref.] an.

Aufgenommener Ton besitzt
einen hohen Rauschpegel.

Die Einstellung des Audioeingangspegels ist
zu niedrig.

Passen Sie die Einstellungen [Audio Input Level] und
[Audio] > [Audio] > [Audio Input] > [AUDIO IN CH1
MIC Ref.] oder [AUDIO IN CH2 MIC Ref.] an.

Clips können nicht
wiedergegeben werden.

Der Clip wird gerade bearbeitet.

Clips können nicht wiedergegeben werden, wenn
Sie Dateinamen oder Ordner geändert haben oder
der Clip auf einem Computer in Verwendung ist.
Dies ist keine Fehlfunktion.

Der Clip wurde mit einer anderen Kamera
und nicht mit diesem Gerät aufgezeichnet.

Clips, die auf anderen Geräten aufgenommen
wurden, werden möglicherweise nicht
wiedergegeben oder in falscher Größe angezeigt.
Dies ist keine Fehlfunktion.
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Das Hochladen von
Dateien schlägt fehl.

Benutzername und Passwort des
Servers sind nicht korrekt.

Benutzername und Passwort des Servers sind ggf. nicht
korrekt. Geben Sie die korrekten Daten ein.
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Verbindung mit externen Geräten
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Streaming nicht verfügbar.

Die Angaben für Benutzername und
Passwort in der Client-Anwendung
zum Betrachten des Streaming von
Gerät sind fehlerhaft.

Falls das Streaming-Format des Geräts auf [RTSP], [SRT-
Listener] oder [NDI|HX] eingestellt ist, ist es erforderlich, in
der Client-Anwendung die für dieses Gerät festgelegten
Angaben für Benutzername und Passwort einzugeben.
Geben Sie Benutzername und Passwort korrekt ein.

Das Streaming-Protokoll ist nicht
eingestellt.

Legen Sie mithilfe von [Stream] > [Stream Setting] im
Webmenü das Zielprotokoll fest.

Es wurden mehr als fünf RTSP-
Sitzungen festgelegt.

Setzen Sie die Anzahl der Sitzungen auf fünf oder
weniger.

UDP-Portnummer ist nicht korrekt
festgelegt.

Prüfen Sie mithilfe von [Stream] > [Stream] > [Stream
Setting] im Webmenü die Portnummer und andere
Einstellungen für das Zielprotokoll.

UDP-Kommunikation wird blockiert. Prüfen Sie die Einstellungen der Sicherheitssoftware.

Audio wird nicht per Streaming
übertragen.

Audio Streaming-Ausgabe ist auf
[Off] gesetzt.

Setzen Sie im Webmenü die Einstellung [Stream] > [Audio
Stream] > [Setting] auf [On].

Streaming wurde getrennt.
Während des Streaming wurden
Einstellungen zu Protokoll oder
Streaming-Codec geändert.

Legen Sie Protokoll und Streaming-Codec vor dem
Beginn des Streaming fest.

Bildgröße von [Video Stream 1]
kann nicht auf 4096×2160 oder
3840×2160 eingestellt werden.

Die Bildgröße beträgt 1920×1080,
wenn [Output Format] auf HDMI
gesetzt ist.

Die Bildgröße für das Streaming kann nicht höher als die
für HDMI eingestellt werden. Ändern Sie mithilfe von
[Monitoring] > [Output Format] im Webmenü die HDMI-
Bildgröße.

Bildrate von [Video Stream 1]
kann nicht auf 60 FPS oder
50 FPS eingestellt werden.

Die Streaming-Bildrate ist auf 29.97
oder weniger eingestellt.

Die für das Streaming verwendete Bildrate wird durch die
Systemfrequenz begrenzt. Ändern Sie mithilfe von [Rec
Format] > [Frequency] im Webmenü die Systemfrequenz.

Auf den Stream [Video Stream
3] kann nicht zugegriffen
werden.

[Video Stream 3] unterstützt
RTSP/SRT/NDI nicht.

Verwenden Sie [Video Stream 1] oder [Video Stream 2].

Der RTSP/SRT-Bildschirm wird
nicht ordnungsgemäß
aktualisiert/angezeigt.

Die für RTSP oder SRT verwendete
Portnummer wird gefiltert oder
blockiert.

Ändern Sie die RTSP- oder SRT-Portnummer auf einen
Port, der nicht von Geräten gefiltert oder blockiert wird, die
den Stream empfangen. Alternativ ändern Sie die für
RTSP oder SRT verwendete Portnummer am Gerät.

Das Bild wird verzerrt oder
ruckartig dargestellt.

Die Videodaten werden durch
Überbelegung des
Kommunikationskanals bedingt nicht
ordnungsgemäß übertragen.

Verringern Sie die Streaming-Bitrate oder setzen Sie den
Codec für [Video Stream 2] ([Codec 2]) auf [Off], um eine
Reserve im Kommunikationskanal zu schaffen.

Die Reihenfolge der Videopakete im
Kommunikationskanal hat sich
geändert.

Verwenden Sie sowohl auf Geräteseite als auch auf
Empfängerseite den gleichen Internet-Dienstanbieter.

Nicht als NDI-Gerät erkannt.
Das Streaming-Protokoll ist nicht auf
NDI|HX eingestellt.

Das Streaming-Protokoll muss auf NDI|HX eingestellt
werden, damit das Gerät als NDI-Gerät erkannt werden
kann. Setzen Sie im Webmenü die Einstellung [Stream] >
[Stream Setting] auf [NDI|HX].

Kann nicht als NDI-Gerät
verwendet werden.

Es ist keine NDI|HX-Lizenz installiert.

In Softwareversion 3.00 und höher ist eine NDI|HX-Lizenz
vorinstalliert. Wenn Sie eine Version vor 3.00 verwenden,
installieren Sie bitte die NDI|HX-Lizenz. Sie können
mithilfe von [Stream] > [Stream] > [Stream Setting] >
[NDI|HX] > [License] im Webmenü prüfen, ob eine
NDI|HX-Lizenz vorliegt.
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Externe Synchronisation

Tally

Objektivcontroller

Symptom Ursache Lösung

Synchronisation mit
externer Quelle nicht
möglich.

Es wird kein für das konfigurierte
Videosignalformat geeignetes externes
Synchronisationssignal zugeführt.

Führen Sie ein für das konfigurierte Videosignalformat
geeignetes externes Synchronisationssignal zu.

Gerät ist doppelt terminiert.

Das Gerät verfügt über einen integrierten 75-Ω-
Abschlusswiderstand. Stellen Sie eine direkte Verbindung
mit einer Signalquelle her (1:1) oder verwenden Sie einen
Verteiler (Splitter).
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Die Tally-Anzeige
leuchtet nicht auf.

Für die Helligkeit der Tally-Anzeige wurde Off
festgelegt.

Legen Sie im Webmenü mithilfe von [Technical] >
[Tally] > [Tally Lamp Brightness] eine geeignete
Helligkeit fest.

Die Aufnahme-/Tally-Anzeige ist als
Aufnahmeanzeige konfiguriert,

Konfigurieren Sie die Aufnahme-/Tally-Anzeige als
Tally-Anzeige wie unter „Zuführen eines Tally-Signals“.

RM-IP500 ist verbunden und VISCA over IP ist
deaktiviert.

Stellen Sie den SETUP-Schalter 3 am Anschlussblock
des Geräts auf „ON“.

Die Verbindung am OPTION-Anschluss ist
fehlerhaft oder der beabsichtigte Kontakt ist nicht
mit GND verbunden.

Verbinden Sie Kontakt Nr. 7 oder 8 des OPTION-
Anschlusses mit GND wie unter „Zuführen eines Tally-
Signals“ beschrieben.
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[Communication Error]
wird in  (Kamerastatus)
angezeigt.

Die Kamera kann nicht mit
dem Objektivcontroller
kommunizieren.

Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller.
Schalten Sie Gerät und Objektivcontroller aus und erneut ein.

[Rotation Error] wird in 
(Kamerastatus) angezeigt.

Im Objektivcontroller ist ein
Rotationsfehler aufgetreten.

Der gespeicherte Zoom-Bewegungsbereich und der Objektiv-
Bewegungsbereich stimmen möglicherweise nicht überein.
Initialisieren Sie den Objektivcontroller.
Sollte das Problem fortbestehen, wenden Sie sich an die Vertretung
des Herstellers des Objektivcontrollers.

[System Error] wird in 
(Kamerastatus) angezeigt.

Im Objektivcontroller ist ein
Systemfehler aufgetreten.

Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller.
Schlagen Sie in der Bedienungsanleitung des Objektivcontrollers
nach und initialisieren Sie diesen, oder schalten Sie Gerät und
Objektivcontroller aus und erneut ein.
Sollte das Problem fortbestehen, wenden Sie sich an die Vertretung
des Herstellers des Objektivcontrollers.

[Unknown Error] wird in
 (Kamerastatus)

angezeigt.

Im Objektivcontroller ist ein
unbekannter Fehler
aufgetreten.

Prüfen Sie die Verbindung zwischen Gerät und Objektivcontroller.
Schlagen Sie in der Bedienungsanleitung des Objektivcontrollers
nach und initialisieren Sie diesen, oder schalten Sie Gerät und
Objektivcontroller aus und erneut ein.
Sollte das Problem fortbestehen, wenden Sie sich an die Vertretung
des Herstellers des Objektivcontrollers.

„Clear Image Zoom“ kann
nicht verwendet werden.

„Clear Image Zoom“ ist nicht
verfügbar, wenn ein
Objektivcontroller aktiv ist.

Die „Clear Image Zoom“-Vergrößerung bleibt bei Verwendung eines
Objektivcontrollers stehen. Schalten Sie den Objektivcontroller
vorübergehend aus und passen Sie dann die „Clear Image Zoom“-
Vergrößerung an.
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Verwandtes Thema
Von einem Webbrowser aus auf die Web-App zugreifen

Verbinden des Geräts per Kabel mit einem Netzwerkgerät

Geräteeinstellungen zurücksetzen
Reset

Ausgeben eines faseroptischen Signals

Anschlussblock
Kompensation des Fokuspumpens

Prüfen der Objektivschalter

Anbringen eines Objektivs
Zurücksetzen der Schwenk-/Neigefunktionen

P/T Range Limit

Wiederherstellen von Speicherkarten
Zuführen eines Tally-Signals
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Hilfe

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Betriebsmeldungen

Wenn am Gerät Warnungen, Vorsichtsmeldungen oder zu bestätigende Betriebsbedingungen auftreten, wird eine Meldung im
Kamerabildbereich angezeigt, und die Anzeigen POWER und NETWORK an der Vorderseite sowie die Aufnahme-/Tally-Anzeige
beginnen, rot zu blinken.

Hinweis
Das Blinken der Aufnahme-/Tally-Anzeige ist nur aktiviert, wenn im Webmenü oder Kameramenü sowohl [Technical] > [Tally] > [Tally Control] auf
[Internal] als auch [Tally Lamp Brightness] nicht auf [Off] gesetzt sind.

Der Status der PTZ-Bildausschnitt-Steuerung wird angezeigt, wenn die Aufnahme-/Tally-Anzeige grün blinkt. Einzelheiten siehe „Status der PTZ-
Bildausschnitt-Steuerung aus der Ferne prüfen“.

Fehlermeldungen

Wenn die Anzeigen POWER und NETWORK wie unten beschrieben blinken, gehen Sie wie beschrieben vor.

Bei den folgenden Anzeigen wird das Gerät angehalten.

Warnmeldungen

Wenn eine der folgenden Meldungen auftritt, befolgen Sie die angezeigten Anweisungen.

Anzeige
POWER

Anzeige
NETWORK Ursache und Maßnahme

Blinkt
langsam
orange

Blinkt
langsam grün

Das Gerät kann nicht normal betrieben werden. Einzelheiten siehe [Maintenance] > [System Log] im
Webmenü. Falls das Problem auch nach Wechsel des Geräts in den Bereitschaftsmodus oder
Ausschalten und erneutem Einschalten weiterhin besteht, wenden Sie sich an Ihre Sony-
Kundendienstvertretung.

Blinkt
schnell
orange

Blinkt schnell
grün Am Gerät ist eine Fehlfunktion aufgetreten. Wenden Sie sich an Ihre Sony-Kundendienstvertretung.

Meldungsanzeige Aufnahme-/Tally-
Anzeige Ursache und Maßnahme

E + der
Fehlercode

Blinkt schnell

Weist auf eine Störung am Gerät hin. Die Aufzeichnung wird angehalten, auch wenn im
Kamerabildbereich ●REC angezeigt wird.
Schalten Sie das Gerät aus, und prüfen Sie die angeschlossenen Geräte, Kabel und
Datenträger. Falls der Fehler nach dem erneuten Einschalten weiterhin auftritt, wenden
Sie sich an die zuständige Sony-Kundendienstvertretung. Je nach Status des Geräts
treten Fehleranzeigen oder Warntöne ggf. nicht auf.

Meldungsanzeige Aufnahme-/Tally-
Anzeige Ursache und Maßnahme

Temperature High Blinkt
Die Innentemperatur ist zu hoch.
Schalten Sie den Camcorder aus, und warten Sie, bis die Temperatur sinkt.

Media Temperature
High

Blinkt
Die Temperatur der CFexpress-Karte ist hoch.
Ersetzen Sie die Karte oder lassen Sie diese vor erneuter Verwendung
abkühlen.

Voltage Low Blinkt Die DC IN-Spannung ist zu niedrig (Stufe 1). Prüfen Sie die Stromversorgung.

485



Warn- und Funktionsmeldungen

Auf dem Bildschirm können folgende Warn- und Funktionsmeldungen erscheinen. Befolgen Sie die angezeigten Anweisungen, um das
Problem zu beheben.

Meldungsanzeige Aufnahme-/Tally-
Anzeige Ursache und Maßnahme

Insufficient Voltage Blinkt schnell
Die DC IN-Spannung ist zu niedrig (Stufe 2). Aufzeichnen nicht möglich.
Schließen Sie eine andere Stromversorgung an.

Media Near Full Blinkt
Der freie Speicherplatz auf der Speicherkarte wird knapp.
Ersetzen Sie sie schnellstmöglich durch eine andere.

Media Full Blinkt schnell
Auf der Speicherkarte ist kein Speicherplatz mehr vorhanden. Der Clip konnte
nicht aufgenommen oder kopiert werden.
Ersetzen Sie die Speicherkarte.

Clips Near Full Blinkt
Die Anzahl weiterer Clips, die auf einer Speicherkarte aufgezeichnet werden
können, verringert sich.
Ersetzen Sie sie schnellstmöglich durch eine andere.

Clips Full Blinkt schnell

Die Höchstanzahl von Clips, die auf der Speicherkarte aufgenommen werden
können, ist erreicht.
Es ist nicht möglich, weitere Clips aufzunehmen oder zu kopieren. Ersetzen Sie
die Speicherkarte.

Last Clip Recording Blinkt
Der gegenwärtig aufgenommene Clip ist der letzte, der aufgezeichnet werden
kann, da die Höchstanzahl Clips erreicht wurde.
Bereiten Sie eine neue Speicherkarte vor.

Media(A) Life Near
End1) Blinkt

Die Speicherkarte erreicht bald das Ende ihrer Lebensdauer. Ersetzen Sie sie
schnellstmöglich durch eine andere.

Media(A) Life End1) Blinkt schnell
Die Speicherkarte hat das Ende ihrer Lebensdauer erreicht. Ersetzen Sie die
Speicherkarte.

Media(A) Near Full1) Blinkt Bei Verwendung der Funktion zur gleichzeitigen Aufnahme

Media(A) Full1) Blinkt schnell Bei Verwendung der Funktion zur gleichzeitigen Aufnahme

Media(A) Clips Near
Full1) Blinkt Bei Verwendung der Funktion zur gleichzeitigen Aufnahme

Media(A) Clips Full1) Blinkt schnell Bei Verwendung der Funktion zur gleichzeitigen Aufnahme

Media(A) Last Clip
Rec1) Blinkt Bei Verwendung der Funktion zur gleichzeitigen Aufnahme

(keine Anzeige) Blinkt

Im Objektivcontroller ist ein unbekannter Fehler aufgetreten.
Prüfen Sie den Status unter Kamerastatus in der Web-App.
Um detailliertere Informationen zu erhalten, prüfen Sie das Systemprotokoll in
der Web-App.

Für die Karte im Einschub B wird „(B)“ angezeigt.1)

Meldung in der Anzeige Ursache und Maßnahme

Backup Battery End
Please Change

Die verbleibende Kapazität der Pufferbatterie reicht nicht aus.
Verbinden Sie das Gerät mindestens 24 Stunden lang mit einer Stromversorgung, um
die Pufferbatterie zu laden.

Unknown Media(A)1)

Please Change

Es wurde eine partitionierte Speicherkarte oder eine Speicherkarte eingesetzt, die
mehr Clips enthält, als vom Gerät verwaltet werden können.
Die Karte kann nicht im Gerät verwendet werden und muss ersetzt werden.
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Informationen zu RTMP-Streamingfehlern

Die folgenden Fehlerinformationen werden ggf. am Gerät angezeigt. Führen Sie die folgenden Vorgänge je nach Erfordernis durch.

Meldung in der Anzeige Ursache und Maßnahme

Cannot Use Media(A)1)

Unsupported File System

Es wurde eine Speicherkarte mit fremdem Dateisystem oder eine unformatierte
Speicherkarte eingesetzt.
Die Karte kann nicht im Gerät verwendet werden und muss ersetzt oder vom Gerät
formatiert werden.

Media Error
Media(A) Needs to be Restored1)

Ein Speicherkarten-Fehler ist aufgetreten. Die Karte muss wiederhergestellt werden.
Stellen Sie die Speicherkarte wieder her.

Media Error
Cannot Record to Media(A)1)

Die Speicherkarte ist möglicherweise defekt und kann nicht mehr für die Aufzeichnung
verwendet werden.
Die Wiedergabe ist möglich. Es wird empfohlen, eine Kopie zu erstellen und die
Speicherkarte zu ersetzen.

Media Error
Cannot Use Media(A)1)

Die Speicherkarte ist möglicherweise defekt und kann nicht mehr für Aufzeichnung
oder Wiedergabe verwendet werden.
Die Karte kann nicht im Gerät verwendet werden und muss ersetzt werden.

Media(A) Error1)

Recording Halted
Playback Halted

Die Aufzeichnung und die Wiedergabe wurden angehalten, weil beim Zugriff auf die
Speicherkarte ein Fehler aufgetreten ist.
Sollte das Problem fortbestehen, muss die Speicherkarte ersetzt werden.

Media Reached Rewriting Limit
Change Media(A)1)

Die Speicherkarte hat das Ende ihrer Lebensdauer erreicht.
Erstellen Sie eine Sicherheitskopie, und ersetzen Sie die Karte. Wenn Sie diese Karte
weiterhin verwenden, funktionieren Aufzeichnung bzw. Wiedergabe eventuell nicht
ordnungsgemäß.
Einzelheiten dazu finden Sie in der Bedienungsanleitung der Speicherkarte.

The specified address is invalid.
Die angegebene Adresse ist ungültig.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

Cannot Use Specified Port Number
Die angegebene Portnummer ist ungültig.
Vergewissern Sie sich, dass die Einstellung korrekt ist.

Lens I/F Error(xx:xx)

Beim Anbringen eines Objektivs mit E-Bajonett wurde während der Kommunikation
über die Objektivschnittstelle ein Objektivfehler festgestellt.
Prüfen Sie den Status der Verbindung mit dem Objektiv mit E-Bajonett.
Sollte das Problem fortbestehen, wenden Sie sich an den Sony-Kundendienst und
nennen den Fehlercode (fünf Zeichen in Klammern).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Die Höchstanzahl Übertragungen wurde erreicht.
Löschen Sie alle nicht erwünschten Übertragungen. Die Einstellung für das Ziel zum
automatischen Hochladen ist ggf. ebenfalls fehlerhaft. Vergewissern Sie sich, dass die
Einstellung korrekt ist.

Fan Stopped

Der Lüfter läuft nicht mehr.
Vergewissern Sie sich, dass kein Staub oder Fremdkörper vorhanden sind.
Falls der Fehler nach Entfernen von Staub oder Fremdkörpern weiterhin auftritt,
wenden Sie sich an die zuständige Sony-Kundendienstvertretung.

Für die Karte im Einschub B wird „(B)“ angezeigt.1)

Fehlercode
Beschreibung Lösung

RTMP RTMPS

1002
1004

2002
2004

Verbindung zum RTMP-Server nicht
möglich.

Vergewissern Sie sich, dass die Einstellung der Server-URL korrekt ist.
Prüfen Sie die Netzwerkverbindung.

1003 2003
Domainname kann nicht aufgelöst
werden.

Vergewissern Sie sich, dass die Einstellung der Server-URL korrekt ist.
Prüfen Sie die Verbindung zum DNS-Server.
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Informationen zu SRT-Streamingfehlern

Die folgenden Fehlerinformationen werden ggf. am Gerät angezeigt. Führen Sie die folgenden Vorgänge je nach Erfordernis durch.
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Fehlercode
Beschreibung Lösung

RTMP RTMPS

–
2005
2008

CRL-Fehler
Vergewissern Sie sich, dass die Einstellung der Server-URL korrekt ist.
Vergewissern Sie sich, dass das Verbindungsziel vertrauenswürdig ist.

2006 CA-Zertifikatsfehler
Vergewissern Sie sich, dass die Uhreinstellung korrekt ist.
Vergewissern Sie sich, dass das CA-Zertifikat korrekt ist.

– 2007
Es ist kein CA-Zertifikat installiert.
Fehler bei der Authentifizierung des
Serverzertifikats.

Installieren Sie ein CA-Zertifikat.
Vergewissern Sie sich, dass das Verbindungsziel vertrauenswürdig ist.

4002 RTMP-Sitzung wurde getrennt.
Das Gerät wurde möglicherweise auf der RTMP-Serverseite getrennt.
Vergewissern Sie sich, dass die Einstellungen den empfohlenen
Codec-Parametern des Dienstes entsprechen.

4003
Die Qualität der Netzwerkverbindung
ist gering.

Prüfen Sie die Netzwerkverbindung.

Anderer Andere Fehler.

Fehlercode
Beschreibung Lösung

SRT-Caller

1001 Unerwarteter Fehler
Das Gerät funktioniert ggf. nicht ordnungsgemäß. Schalten Sie
das Gerät aus und erneut ein.

1002
Kommunikation wurde aufgrund von Änderungen
der Einstellungen getrennt

Die Kommunikation wurde getrennt, weil die Einstellungen
geändert wurden.
Stellen Sie die Verbindung wieder her.

5001 Unerwarteter Fehler
Das Gerät funktioniert ggf. nicht ordnungsgemäß. Schalten Sie
das Gerät aus und erneut ein.

5005 Verbindungsfehler
Vergewissern Sie sich, dass die Einstellung des
Verbindungsziels korrekt ist.

5006 Verschlüsselungsfehler
Vergewissern Sie sich, dass die Verschlüsselungseinstellung
korrekt ist.

5007 Unerwarteter Fehler Das Gerät funktioniert ggf. nicht ordnungsgemäß. Schalten Sie
das Gerät aus und erneut ein.5008 Unerwarteter Fehler

5009 Übertragungsfehler
Das Gerät wurde während der Kommunikation getrennt.
Prüfen Sie die Netzwerkverbindung.
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Liste der Menüelemente

In den folgenden Tabellen sind die Menüelemente des Geräts aufgeführt.

Legende
„Kameramenü“ und „Webmenü“
●: verfügbar
▲: einige Elemente verfügbar
–: nicht verfügbar

„All File“ und „Scene File“
Ja: Element wird in ALL- oder Szenendatei gespeichert
Nein: Element wird nicht gespeichert

„All Reset (except for Network Settings)“
Wenn [Reset] > [Reset] > [All Reset (except for Network Settings)] im Webmenü ausgeführt wird:
Ja: Element wird initialisiert (ausgenommen Netzwerkeinstellungen)
Nein: trifft nicht zu

„Network Reset“
Wenn [Reset] > [Reset] > [Network Reset] im Webmenü ausgeführt wird:
Ja: Element wird initialisiert (Netzwerkeinstellung)
Nein: trifft nicht zu

„Factory Default“
Ja: Element wird auf werkseitigen Standardwert zurückgesetzt
Nein: trifft nicht zu

Shooting

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

ISO/Gain/EI ● – Ja Ja Ja Ja Ja

ND Filter ● – Ja Ja*1 Ja Nein Ja

Shutter ● – Ja Ja Ja Nein Ja

Iris ● – Ja Ja Ja Nein Ja

Auto Exposure ● – Ja Ja*2 Ja Nein Ja

White ● – Ja Nein Ja Nein Ja

White Setting ● – Ja Nein Ja Nein Ja

Offset White ● – Ja Nein Ja Nein Ja

Focus ● ▲ Ja Nein Ja Nein Ja

S&Q Motion ● – Ja Nein Ja Nein Ja

LUT On/Off ● – Ja Nein Ja Nein Ja

Noise
Suppression

● – Ja Ja Ja Nein Ja

Flicker Reduce ● – Ja Nein Ja Nein Ja
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Project

Paint/Look

Pan-Tilt

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

SteadyShot ● – Ja Nein Ja Nein Ja

[Mode] nicht zutreffend*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] nicht zutreffend*2

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Base Setting ● ● Ja Nein Ja Nein Ja

Rec Format ● ● Ja Nein Ja*1 Nein Ja

Cine EI/Flex.ISO
Set

● – Ja Nein Ja Nein Ja

Simul Rec ● ● Ja Nein Ja Nein Ja

Proxy Rec ● ▲ Ja Nein Ja Nein Ja

Interval Rec ● ● Ja*2 Nein Ja Nein Ja

Picture Cache
Rec

● ● Ja Nein Ja Nein Ja

SDI/HDMI Rec
Control

● – Ja Nein Ja Nein Ja

Assignable Button ● – Ja Nein Ja Nein Ja

All File – ● Nein Nein Nein Nein Nein

[Frequency] nicht zutreffend*1

[Setting] nicht zutreffend*2

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Scene File ● – Nein Nein Nein Nein Nein

Base Look ● ▲ Ja*1 Nein Ja*1 Nein Ja*1

Reset Paint
Settings

● – Nein Nein Nein Nein Nein

Black ● – Ja Ja Ja Nein Ja

Knee ● – Ja Ja Ja Nein Ja

Detail ● – Ja Nein Ja Nein Ja

Matrix ● – Ja Ja Ja Nein Ja

Multi Matrix ● – Ja*2 Ja*2 Ja Nein Ja

LUT-Daten als grundlegenden Look importiert nicht zutreffend*1

[Axis] nicht zutreffend*2
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TC/Media

Monitoring

Audio

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for Network

Settings)
Network

Reset
Factory
Default

P/T Speed – ● Nein Nein Ja Nein Ja

P/T
Acceleration

● ● Nein Nein Ja Nein Ja

P/T Range
Limit

– ● Nein Nein Ja Nein Ja

P/T Direction – ● Nein Nein Ja Nein Ja

P/T Preset – ● Nein Nein Ja Nein Ja

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Timecode ● – Ja*1 Nein Ja Nein Ja

TC Display ● – Ja Nein Ja Nein Ja

Users Bit ● – Ja*1 Nein Ja Nein Ja

HDMI TC Out ● – Ja Nein Ja Nein Ja

Clip Name
Format

● – *2 Nein Ja Nein Ja

Update Media ● – Nein Nein Nein Nein Nein

Format Media ● – Nein Nein Nein Nein Nein

Media Life ● – Nein Nein Nein Nein Nein

[Setting] nicht zutreffend*1

[Auto Naming] trifft zu, [Camera ID] trifft nicht zu*2

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output Format ● ● Ja Nein Ja Nein Ja

Output Display – ● Ja Nein Ja Nein Ja

Display On/Off ● – Ja Nein Ja Nein Ja

Video Signal
Monitor

● – Ja Nein Ja Nein Ja

Marker ● – Ja Nein Ja Nein Ja

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for Network

Settings)
Network

Reset
Factory
Default

Audio Input ● ▲ Ja Nein Ja Nein Ja

Audio
Output

● ▲ Ja Nein Ja Nein Ja
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Thumbnail

Technical

Network

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Display Clip
Properties

● – Nein Nein Nein Nein Nein

Set Clip Flag ● – Nein Nein Nein Nein Nein

Lock/Unlock Clip ● – Nein Nein Nein Nein Nein

Delete Clip ● – Nein Nein Nein Nein Nein

Transfer Clip ● – Nein Nein Nein Nein Nein

Transfer Clip
(Proxy)

● – Nein Nein Nein Nein Nein

Filter Clips ● – Nein Nein Nein Nein Nein

Customize View ● – Ja Nein Ja Nein Ja

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Color Bars ● – *1 Nein *1 Nein Ja

Genlock ● – Nein Nein Nein Nein Nein

Tracking Data
Output

– ● Ja Nein Ja Nein Ja

Tracking Data – ● Ja Nein Ja Nein Ja

Tally ● ● Ja Nein Ja Nein Ja

Rec Review ● – Ja Nein Ja Nein Ja

Zoom ● – Ja Nein Ja Nein Ja

IR Remote – ● Nein Nein Ja Nein Ja

RCP/MSU – ● Ja Nein Ja Nein Ja

Lens Controller – ● Nein Nein Ja*2 Nein*2 Ja*2

Lens ● – Ja Nein Ja Nein Ja

APR ● – Nein Nein Nein Nein Nein

[Type] trifft zu, [Setting] trifft nicht zu*1

nur [Setting] trifft zu*2

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Camera Name – ● Nein Nein Nein Nein Ja

User – ● Nein Nein Nein Ja Ja

Wired LAN*1 ▲ ● Nein Nein Nein Ja Ja
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Stream

Maintenance

Einstellungsbildschirm PTZ AFR

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

File Transfer ● ▲ Nein Nein Ja Ja Ja

FTP Server 1 – ● Nein Nein Ja Nein Ja

FTP Server 2 – ● Nein Nein Ja Nein Ja

FTP Server 3 – ● Nein Nein Ja Nein Ja

SSL – ● Nein Nein Nein Ja Ja

SSH – ● Nein Nein Nein Ja Ja

Referer Check – ● Nein Nein Nein Ja Ja

Brute Force Attack
Protection

– ● Nein Nein Nein Ja Ja

nicht mithilfe des Kameramenüs konfigurierbar (nur Anzeige)*1

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for Network

Settings)
Network

Reset
Factory
Default

Stream
Setting – ● Nein Nein Ja*1 Nein Ja*1

Video Stream – ● Ja Nein Ja Nein Ja

Audio Stream – ● Ja Nein Ja Nein Ja

[NDI|HX] > [License] nicht zutreffend*1

Menüpunkt
(Ebene 2) Kameramenü Webmenü All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Language ● ● Nein Nein Ja Nein Ja

Accessibility – ● Ja Nein Nein Nein Ja

Clock Set ● ● Nein Nein Ja*2 Nein Ja

Reset – ● Nein Nein Nein Nein Nein

Hours Meter ● – Nein Nein Nein Nein Nein

Information – ● Nein Nein Nein Nein Nein

System Log – ● Nein Nein Nein Nein Ja

HTTP Access
Log

– ● Nein Nein Nein Nein Ja

Service – ● Nein Nein Nein Nein Nein

Software – ● Nein Nein Nein Nein Nein

Informationen zu Datum und Uhrzeit nicht zutreffend*1

Informationen zu [Time Zone], Datum und Uhrzeit nicht zutreffend*2
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Einstellungsbildschirm Zielfunktion All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Initial Setup Alle Nein Nein Nein Nein Nein

Framing Alle Nein Nein Ja Nein Ja

Tracking Operation Alle Ja Nein Ja Nein Ja

Start Position
Festlegen der
Startposition

Nein Nein Ja Nein Ja

Detection Settings Alle Ja Nein Ja Nein Ja

Others Alle Ja Nein Ja Nein Ja
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In Voreinstellungspositionen gespeicherte Elemente

„Ja“ bedeutet, dass die Einstellung für die Voreinstellungsposition gespeichert wird. „Nein“ bedeutet, dass sie nicht gespeichert wird.

Schwenk-/Neigeelemente

Zoom-Elemente

Fokus-Elemente

Anzeigestelle Menüpunkt Speicherung

Steuerbereich für den Bildausschnitt des Live-
Betriebsbildschirms

Schwenk-/Neigeposition Ja

[Pan-Tilt Speed] Nein

[Pan-Tilt] im Webmenü

[P/T Speed] Nein

[P/T Acceleration] Nein

[P/T Range Limit] Nein

[P/T Direction] Nein

[P/T Preset] > [Pan-Tilt] Nein

[P/T Preset] > [Default] > [Pan-Tilt Speed Unit] Ja1)

[P/T Preset] > [Default] > [Pan-Tilt Speed for
Separate] Ja1)

[P/T Preset] > [Default] > [Pan-Tilt Time for
Separate] Ja1)

Die beim Speichern einer Voreinstellungsposition herrschenden Werte von Einstellungen werden als Werte dieser Voreinstellungsposition gespeichert. Nachdem
die Werte gespeichert wurden, können sie für jede Voreinstellungsposition geändert werden. Einzelheiten siehe „Ändern der Übergangsgeschwindigkeit
(Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition“.

1)

Anzeigestelle Menüpunkt Speicherung

Steuerbereich für den Bildausschnitt des Live-Betriebsbildschirms
Zoomposition (Fokusabstand) Ja

[Zoom Speed] Nein

[Pan-Tilt] > [P/T Preset] > [Default] im Webmenü
[Zoom Sync] Ja1)

[Zoom Speed] Ja1)

[Technical] > [Zoom] im Kameramenü [Zoom Type] Nein

Die beim Speichern einer Voreinstellungsposition herrschenden Werte von Einstellungen werden als Werte dieser Voreinstellungsposition gespeichert. Nachdem
die Werte gespeichert wurden, können sie für jede Voreinstellungsposition geändert werden. Einzelheiten siehe „Ändern der Übergangsgeschwindigkeit
(Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition“.

1)

Anzeigestelle Menüpunkt Speicherung

Kamerabildbereich des Live-
Betriebsbildschirms

Für Echtzeitverfolgungs-AF angegebenes Verfolgungsziel Nein

Für Spot-Fokus angegebene Koordinaten Nein
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Verwandtes Thema
Ändern der Übergangsgeschwindigkeit (Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition

5-041-957-64(1) Copyright 2022 Sony Corporation

Anzeigestelle Menüpunkt Speicherung

Registerkarte  (Focus) des Live-
Betriebsbildschirms

Schalter [Touch Focus] Nein

Schalter [Auto Focus] Ja

Zustand der Taste [Focus Hold] Nein

Zustand der Taste [Push AF/MF] Nein

[Face/Eye Detection AF] Ja

[AF Subj. Shift Sens.] Ja

[AF Transition Speed] Ja

Fokusposition Ja1)

[Shooting] > [Focus] im Webmenü

[Push AF Mode] (einschließlich Einstellungen über belegbare
Tasten)

Nein

[Touch Function in MF] Nein

[AF Assist Control] Nein

[Pan-Tilt] > [P/T Preset] > [Default] im
Webmenü

[Focus Recall] Ja2)

[MF Speed] Ja2)

[Shooting] > [Focus] im Kameramenü

Mithilfe von [Focus Area] eingestellte Größe und Position des
Fokusbereichs Ja

Mithilfe von [Focus Area (AF-S)] eingestellte Position des
Fokusbereichs

Ja

Wird nicht wiederhergestellt, wenn der Schalter [Auto Focus] in der Stellung „On“ ist. Wird bei Stellung auf „Off“ wiederhergestellt.1)

Die beim Speichern einer Voreinstellungsposition herrschenden Werte von Einstellungen werden als Werte dieser Voreinstellungsposition gespeichert. Nachdem
die Werte gespeichert wurden, können sie für jede Voreinstellungsposition geändert werden. Einzelheiten siehe „Ändern der Übergangsgeschwindigkeit
(Schwenken-Neigen/Zoom/Fokus) beim Aufrufen einer Voreinstellungsposition“.

2)
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Blockschaltbilder

Audio Input

Audio Output

5-041-957-64(1) Copyright 2022 Sony Corporation
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Aktualisieren der Software eines Objektivs mit E-Bajonett

Sie können die Software eines Objektivs mit E-Bajonett mithilfe des Geräts aktualisieren.
Informationen zu updatefähigen Objektiven und die entsprechende Software finden Sie auf der Website des jeweiligen Objektivs.
Die Software wird mithilfe des Webmenüs aktualisiert.

Hinweis
Führen Sie die folgenden Tätigkeiten nicht aus, bis die Aktualisierung abgeschlossen ist.

Trennen der Netzwerkverbindung
Abnehmen eines Objektivs
Ausschalten der Stromversorgung

Falls eine Meldung angezeigt wird, die angibt, dass die Aktualisierung fehlgeschlagen ist, prüfen Sie die angezeigte Beschreibung und versuchen
Sie die Aktualisierung erneut.

5-041-957-64(1) Copyright 2022 Sony Corporation

Bringen Sie ein Objektiv mit E-Bajonett am Gerät an.1

Prüfen Sie [Maintenance] > [Information] > [Lens] > [Model Name] und [Version Number] im Webmenü.

Die Softwareversionsnummer des Objektivs mit E-Bajonett wird auf der Seite angezeigt.
Prüfen Sie die Nummer der Softwareversion und aktualisieren Sie die Software dann bei Bedarf.

2

Laden Sie in der Web-App die Aktualisierungsdatei der Objektivsoftware für Windows (Erweiterung .exe) auf das Gerät
herunter.

3

Drücken Sie unter [Maintenance] > [Information] > [Lens] > [Version Up] auf die Schaltfläche [Choose File] und wählen
Sie die heruntergeladene Aktualisierungsdatei aus.

4

Folgen Sie den Anweisungen auf dem Bildschirm.5
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Abdeckung der Objektivfreigabetaste anbringen

Sie können verhindern, dass das Objektiv unbeabsichtigt entfernt wird, indem Sie auf der Objektivfreigabetaste die zur
Deckenhalterung CIB-PCM1 (optional) mitgelieferte Abdeckung anbringen.

Hinweis
Dies verhindert nicht, dass das Objektiv vollständig entfernt wird.

Verwandtes Thema
Anbringen eines Objektivs

5-041-957-64(1) Copyright 2022 Sony Corporation

Bringen Sie ein Objektiv an.

Einzelheiten zum Anbringen eines Objektivs siehe „Anbringen eines Objektivs“.

1

Schieben Sie den Arretierhebel für Schwenken/Neigen in die Stellung LOCK, um die Schwenk-/Neigebewegung des
Kamerakopfs zu arretieren.

2

Bewegen Sie den Kamerablock in eine Position, in der die Abdeckung für den Objektivauswurf angebracht werden kann.3

Bringen Sie die Abdeckung für den Objektivauswurf so an, dass sie die Objektivfreigabetaste abdeckt.4

Sichern Sie die Abdeckung für den Objektivauswurf mit der dazugehörigen Halteschraube.5
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Lizenzen

MPEG-4 AVC Patent Portfolio Lizenz

DIESES PRODUKT IST LIZENSIERT IM RAHMEN DER AVC-PATENT-PORTFOLIOLIZENZ FÜR DEN PERSÖNLICHEN
GEBRAUCH EINES VERBRAUCHERS ODER SONSTIGE ZWECKE, FÜR DIE KEINE VERGÜTUNG GEZAHLT WIRD
(i) KODIEREN VON VIDEODATEN ENTSPRECHEND DEM AVC-STANDARD („AVC VIDEO“) UND/ODER
(ii) DEKODIEREN VON AVC-VIDEODATEN, DIE VON EINEM VERBRAUCHER ZUM PERSÖNLICHEN GEBRAUCH KODIERT
UND/ODER VON EINEM ZUM ANGEBOT VON AVC VIDEO ERMÄCHTIGTEN VIDEOANBIETER ERHALTEN WURDEN.
FÜR JEGLICHE ANDERE VERWENDUNG WIRD KEINE LIZENZ ERTEILT, DIES WEDER AUSDRÜCKLICH NOCH IMPLIZIT.
WEITERE INFORMATIONEN ERHALTEN SIE VON MPEG LA, L.L.C. SIEHE HTTP://WWW.MPEGLA.COM

Zugriff auf Software, für die die GPL/LGPL gilt

Dieses Produkt verwendet Software, für die die GPL/LGPL gilt. Dies bedeutet, dass Sie berechtigt sind, auf Quellcode für diese
Softwareprogramme unter den Bedingungen von GPL/LGPL zuzugreifen, ihn zu modifizieren und zu verbreiten.
Der Quellcode ist im Internet verfügbar. Verwenden Sie die folgende URL, und befolgen Sie die Anweisungen zum Herunterladen.
https://oss.sony.net/Products/Linux/
Bitte sehen Sie nach Möglichkeit davon ab, sich bezüglich des Inhalts des Quellcodes mit uns in Verbindung zu setzen.

μT-Kernel-Quellcode

In diesem Produkt wird der Quellcode von μT-Kernel unter der vom TRON Forum (www.tron.org) gewährten T-Lizenz 2.1 verwendet.

ENDBENUTZER-LIZENZVEREINBARUNG

Mit Beginn der Nutzung dieses Produkts erklären Sie sich mit den Bedingungen der Softwarelizenzvereinbarung einverstanden.
Die Softwarelizenzvereinbarung zwischen dem Kunden und Sony ist auf unserer Website (https://rd1.sony.net/help/di/el23/h_zz/)
verfügbar.

5-041-957-64(1) Copyright 2022 Sony Corporation
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Technische Daten

Allgemeines

Gewicht
ca. 4,6 kg (nur Gehäuse)
ca. 6,0 kg (mit Objektiv SELP28135G)

Abmessungen
Siehe „Äußere Abmessungen“.

Betriebsspannung
19,5 V DC
PoE++ (IEEE802.3bt, entspricht Type 4, Class 8)

Leistungsaufnahme
19,5 V DC: max. 80,0 W
PoE++: max. 71,3 W　

Betriebstemperatur
0 °C bis 40 °C

Lagertemperatur
−20 °C bis +60 °C

Aufzeichnungsformat (Video)
XAVC Intra
XAVC-I 4K/QFHD-Modus: VBR, Bitrate max. 600 Mbit/s, MPEG-4 AVC/H.264
XAVC-I HD-Modus: CBG, Bitrate max. 223 Mbit/s, MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD-Modus: VBR, Bitrate max. 150 Mbit/s, MPEG-4 H.264/AVC
XAVC-L HD 50-Modus: VBR, Bitrate max. 50 Mbit, MPEG-4 H.264/AVC
XAVC-L HD 35-Modus: VBR, Bitrate max. 35 Mbit, MPEG-4 H.264/AVC

Aufzeichnungsformat (Audio)
LPCM 24 Bit, 48 kHz, 4 Kanal

Bildrate bei der Aufzeichnung

XAVC Intra
XAVC-I 4K-Modus: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD-Modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD-Modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD-Modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50-Modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 35-Modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Aufnahme-/Wiedergabedauer
XAVC Intra
XAVC-I QFHD-Modus: 59.94P, ca. 30 Minuten (mit CEA-G160T)
XAVC-I HD-Modus: 59.94P, ca. 78 Minuten (mit CEA-G160T)
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XAVC Long
XAVC-L QFHD-Modus: 59.94P, ca. 115 Minuten (mit CEA-G160T)
XAVC-L HD 50-Modus: 59.94P, ca. 155 Minuten (mit CEA-G80T)
XAVC-L HD 35-Modus: 59.94P, ca. 210 Minuten (mit CEA-G80T)

Hinweis
Die Aufnahme- bzw. Wiedergabezeit kann aufgrund der Nutzungsbedingungen und Speichereigenschaften schwanken. Die Aufnahme- und
Wiedergabedauern gelten für kontinuierliche Aufzeichnung als ein einziger Clip. Die tatsächlichen Dauern können je nach Anzahl der
aufgezeichneten Clips kürzer sein.

Bereich Schwenk-/Neigeantrieb

minimale Schwenkgeschwindigkeit: 0,02°/s
minimale Neigegeschwindigkeit: 0,02°/s
maximale Schwenkgeschwindigkeit: 60°/s
maximale Neigegeschwindigkeit: 60°/s
Schwenkbereich: −170° bis +170°
Neigebereich: −30° bis +195°
NC-Wert: NC35 oder geringer
Voreinstellungspositionen: 100

Bereich Kamera

Bildgebungsgerät
35mm Vollbild (35,6 × 23,8 mm), CMOS-Sensor Exmor R

Anzahl der Pixel
ca. 12,9 Megapixel (Gesamtpixel)
ca. 10,3 Megapixel (effektive Pixel)

Autofokus
Erkennungsmethode: Phasenerkennung/Kontrasterkennung

Interne ND-Filter
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Linear variabler ND-Filter: 1/4ND bis 1/128ND

ISO-Empfindlichkeit
ISO 800/12800 (Modus Cine EI, D55-Lichtquelle)

Objektivgewinde
E-Bajonett

Belichtungsspielraum
15+ Stopps

Verschlussgeschwindigkeit
64F bis 1/8000 s (23.98P)

Öffnungswinkel
5,6° bis 360°, 2 bis 64 Einzelbilder

Zeitlupe & Zeitraffer
XAVC QFHD: 1 fps bis 120 fps
XAVC HD: 1 fps bis 240 fps
XAVC 4K: 1 fps bis 60 fps
XAVC HD (S35): 1 fps bis 120 fps
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Weißabgleich
2000 K bis 15000 K

Verstärkung (Gain)
−3 dB bis +30 dB (in Schritten von 1 dB)

Grundlegender Look
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Bereich Audio

Abtastrate
48 kHz

Quantisierung
24 Bit

Frequenzantwort
XLR-Eingang, MIC-Modus: 20 Hz bis 20 kHz (±3 dB oder weniger)
XLR-Eingang, LINE-Modus: 20 Hz bis 20 kHz (±3 dB oder weniger)

Dynamikbereich
XLR-Eingang, MIC-Modus: 80 dB (typ.)
XLR-Eingang, LINE-Modus: 90 dB (typ.)

Verzerrung
XLR-Eingang, MIC-Modus: 0,08% oder weniger (Eingangspegel −40 dBu)
XLR-Eingang, LINE-Modus: 0,08% oder weniger (Eingangspegel +14 dBu)

Bereich Eingänge/Ausgänge

Eingänge
DC IN

EIAJ-konform, 19,5 V DC

AUDIO IN

XLR-Typ, 5-polig, weiblich
LINE / MIC / MIC+48V schaltbar
MIC: Referenz −30 dBu bis −80 dBu

GENLOCK IN

BNC-Anschluss, 1,0 Vp-p, 75 Ω

TC IN

BNC-Anschluss

Ausgänge
SDI OUT

BNC-Anschluss, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Anschluss Typ A

OPTICAL-Ausgangsanschluss

SFP+-konform
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* Das Gerät unterstützt keine optische Signaleingabe.

Eingang/Ausgang
LAN-Anschluss

RJ-45, 1000BASE-T

OPTION-Anschluss

RJ-45, Tally-Ein-/Ausgangsanschluss

Bereich Medieneinschub

Einschub für CFexpress Type A/SD-Karte (2)

Lieferumfang

AC-Netzteil (1)
Netzkabel (1)
Infrarot-Fernbedienung (1)
Gehäusedeckel (1) (an Gerät angebracht)
Halteplatte für HDMI-Kabel (1)
Vor Verwendung dieses Geräts (1)
Garantieheft (1)

Äußere Abmessungen

Abmessungen sind ungefähre Werte.
Einheit: mm

Kameragehäuse
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Deckenhalterung

Gestaltung und technische Daten können jederzeit ohne Ankündigung geändert werden.

Stativschraube*1
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Marken

 ist eine Marke der Sony Group Corporation.
XAVC und  sind eingetragene Marken der Sony Group Corporation.
Die Begriffe HDMI und HDMI High-Definition Multimedia Interface sowie das HDMI-Logo sind Marken oder eingetragene Marken
von HDMI Licensing Administrator, Inc. in den Vereinigten Staaten und anderen Ländern.
Microsoft und Windows sind Marken oder eingetragene Marken von Microsoft Corporation in den USA und anderen Ländern.
Mac und macOS sind in den USA und anderen Ländern eingetragene Marken von Apple Inc.
Das „Catalyst Browse“-Logo ist eine Marke oder eingetragene Marke der Sony Group Corporation.
IOS ist eine Marke oder eingetragene Marke von Cisco in den USA und anderen Ländern und wird unter Lizenz verwendet.
iPadOS, Safari, und iPad sind eingetragene Marken von Apple Inc. in den USA und anderen Ländern/Regionen.
Android und Google Chrome sind Marken oder eingetragene Marken von Google LLC.
Wi-Fi ist eine eingetragene Marke der Wi-Fi Alliance.
Das SDXC-Logo ist eine Marke von SD-3C, LLC.
CFexpress und das CFexpress Type A-Logo sind Marken der CompactFlash Association.
NDI® ist eine Videoverbindungstechnologie und ist eine eingetragene Marke von Vizrt NDI AB in den USA und anderen Ländern.
JavaScript ist eine eingetragene Marke oder Marke von Oracle Corporation und/oder seinen Tochtergesellschaften in den USA und
anderen Ländern.
Intel, das Intel-Logo und Intel Core sind Marken von Intel Corporation oder ihrer Tochtergesellschaften.
QR Code ist eine Marke der Denso Wave Inc.
DaVinci Resolve ist eine eingetragene Marke von Blackmagic Design Pty. Ltd.
Alle weiteren Firmen- und Produktnamen sind eingetragene Marken oder Marken ihrer jeweiligen Eigentümer. Geschützte Objekte
sind in diesem Dokument nicht durch ™ oder ® gekennzeichnet.
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